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1 Introduction

Auditbase is an integrated information system for hearing clinics. The system seeks to integrate
all the working operations of a hearing clinic and to collect in one database all data concerning
clients, hearing instruments, administration, etc.

The Auditbase system has been designed as a Microsoft Windows based client-server complex
program for application in PC based networks.

Auditbase consists of a number of modules, which reflect the various working operations at a
hearing Audiology clinic.

An Auditbase system uses an SQL database in which all the data is saved. Using an SQL
standard provides the use of a range of standard tools to query information from the database.
For an outline of the database tables and their columns, please consult the technical help.

The SQL database and the Auditbase design provide the facility to link with other databases
and systems as is the case with a number of Auditbase versions.

Auditbase is also integrated with the Noah Framework for office systems platform by means of
the Noah4Auditbase subsystem. It means that you can run a variety of Noah fitting and
measurement modules and store the resulting data in the Noah database. For more
information about Noah, please visit the HIMSA website.

To facilitate the work with clients and their records in the database, Auditbase supports
recognition of data read by magnetic card scanner attached to the computer. Reading a client's
personal number by barcode scanner is also supported. In Stock, barcode scanners can be
used to read and process device barcodes.

The Auditbase system modules have all been provided with on-line help. To activate this
function, press F1, Shift+F1, or select Help in the menu.

To search for and retrieve a client in the system from anywhere in the system, press F3, fill in
the search criteria and select from the list of clients matching the criteria.

Client quick search (that is, search by personal number) is accessible by pressing Ctrl+F3.

System Administrator is a person(s) with the rights to make changes in Administration.

Documentation

From the Help menu in Auditbase, you can access the most recent user guide and change
guides concerning different areas in Auditbase that have changed significantly since Auditbase
version 4.15.xx.

The aim of this User guide is to provide a comprehensive description of the Auditbase modules.

Please refer to "Instructions for use" for:

© Auditdata - 2025, ID: 20.0040/36 12
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e General guidelines on how to use the system

e Safety instructions

¢ Installation and setup requirements

¢ How to log in and out of Auditbase

e Password change procedure

¢ User favourites and pane configuration options

© Auditdata - 2025, ID: 20.0040/36
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2 Client Summary

The Client Summary allows you to review the most recent information stored in the system for
the current client. This information is presented through 'views', which are combinations of
'panes'. Each pane contains client data from a specific module in the system and is available in
read-only mode.

To access the Client Summary:

1. Select the global client.

2. Use the toolbar button ,%, a navigation item on the menu, or the F4 key.

NOTE: Client summary is not available in the offline mode.

L] Client MR FIRSTNAME17653 LASTNAME17653 = _,":Z'__ > Bl user Maksy All loca
Navigation Mew Delete || Search | Label EditID PAS U
E}- Favourites
""" i\ Attention list Hospital no.  T117653 NHS no.
.20 Cli i
A Cl?ent'.s entnes. Title e .
----- .~ Clientinformation
Ga) Dayview Surname LASTNAME17653
--ff7] Documents and attachments First name FIRSTNAME17653
-fz] Booking Extra name
----- * Referral
..... Stock Address 99 JOCOO00O000(
--$=] Journal KOO0
JOCCOOC00
JOCCO0000K
Postcode PC:1484 City
Gender Male - User USER NAMET1 -
Individual client Date of bith ~ 02/13/1935 Age 90y Date of death
COI Client information Alert - PAS alert
-iff Paediatric
E Joumal Home phone 99999 999999 Work phone
-IF] Documents and attachments Mobile phone Consentto SMS
g\ Fh_aferral } Email Only email*
-2 8 Client's entries
-2 Device list Customer 50K WILTSHIRE PCT -
~Ed Observations and procedures Location All locations - Depariment All departments -

(% Earmoulds

S e Doctor GP DR PD FUDGE, TINKERS LANE SURGERY, HIGH STREET, WOC _

-[t1] Medical history Doctor ENT

;%\ D.|reF;t referral HA (adult) Civil status

{4 Tinnitus o

ﬁ Surgery Signif. other

-[£1] HI Satisfaction Questionnaire Transport
[]--% Measurements )

= . . Infi It

&[] Questionnaires nrormation -
B-[=] Tests
B+ Implant

o'E:| Run external application

CDI Client summary

-
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2.1 Client summary views

When you open the Client Summary module for the first time, the Client Summary page is
initially empty. Once you select a view, Auditbase will remember this selection, and the next
time you open the page, the last used view will be displayed.

Application, site and user views
In Auditbase, the following types of views are available:

¢ Application Views
¢ Site Views
e User Views

Each type of view is assigned a corresponding icon for easier identification within the system.

File Client summary views Client summary panas
I:@ I: ~[E E]
Mew view = Save view  Save view as.. Delete view Select view

-

3

5 Administrative view
L] Client MR FIRSTNAME17653 LASTNAME1765

3 €

Clinical view ==

&

Navigation Tose (D Implant view imary pa
& Favourites T Paediatric view

by Attention list @ s )

F- . . Layr) Urgery view

i 2 Client's entries - 9=

i Client information Surgery view (site]

H -

r-{24) Day view L. Surgery view {user)

i-00F] Documents and attachments

LB Bankinn

Standard application views

The Client Summary includes several predefined views that provide a comprehensive overview
of client information. These views are available in read-only mode and cannot be modified. They
can only be disabled in Auditbase Administration:

Administrative view
Clinical view
Implant view
Pediatric view
Surgery view

Site views

These views are available to all users in the system. Created and managed by users with
extended rights within the clinic, site views can be tailored to meet specific needs and can be
renamed or deleted by users with the corresponding permissions. They allow for a customized
experience while ensuring consistency across the clinic.

User Views

© Auditdata - 2025, ID: 20.0040/36 15
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Personalized views created by individual users, user views are only available to the user who
created them and can be modified to suit their specific requirements. They provide flexibility for
users to organize and access client information in a way that best fits their workflow.
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2.2 Available information (panes)

The “Client Summary Panes” ribbon includes all panes that can be potentially added to the
Client Summary views. The panes currently included in the view are highlighted.

09)) Auditbase - [Client summary- [Surgery view]]
File Client summary views Client summary panes

Coi Alerts g Journal E Audiogram list '_:‘: Devices E Client lists/Trials @ Observations and procedures

= & noan 5]
o . . = .
£ Parameters 2 Appointments E Audiogram ’__‘E Agcessories E Onward referrals W8 Implant ﬁ Condition (Paed and Adult)
g\ Referral list EJE ‘Waiting list entries F‘E Device information =u) Earmoulds = Tasks 24?- Surgeries Documents an'd sttachments ﬁ Paediatric - Diagnostic status
Summary panes
L] Client MR FIRSTNAME17653 LASTNAME17653 =R Z |[El| User Maksy All locations ¥ All departments - ¢ ?

The following panes are available:

¢ Audiogram list and Audiogram

e NOAH

o Alerts

e Parameters

¢ Referral list

e Journal

¢ Appointments

e Waiting list entries

¢ Device information (Devices, Accessories, Earmoulds)
¢ Client’s lists

¢ Onward referrals

¢ Tasks (related to the current client only)
e Surgeries

* Documents and attachments (3 panes)
¢ Observations and procedures

e Implant

¢ Paediatric - Diagnostic status

¢ Condition (Paed and Adult)

The pediatric tab from the Client Information screen is divided into two panes within the Client
Summary Module: Pediatric Diagnostic Status and Condition.

° The Pediatric Diagnostic Status pane includes essential details about the patient's early
health and hearing screening.

° The Condition (Paed and Adult) pane provides a summary of the patient's medical
history and current health status, including hearing-related information and risk factors.
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2.3 Managing views

To customize the Client Summary module to fit your specific needs, you can efficiently manage

views if you have the necessary extended rights.

¢ Your clinic (site) can decide whether users can create their own views or designate who
will be responsible for creating site views. Any user with rights to site/user views can

rename or delete other site/user views.

¢ If the standard application views do not meet your requirements, you can create a new

view or modify an existing one and save your changes.

Creating views

To do create a new view:

1. Open the Client summary module.
2. Navigate to the "Client summary views" tab and click on New view.

File Client summary views Client summary panes
[Er) [ EIE E]
Mew view = Save view  5Save view as.. Delete view Select view
summary vie...

3. Switch to the "Client summary panes" tab and select the panes you want to include in the

new view.

0)) Auditbase - [Client summary- [New]]

File Client summary views Client summary panes
o = —
£ Alerts E Journal E Audiogram list |_—'5 Devices E Client lists/Trials @ NOAH @ Observatio
ﬁoi Parameters =8 Appointments E Audiogram F‘E Accessories E Onward referrals &) Implant
&\ Referral list PE ‘Waiting list entries F‘E Device information i':::) Earmoulds = Tasks _’Z Surgeries Documents ar‘lvd attachments w Paediatric -
Summary panes
E Client MR FIRSTNAME17653 LASTNAME17653 -lale= 8| user Maksy Al locations +| Al depart
Navigation To select aview, please go to the ‘Summary pane views' ribbon and click on the Select view’ button
B Favourites
' -/, Attention list Client’s appointments
+-2 Q Clients entries o
/£ Clientinformation ] [
(4) Day view Date | Time [Loc| Appt |Status|Resource Reason |sms1| shsz2|Declined ¢+
-] Documents and attachments 04/09/2025 | 0915 T = |Resds | ++GP direct referral
{7 Booking 07/09/2008 | 08:15 82 | & |Resos |++Patientseffreferral
o FEE D6/25/2008 | 10:45 85 | D |*Reso7 |++GP directreferral
i--[m] Stock
04/19/2004 | 10:30 R S |Stassy
“£=] Journal
4

Individual client

5 Clientinformation

i Paediatric

=E| Journal

@] Documents and attachments
=$\ Referral
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4. Arrange the panes using the standard Windows functionality. Docking and undocking can
be performed as follows:

¢ Docking controls are displayed when you move a pane, highlighting the area where
the pane will be docked.

¢ Panes can be docked to the entire screen or to another pane using 'Arrow' buttons.

¢ Undocking is achieved by moving the pane from the docked position.

¢ When the screen is resized, the docked panes will automatically adjust their size to
remain visible.

) Auditbase - [Client summary- [New]]

File  Clientsummaryviews | Client summa 1y panes

S mets £ toumal ) Audiogram it o 3 Obserations and proceaures
5 Parameters £@ Appointments H Audiogram 2 @ mplant i Condition (Paed and Adutt)
EIREIEHAM . woiting st entries [ Device intormation G Eamoulds = Documents and attachments  eor o, iatric - Diagnostic status

E Client MR FIRSTNAME17653 LASTNAME17653 All locations v Al departments - ¢ ?

Navigation
B Favourites

/i) Attention list

i-39 Clients eniries

12 Clientinformation

@) Day view

14 Documents and attachments

oo | 06128iz008 | 10:45
; ooking
iS5, Referral
-] stock
4] Journal

Documents and attachments

@ ¢  Documenttype: P-NR Al

Name / Comments

Individual client

&5 Clientinformation
-ffi} Paediatric

£] Joumal % 4| | Document type:  P-NR - Al -
) Documents and attachments
-5, Referal

19, Client's entries

[ Device list

Observations and procedures £
5 Earmoulds

20 Hearing Therapist

[i] Medical history

55, Directreferral HA (adult)
) Tinnitus &l @
E{] a“ﬂsg:m;ymum Questionnaire [ modified date stock type to| Articte [ LR [User | serial number| Notes |
s 07/09/2008 | FITTED/EXC OTICC R |USEI| 788907

[i] Questionnaires 07/09/2008 | FITTED/EXC OTICC|L  |USEI 798911

2] Tests

Documents and attachments E!

O/O

Devices

Return to the “Client Summary Views” tab.

Click Save or Save as.

7. Onthe “Save Summary View” dialog, enter the new view name and type (user view or site
view).

8. Click Save. Saving can be done as either site views (available for all users on site) or user

views (only available to the user who created the view), depending on the extended rights.

o O

é Created views should be used only on the screen resolution they were designed for to
avoid issues such as not visible data and incomplete panes. When configuring the Client
Summary on a high-resolution screen, note that it may not display correctly on lower-resolution
screens, potentially omitting some information. To avoid confusion, it is recommended to
include the resolution size in the configuration name if it is especially high.

Modifying views

In addition to creating new views, you can also modify existing site or user views. This includes
adding, rearranging, or removing panes.
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Application views serve as initial templates and cannot be altered. Any changes made to
application views are temporary and will only be available during the current Auditbase
session.

Adding and rearranging panes

To add new panes or rearrange existing ones, follow the same steps outlined in the "Creating
Views" section.

Removing panes

To remove a pane from the current view, click the X control located in the top right corner of the
pane.

Updating pane content

Use the Refresh button 2 to update the content if a change was made by another user. Any
changes you make in a module will be refreshed automatically.

Updating client data

Each pane on the Client Summary screen includes a button that opens the corresponding
module, allowing you to make changes to client data.

¢ [f you click on a module icon without selecting any record, the corresponding module will
be opened.
¢ Double-clicking on any element in the pane will open that element in the module.

Client’s appointments

= (ra
[] e

Date | Time |Loc.| Appt |Status|Resource Reason |sMs1|sMs2| Declined offer Symbol
04/09/2025 | 09:15 T * |Resdf | ++GP direct referral 1

r S |Res95 | ++Patientself referral GWH Audio review~

++GP direct referral GWH Audia review-~

Stassy GWH Repair

¢ If you do not have the rights to view a record in a certain location or resource, an error
message will be displayed.
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0)) Auditbase - [Booking]
File Edit View Functions
o] O, ~
2 E = = &, Importfram oah ~ ©)
Q| & » = = = c =
Detailed = Quick  Exportto MS Qutlook  Print schedule = Print letter  Import data ' Export data "@ Export to Noah Log off = Exit Auditbase
Search Export Print Import/Export Client data Exit
E Client MR FIRSTNAME17653 LASTNAME17653 -[R1.& =Bl user Maksy All locations - All departments -| || ?
Navigation Monday 04/19/2004 10:30 - 10:45 | Stassy | N filter] v .| fi]| general paily |
=] Eavuumes Time Resg5 Travy Sta:
+-/i\, Aftention list 0800 '2-2+1 KJH22304 @
S, Clients entries 08:15 &
08:30
; Clientinformation
0845 Message X g
Day view 09:00 1]
+-4E| Documents and attachments 0915
; Booking gg ig /2. The appoiniment you are trying to view in Booking is not available because you do not have permissons: £
., Referral 10:00 LN H
Stock 10:15 -To seethe resource.
10:30
~£=] Journal ﬁ g
11:00 4
i
11:30 T W oI ]
11:45 iy @ NDONOTBOOK
12:.00 Fig @ RS, MRS FIRSTNAME4
1215 fij ® Efs. MR FIRSTNAMESS
Individual client 2 ® ¢ EEESERSIEE

Saving changes

After modifying the view configuration, you can save the changes using either Save view or Save
view as on the "Client summary views" tab.

» Save view: This option will save the changes directly to the current view.
e Save view as: This option provides additional options, such as saving the view under a
different name or as a different view type.

File Client summary views Client summary panes
[@ [ E]
Mew view | Save wiew | Save view as.. Delete view Select view
I,} Summary vig..,
Save summary view x

Save Close

Save to the current summary view

Rename the current summary v
# Save as a new Client summary view
Mame Draily view

Save as site view

#| Save as userview

Deleting views
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To manage your views effectively, you may need to delete certain views. This helps maintain a
clean and organized workspace, ensuring that only the most relevant views are accessible.

To delete a view, select the appropriate option on the "Client Summary Views" tab. With the
necessary rights, you can delete both user views and site views created by others.
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3 Clients and Client information

Click the button below to access our training materials.

Client registration and client information is managed from the Client information module.

A client must be registered in the client module before you can work with the client in the other
modules.
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3.1 General information

General client information is listed to the left. It contains a primary identification code, usually
labelled Hospital no. or Case no. and a secondary identification code usually labelled as NHS
no. The formats of the identifier codes i.e., what types of characters can be used at what
position, the maximum length and any hyphenation or space characters that can be entered for
new patients’ are set by the System Administrator. The visible lengths of the fields can be set
larger to view historical or imported patients. Other fields shown include Title (which is a drop-
down list that can be edited by the System Administrator or you can type in individual values),
name, Address, GP, Date of birth, Age (years and months for under-fives), phone numbers,
Email, Location and Department that the client is most associated with and more. Unlike other
date fields in the application, which all activate a calendar on right click, the Date of birth field
brings up an edit dialog on right click. You must highlight the field first and then the date can be
copied to paste elsewhere. The Date of Birth is expected to be entered by keyboard rather than
calendar.

¢ Last name (Surname) is always a mandatory field to complete. In addition, First name,
Extra name and Birth date can be made mandatory via the Administration tool.

<)) Auditbase - [Client information]

File Edit View Functions Settings
o) o] o] °] B =
¥ a8 = [+]
QA @ B e = e - =2
Detailed Quick Mew  Save  Systeminfo  Print | Printlabel Importdata Exportdata ExporttoMoah Logoff | Exit Auditbase
Search Client Print Import/Export Client data Exit
L] Client <T>T11001 MASTER FIRSTNAME1001 LASTNAME1001 - 3 |B | User SysAdm All locations = All departments - * >
New Save Delete Search Label Edit ID PAS update e
Hospital no T11001 NHS no. Contacts | Details | Lists/Photo  Devices | Onward referrals and reporting  Implant  Visit charge | Paediatri 4 »
Title MASTER - -
Additional professional contacts Remaove
S LASTNAMET001 K‘Type ‘ Mame ‘Address | Postcode | Phone | Email | Information | GP Code | C\tylFalera:tlce code ‘ CCG code
Firstname FIRSTMAME1001 []1Gene ADAM | 123 STR,
Extra name 1231
Address 99 JCQO00OC XXX 1241110
JOCOCOOCO 1111
JOOCOOXK 1T
JOOHT
Postcode PCi4542 City
Gender Male A User *USER NAMES -
< >
Date of birth 03i27/2000 Age 22y Date of death
i: Local keyworker
Alert T, Transport - PAS alert
Relatives and other contacts Add Ed
Home phone 99999 9999991 Mobile phone
P ‘ cc | Relationship ‘ Mame ‘ Address ‘ Postcode | Home phone | Mobile phone | Work phone | Email | Information
Rotis 1 Consentto SKS Father L 1 1 1 1 1
Email Only post* 100 | Mother 123 123 1 1 2 3 3456
Customer 5K3 SWINDON PCT -
Location All locations - Department 2 Department2 -
Doctor GP * DR ROWLANDSON
Doctor ENT MISE SE CHALSTREY, CONSULTANT ENT SURGEON, GREAT WESTERN HOSP
Civil status 1144 = o
Signif. olher 213 P: Priority contact. CC: Send copy of letters
Transport 312 Relative’s information
1
Information JOCHGOC000O0CCO0COO0 X000 XX122121
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You can set an alert for the patient that is distinct from a PAS alert; both are displayed. If an
alert is set, the client’s name changes colour to red in the tool bar and you can see which alerts
are associated with the patient by hovering your mouse over the patient name in the tool bar.

G:‘:l Auditbasze - [Chent information]

L] Client <T=T11001 MASTER FIRSTNAME1001 LASTNMIF'IE1E - > Bl|user SYSTEM ADMINISTRATOI
File Edit View Functions Settings
Alert 'Transport’ is set for client
o o O ) e 7
ame and a Fess.
Q| £ N d add -» Z]
Detailed | Cuick MNew Save MASTER FIRSTMNAMETD0T LASTNAMET001 |data | Export data | Export to Moat
G0 H0COCO0 )0G01241110
Search Client | XCCGGCCC0O1TN Import/Export Client data

— XK1
Navigation W00 belete | Search || Label
B Favourites PC:4642

o Referral

] Hospital no.: T11001 NHS no.

E Sl NHS no.: - R -

-LIF] Documents and attachments

--F- Waiting list Phone, home: 99999 9999991 ME1001

AB Audiogram Phone, work: 11 ALE1001

-3 NOAH module selection Date of birthe 27/03/2000

A\ Aftention list =t e

SMS Appointment Reminder consent
Sending SMS appointment reminders to clients is a licensable extra within Auditbase.

For a client to receive an SMS reminder, the client’s mobile phone number must be recorded in
their Client Information.

If the Consent to SMS box shows on the Client information page and the patient consents to
SMS reminders, record their mobile phone number in the Mobile phone field and check
Consent to SMS. If the patient does not consent to SMS reminders, do not check the box.

Home phone

Work phone ||

Mobile phone | 077 ¥55566589

| B Consentto SMS

If the No consent to SMS box shows on the Client information page and the patient does not
consent to SMS reminders, check the No consent to SMS box. Leaving the No consent to SMS
box unchecked implies consent has been given.

Home phone Mobile phone | 0777 5556589 |

Work phone B Mo consentto SM3

SMS will be sent to all patients with appointments configured for SMS. Should the SMS facility
stop working for a period, it will check back upon re-start and send up to two reminders to those
clients that were missed because of the close down but will not send more than one per patient
on any day.

Viewing SMS notifications for a particular client

25
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If SMS Appointment Reminder is licensed, then the date and time of any SMS appointment

reminders sent will be shown in the two columns called SMS1 and SMS2 on the Client’s
entries dialog. This can be found in two ways. In Navigation-> Booking -> Functions -> Client’s
entries or in Navigation-> Client’s entries.

Client's appointments and waiting lists

Client MRS FIRSTNAME106 LASTNAME106

Appointments list- 393 item(s) History of changes Attached action

Date |Time|Loc.|Dept.| Appt. |Status|Resource

Reason Declined offer

281212018 | 08:00 b *  |Alan A
2811212018  08:00 ¥ * | Charlie A
281212018 | 08:00 b *  |Res70 A
101212018 | 12:30 %] * Charlie | ++GP direct referral SA
10M2/2018 12:00 E| * Alan ++GP direct referral PE
05/07/2018 | 10:00 1 * | Trawy 1
04/0712018 | 12:00 & * | Travy SA
23/06/2018 1100 2 | 2 E] * | Stassy PF
< b3
Waiting list entries - 13 item(s) Add E Sl wa 5
Wait time Date | Waiting list Information

-275 03M10/2013 |z SAVERNAKE-OLD DO MOT USE OR DELETE (Aud ass) + 1231231

-324 01M0/2013 |ZTGW - PAED HEARING AID CLINIC 3 333333333

-292 09/04/2014 | TGW - FOLLOW LIP 3 testinfo Az

=271 27M0/2014 | TGW - CALORICS & POSITIOMNALS - PP 41@# 5% &7\ abcdefgsdf

-258 271012014 | TIDWORTH - review 3 abcdefgsdf

-283 05/03/2015 | TGW - DOMI new 1 123123123

20 TAMAMNAE TAl O L MAR LI 2 A

Email

Having entered the clients email address, select the clients preferred method of receiving
letters and documents. Use the browser button next to the email address to select from the
variations of post or email. If the site default option is used it will be starred with an asterisk.

Email
Customer
Location
Dactor GP
Dactor ENT

jany@com.com Only post®
UNKMOWN PCT

All locations - Department |All departments

DRALALLIK, 123 5TR, SOME CITY, ABC 1234 CITY

MRS ANMAN, 222 STR, HOME CITY

ETHNICTTY

!

-

Site default (Only post, ignore email address)

Only post, ignere email address

Post and email if email is available

Only emall, post if email is not available

Be aware: Please ensure the e-mail address is correct; entering an incorrect e-mail can cause
sending the client's data to a wrong addressee.

Delete client
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A client can be deleted from the database in two ways; either a recoverable delete or a
permanent delete. These are extended rights which have to be assigned to the Auditbase user
for them to be able to perform this function. The recoverable delete right and the permanent
delete right are now separate from each other.

To delete a client from the database that can be recovered, click the Delete button. The user is
warned that carrying out this action cannot be undone.

* Pressing Yes to this security question of deleting disables future handling of that client.

* Pressing No ends deleting session without erasing client information.

¢ Recovering deleted clients can be done by the system administrator in the System
Administration tool.

To delete a client that is permanent and cannot be recovered, select Permanent delete from
the drop-down menu on the Delete button or select Edit -> Delete client -> Permanent delete.

A warning message appears, advising you that this is a permanent function and cannot be
undone. You have the option to Preserve Gender and Year of birth only for research purposes.

Client information X

I.fd__q"“.I Warning! The "Permanent delete’ function is irreversible,

w yviou will not be able to recover the client data.
Are you sure you want to continue?

Preserve Gender and ear of birth

Yes Mo

¢ Select Yes to permanently delete the client or No to cancel the deletion. The client will
then be permanently deleted from the database and cannot be recovered.

Client labels
You can create and print a client label for a client.

Press Label from Client information.

¢ The Label window opens with a predefined label text containing the client’s name,
address, postcode and city.

¢ You can edit this text.

¢ Click Print to print the label. Note that a label printer must be specified by the system
administrator.

Edit ID

To edit the ID fields on an existing client in the database, click the Edit ID button. This will open
a dialog where you can change the ID.
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To change either of the IDs, click Change to and enter the new ID value or check for a
temporary ID to be generated.

A ‘Verification’ status of ‘Verified’ can be set by Users, or set by PAS, on either the Primary or
Secondary ldentifier Code. These settings are enabled in the system administration.

To set the client’s code as verified, open the Edit ID dialog from the Client Information screen
and choose a verification status from the dropdown list. The Verification status will be set with
the User, date, and time of the verification. The verification status can be removed by choosing
the empty line in the dropdown list and clicking Save.

Edit ID *

Zancel

Hospital no. | MHS no.

Current value T4110

Verification
Status -

ser

Diate

The Verification status will be shown on the System Information dialog for the Client, available
from the File menu.

PAS update

If PAS link is set up, this function updates the demographic data for the selected client.

A Please ensure that the client is the same as requested before saving.

PAS refresh: If the Hospital HL7 system supports updating identifiers, and an updated identifier
is returned, and that identifier is already applied to another patient instance, then the user may
receive a notification that a patient merge record is created in the Attention List.

System information

This window presents technical system information about a selected client. To open the
window, select File -> System information from Client information.
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The user who created the client in the database and the creation time is shown in Record
creation.

The user who last edited the client and the time for the modification is shown in Last record
modification.

ID (Internal system client identifier) and GUID (Global Unique Identifier are shown in Record
identification keys. GUID can be copied to the clipboard by clicking Copy.

Customers

e Select Settings -> Customer from the Client information module. This will open a window
where the customer's name, address, invoice address, contact person, customer number
(max. 9 characters), etc. can be defined.

» Before entering details click on New. The name of the Customer can be entered and the
Priority can be set. Auditbase uses this priority to list the customers. If no priority is set,
the customers are listed alphabetically.

¢ A Customer code can be set; this can be up to 10 symbols in length. Please note that a
customer code can be mandatory if configured in the Administration tool.

¢ The Address and Invoicing address (if not the same) are entered in the appropriate
boxes as well as the Contact person and their Telephone no.

¢ From the drop-down list, select the default payment account for the customer. If the
customer is included in a customer group, select the group from drop-down list.

» Click Save to save customer information to the database.

e Editing the customer data is done by highlighting the fields with the saved information,
altering this information and pressing Save.

Click Delete to delete a defined customer from the database. Note that the system does not
allow deleting a customer which is referenced elsewhere in the system. If a customer is no
longer in use as the requirements have changed then it is now possible to outdate the
customer within System Administration.
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3.2 Tabs

The tabs on the right, Contact, Details, Devices and Visit charge, contain further information
related to the client including contact information for relatives and professionals, condition,
client’s ethnicity and possible need for an interpreter, privately granted aids, notes, and other
site specific information. Depending on licensing you will also see a PPP and Implant tabs -
please see chapters on PPP, Client Information, and on Auditory Implant Module, Auditory
Implant Module and Client Information Screen.

To set a tab as the default tab, go to View -> Default information tab and select which tab you
would like as the default tab. The selected tab will be the default tab when entering Auditbase
and when changing client.

The layout of the Client Information module can be modified from the Administration tool (via
Client module settings and/or User specific options) in a way that some or all of the following
tabs can be hidden from view: Contacts, Lists (Trials)/Photo, Devices, Implant, Paediatric, PPP
or Record history.

¢ Details is a mandatory tab and will appear in any layout.

3.2.1 Contacts

From the tab Contacts you can Add, Edit or Delete professional or personal contacts of the
client. These can be used when making correspondence.

Contacts | Details  Lists/Phote | Devices | Onward referrals and reporting | Implant | Visitcharge | Paediatric  PPP | Record history

Additional professional contacts Add Remove

K‘ Type | MName | Address Postcode |F’hune| Email Information ‘ GP Code ‘ Cityl Fax |F’FEICUCE code | CCG code CCG name

| Column is sorted ascending[l3 | 123 ABC 23455 123  yulia@auditdata.com | 123 1 123 |2 SFL BATH & NE SOMERSET PCT | Site defaul
[ General Practice |azs13 Site defaul
[ General Practice | AD AM 123 5TR, HOME CITY Site defaul
[ General Practice | DR CADE Ja3617 Site defaul
[ General Practice | DR DAN DAM | 444 STR, SOME CITY Site defaul

< >

K: Local keyworker

Relatives and other contacts Add Edi

F“CClRe\ationsh\pl Name ‘ Address Postcode | Home phone | Mobile phone | Work phone Email Information‘city‘ Communication method

[ Father 1 1 1 1 1 1 1 Site default (Only post, ignore email address)
[ |Father FNAME |3 2 4 3 5 oleksandrp@auditdata.com | 7 Only email, post if email is not available
[ |Mather MName | testAddress1 [112 1 3 2 oleksandrp@auditdata.com testinfo Only email, post if email is not available

P: Priority contact. CC: Send copy of letters.

Relative’s information

HOCQOOOCK X000
99 20000 X000
XOCOCOCCN

XX9 93K

When adding or editing a Relative and other contact, you can select that contacts preferred
method of receiving letters or documents. Select from the various post and email options.

© Auditdata - 2025, ID: 20.0040/36 30



User Guide

Relatives can be updated by a PAS interface if this has been set up by the System
Administrator. Relatives that have been created manually may be removed by a PAS interface if
they are not included in a PAS interface message.

When adding a professional contact, such as a teacher or consultant, you either search on part
of the name through all the referring agents in Auditbase or add a new referring agent. One of
the professional contacts can be marked as the local keyworker, shown as a check under the
K column. A professional contact can automatically be added as a recipient of a specific letter
in the Letter dialog from the Booking module.

When adding a personal contact, such as parent or legal representative, you click Add to enter
the details you have been given. A personal contact, unlike the professional contacts, will only
be added for the selected client, so you cannot re-use these for other clients.

One of the personal contacts can be set as the priority contact, shown as a check under the P
column. If you try to set a second contact as the priority contact, you will be prompted to either
keep the existing priority contact or update the priority contact to the currently selected contact.
You may also set any number of contacts as copy to, shown as a check in the CC column, so
that they can be included on letters by default.

When designing a letter, you can list all contacts that have been marked as CC and all other
contacts chosen as recipients by using the variable List of recipients under Letter specific
information.

3.2.2 Details

Under the tab Details, you will find an array of extra information about the client such as which
condition the client is in (physical, visual and attitude), the ethnic category the client belongs to
and whether or not the client requires an interpreter, special aids and forms and other site
specific information which is configurable by your System Administrator.

Irrelevant information can be hidden via the Administration tool. Thus, any of the following
fields can be excluded from the tab layout:

¢ Referral outcome
Ethnic category
Special aids and forms
Other invoice receiver
Travelling distance
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Contacts || Details | Lists/Photo | Devices | Onward referrals and reporting | Implant | Visit charge | Paediatric | PPP | Record history

Alerts Add Parameters Add
Cod{ MName | User | Date Name User Date
s 19.06.19 System Admin 03/06/2024 15:38: Research System Administrator 231231232 | 02/09/2022 11:17.43
4 G1 System Admin 27/11/2024 22:59 July 04 - digital aid info leaflet  System Administrator 231231232 | 02/09/2022 11:17.55
Domiciliary patient System Administrator 231231232  27M11/2024 22:46:04
Current referral outcome 20b, Cancelled - RTT rebook, 09/04/2025 Counting Grant for aid at private dispenser
Condition W Interpreter required Other invoice receiver
Visual Language Palish - Travelling distance (one way) On laptop
Physical h Ethnic category - Special aids and forms
Attitude - Tinnitus analysis Direct referral
W Video appointments accepted
Site specific information
ETHNICITY EDUCATIONAL SETTING
TEACHER OF HEARING IMPAIRED CONDITION / SYNDROME

You can also set multiple alerts and parameters for the patient. The specific alerts and
parameters are set up by your System Administrator. The user responsible for setting the alert
is recorded in the details tab as well as the date that it was added on. This is as well as a record
of the user who set the alert being added to the Security Log in the System Administration tool.

The System Administrator can also enable an Auto Journal Event (1490: Client Alert Removed)
that will trigger a record to be created in the Journal specifying the User who removed the Client
Alert and the time the Alert was removed.

If a client is marked as Deceased, users will be prevented from making appointments or
referrals for the client or adding the client to any waiting lists. You can still make a Treatment
summary for the client but you will be warned beforehand that the client is marked as
deceased.

The time when a deceased alert is set, and by which resource, is registered in the system’s
security log, which is accessible for System Administrators.

A snapshot of a patient’s most recent or Current referral outcome entered on their referral is
shown in the Details tab. Since outcomes can be entered with retrospective dates, the most
recent one is the one which most recently applies, rather than the one most recently entered.

The information shown is

¢ Qutcome status code

¢ Qutcome status name

* Date the outcome applies to the referral
¢ Clock action of the outcome

If you check the need for Interpreter, you can also choose which language the interpreter
should speak. After choosing language, if you uncheck Interpreter, language is left on, which
can be useful if you just want to make a note of which language the client speaks.
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Whether or not a patient is suitable or consents to have Video Appointments can be recorded
on the Video appointments accepted checkbox. This value can also be both seen and set on
the Make Booking dialog.

The Travelling distance (one way) can be added. This is shown in Client lists/Trials.

3.2.3 Lists/Photo

The Lists/Photo tab will display all Client lists/Trials that the client is assigned to and is a place where a
photo of the client can be uploaded. The active client can be added to or removed from a list and their
status on the list can be changed.

Contacts | Details || Lists/Photo | Devices | Onward referrals and reporting | Implant | Visit charge | Paediatric | PPP | Record history

Show in List Add to List Remove from List Change status
Start date | End date | Title Client status | Status | Responsible | Type [ Min. clients | Act. clients
Test Referral list Motasked |Planned System Administrator 231231232 18
Referral list #1 Mot asked Planned | System Administrator 231231232 21
Clients picture
Upload
Download
Remove
Show large

If a client has not been assigned to a list yet, all the buttons on this tab, except Add to List, will
be inactive. If you wish to add this client to a current list, select Add to List and all active lists
will be displayed in a window.

Add client to Client list *
Select Close
Choose Client list to add client
Responsible Act. clients ~
2016 |0 ve Title 4 USER NAMEZ29
01/01/2016 | 02/01/2017 | Active Title 4 - Copy | USER NAMEZ29 444 |5
07/03/2019 Planned |List 1 SYSTEM ADMINISTRATOR 1
07/03/2019 | 05/22/2020 |Planned |List 2 SYSTEM ADMINISTRATOR 7 0
07/03/2019 | 05/22/2020 |Planned |List 2 - Copy | SYSTEMADMINISTRATOR 1
07/03/2019 | 05/22/2020 |Planned |List 23- Copy | SYSTEM ADMINISTRATOR 7 0
05/22/2020 | 05/22/2020 |Planned |test1 iryna list1 /34 |0
08/22/2020 | 05/22/2020 | Planned |vf iyna list1/4 |0
08/22/2020 | 05/22/2020 |Planned |vf- Copy iyna list1/4 |0 v
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Select a list by clicking on it and Select. The client will then be added to the list with the default
Client status. This Client status can be changed by selecting the Change status button or click
into the Status column directly in the table. You will be able to Select new status for client
from the drop-down list prepared by your System Administrator.

If the client is already on a list, Show in list will take you to the Client list and display more
details. A client can be removed from a list by highlighting the list and selecting Remove from
list. A confirmation message will ask you to confirm that you want to remove the client from the
list, Yes will confirm and No will return you to the client’s information.

A photograph of the client can be added to the Lists/Photo tab. Select Upload and navigate to
the photograph image file, there is no maximum size control so do not load more than a few
hundred kilobytes otherwise the database will grow. Once the file has been selected, Open will
add this to the tab. If you wish to save a copy of the photograph, Download will open a window
where the image file can be saved. Remove will remove the photograph from this tab, after you
have confirmed this is what you intended. A larger version of the photograph can be shown by
selecting Show large which shows up to a maximum height of the minimum screen resolution.
The window that opens can be closed using the Close button.

3.2.4 Devices

The tab Devices is a quick overview of the currently issued devices for the client. It shows
Earmoulds, serial controlled current Devices and quantity controlled current devices, which are
marked in System Administration as Accessories.

Earmoulds synopsis is shown below. This demonstrates the type of mould per ear and the vent
size which has been selected for each mould. It also shows the date of the last stage of where
the earmould is e.g. Sent to Manufacturer, Ready or Issued.
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Contacts | Details | Lists/Photo || Devices | Onward referrals and reporting | Implant | Visit charge | Paediatric | PPP | Record history

AcCcessory issue Refresh (F5)
Earmoulds

L | 09/23/2010 - EM 2112 - SHELL~ACRYLIC ALL SOFT  Vent
R 04/21/2010 - EM 2112 - SHELL~ACRYLICALL SOFT  Vent
Ready
Devices Copy SN ew status
| [modified date | Stock type to | Article | IR | User | Serial number | Notes |
11/02/2009 |REPLACEME OTICC|R |USEI 88182
11/02/2009 |REPLACEME OTICC|L |USEI 88183
11/02/2009 | SENT FOR F| OTICC USEI| 52001
11/02/2009 | SENT FOR F| OTICC USEI| 904142
02M3/2009 |SENT FORF|OTICC USEI| 71481
02/13/2009 |SENT FOR F|OTICC USEI| 71482

e i i

ACCessories ew status

Created date Stock type to Stock Group Article [ur|at.|  user
[ |09/01/2010 | POSTAL BATTERIES (Issued batteries) | BATTERIES (Quantity-Accessory) |NHS SUPPLIES, 675 COCHLEAR IMPLANT | |60 | USER NAI
< >

The Copy SN button allows you to copy the serial number from a selected row. If no row is
selected, it will copy the serial number from the most recently issued device.

You can change the status of a device or an accessory, for example, to register it's returning to
stock, by selecting it in the list and then clicking the New status button.

When designing a letter, you can insert variables with information about the four latest serial
number controlled devices and the four latest accessories from the Current issued devices
and Current issued accessories groups, respectively.

3.2.5 Onward referrals and reporting

From this tab on the Client Information page, you can view, create and edit the patient's
'Onward referrals and reporting' memberships.

Contacts | Details | Lists/Photo Devices | Onward referrals and reporting | Implant | Visit charge = Paediatric  PPP | Record history

Show in list Add to list Editin list Remove from list
Title Status date Status Comment to status Responsible for list | Type | Consent Cnst. chng. date
Swedish Severe hearing loss regi| 2710/2022 | Added to list System Administrator 231231232 | Type1 Mot asked 27M10/2022
Reflist#2 30M1/2022 | Declined System Administrator 231231232 | Type3 | Mot asked

Reflist#1 eferred from external centre | Data missingewrrrrrerrrrrerrrrrrr | USER MAME3D Type1 Mot applicable | 14/09/2022
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From the Add/Edit onward referral dialog, you can choose the professional or organisation that

you refer to, attach an appointment, change the status of this onward referral, as well as add
comments and patient consent.

The audiogram that triggered the notification rule and subsequent addition to the onward
referral list is displayed in text form.

Add/Edit onward referral X

The Auditbase audiogram must not be used as the sole means by which

Close
a diagnosis is made

Referred to |hLISON STAGG

Responsible user Systemn Administrator 231231232 -

At appointment 27I05/2021, SAY ENT audio

Audiogram
Status
Referred from external centre ~  14/09/2022 E

Data missingewrTIrIrrrrrrrrrrrrrrrr T W rwWITTTITTTITTTTTT -~

2222220222 2220022 2200022200002 2220020 2220020 222222222222272222
21313

21T TN T I AT 1111111
T
wetewt

-
Patient consent

Mot applicable ~ 14/09/2022 ﬁ

3.2.6 Implant

The Implant tab is only available if you are licensed to use the Auditory Implant module. The tab
will show you an overview of the client’s implant status.

On this tab, you can create a ‘quick’ version of the Pre-Op, Surgery and Switch-on records with
just the minimum of information directly from this tab.

¢ Click the down arrow on the New button to choose which type of record to create.
 Mandatory information depends on the type of record. However, date, an ear side and a
referral are required for all types.
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Contacts | Details | Lists/Photo | Devices

Invoice services

Onward referrals and reporting

Implant | Visit charge

Paediatric | PPP | Record history

Print device info report

rRIGHT rLEFT
Implant type Implant type
Electro acoustic implant Electro acoustic implant
First Latest First Latest
Assessment 03/09/2012 22M212021 Assessment 03/09/2017 12/08/2021
Surgery 03/03/2013 241212021 Surgery 03/03/2013 02M10/2013
Switch-on 0110/2013 01M10/2013 Switch-on 2710512021 2710512021
Upgrade due date 0110/2013 Upgrade due date 2710512021
Mew - Open | - Mere - —_—
Quick Pre-op assessment
] Quick Implant surgery
Client preferences |mmunisation . )
Select Quick Switch On
13valent PCV -
Type | R| L| MName Status
Cable ] ITE10MR Immunized -
Magnet ] ITE10ML Date 2710512021 E
Ear hook []BE101
Battery type M BE101 Surgical consent
Other 1] BE102HF Mot given -

Date

Consortium (Customer Group)
Test customer group

Funding Status

Agreed, patient not responding
Implant keyworker

USER NAME38

27/05/2021 E

¢ Ear side is pre-selected depending on which New button you click (from left or right), but
you can change the value to unknown or bilateral.

Create Pre-op assessment

Client

MRS FIRSTNAME 1066 LASTMAME106

Save

Close

X

10/04/2025

5

Left -

Date User

Ear side

Referral

Andrey Shustov

Right
Bilateral
Unknown

¢ You must either choose to attach to an existing referral or create a new one.

Create Pre-op assessment x

Client MRS FIRSTNAME 1066 LASTNAME106 Save Close

Date 10i04/2025 E User Andrey Shustov -

Ear side Left - Referral I__|
New
Attach
Detach
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If the referral does not exist or an existing one cannot be used, you can create a ‘quick’ referral

by clicking the New button from the = button to the right of the Referral field. See details in
Quick referral creation.

In order to view full records to which the dates of Assessment, Surgery and Switch-on refer,
use the Open button to select the relevant form.

Contacts | Details | Lists/Photo | Devices | Onward referrals and reporting || Implant | Visit charge = Paediatric | PPP | Record history

Invoice senvices Print device info report
rRIGHT rLEFT
Implant type Implant type
Electro acousticimplant Electro acoustic implant
First Latest First Latest
Assessment 03/09/2012 2211212021 Assessment 03/09/2017 1210812021
Surgery 03/03/2013 241212021 Surgery 03/03/2013 02M10/2013
Switch-on 01/10/2013 01/10/2013 Switch-on 2710512021 2710512021
Upgrade due date 011012013 Upgrade due date 2710512021
Mew - Open | - Mew - Op~~ =
Pre-op assessment
] Implant surgery
Client preferences Immunisation ;
Select Switch On
13-valent PCV -
Type |R| L| Name Status
Cable H O ITE10MR Immunized -
Magnet O ITET10ML Date 2710512021 E
Ear hook  |[/][]BE101
Battery type [ Bee101 Surgical consent
Other 1] BE102HF Mot given -
Date 2710512021 | 3]
Consortium (Customer Group)
Test customer group -
Funding Status
Agreed, patient not responding -
Implant keyworker
USER NAME3S -

3.2.7 Visit charge

This tab is primarily used in Sweden. It gives you the overview of a patient’s eligibility for free of
charge visits, including annual card number, date due (the date the annual card expires),
preferred payment method (used if the client is not eligible for free of charge visits) and the
client’s free of charge status (enabled or disabled). Additionally, it shows the client’s self-check-
in status (allowed or prohibited) where applicable.

3.2.8 Paediatric

The paediatric tab allows new information to be entered and will collate information from the
Paediatric module and the History in DR Medical Assessment.

If a client has an ABR and OAE screening and diagnostics entry where Test type is screening
referral, the most recent outcome will be shown in the box labelled Hearing screening referral.

© Auditdata - 2025, ID: 20.0040/36 38



User Guide

Contacts | Details | Lists/Photo | Devices | Onward referrals and reporting | Implant | Visit charge | Paediatric | PPP | Record history

Hearing screening referral |blear Response - Mo Follow-up Required
RIGHT LEFT
Diagnosis SMHL - Diagnosis SMNHL -
Current Hl type BC - Current Hl type BTE -

Medical history

Date 271052021 - Edit Mew Cpen
Hearing loss
Right Moderate Left Moderate
Confirmed syndromes Risk factors
MName Mame
Progressive unknown Absence of Tibia
Meningitis

Risk factors and syndromes are taken from the Paediatric module. Medical history lists are

empty

SCBUMHUMICU Well baby -

Confirmation of PCHI: Date 01102013 7] Age 24 Year(s) 6 Month(s) 13 Dz
Weight at birth (kg) 3.00 Gestation (weeks) 4

Diagnosis and Current HI type can be entered from the drop-down lists for left and right; this
information is not displayed anywhere else in Auditbase. The options cannot be adjusted in
System Administration.

DR-Med - Information from the most recent DR-Med questionnaire can be shown. Previously
created questionnaires will be shown in the drop-down box labelled Date. New or Edit can be
used to create or edit just the information in this box in a pop-up dialog. It will save to a DR-Med
record. Open DR-Med will open the full DR Med History.

SCBU/NHU/NICU, Confirmation of PCHI Date and Age, Weight at Birth and Gestation can be
entered here and will be repeated on the Paediatric module and vice versa.

3.2.9 Record history
The Record history tab shows:

¢ when a client's record was created or modified

¢ if/when the deceased alert was issued

¢ NHS number verification status and the time it was set
¢ last updates to the record by a PAS/HLY interface
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At the bottom of the screen, there is the Client origin information (e.g., whether a Client
originated from a merge or conversion, and when).

o NOTE: This data is not backdated.

Contacts | Details | Lists/iPhoto | Devices | Onward referrals and reporting | Implant | Visit charge @ Paediatric | PPP | Record history

Record creation
User JUSER NAME11

Timestamp 08/12/1999 00:00:00

Last record modification

User System Administrator 231231232
Timestamp 2711112024 22:58:18

Deceased alert modification
User System Administrator 231231232

Timestamp 22111/2022 16:25:09

MHS no. verification

Status 01, Mumber present and verified

Timestamp 19/02/2019 12:30:38

User Oleksandr Pushchalo

Latest PAS update 29 March 2022 13:29:41

Client's origin

Converted from PN -

3.2.10 Refreshing tab content
When changes are made outside of the Client Information module that affect the Client
Information content, the Client Information screen does not refresh automatically. To update

the screen, it is necessary to refresh it manually by clicking the Refresh button K located on
the toolbar.
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3.3 Barcode Scanner Input - Restricted to Danish Users

From Client information, you can perform a client search by scanning the barcode. The system
administrator defines how the system recognizes input from the barcode.If the recognition is
successful, the system performs a search for the client by personal number read from the
barcode.
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3.4 General search for a client

e Press F3 or File -> Client Detailed search.

* Enter Basic search criteria.

¢ [f you list the surname and first name, you get a list of all clients registered to the
Auditbase System matching the criteria. Auditbase will also search for part of a name; i.e.
entering 'sm' in surname will list all clients whose surname starts with 'sm'.

Client advanced search

Search | Clear

Exportto CSV || To Clientlist || To Waiting list Print

Select

*

Close

Basic search criteria

Address

Hospital no.

Select all - No rows selected

Firstname
Postcode
NHS no

Date of birth
Gender -

Location All locations

¥ Show advanced criteria

-

Hospital no ‘NHS no. |DOEI‘Name‘Address|PmstcudelTiﬂe|Firstname Last name

MNUM

¢ Click Search or press Return.
¢ Click on the appropriate client and click Select or double-click on the appropriate client.
* Where the search should be abandoned, and a new search started there is an option to
Clear the Search fields. This allows for the Auditbase user to clear all of the fields which
have been populated.
¢ Once the list of clients has been produced, this list can be saved to a CSV file which can
be read in Excel. Select Export to CSV and a window opens where the CSV file can be

saved.
o)) Savefile =
Savein: |- Desktop j & E-
* admin Q This PC
Quick access g
- [ Libraries 3 MNetwork
Desktop n @
B [ Patients attending multiple
m ABASE X unscheduled appt types 201...
Libraries Microsoft Excel Comma Sep...
This PC
Network
File name: j Save |
Save as type: |CSV file j Cancel
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e Itis an extended user right to be able to export these clients. If you do not have the rights,
a window will appear informing you of this. You will need to contact your System
Administrator to assign you the extended right.

Insufficient privileges *

BRIAN HARRIS <BH> has insufficient privileges in AuditBase for Client: Export clients data’feature.

L
— Contact your system administrator.

When you have selected the appropriate client, the system returns to the main screen of the opened
module, for instance Booking. The selected client's name will be displayed at the top of the screen.

It is important to check the client’s name regularly to make sure you are working with the
correct client.

Multiple clients can be selected using the check boxes in the left-hand column. This multiple
selection may be printed or added To Client list or To waiting list. During the creation of a
group booking a selection of clients with the same settings in Advanced criteria can be made
using this feature.
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3.5 Quick searching for a client

e Press Ctrl+F3 or File -> Quick.
¢ Enter the client’s personal number or a hospital no. assigned to the client.

° When searching on Dutch Employee ID, there is no need to enter leading zeros for
ID to search. Only the main ID part should be entered. The system will add leading
zeros according to the ID entering mask configured in the Administration tool.

¢ You can use the wild card ‘%’ in this field.

¢ Click Search or press Return

¢ If the client exists, the system selects it automatically

¢ If the client is not found, or multiple clients share an incomplete personal number, the
Client advanced search screen is activated

Client quick search x

Search Cancel

Search criteria

Hospital no. ||

If none or more than one client match the search
criteria, the result will be shown in the normal
search window.

It is important to check the client’s name regularly to make sure you are working with the
correct client.

Contact your system administrator to configure which type of hospital code is searched for
in this feature.
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3.6 Advanced Search criteria

e Press F3 or File -> Client Detailed search.

* The Client advanced search window will open.

¢ Click Show advanced criteria to show and enter more details such as Alerts and
Parameters, Email, Department, Date of Birth, Date of Death and Customer if needed.

¢ You can use the search criteria Phone to search for any phone number, such as work,
home or mobile phone number.

¢ You can also search for clients with a specific Alert, either a patient alert or a PAS alert.

¢ If you want to exclude deleted clients, check the box Exclude deleted clients.

¢ You can also search on a Parameter to find clients with either of two specific parameters.

e You can use the ‘%’ wild card in the search fields that are not dropdown lists.

e When searching on Dutch Employee ID, there is no need to enter leading zeros for ID to
search. Only the main ID part should be entered. The system will add leading zeros
according to the ID entering mask configured in the Administration tool.

Client advanced search X

Search Clear Export to CSV To Clientlist || To Waiting list Select Close

(=]

Advanced search criteria

Surname I:I First name Date of birth
Address Postcode Gender v
Hospital no. MNHS no. Location All locations -
Phone Email Department  All departments -
Date of birth Period from To Alert -
Date of death Period from To PAS alert -
Customer hd M Exclude deleted clients
Parameter#1 - Parameter# 2 -
ETHNICITY - TEACHER OF HEARING IMPAIREC -
EDUCATIONAL SETTING COMDITION / SYNDROME
Audiogram (latest curve) Device

Searchby g4 Curve Search by device(s)
hearing loss -

125 | 250 | 500 | 750 | 1K |1.5K] 2K | 3K | 4k | 6K | 8K |

125 | 250 | 500 | 750 | 1K |1.5K] 2 | 3 | 4k | 6K | 8K |

Select all - No rows selected # Hide advanced criteria

Hospital n0.|NHS n0.|DDB|Name|Address|F'ostcode|TitIe|Firstname Last name

NUM

3.6.1 Searching for clients by audiogram

Clients can be searched for by hearing threshold using the client’s latest Audiogram curve.
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e Select Search by hearing loss and the Ear, Curve and date range options will become
available.

e The date range will default from one year ago to the current date.

¢ There are three options for Ear; Bilateral, Unilateral and Distinct ears.

¢ Enter the Min and Max thresholds for the relevant frequency. Selecting Distinct ears will
activate both threshold fields which are not side specific.

¢ Different types of audiogram can be chosen using the Curve selection. Only the latest
curve of the selected type will be searched.

e Search will show the results and these can be selected by checking the box to the left of
the name or Select all and can then be added To Client list, To Waiting list or can be
printed by selecting Print.

Audiogram (latest curve)

[ Search by Ear  pilateral - Curve Air -
hearing loss
125|250 | 500 | 750 | 1K [1.5K] 2K | 3K | 4K | 6K | 8K |
Min
from Max
09/01/2019
: 125 | 250 | 500 | 750 | 1K [1.5K| 2K | 3K | 4K | 6K | 8K |
a
09/01/2020

3.6.2 Searching for clients by device
Clients can also be searched for by Device:

» Check the box Search by device(s) and selections can be made from Stock group,
Manufacturer and Article type. These options are taken from your Stock module. Each
Article in Stock is defined as one of several Article types.

e Search will show the results and these can be selected by checking the box to the left of
the name or Select all and can then be added To Client list/Trial, To Waiting list or can
be printed by selecting Print.

Device
B Search by device(s):

Stock group

Manufacturer

Aricle type
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3.7 Recently accessed clients

Each user of the system has a list of the 9 most recent clients. To access the list, click on [T/ on
the toolbar to the right of the patient name on the Booking screen or press Shift+F3.

—

: DR, TESTFNAMET TESTSMAMET

: MASTER FASTS MASTS %
: DR, TESTFMAMEZ12 TESTSMNAMEZ12

: MISS FIRSTMAME34294 LASTMAMES4204

: MISS FIRSTMAME36249 LASTMAMESR24S

: MST FIRSTMAMEZ25177 LASTNAMEZ25177

: MR FIRSTMAME45367 LASTMAME4S867

: MRS FIRSTMAMES16T LASTMAMES16T

: MRS FIRSTMAME43408 LASTNAME45408

Wots o e o b W pa |
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3.8 Adding a new client to the database

Search for the client first to ensure the client is not already in the database.
* Navigation-> Client information, press Ctrl+Shift+C, or click A .

e Click New.
¢ Enter the client details.
« Click Save.

The fields Surname and Case number or NHS number are mandatory. You can enter as much
or as little other information as you require.

Gender options are expanded beyond just Male or Female and can be defined by your System
Administrator from a default Department of Health list.

If two users are working on the same client, a Refresh button is available to update the client’s
details immediately.

Postcode validation may be applied in Administration which restricts formats of postcodes
allowed to be entered.

Contact your system administrator to find out which fields are mandatory.
Contact your system administrator to configure the default first field when creating a new

)} Auditbase - [Client information] — [m] X
E Client  <T>T11001 MASTER FIRSTNAME1001 LASTNAME1( - || 2 | = Bl |User SYSTEM ADMINISTRATOR All locations ~ | All departments A ¢ ?
File Edit View Functions Settings
o] O, o] Q O=] =
£ 2 = o
as QY e QuaC] & & = @
Detsiled | Quick New | Save  Systeminfo  Print | Printlabel |mportdasta Exportdata  ExporttoNoah Logoff | Exit Audithase
Search Client Print Import/Export Client data Exit
Navigation New Save Delete | Search Label EditID PAS update [=]
B Favourites
i % Referral Hospitalno.  T11001 NHS no. Contacts | Details | Lists/Photo | Devices | Implant | Paediatric | PPP
i£5 Booking )
H Titl - =
i-gi7] Documents and atiachments e MASTER Additional professional contacts Add Remove
i-FL waiting list Sumame | LASTNAME1001 K_[Type [Name | Adaress | Postcode | Phone | Email [ information | GP Code | city [Fax [Prac
' AB Audiogram Firstname FIRSTNAME 1001 [ GeneADAM 123 STR| makkr|
i+{2) NOAH module selection Bxraname 1231
L. /iy Attention list
£ NOAH session browser Address 99300000000000(1241110
V000N 1111
X0000CC11
Individual client KO
/S Clientinformation Postcode PC:4842 City
-] Paediatric Gender Male - User * USER NAWMES -
£] Joumal Date of birth  27/03/2000 Age 19 Date of death : )
~fZ] Documents and attachments < il K: Local keyworker
Alert ~  PASalert
% Referral =y Relafives and other contacts Add Edit Delete
2 A Clients entries Home phone 99999 9999991 Mobile phone
-2 Device list Work ah P_|cc|Relationship[Name | Address [ Postcode |Home phone | Mobile phone |Wark phon
Obsenvations and procedures orkphone | 11 ErTEElETE Father 1 1 1 1 1 1
-(%) Earmoulds Email Post and email* i O |0 Motner 123 123 1 1 2 3
.‘3\;1) Hearing Therapist Customer 5K3 SWINDON PCT T
[1] Medical histary Locat Deparment
-5, Direct referral HA (adult) ocation All locations - epartment| 2 Department2 -
La) Tinnitus Doctor GP * DR ROWLANDSON
-4/ Surgery Doctor ENT  MISS SE CHALSTREY, CONSULTANT ENT SURGEON, GREAT W
[:i] HI satisfaction Questionnaire — 1144
#-[7] Measurements i stats < >
-] Questionnaires Signif. other 213 P: Priority contact. CC: Send copy of letters.
Tests Transport 312 Relative’s information
-+ ) Implant 1 -
& Run extemal application Information 04006 CE0CCC00000K 000000122121 -
- -

Alternatively, you can register a new client by scanning barcode or pressing F4 and scanning
the client’s magnetic card.
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If no hospital number or personal identification number is entered, Auditbase will assign a
temporary ID or give a warning that mandatory data is missing. The system remembers what
the last code used was and adds one. If it finds a problem with codes that have been used
manually it will search for the lowest free code and use that one. You can change the temporary
ID number any time by clicking Edit ID.

You can also select a client by filling in client ID. The information for the client will be displayed.
You can only enter data in this field when no client is currently selected or you have pressed the
New button. When filling in client ID, the information will be displayed in the window.

If PAS link has been set up, you use PAS update to look up a client in the Patient Administration
System and transfer the data.

e To print a label, click Label.
e To view technical details such as creation date, modification time, internal ID, GUID for

the client select the File -> System information menu item.
e To print demographic and other data presented on the screen, select File->Print.

When saving a new patient, Auditbase will offer to verify it automatically.

Set Hospital no. verification status X

Save Cancel

¥ou have just saved averifiable identifier. Do you want to verify now?

Yerification status: 01, Mumber present and verified -

01, Mumber present and verified |

02, Mumber present but not traced =
03, Trace required =
04, Trace attempted - Mo match or multiple match fo
05, Trace needs to be resolved - (NHS Mumber or p:
06, Trace in progress

07, Mumber not present and trace not required

08, Trace postponed (baby under six weeks old)

1ate| Stock type to| Stocl

¢ Choose a verification status in the dropdown list and then Save. The Verification status
will be set with the User and date and time of the verification.

¢ A patient identifier can also be verified after the patient has been saved by pressing the
Edit ID button.
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Edit ID
Save Cancel
Huospital no. || MHS no.
Current value TIITiTTiT
B Change to
Werification
Status 01, Number present and verified -

User SYSTEM ADMINISTRATOR
Date 09/01/2020 14:19:03

¢ Choose from 8 different verification statuses in the drop-down box.

¢ The verification status is removed by choosing the empty line in the drop-down box.

¢ Click Save.

If your system administrator has enabled that only verified NHS numbers will be printed,
then the NHS number will not appear on any printouts, reports or letters unless it has the

right verification status.

* The verification status and details can also be viewed on the System information dialog

for any client, opened from the File menu on the Client information screen.
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3.9 Adding a doctor to the client information

¢ Open Client information.
* Click the Browse button || next to the Doctor GP/ENT field.

Dactor GP - |
Create new
Doctor ENT
] Search all
Civil status Select from list
Signif. other Clear field

¢ When the flag Enable GP/ENT code in main screen is set in the Admin tool (Client
related > Client definitions > Client module), it is possible to specify a doctor by filling in

the GP code.
Doctor EMT

Having entered the GP code, click into the grey part of the field or click " to add the
doctor.

Doctor GP 221324234 DRALALLIK, 123 STR, SOME CITY, ABC 1234 CITY

Doctor EMNT

¢ Search all or select from the list.

¢ Double-click the doctor to add to the client information.

» [f the doctor does not appear on the list already, add the doctor by choosing Create new
and filling in the form.

¢ To delete a doctor from the Client information, click the button next to the Doctor GP field
and select Clear field.
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3.10 Client Access Restriction

Restrict which users have access to specific clients’ information in Auditbase. You will need
extended user rights to be able to restrict users’ access to a client or to be able to override any
restrictions in place.

¢ Select Client Information for the client you wish to restrict access to.
¢ Select the Functions ribbon to display the Access restriction icon.

File Edit View Functions Settings
o= o] o EE@ %o =
d i =3 Cobp S5

Label |Access restriction Magnetic card Add to PPP list  PAS refresh  Merge clients = Mew task

A pop up will display, allowing restrictions to be put in place.

Restrict access to client's data >

Client 23423423 Save Close

Filter
Location All locations -

Users without restricted access Users with restricted access

Test user new role - PROG
testuser SYSTEM ADMINISTRATOR
TEST123 testfullname
testazs

testazme.

TESTQZ

TTT1T

USER MAME11..

USER MAME13

USER MAME14 III

USER MAME1S 4

USER MAME1G

USER MAMEZ2

USER MAMEZ24.

USER MAMEZ3.

USER MAMEZ29.

USER MAME30.

USER MAME32

USER MAME3S

USER MAME38 -

Add All Remove All

3 restricted users filtered

3 restricted users in total

Select the users you wish to restrict and use the arrow to move them to the restricted column.
All users will be displayed and can be filtered on location for fast selection. You can check the
Select All checkbox if you wish to restrict access to all users in the list.

Save this and all users moved to the restricted access column will no longer be able to view
Auditbase records for the selected client.
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The restricted user will be able to see the client listed on the waiting list, referral overview and
on the booking screen. If restricted users attempt to select the client, an information box will
appear advising of the restriction in place.

If the user has the further extended right they can break the restriction which will be logged as a
security event. Users can be denied access to view details of patients who are not associated
with their Locations or Departments.

If the user has the further extended right they can break the restriction which will be logged as a
security event.
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3.11 Merge Clients

To merge two records for a client, use Functions -> Merge clients. Your System Administrator
must provide you with the extended user permissions. Merges are logged in the Security Log.

After Merge clients has been selected, the currently selected client will become a Major client
for merge. If the selected client should be the Minor one, then use the Select buttons to
reselect as Minor and to select a different Major. If no client was pre-selected, use the Select
button to search for a client.

The details of the record you want to keep are shown in the top boxes; the lower boxes are the
record which will be removed upon completion of the merge. It is important that you get these
the correct way around. The client can be chosen using the Select button. This will bring up the
standard Client search window and a client can be selected in the usual way. Once both
records have been selected, the Merge button becomes active. A warning message is displayed
to ensure that you have selected the proper records, the correct way around.

Cuestion

/@™  You are about to merge the data of the selected clients.
' _/.' Please check once more that you have selected the comect clients as unmerge is not possible.

.-
Should clierts be merged?

Yes No

If this is correct, select Yes and the records will be merged.

If a Minor patient has been selected by another Auditbase user and is in active use, then an
error message will appear. This will not prevent the merge from taking place if Yes is selected
however this will affect any data which is being managed by the other user.

The merge process may take some time. The cursor changes into an hourglass while the merge
is ongoing. Once the cursor changes back to an arrow, you can continue working in Auditbase.

A further message will display the Case number that will be lost when the client is merged. It is
recommended to record this number if you later need to apply it to the merged Major client.

Besides demographic data, the merged client will also contain the following data where it exists
for either of the clients:

e Audiogram (Including Noah sessions)
¢ Journal data

e Ear mould

¢ Tinnitus

e Stock

¢ Booking data

¢ Observations and procedures

e Hearing therapist report

© Auditdata - 2025, ID: 20.0040/36 54



User Guide

¢ Documents

¢ Referral

e Implant

¢ Repair list

e Surgery

e Tests

¢ Clinical actions
e Waiting list

¢ |nvoice

e Task list

¢ Adult assessment questionnaire

If both clients have any of the below data, the user will be notified that the merge is not possible
until the record on one of the clients is removed:

¢ Open PPP sessions

¢ Bone Anchored Hearing Aid questionnaire

¢ Direct referral HA (Adult) data

¢ Open waiting list entries with the same type

» Paediatric data - If a client has Paediatric data, the following warning will be displayed
"Both the Major and the merge client have a Paediatric Module record, only the record
belonging to the Major will be retained after merging. Please ensure you have copied all
important data from the Paediatric Module record of the client to be merged into the
Paediatric Module record of the Major client before merging”. When this is done you can
proceed with the merge.

e COSI data for the same date

¢ Direct Referral - medical data for the same date

¢ Hearing Attitudes in Rehabilitation data for the same date

o Satisfaction with Amplification in Daily Life data for the same date

¢ Auditory Lifestyle and Demand Questionnaire data for the same date

¢ Abbreviated Profile of Hearing Aid Benefit (Initial or Follow up) data for the same date

o Attitude, Motivation, Expectation Questionnaire (Re-assessment) data for the same date

* Attitude, Motivation, Expectation Questionnaire (New) data for the same date

¢ Q3 guestionnaire data for the same date

¢ Questionnaire for IHR Family Hearing Aid Benefit data for the same date

¢ Hearing Aid and Programme Selection questionnaire data for the same date

¢ International Outcome Inventory for Hearing Aids questionnaire data for the same date

¢ Hearing Direct Routine Follow-up questionnaire data for the same date

¢ Both clients have records in the same waiting list

Once the merge is done, the Information window appears.

Information >

Clients merged successfully

oK
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The record that was merged is then removed.

When a user has removed the data from one of the clients via the Auditbase application, the merge will
be possible, and the data left will be available for the client.
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4 Referrals

Click the button below to access our training materials.

The Referral module is opened from Navigation -> Referral or Shift+Ctrl+F. If the module is
opened with no client pre-selected, then it opens on the Referral overview tab. If a client is
selected, the module opens on the Client’s referral tab and displays the Client’s latest existing
referral. If a different tab is selected and then a different module, Auditbase will open this
selected tab when the Referral module is re-opened.
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4.1 Referral overview

Columns
The columns available contain most of the fields on the Client’s referral tab, such as:

¢ Current stage

¢ Active length

e Assessment

e Status - (Outcome status)

¢ Clock action

¢ RTT end date

¢ RTT end status

¢ Previous and Next appointments- shows appointment status as well as date.

o Latest appt date and Next appt date - shows only the date, for easier chronological
sorting.

¢ Latest appointment outcome

¢ Medical Priority

e Waiting List - (If referral is attached to one (Must be activated in System administration))

Referral overview Clients referral | Referral progress | Referral answer | Clinical actions

Filter: v || Setas user default Setup filters Boo Search and boo Print list Exportto CSV Refresh

Pathway ID| RTT start ‘ Client name Hospital no.|NHS n0.|A|:1ive length Assessment Treatment
11/03/2010 MR FIRSTNAMEZ23026 LASTNAME23026 | T123026 582w, 4d |1214/2010, Has been breached. No appt 02/02/2011, Has been breacl
11/09/2010 MR FIRSTNAME 1941 LASTMNAME 1941 T11941 581w,5d |12/20/2010, Has been breached. No appt 02/08/2011, Has been breacl
11/22/2010 MRS FIRSTNAME19079 LASTHNAME19079 | T119079 579w,5d |01/02/2011, Has been breached, status not'completion’ | 02/22/2011, Has been breacl
11/29/2010 MRS FIRSTMAME3281 LASTMAMES281 T13281 578w, 6d |01/09/2011, Has been breached, status not'completion’ | 02/28/2011, Has been breacl
1115/2010 MR FIRSTMNAMEZ1335 LASTMNAMEZ21335 | T121335 580w, 6d |12/26/2010, Has been breached, status not'completion’ | 02/14/2011, Has been breacl
12/31/2010 MR FIRSTMNAMEGT 48 LASTNAMEGT 46 T16746 574w, 2d |02M0/2011, Has been breached, status not'completion’ | 04/01/2011, Has been breacl
01/05/2011 MR FIRSTNAME39376 LASTMNAME39376 | T139376 569w, 6d | 0313201 05/02/2011
01/06/2011 MR FIRSTNAMEG105 LASTMNAMEG 105 T16105 573w, 3d |02M6/2011, Has been breached, status not'completion’ | 04/07/2011, Has been breacl
01/06/2011 MRS FIRSTNAMEZ29548 LASTMNAMEZ29548 | T129548 573w,3d |02M6/2011, Has been breached, status not'completion’ | 04/07/2011, Has been breacl
01/07/2011 MRS FIRSTMNAME2741 LASTNAMEZ741 T12741 573w,2d |02M7/2011, Has been breached, status not'completion’ | 04/08/2011, Has been breacl
01/07/2011 | MRS FIRSTNAMEG232 LASTMAMEG232 T16232 573w, 2d |02M7/2011, Has been breached, status not 'completion’ | 04/08/2011, Has been breacl

The order these columns are shown can be adjusted by clicking under the column heading and
dragging the column to the desired position. This can be saved for future viewing by right
clicking anywhere on the grid and choosing Save user view. An information window then
informs you that you need to have the same number of stages to use this view for another filter.

Message X

Because the number of columns varies with different Filters depending on what Stages are included,
y I % this view configuration is only saved for Fiters with the same number of stage columns.
o A new view configuration must be made for Fitters with a different number of stage columns

oK

If a user has a Location or Multiple locations selected, the results will be further filtered by the
client’s Location and they will not see all records. When Location is selected globally, the
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corresponding message will appear on the status bar, informing that the "List is filtered by

H 1 H "
clients' location".
o)) Auditbase - [Referral] - ] b4
File View Functions
E Client  T101010 Mr. John Smith - |2 Z Bl user SYSTEM ADMINISTRATOR L Taw Hill ~ All departments - Q ?
N_m'igati“" "o Referral overview Clients referral | Referral progress | Referral answer = Clinical actions -
B Favourites
b/ Attention list Setas user default | Setup filters Bool Search and book Print list Exportto CSV Refresh
£ Booking
i) Switch on / Review sessions Pathway ID| RTT start Client name Hespital no. | NHS nu.lAdwe length Assessment ~
L 85, Referral 11/02/2010 | MR FIRSTNAMEZ22026 LASTMAME22026 | T122026 582w, 4d | 12/14/2010, Has been breached. No appt 02/02/207
(5] AB Audiogram 11/09/2010 | MR FIRSTNAWME1941 LASTNAME 1941 T11841 581w, 5d |12/20/2010, Has been breached. No appt 02/08/20°
11/23/2010 | MRS FIRSTNAME19079 LASTNAME13079 | T119079 579w, 56d | 01/03/2011, Has been breached, status not‘completion’ | 02/22/207
11/29/2010 | MRS FIRSTNAME32381 LASTNAME3281 T13281 578w,6d |01/09/2011, Has been breached, status not‘completion’ | 02/28/20°
.+@) Pre-op assessmentform 11/15/2010 | MR FIRSTNAMEZ21335 LASTMAME21335 | T121335 580w, 6d | 12/26/2010, Has been breached, status not ‘completion’ | 02/14/20°
12/31/2010 | MR FIRSTNAMEG746 LASTNAMEGT 46 T16746 574w,2d | 02M0/2011, Has been breached, status not'completion’ | 04/01/207
01/05/2011 | MR FIRSTNAME39376 LASTNAME39376 | T139376 569w, 6d 03132011 05/02/20°
Modules 01/06/2011 | MR FIRSTNAMEG105 LASTNAMEGS105 T16105 573w,3d | 02M6/2011, Has been breached, status not'completion’ | 04/07/207 »

A\ The list i filtered by clients' location

If the user wants to see all clients, they should change to All Locations.
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4.2 Referral filters

A number of different filters can be set up so that the referrals can be viewed in many ways.
Click on Setup filters to define filters.

Filters for referrals overview K
Up Down Concise mode Mew Save Delete Close
newOneTest 4| Filter name:

COUNTING CLOCKS

COUNTING CLOCKS

AUDIO REVIEW - counting
AUDIO REVIEW - stopped

DIRECT REFERRALS - counting

DIRECT REFERRALS - stopped
PAEDS counting

TINNITUS

DMA & inappropriate referrals’s
Mullified referrals

Copy and replace criteria from the filter:

Incorrect outcomes hd T -
Filter criteria
ey eaEtE from | 0B/02/2008 |t | DG02/2008
RTT end date
Treatment type: * DO NOT USE-HEARING AID FITTING - Reason
B All stages All statuses B Al clock actions Regardless of breach warning
Current stage Status Clock action Filtering by breach warning
Stage Name . Status ~ | ® Counting W Display referrals without breach warning
v | Assessment | SUSP Suspended B Suspended [W] Display referrals with breach warning
[v | Treatment [~ | 10a, Awaiting first ACTIVITY B Stopped Filter on warning type and the stage it applies to:
v Followup I~ | 11a, End Active monitoring - tn O e Before target date
v  Completed I~ | 11b, End Active monitoring - di B Liable to breach
- " n M Referral closed .
[~ | 20a, Decision to treatl@#5% W Wil breach
[~ 20b, Cancelled - RTT rebook After target date
[~ 20c, DMAtreatment- rebook Has been breached, no appt
[~ | 20d, Further assessment req: Has been breached
Iv | 30a, Treatment commenced Has been breached, status not"completion’
[~ | 31a, Active monitoring - patien Breach warning activated for stage(s):
[ | 32a, Active monitoring - clinici; . Stage Name
[~ | 32b, Neonate 8 mth review res v |Assessment
| 33a, DMA1st assessment v | Treatment
|~ | 33b, Inappropriate referral [~ |Followup
[ | 34a, Treatment not required [~ | Completed

Al Mnfarend fn nneesband (T

This window can be seen by all users but the filters can only be edited and saved by users with
the extended user right for this.

To use an existing filter as a template, choose it from Copy and replace criteria from the filter
and click Copy.

To set up a new filter, click New.

The window can be viewed in Concise mode or Advanced mode.
There is an option to filter on RTT end date instead of RTT start date.
Existing filters will retain the original settings of RTT start date.

Newly created filters will default to using the RTT end date criteria but either start date or end
date can be selected.
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If RTT end date is selected then only referrals that have an RTT end date within the date

parameters selected will populate. Multiple results will be shown if all end dates are within the

date period selected.

Concise mode

Filters for referrals overview

Up Down Advanced mode Mew Save Delete Close

newOneTest 4| Filter name:
COUNTING CLOCKS DIRECT REFERRALS - counting
AUDIO REVIEW - counting
AUDIO REVIEW - stopped
DIRECT REFERRALS - stopped
PAEDS counting
TINMITUS
DMA & inappropriate referrals’s Copy and replace criteria from the filter:
Mullified referrals .
Incorrect outcomes A o
Filter criteria
= RTT start date

RTT end date
Treatment type: ++DIRECT REFERRAL / Audio assessment = Reason -

from 01/04/2009 1o

All stages All statuses All clock actions Regardless of breach warning

Parameters are made simpler in concise mode by checking the boxes for stages, statuses,
clock actions and breach warning boxes to show all or no options.
Advanced mode

A more detailed filter can be created using the Advanced mode button and selecting specific
stages, outcomes, clock actions or breach warnings.
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Filters for referrals overview X
Up Down Concise mode Mew Save Delete Close
newOnaTest | Filtername:
COUNTING CLOCKS DIRECT REFERRALS - counting
AUDIO REVIEW - counting
AUDIO REVIEW - stopped
DIRECT REFERRALS - counting
DIRECT REFERRALS - stopped
FAEDS counting
TINNITUS
DMNA & inappropriate referrals’s Copy and replace criteria from the filter:
Mullified referrals o
Incorrect outcomes v h sl
Filter criteria
«| RTT start date fom | 0110412009 |ig
RTT end date
Treatment type: ++DIRECT REFERRAL / Audio assessment |~  Reason hd
All stages All statuses All clock actions Regardless of breach warning
Current stage Status Clock action Filtering by breach warning
] | Stage Name | ] | Status ~ | W Counting B Display referrals without breach waming
v | Assessment — | SUSP Suspended Suspended M Display referrals with breach warning
v | T Iv | 10a, Awaiting first ACTIVITY Stopped Filter on warning type and the stage it applies to:
[~ | Follow up [~ | 11a, End Active monitoring - tn Nullified Before target date
[~ Completed [~ | 11b, End Active monitoring - di W Liable to breach
- Referral closed
[~ | 20a, Decision to treatl@#3%*" B Wil breach
[~ | 20b, Cancelled - RTT rebook After target date
[ | 20c, DNAtreatment - rebook M Has been breached, no appt
| | 20d, Further assessment reqi M Has been breached
[~ | 30a, Treatment commenced B Has been breached, status not‘completion®
[~ | 31a, Active monitoring - patien Breach warning activated for stage(s):
[ | 32a, Active monitoring - clinici: . Stage Mame
[ 32b, Neonate 8 mth review re ¥ | Assessment
[~ 33a, DMA1stassessment ¥ | Treatment
[~ | 33b, Inappropriate referral [~ |Followup
I~ | 34a, Treatment not required [~ | Completed
W

Note: Both Clock action and Referral outcome status need to be completed to show the

You can also choose to

correct data set of patients.

view All referrals from the Referral overview tab, which is likely to take a

long time to populate as it will include all referrals ever created. For this reason, All cannot be
selected as the default filter with the Set as user default button. Any other filter can be set as

your user default.

Once afilter or the Refresh button has been selected, a progress bar will be displayed. This bar
shows the total number of records that meet the criteria; it also shows the number of records
that have been processed or completed and the number that have been found in the search so

far.
Referral overview | Client's referral | Referral answer | Clinical actions
Filter: PAEDS counting * | Setas user default Setup filters Book Search and boo Print list Export to CSV
Pathway ID RTT start Client name Hospital no.| MHS no. |Active length Assessment |

02/11/2010 |MST FIRSTNAME33372 LASTMAME33372 | T133372 479w, 2d  |[13M2/2010, Has been breached. Mo appt 01/02/20
08/11/2010 |MST FIRSTNAME46057 LASTMNAME4G6057 | T146057 478w, 3d [19/12/2010, Has been breached. Mo appt 0710220
121172010 |MISS FIRSTNAME46130 LASTNAME46130 | T146130 477w, 6d |23M2/2010, Has been breached. Mo appt 1102120
1511172010 |MST FIRSTNAME46153 LASTMNAME46153 | T146153 477w, 3d |26M2/2010, Has been breached. Mo appt 14102720
06/12/2010 |MISS FIRSTNAME45916 LASTNAME45916 | T145916 474w, 3d |16/01/2011, Has been breached. No appt 07/03/20
14M12/2010 MISS FIRSTMAME46544 LASTNAME46544 | T146544 473w, 2d | 24/01/2011, Has been breached. Mo appt

151202010 |MST FIRSTNAME46553 LASTMAME46553 | T146553 473w, 1d |25/01/2011, Has been breached. No appt

161212010 |MST FIRSTNAME43958 LASTMAME43958 | T143958 473w, 0d |26/01/2011, Has been breached, status not’completion’ | 17/03/.
201202010 |MST FIRSTNAMEZ29636 LASTMAMEZ29636 | T129636 472w, 3d |30/01/2011, Has been breached, status not'completion’ | 21/03/
201212010 |MST FIRSTNAME36584 LASTMAME36584 | T136584 472w, 3d |30/01/2011, Has been breached, status not’completion’ | 21/03/20
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Click on Book or Search and book to book a client’s appointment directly from the overview
screen.

When booking an appointment directly from the referral overview, you will receive a breach
warning, if so configured by your system administrator, if the date is set to exceed the target for
the current stage. Click OK to continue and book the appointment regardless or Cancel to go
back and change the date.

You can export the Referral overview to CSV by clicking Export to CSV.
To print the filtered list, click on Print list.

The Print list function is best used if you want an overview of one patient, whereas the Export
to CSV function is best used if you want an overview of several patients or specific information
such as stages or outcome statuses.

To see changes to the list, click on Refresh.
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4.3 Client’s referral
When the client's details have been saved, an initial referral must be created.

Use the Referral dialog to record the referral from a GP or ENT clinic to an audiologist or a
referral from an audiologist to hearing therapy.

Statistics on referrals is available in the Booking module.

Client's referral tab can have a single or a split view.

If configured in administration, Referral progress information can be displayed on a separate
tab.

SPLIT VIEW

Referral overview Client's referral | Referral progress | Referral answer | Clinical actions
Referrals: Client name MST FIRSTNAME417 LASTNAME417 =
Book Search and book Add to list Add observation Print referral Print receipt | Print answer Save Delete
Waiting list entries Attach Detach Edit Show in waiting list
Wait time Date Waiting list Information
-5489 11/30/2010 | TGW - PHAC Temporary loss Reassessmentreview 6 months
Appointments Attach Detach Edit Show in Booking
Date | Time | Symbol | Statusl Resource Reason
11/30/2010 | 11:30 i} D |Res70 AUDIOLOGY referral
04/27/2010 0915 @ 5 |Res70 ENT referral
Observations and procedures Detach Edit
Obsno. | Date |Adds| Text Comment
Current status
Outcome  32a,Active monitoring - clinician start  Clock  Stopped Referral stages
i Active length: Ow 4d
since 04/27/2010 12:08:55 Addnew | | History Name _|Target date and warings Current _ ~ 2
o = e AL T, T SR GT RS E T I Assessmer | 06/03/2010 [ RTT end date: 04/27/2010
SEmINEL e it Treatment |07/23/2010 v RTT end date set by outcome status
MNew outcome status 32a, Active manitoring - clinician start = |Follow up I v 32a Active monitoring - clinician start
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Referral overview Client's referral

Referral progress

Referral answer

Referrals:

Clinical actions

Client name MST FIRSTMNAME417 LASTNAME41T =
Book Search and book Add to list Add observation Print referral Print receipt Print answer Mew 5 Delete
Treatment type PAEDIATRIC hearing aid journey (PHAC) - Information Edit
RTT start date 04/23/2010 Age at start 10y Reassessment
review 6 months
Referral date 0412312010 Other date 0412312010
Waittime
i
Customer BERKSHIRE WEST PCT (RG) - Client contact date
Referred by DR N CURRIE, THE SURGERY, BOCKHAMPTON ROAD, LAMBC | Interview
Referring agent ref.
Reason AUDIOLOGY referral -
Medical priority High -
Referral handling hd
Put on waiting list Booked directly
PathwaylD Edit Registered by USER NAMESD -
©)) Auditbase - [Referral]
File View Functions
A & : 2 B8 ar I
T port from Noah =]
Q. ak & - 5 @ Al 4
Detailed | Quick  Save | Printlist Importdsta | Exportdata %y Export to Noah Log off | Exit Auditbase
Search Referral Import/Export Client data Exit
| client  <4> <s>T1106435345656565 MRS FIRSTNAME106(~ | 3| & = |[E User  Anarey Shustov All locations ~ Al departments ~ ] ?
Referral overview | Client's referral | Referral answer | Clinical actions
Referrals: 109388, 08/06/2015, ++AUDIO REVIEW reassessment ~ Clientname MRS FIRSTNAME1066 LASTNAME 106 =]
Baok Searchandbook || Addtolist  |Add observation Printreferral || Printreceipt | Printanswer New Save || Delete
Selected referral
PathwaylD 1213 Edit Waiting listentries | Aftach | | Detach || Edi v in waiting list
RTT start date 08/06/2015 Age at start 26y Waittime Waittime Date Waiting list ion
Referral date 08106/2015 Otherdate | 08/06/2015 -357 08/06/2015 | HOLDING - REASSESSMENT TG\ 123
Treatment type ++AUDIO REVIEW rea:
Customer GLOUCESTERSHIRE PCT (GL) h
Referred by BHAMBRA (MK), RIDGE GREEN MEDICAL PRACTICE, RAMLEAZE DRIV,
Appointments Attach | [ Detach | [ Eait
WMedical priority Highest - Date ‘ Time ‘ Symbullslatu# Resource Reason
26(2/2015 |12:00 (@ * | Resd ++External health professional referral (eg.HV"
Referral handling h
08/06/2015 | 11:30 @ | Charlie ++External health professional referral (eg.HV"
T Edit 08/06/2015 | 11:00 | [@ * |Resdd ++External health professional referral (eg. HV
=
=
Interview Client contact date
- Obsenvations and procedures Detach Edit
Obsno. | Date |Add[s| Text Comment
=
Registered by full name tests?7? M
Current status
Outcome 102, Awalting first ACTIVITY Clock  Gounting Referral stages
T il Name Target date and warnings Current Active length: 513w, 3d
since ddnew)| [§istoo) Assessment 19/07/2015, Has been breached. Mo appt v RTT end date
Comment Treatment 0 )15, Has been breached. No appt r
Follow up 07/03/2016 r RTT end date set by outcome status
New outcome status 10a, Awaiting first ACTIVITY - Completed r

Primary information
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e The red area in the below screen shot is the main window of the client’s referral where
you will find the primary information like RTT start date, Referral date, referral Reason,
etc.

¢ The RTT date is the date that will be used for calculating the Active length. This date will
transfer to a Waiting list if the Waiting list is booked from the referral.

e The Referral date is the date when the referral letter was written or sent to your
department. Auditbase automatically enters the current date, which can be edited. This
date is not involved in calculations

e Treatment type is the pathway which the patient is following. The Treatment Type is
shown in the list of Referrals a patient has had.

¢ Reason is definable and set up by the system administrator - it can be mandatory or
disabled.

e Other date is usually used where referrals have another important date such as date of
referral to ENT - this date is not used in calculations.

* Medical priority is used to indicate an overall medical priority for the patient besides the
clinics internal waiting list priorities.

¢ Referral handling can be used to support extended pathways in corporation with other
hospital departments. Use it to indicate how the referral has been handled, i.e. if it was
accepted, denied, referred onwards etc.

¢ Information that is relevant for an appointment can be added which will be transferred to
Waiting List Information. This free text can be up to 254 characters in length.

Active length period

¢ Inthe blue ringed areas, you will find the active length period information i.e. RTT start
date, Active length and RTT end date.

e The Active length period is directly related to the Clock value of the outcome Status of a
referral and only increases when the outcome Status has a clock action of Counting.

e [fitis Suspended, the Active length will not increase.

e [fitis then set to Counting again, it will start counting from when it was suspended.

¢ Only 5 Suspension periods are supported by the Active length and Current Outcome
feature in one referral.

* |f the clock is set to Stopped and then to Counting again, it will start counting again from
zero.

¢ Dynamic data is used to see which sub-journey (first, second, third, fourth or fifth) is
current.

* |f the clock is set to Nullified, nothing will show in the Active length field.

Current outcome status and last appointment

e The purple areas relate to the Current outcome status of the client’s latest appointment.

e Qutcomes appearing on the Booking information drop down list represent an
Appointment outcome. Those selected from the New outcome status list on the referral
screen represent a Referral status. Outcomes selected from the New outcome status on
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a Waiting list represent a Waiting list status. Outcomes can transfer from appointments
to waiting lists and referrals and from waiting lists to referrals if the entries are linked and
if the Outcome is configured as being applicable to these functions. l.e. if an Appointment
Outcome is configured as a Referral outcome but not as a Waiting list outcome, it can
transfer from the appointment to the referral but not to the waiting list. Most outcomes
could be required as an Appointment, Referral and Waiting list outcome status but some,
e.g. referral received and referral closed, may only be required as a Referral status.

e The Appointment field shows the client’s last appointment including the status of the
appointment.

¢ Appt outcome is the appointment outcome of the above appointment.

¢ In the Status field the current outcome Status assigned to the client is displayed followed
by the Clock action and the time and date when the Status was last changed, as well as
any Comments.

e The New outcome status can be changed manually or it can be set from the next
appointment, if that has been set up by your System Administrator.

¢ To change the New outcome status manually, either choose a new outcome status in the
dropdown list next to New outcome status.

¢ Oruse the Add new button where a date in the past or future can be set, if the associated
extended user right in System Administration, Referral: Edit Status History, has been
enabled. Setting a date in the future is particularly useful for future patient unavailability.

Mew cutcome status >

Save Cancel

Date 01/02/2022

Outcome status: Clock action Stopped

Comment

The same Outcome status can be set twice or more in succession, either by using the Add new
button or by auto-assigning from the Booking module.

Outcome statuses can be paired so that setting one outcome will immediately initiate another.
This is particularly useful where a stopped status precedes a close status. For example, if a
client declines treatment, you may want to stop and close their referral. This can be done by
pairing these two outcome statuses. Your System Administrator will set this up and the first
outcome can be selected by auto-assigning from the Booking module or using Add new as
described above. These changes will be shown in History.

Multiple clock stops and starts can be viewed in one referral. The Target date and Active length
is shown for the 'current instance', i.e. from a new clock start after a stop there is a new active
length and Target date for up to five restarts, and indicates when it is not the first instance.

All outcome status changes can be found under the History button.
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Outcome status history and journey summary X
Close

Outcome status history Mew outcome status | | Edit outcome status ||| Delete outcome status
Date Outcome status | clock | Comment

01/01/2022 18:38: 11 1003, Referral closed Closed

01/01/2022 18:24:03 10a, Awaiting first ACTIVITY Counting

01/01/2022 17:58:48 100a, Referral closed Closed Standard efterfalger til '"11b, End Active monitoring - disch:

01/01/2022 17:58:47 11b, End Active moanitoring - discharge | Stopped

01/01/2022 17:52:34 100a, Referral closed Closed Standard efterfglger til "11b, End Active monitoring - disch:

01/01/2022 17:52:33 11b, End Active monitoring - discharge | Stopped
12/29/2021 14:56:23 11b, End Active monitoring - discharge | Stopped

12/24/2021 18:37:54 10a, Awaiting first ACTIVITY Counting
< >
Clock summary Active length summary as of today
Date Clock Duration Journey Start End In suspension | Active length
01/01/2022 |Closed Ow 1d 3 01/01/2022 | 01/01/2022 0w, Od 0w 0d
01/01/2022 | Counting Ow 0d 2 01/01/2022 | 01/01/2022 0w, Od 0w 0d
01/0142022 |Closed 0w 0d 1 12/24/2021 | 12/29/2021 0w, 0d O0w5d
01/01/2022 | Stopped Ow 0d

01/01/2022 | Counting Ow 0d
01/01/2022 | Closed Ow 0d
1212912021 | Stopped 0w 3d
12/24/2021 | Counting Owb5d

When the client does rearrange, the appointment for the future outcome status can be found
under the History button and can be deleted or modified and new ones can be added
retrospectively.

The history dialogue shows the referral outcome status history, which can be manually modified
if the appropriate extended user right is enabled. In addition, the history dialogue shows the
Clock summary and Active length summary, which cannot be manually modified. If an outcome
is applied that has a no change clock action, the status is shown, but there is no change to the
current clock action and there are no changes to the clock summaries.

Referral stages

Auditbase generates the referral stage from the current outcome status.

The current stage is checked in the Current column of the Referral stages table.

If the stage is incorrect and needs to be changed, it must be done by changing the outcome
status to one that puts the client in the correct stage of the referral.

If the Referral stage is still incorrect, then inform your system administrator who can check the
set up in the system administration tool.

Target dates will be shown depending on the settings entered by your System Administrator.
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If clock suspensions are permitted, an outcome status that has a suspended clock action will
suspend the clock. Any target dates will increase by a day for each day that the clock is in
suspension. Suspension periods do not count towards the Active length total. Active length
does not increase while the clock is suspended.

Depending on how your System Administrator has set up Auditbase, the Book and Search and
Book buttons will default to different settings for each of these referral stages.

It is possible for Auditbase to be set up so that when either of these buttons is selected, the
next appropriate appointment is found, with symbols etc. pre-selected.

If Search and book has been set up but the required appointment symbol is not listed, you
need to check that you are searching for the correct appointment type and that is it appropriate
to link it at this stage.

If all is correct, but the symbol is still not displaying, then Close the Search and book window
and you will then be taken back to the Referral module.

Select Book and book the appointment directly, attaching the appointment to the referral as
previously described - your system administrator should then be informed.

If a Referral has a Closed outcome the Book and Search and Book buttons will generate a
message preventing their use. An appointment can be attached to the referral with an extended
user right.

Referral >

The selected refemal is Closed. Cannot book an appointment faor this referal

I'x

Furthermore, Waiting List entries cannot be attached to a closed referral, if a Referral has a
closed outcome then the user will get an error message stating that they are unable to attach
the waiting list entry.

Referral *

The selected referral is closed /nullified. Cannot attach the waiting list entry with start date: 12/23/2021

l.\

Waiting list entries

Click Add to list to open a Client to waiting list window.
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Client to waiting list >
Letter Concise mode Save Cancel
Client Mr. John Smith Appointments Aftach Detach
PathwayiD Edit Date | Time | Symbol|8tatus| Resource
Active wait Projected wait
List GW - CORDAFITTINGS +2 -
Initial wait 0 weeks ZEST Mo -
Registered 122412021 Time on waiting list  20:38
< >
Other relevant date 010212022 -
Edit
Information Qutcome status history Add Edit Delete
Date Outcome status Clock
Reason ENT referral -

Letter printed Print letter after saving

Current outcome status

since
Mew outcome status -
Linked referral’s current outcome
20d, Further assessment required  SINCE  01/02/2022 20:35:20 Counting
Current stage breach date
Medical priority < >

Any waiting list entries saved in this way will appear on the Waiting list entries table at the top
right of the main referral screen.

Waiting list entries Aftach Detach Edit Show in waiting list

Waittime Date Waiting list Infarmation
g 12/29/2021 | TGW - FOLLOW UP 3
-1 12/24/2021 | TGW - Audio Review +1 GP LETTER
25 1212412021 | TGW - PHAC Tempaorary loss
12 121 | TGV DAFITTINGS +2

The waiting list entry is saved with current time as the registration time whether the entry is
made in the Waiting List module or the Referral module so that clients are sorted in the correct
arrival time order on the waiting list if used for walk-in clinics.

Therefore, when a Waiting List entry is made from an existing Referral then on the Waiting List
entry, the Date will default to when the Referral was made, but the time will default to when the
Waiting List entry was made.

If you create a waiting list entry directly in the Waiting list module, it will not be linked to a
referral unless you have auto-linking enabled by your system administrator.

You can link it using the Attach button, which will open a window with a table showing existing
waiting list entries that could be linked to the referral.
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Attach WL entry to referral ¥

Select Cancel

Treatmenttype:  All -

Date  |Pathway D Waiting list | status | Referral Treatmenttype | A
1212512021 TGW - DOMI follow up 3 ENT Hearing aid referral
12/24/2021 TGW - PHAC Temporary 1055 109548, 12/24/2021 | ENT Hearing aid referral

1212412021 MHSP - 8 month fallow up ENT Hearing aid referral

2124/202 TGW - CORDAFITTINGS +2 109548, 1 2021 |EMNT Hearing aid referral
1212412021 TGW - Audio Review +1 108548 12/24/2021 |ENT Hearing aid referral
12/24/2021 TGW - SPEECH AUDIO 1 EMT Hearing aid referral

If a mistake has been made and the waiting list entry should not be attached to this referral, the
Detach button on the main referral screen can be used to select and detach a waiting list entry.

Click the Edit button to edit the selected waiting list entry and the Show in waiting list button to
open the waiting list that the selected entry is part of.

Note:

If the ‘Keep client’s entries on waiting list after booking an appointment’ box has been
checked in the system administration tool, a client waiting list entry will remain until they
are deleted manually from the waiting list.

If an appointment has been booked for this client and then they are deleted from the
waiting list, any appointments associated with that waiting list entry remain attached to the
referral. This is explained in an information message when deleting from the waiting list.
To prevent confusion at a later date, the appointment which remains attached to the
referral can be detached manually, if required using the Detach button on the
Appointments section.

Appointments

The Appointments table at the right shows all the appointments linked to this referral. This
includes:

¢ Any appointments created from a waiting list entry that is linked to this referral.
¢ Any appointments created directly from this screen from the Book or Search and book

buttons.
¢ Any appointments created in the booking screen when the window opens to link the

appointment to a referral.
¢ Any appointments added to the referral by the Attach button from this screen. This
includes cancelled appointments from the Cancellation History.

Appointments Aftach Detach Edit
Date | Time | Symbol | Status{ Resource Reason
01/01/2022 [12:00 [m] * | Charlie ENT referral
12/28/2021 [10:00 [m] * | Charlie ENT referral
1212812021 |10:00 [m] * | Travy (EMT referral
1212512021 |09:45 [m] * Stassy (EMT referral
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If a mistake has been made and the appointment should not be attached to this referral, select
the appointment and click on Detach.

Right-click on an appointment to open the Booking information window.

Click the Show in booking button to open the selected appointment in the Booking module and
the Edit button to edit the selected appointment in the Edit appointment window for that
appointment.

Observations and procedures

The Observations and procedures table at the right shows all the observations and procedures
linked to this referral including:

¢ Any observation or procedure created on the Appointment information window of any
appointment linked to this referral.

e Any existing observation or procedure linked directly to this referral from the Add
observation button on this screen.

Observations and procedures Dietach
Obsno. | Date |Add|S] Text Comment
126 1212412021 Otoscleros

Select an observation or procedure and click on Edit to edit it.

If a mistake has been made and the observation or procedure should not be attached to this
referral, select it in the table and click on Detach.

Print Receipt

You may wish to send an acknowledgement of referral to the referrer or client. Click the Print
Receipt button and the letters dialog will open displaying those templates that have been
authorized for use as a receipt. Select the letter you wish to use from the table and open,
preview or print/email it.

Referral receipt templates are created in the letters module (Booking — Functions — Settings
— Letters) and should be marked as Available for Referral receipt.

4.3.1 Quick referral creation

If the referral does not exist or an existing one cannot be used, you can create a new ‘quick’
referral.

This option is available for:
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¢ Booking (when Referral linking to an appointment is mandatory for that appointment
type)

e Waiting list linking to referral

e Surgery

¢ Implant screens

¢ Client module (Implant tab)

To create a quick referral:

¢ |n the Booking and Waiting list modules, click New Referral

| New Referral | Select Cancel

Mew referral >

Treatment type:

Referral date

Client MR FIRSTMAMESTE8 LASTMNAMEST 62 Save

02/27/2017 RTT start date f2i072021

0710612008 Treatment type -
09/05/2005

og/o/2005 || Reason -
0911312004 || Customer

Close

101212001 Referred by

PathwaylD

In the Surgery and Client modules as well as Implant screens, click = and then New to
the right of the Referral field.

Referral I__I |

Mew

Attach
Detach

» Select the relevant options for Reason, Customer and Referred by fields.

New referral x
Client MR FIRSTMAMESTGS LASTNAMEETES Save Close
RTT start date 12/06/2021
Treatment type ENT Hearing aid referral h
Reason ENT referral -
Customer WILTSHIRE PCT -
Referred by MELSON (SC), NEW COURT SURGERY, BOROUGH FIELDS, WOOTTOMN BAE | .
PathwaylD [l

e Save.

For convenience and ease of use, the system administrator can configure default values for
Reason, Customer and Referred by dependent on the Treatment Type.
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Note that Reason may not be shown if disabled in Administration.
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4.4 Referral answer

After saving a referral, you can enter and print an answer.

¢ Enter the Date.
e Type the answer text.
¢ Click Print answer.

When the answer has been saved, it may be disabled for editing, if this is defined by the
system administrator.

Referral overview Client's referral = Referral progress || Referral answer | Clinical actions
Referrals |109548‘ [42/24/2021, ENT Hearing aid referral | Clientname Mr. John Smith =
Book Search and book Add to list Add observation Print referral Printreceipt || Printanswer Save Delete
Date 122512021 User SYSTEM ADMIMNISTRATOR -

-
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4.5 Clinical actions

This tab lists the clinical actions which have occurred within one of the appointments that are
linked to the referral.

The type of actions to be caught are configured in the System Administration tool.

Referral averview Client's referral = Referral progress | Referral answer || Clinical actions

Referral 109548, 12/24/2021, ENT Hearing aid referral Client name Mr. John Smith

Refresh Detach ew audiogram Open

Action date | Appt.date Stage Appt. symbol Action type Description

12/24/2021 | 12/125/2021 | Assessment | ENT new patien | Stock: Lend out article MNHS HEARING AID (Serial Mo.), NHS SUPPLIES, BE101G, RFG312
12/24/2021 |12/25/2021 |Assessment | ENT new patien | NOAH action

12/24/2021 | 12/25/2021 |Assessment| ENT new patien | Audiogram 1212412021, no. 1, Aided

121242021 | 1212512021 Assessment | ENT new patien | OtoSurgery Pre-op

1212512021 | 1212512021 | Assessment | ENT new patien | BKB test

122412021 | 12/25/2021 |Assessment EMT new patien | Document Headed letter template

Clinical actions may have a description, either entered manually or generated automatically by
the system.

For example, a Glasgow questionnaire has an automatically generated description which
contains the abbreviated questionnaire type and the values of global scores; the earmould
impression description is in the form of "L: Name, Material; R: Name, Material", where L/R
stands for the left/right mould, Name - the name of the mould, and Material - the material of
the mould.

The Refresh button will re-populate the list of clinical actions.
Any clinical actions that are not required can be removed from the list using the Detach button.
Any saved audiograms can be viewed by selecting the View audiogram button.

Any action can be viewed by selecting it and clicking on the Open button - this will open the
required module/page in Auditbase so that details can be read.

For example, for a clinical action related to stock, the Device list dialogue box will open where
you can review devices, accessories, earmoulds and repair tasks, as well as attach an
appointment to the stock transaction.
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Infarmation Show in stoc History Print receipt Client MR. JOHN SMITH Print Close

Devices | Accessories | Repairlist | Earmoulds

Present < History Accessory issue Aftach Detach |
Modified date Stock type to Article LR User Serial number | Notes | Version | Reason to issue
02 LOAM (Lent outto client) | MHE SUPPLIES, BE101G |L | SYSTEMADMIMNISTRATOR | RFG31257
Attach appointment to stock tranzaction X
Close
Date | Symbol| Description Resource Status

121252021 [m] ENT new pa Stassy

If you try to delete an appointment which has Clinical actions attached to it, you will get a
message and will not be allowed to delete the appointment.

To delete the appointment, you must first detach the Clinical actions:

¢ Select the action and then Detach.

* You will be asked if you want to add this action to another appointment or not.

* Select the appropriate option and continue until all actions have been detached.
¢ You can now return to the Booking module and delete the appointment.

NOTE: If a clinical action is created that requires an appointment to be attached to it—this
is defined in the system administration tool — the most relevant appointment will be
added. If only one appointment occurs for the patient that day, and the appointment start
time is earlier than the current time, then the action will be attached to that appointment. If
it is not clear which is the most relevant, for instance if there is more than one appointment
on the same day or none that day, an information box will appear asking you to Attach the
most appropriate appointment.
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4.6 Linking Bookings and Waiting lists to Referrals

When making certain appointments directly in the booking screen or when making a waiting list
entry directly in the waiting list module, Auditbase can pop-up a window requesting you to link
this to an existing referral or make a new one.

This can be configured in the System Administration tool, as well as whether this window can be
cancelled.

Select referral for attaching to waiting list entry x
MNew Referral Select Cancel
Treatment type: All -

Referral date| Pathway ID Treatment type Active length Status
18 015 ++AUDIO REVIEW rea sment : 0d | 20d, Further nent required
1010412015 ++AUDIO REVIEW reassessment 247w 6d | 10a, Awaiting first ACTIVITY

24/03/2015 ++ALIDIO REVIEW reassessment 250w, 2d |20a, Decision to treall@#5% 84"
121042001 ++DIRECT REFERRAL /Audio assessment| 951w, 6d | 10a, Awaiting first ACTIVITY

All referrals are shown in date order — Auditbase will, by default, select the most recent referral.

e If necessary, you can create a ‘quick’ referral by clicking the New Referral button. See
details in Quick referral creation.

If it is allowed to be cancelled, then an Automatic Journal Event may be generated and opened
to accept some text explaining why the appointment or waiting list was not linked to a referral.

Journal events X

Selected event
1461

User rejected attaching WL entry to referral

Keyword
GENERAL -
User SYSTEM ADMINISTRATOR has rejected attaching the following waiting list entry to a referral: "

09/01/2020, TGW - CALORICS & POSITIONALS - PP 41@#$%"&/?"

tw
L]
(=]
I
(]
i

N (= EEE

If your System Administrator has set that you may not cancel, you must link the appointment or
waiting list entry to a referral or make a new referral.
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4.7 Referral statistics

The referral statistics are accessed from the Booking module under Functions -> Referral
statistics.

Referral statistics ordinary et

RTT start date from D‘HD'UEEI'IQ to  09/01/2020 Show Close

Treatment type Customer £ £ £ - = ~
Mew Waiting list| Booked | Booked & WL Total

0

++DIRECT REFERRAL / Audio BERKSHIRE WEST PCT (RG) 0
++DIRECT REFERRAL /Audio GLOUCESTERSHIRE PCT (GL 0
++0IRECT REFERRAL /Audio BRISTOL PCT ]
++DIRECT REFERRAL / Audio| Auto-created customer with cod 0
++AUDIO REVIEW reassessm SWINDOMN PCT 1
++AUDIO REVIEW reassessm GLOUCESTERSHIRE PCT (GL 1
++AUDIO REVIEW reassessm BATH & NE SOMERSET 0
++ALDIO REVIEW reassessm FORCES-UK 0
++ADIO REVIEW reassessm SURREY PCT 0
++ADI0 REVIEW reassessm Auto-created customer with cod 0
++TINMITUS FORCES-UK 1
¥ DO NOT USE-OAE Auto-created customer with cod 0
¥ DO MNOT USE-BATTERIES | BUCKINGHAM PCT 1
++NEOMNATAL ASSESSMENT | OXFORDSHIRE PCT (OX) 0
++FITTING - from previous refe WILTSHIRE PCT [\
+FITTING - from previous refe ABCD 0
++FITTIMNG - from nrevinns refe Auto-created customer with cnd bl

s O PSR VO W e T S J S S N W Y e P R Y T
e e = R = =R e T T A e R o i s P e
RN JRPRRE VRV TV NN AN UV DS N A QS A U A RS U Y O S R Y O

e Y e e R = R = = R B T = ) e e e Y

4.7.1 Referral ordinary statistics

An overview of referrals at a given time is listed by selecting Functions -> Referral statistics ->
Ordinary statistics from Booking.

Period from/to can be entered and information such as treatment type, customer, indication of
number of new referrals, how many are put on waiting list/booked directly together with the
total number, are listed when hitting Show.

Symbols of + and - are added over the columns to indicate how the total number is calculated.
The total number of referrals is calculated based on New referrals plus referrals put on a
Waiting list plus referrals Booked directly from an appointment minus referrals both from a
waiting list and a booked appointment.

4.7.2 Referral advanced statistics

Access Referral statistics advanced via Functions->Referral statistics->Advanced statistics
from Booking.

Here you can calculate referral advanced statistics using the specified criteria.

The statistics contain the following data:
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¢ New referrals: the number of referrals not booked and not included in a waiting list.

¢ |n waiting list: the number of referrals put on waiting list.

e Waiting list entries without referral: the number of current entries on waiting list without
reference to a referral, plus the number of appointments with reference to a waiting list
entry, but with NO reference to a referral.

¢ Booked directly: this is the number of referrals booked directly without creation of a
waiting list entry.

¢ The numerical results in the statistics are sorted and grouped first by referral reason,
then by customer. This means that the statistics contain totals by reasons and subtotal by
customers within each reason.

¢ The Calculation criteria section is used to specify parameters of the calculation. The
following parameters can be specified:

¢ Date range: referrals, waiting list entries and appointments within a specified date range
will be included in the statistics. Empty date in the range means unlimited interval.

¢ Age interval: referrals, waiting list entries and appointments for clients within the
specified interval will be included in the statistics. Empty value in the range means
unlimited interval.

¢ Show detailed rows: When checked, the statistics will include detailed rows, with names
and personal numbers of the clients each sub-total comprises.

When all criteria have been specified, press Calculate. The result is shown in the Result table
below. Detailed rows are shown in black and sub-total rows are shown in blue.

Press Print to print the results.

It is also possible to export results into a comma-separated values (CSV) file by pressing Export
to file button. Press the button, then select target file in the opened file selection dialog to get
results exported into the selected file.
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5 Waiting lists

Click the button below to access our training materials.

Waiting lists are user-defined. To access the Waiting List, got to Navigation -> Waiting List or
use Shift+Ctrl+W. The Waiting list can also be accessed via Booking and Referral.
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5.1 Adding a client to a waiting list

* Press F3 to search for the client or Ctrl+F3 to make a quick search or add a new client to
the database using Client information and New.

» Select Navigation -> Waiting List or Shift+Ctrl+W and click Add to list.

e Alternatively, from the Referral module select Add to list.

e Enter Pathway ID - can be made mandated by your system administrator.

¢ Select the appropriate waiting list from the drop-down list.

¢ Enter Initial wait (shown as Wait time on the list.) The Initial wait is always entered as a
number of weeks. This field can be filled with a predefined waiting time for this waiting
list, if so configured by your system administrator.

* Registered date is automatically entered but can be adjusted manually.

e Other relevant date defaults to the current date, if so set up by your system
administrator. It can also be set to either mandatory or optional.

e Add any further Information.
¢ Specify a Reason if required.

e There is an option to Print letter after saving if required.

* A New outcome status will default, if so designed by your system administrator.

¢ Any Appointments and the Outcome status history attached to this waiting list entry can
be viewed on the right-hand side of the waiting list window. This can be hidden by

selecting Concise mode.

e Click Save.
Client to waiting list x
Letter Concise mode Save Cancel
Client MR JOHN SMITH Appointments
PathwaylD Date | Time | Symbol|8tatus| Resource
Active wait Projected wait
List TGW - AUDIO ASSESSMENT +1 -
Initial wait 52 weeks Earmould |No -
Registered 09/01/2020 Time on waiting list = 15:22
< >
Other relevant date
Edit
Information Qutcome status history Add Edit elete
Date Outcome status Clock
Reason A
Print letter after saving
Current outcome status
since
Mew outcome status -
Linked referral’s current outcome
since
Current stage breach date
Medical priority < >

The name of the No/Yes Optional attribute (Earmould in above screenshot) may be changed

by your system administrator.
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Besides changing the value from the Client to waiting list window, you can also double-click on
the value field in the list on the main waiting list screen.

| Title | First name Last name | Earmould |Transpnrt| Letter | Pathway 1D |
MRS | FIRSTMAME: LASTMNAMEZ272 | Mo
MR |FIRSTMNAME: LASTMNAME4G88T | Mo
MISS | FIRSTMAME | LASTNAME1505T | Mo
MR |FIRSTMAME: LASTMNAMEZ94021 Mo 1

Good to know
How status works

An outcome status can be set on either an appointment or on a waiting list entry. When the
outcome status for an appointment is set, this affects the outcome status of any waiting list
entries linked to the appointment and vice versa.

If configured by your system administrator, the outcome status can be updated by the
appointment status, so when the appointment status changes, so does the outcome status.

Outcomes appearing on the Booking information drop down list represent an Appointment
outcome. Those selected from the New outcome status list on the referral screen represent a
Referral stats. Outcomes selected from the New outcome status on a Waiting list represent a
Waiting list status. Outcomes can transfer from appointment to waiting list and referrals and
from waiting lists to referrals if the entries are linked and if the Outcome is configured as being
applicable to these functions, i.e. if an appointment Outcome is configured as a Referral
outcome but not as a Waiting list outcome, it can transfer from the appointment to the referral
but not to the waiting list. Most outcomes could be required as an Appointment, Referral and
Waiting list outcome status but some, e.g. referral received and referral closed, may only be
required as a Referral status.

Clock actions and closing

Once the outcome status is set, this effects the clock action. Set up in the system
administration, different outcome statuses have different clock actions, so for instance an
outcome status of “Discharged/Referred back to GP” would typically have the clock action
Stopped associated with it.

If a waiting list entry has been set to Closed, it can be referred completely from the waiting list,
if so set up by your system administrator.

Once a waiting list entry has been linked to an appointment, the single row in the list is
automatically refreshed. You also have the option of using the Refresh button on the waiting
list screen or press F5, to see any hew changes made by your colleagues.
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0.‘) Auditbase - [Waiting list]

Eile View Edit Functions

A& S B 8 % A 4

Detailed Quick Printlist |mport data | Exportdata | Exportto Noah Logoff | Exit Auditbase

Search Print Import/Export Client data Exit
E Client T18765 MR JOHN SMITH ~||.8 |Z | El|user SYSTEM ADMINISTRATOR Multiple locations ~ Multiple departments... Q ‘7
= Client's entries Journal || Referral Export || Book |[Searchand book || Letter o Clientlist || Addfolist| Edit Delete Print_|[Mew outcome status | =
g
=
e Waiting list Registration period Selection
= TGW - AUDIO ASSESSMENT +1 - to
Mo entries selected | 4 | P
Appointments Outcome status and Clock action
iting i Apply defaults
Mext Previous Outcome Al = Clock Counting+Suspended Q EEmt T 15 EEH
From Referral
Latest previous appointment|Next upcoming appointment Reason MHS no. | Customer no. Customer name | Other date | Title ‘ First name Lastname Earm
Mot displayed Mot displayed ++External health prof 2222222222 |5K3 SWINDON PCT MRS FIRSTNAME: LASTNAMEZ278 | Mo
Mot displayed Mot displayed ++External health prof 124 5QH GLOUCESTERSHIRE PCT (Gl MR FIRSTNAME: LASTNAME46887 | Mo

Your system administrator can set up for the whole site or you can configure in Administration
for when you log in whether or not the waiting list should refresh immediately after changing

filter criteria. If not, the Refresh button will turn yellow to indicate that changes have been
made and you should refresh the waiting list.

0)) Auditbase - [Waiting list]

File View Edit Functions

A& B8 B A af

Detailed | Quick  Printlist |mport data | Exportdata ExporttoMoah Log off | Exit Auditbase

Search Print Import/Export Client data Exit
E Client - ,9\ = |Bl|user SYSTEM ADMINISTRATOR Multiple locations... ~ Multiple departments.. - ¢ 9
= Client's enfries Journal | Referral Export Book || Search and book Letter o Clientlist ||| Add to list Edit Delete Print  ||New outcome status ‘ =
£
‘; Waiting list Registration period Selection Clearall
E = Changes made, press to refresh (F3)
5 TGW - AUDIO ASSESSMENT +1 - to Selectall
Mo entries selected | 4 | p
Appointments Qutcome status and Clock action
0 Apply defaults
Next Previous Outcome Al ~| Clock FEEL ] st
From Referral
Date Active wait Wait time | Outcome status | Clock ac‘udHUsp\Ia\ no. MName ‘ Postcode ‘ DoB |Nu‘ Information
| |0910/2007|639w,2d -587 20b, Cancelled - Counting | 712278 MRS FIRSTNAMEZ2278 LASTNAMEZ2: PC:4541 12/051959 1
L | 19/01/2011 468w, 1d -416 20a, Decision to Counting

MR FIRSTNAME48887 LASTMAME4E PC:208 0111011998 2/109075 G.P. letter- FF
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5.2 Viewing and filtering Waiting lists

e Select Navigation -> Waiting list.

¢ Select the relevant waiting list from the drop-down list.

e You can view the individual waiting lists or select All to view all the waiting lists at the
same time.

e When scrolling to the right, you will see a column called Projected wait, which shows
what the wait will be when the booked appointment occurs. It only shows when the option
to show Previous and Next appointments is enabled on the particular list. The
appointment must be linked to the waiting list for the predicted wait to be displayed.
Appointments with certain statuses chosen in System Administration are not included.

e Limit the Registration period, if required.

« [f all entries do not fit into the table, use the Right arrow button to see further entries.

¢ You can also filter the waiting lists, if so set up by your system administrator.

¢ The filters have the following actions:

* Appointments - Next and Previous. This filter will display those clients that have a next
or previous appointment which can be Found or Not found.

+ Outcome status. Displays all clients with the selected Outcome status.

¢ Clock action. Displays all clients with the selected Clock action or combination of
actions.

¢ Current stage breach date. Displays the target date for the current stage only. This does
not display the target date of the stage when the client was added to the waiting list.

¢ If you select From Waiting list, data will be filtered on the outcome status and clock
action from the waiting list entry; if you select From Referral, then data will be filtered on
the outcome status and clock action from the linked referral.

¢ Limit the Registration period, if required.

¢ Your System Administrator can set breach warnings allowing entries to change colour
dependent on how close to breach they are or if they have breached. The breach date can
be calculated in days or weeks.

NOTE: The From Referral option can be disabled from the Auditbase Administration tool by
clearing the Display medical priority, outcome and clock action from linked referral on
the main WL screen check box in the Waiting list types settings.

e When scrolling to the right, you will see columns called Referral outcome and Referral
clock action, which contain the current outcome status and clock action from the linked
referral. The columns will be empty if the waiting list entry is not linked to a referral and
will contain “<Not displayed>" if the From Referral option is disabled.

e These filters can be used singly or in combination with each other. The defaults set by
your system administrator can be applied by clicking the Apply defaults button.

« |f the current filter excludes the chosen entry under Client’s entries, the filter will be
changed to show the entry. The new filter you see is only filtered on the date of the
selected client’s entry.

¢ Active wait and Projected wait will be shown in weeks and days or just days depending on
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the setting in Administration.
e Print if required.

o)) Audithase - [Waiting list] - m] ®
File View Edit Functions
O o, = % @ =» o’n 'U
@ | Em S > © i
Detailed | Quick  Printlist |mportdata Exportdata Exportto Moah Logoff | Exit Auditbase
Search Print Import/Export Client data Exit
@ Client T137586 MST FIRSTNAME37586 LASTNAME37586 |~ | 2| & B User SYSTEM ADMINISTRATOR Multiple locations... = Multiple departments... |- ¢ ?
= Client's entries Journal Referral Export Book | Search and book | Letter To Client list | Add to list Edit Delete Print | MWew outcome status
<
& Waiting list Registration period Selection
g Selectall S
= TGW - AUDIO ASSESSMENT +1 - to
1 entry selected 4/
Appointments Outcome status and Clock action
. Apply defaults
Next Previous Outcome Al + Clock Counting FROID U T R
From Referral
Date Active wait ‘Wait time | Quicome status | Clock acli4 Hospital no. Name Postcode DOB | Mo. | -~
09/10/2007 |639w, 2d -587 20b, Cancelled - Counting | T12278 MRS FIRSTMAME2278 LASTNAMEZ] PC 4541 12/05/1959 1
19/01/2011 |468 w, 1d -416 203, Decision to| Counting MR FIRSTMAME4G887 LASTNAME4E PC:208 01/10/1998 2|109075 G.P. letter- FF
18/02/2015 (255w, 1d -203 Counting | T115057 MISS FIRSTNAME15057 LASTNAME PC 64097 22/06/1998 3
18/02/2015| 255 w, 1d -203 Counting | 7128402 MR FIRSTMNAME294021FIRSTNAME] KK3 8LL 30/05/1951 4
20M11/2015 | 215w, 6 d Counting | truhwet MR OK OK B& 3EE 06/09/1943 i}
07/07/2017 (130w, 6 d -78 203, Decision to| Counting | T999811 Father dzee2 azel m 03/04/1992 7
07/07/2017 (130w, 6 d -78 Counting | T1105 MRS FIRSTMAME 105 LASTNAME10f PC 3649 16/08/1910 8
15/06/2018 |81 w, 6d -29 103, Awaiting firs Counting | T144659 MR FIRSTMAME44659 LASTMAME4: PC: 7386 06/0711947 9
15/06/2018 81w, 6d -29 20a, Decision to| Counting | T1120 MRS FIRSTMAME 120 LASTNAME12( PC:6082 19/08/1929 | 10| 555S5555S5X00000000XCCCZSSSS
O7N720MA I TRw A d -2R Countinn | TAR4RARG M= Surnerv 0412018 " e
< >
Waiting list: TGW -AUDIO ASSESSMENT +1 Client phone 99999 999999 Transport:
Customer name:  SWINDON PCT Customer no.: 5K3 Client location:Disabled in Admin

NUM
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5.3 Searching for a client on a waiting list

* Press F3 to search for the client or Ctrl+F3 to make a quick search.
¢ Navigation-> Client’s entries or press Shift+Ctrl+Q.

e Highlight required waiting list entry in lower table.

» Click Show in waiting list or double-click.

¢ Click Edit to edit the entry.

¢ Click Add to create a new entry.

Client's appointments and waiting lists X
Client MSTFIRSTNAME37586 LASTNAME37586 Close
Appointments list - 17 item(s) History of changes Attached actions Delete from history Show in appt book
Date | Time |Luc.| Dept.| Appt. |Status| Resource| Reason |SMS1 | SM32| Declined offer Symbo A
2000612018 | 10:000 4 | 4 T * |Resd4f |++BExernal health professional referral (eg.HV's) GWH Audio asses
19/06/2018 17:00 m] * | Trawy ENT new patient r
18/06/2018 16:00 I * | Charlie | ++External health professional referral (eg.HV's) from1
18/06/2018 | 10:00 E] * | Trawy +CIRENCESTER Treatment Centre (ISTC) PHAC new patient
10/06/2018 1 13:15 1" * | Stassy ALDIDLOGY referral to1
23M1/2015 | 10:15 7 5 |Res81 ENT referral 2
09M1/2015 | 10:45 7 * | Trawy ++External health professional referral (eg HV's) 2
051112015 | 12:00 T A | Trawy ++External health professional referral (eq HV's) 2 ]
< 3
Waiting list entries - 1 item{(s) Add Edit Show in waiting list

Waittime| Date| Waiting list| Information|
166 | 02111 TGW - AUD| 12" 1A

Appointments where an offer has been declined will appear in a Burgundy colour on the screen,
with the associated Appointment status.
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5.4 Selecting clients’ entries from waiting list

* Press F3 to search for the client or Ctrl+F3 to make a quick search.
e Select Navigation -> Waiting list.
e To select one client, click on the client’s row. Your System Administrator can configure

whether or not a warning will appear when changing a client.
* To select multiple clients, click each one in the grey column to the far left. This will turn on

the check mark.

®* When a client is selected, he also becomes temporarily checked until another is
selected or the check is confirmed by clicking on it.

* Multiple selections can be used for Export, PPP, Delete, and Book functions.

* When multiple clients are checked, the client highlighted in black will be the one used by
the Client’s entries, Journal, Referral, Add and Edit buttons.
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5.5 Deleting client's entry from waiting list

It is not possible to delete a waiting list which contains client entries.

¢ Press F3 to search for the client or Ctrl+F3 to make a quick search.

* Navigation -> Waiting list.

¢ Select the client's entry (or entries) by clicking on it; a check mark will appear at the start
of the row.

¢ Click Delete.

e Click Yes.

* When multiple clients are checked, the whole group will be deleted.

Clients entries Journal | Referral | Export Book | Search and book | Letter | To Client list | Add to Jist Edit Delete Print | New outcome status |£‘,
Waiting list Registration period Selection
Select all Clear all
TGW - AUDIO ASSESSMENT +1 - to electa
3 entries selected 4| »
Appointments Oy Waiting li
g list . fting f Apply defaults
Mext Previous Ou T Erom ‘._'Vamng = By
I@I Are you sure you want to delete selected 3 client(s) from waiting list? -
Date Active wait Waittime | Outco| & Postcode | DOB  [No.|
09/M10/2007 639w 2d -587 20b,d C4541 12/05/1959 1
19/071/2011 (468w, 1d -416 20a,0 Yes Mo Cc:208 01/10/1998 2109075 G.P. letter-

v (1 0 1d 03 C:6497
18/02/2015 | 255w, 1d -203 Counting | T129402 MR FIRSTMNAMEZ294021FIRSTMNAME KK9 8LL 30/05M1951 4

w2 I NUINAR 1212w 2 A -1RR Manntina | T127R08R MaT FIRSTRIAMEITRAR | AQTHAMET B-2010 nN7Iennn B UUPIAL" 1AL "I98
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5.6 Editing or moving a client's waiting list entry

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

¢ Navigation -> Waiting list.
¢ Highlight the client's entry.

¢ Click Edit or double click on the row (except in the Optional att column where a double-

click toggles the value).

Edit waiting list entry x
Letter Concise mode Cancel
Client MRS FIRSTNAME120 LASTNAME120 Appointments Aftach Detach
PathwaylD Edit Date |T|me | Symbol|8tatu51 Resource
Active wait Ow,0d Projected wait
List TGW - AUDIO ASSESSMENT +1 -
Initial wait 52 weeks Earmould MNo -
Registered 15/06/2018 Time on waiting list  14:30
< >
Other relevant date 15/06/2018 -
Edit
Infarmation 5555555555 “| Outcome status history Add Ed g
00000000 -
Date Outcome status Clock
Reason ++GP direct referral w | |15/06/2018 14:47:07 91a, Active monitoring - continued Stopped
i i 15/06/2018 14:39:07 100a, Referral closed Closed
Print letter after saving - -
15/06/2018 14:39:06 36a, Patient died before RTT treatment | Stopped
CITEHCTEID TS 15/06/2018 14:38:16 | 100a, Referral closed Closed
913, Active monitoring - continued  since  15/06/2018 14:47:07 Stopped 15/06/2018 14:38:15 36a, Patient died before RTT treatment | Stopped
Change 15/06/2018 14:32:36 31a, Active monitoring - patient start Stopped
Mew outcome status -
Linked referral's current outcome
33a, DMAst assessment since | 15/06/2018 14:65:27 Mullified
Auto assigned by: 15/06/2018, 333, PHAC new patient mould~
Current stage breach date
Medical priority ~ Mormal = N

¢ The Initial wait (weeks) and Registered can be modified. If a client is entered on a
waiting list with a waiting time of O weeks, Auditbase will calculate how long the client has
been on the waiting list. It can be used to prioritize clients i.e. entering 4 weeks for urgent,
6 for soon and 8 for routine. Auditbase will then list the clients with the urgent clients at
the top of the list.

¢ On an entry editing, the system offers possibility of either initial Waiting time editing or
Waiting time rest editing. This depends on settings in the Administration tool.

¢ Active wait and Projected wait will be shown in weeks and days or just days depending
on the setting in Administration

¢ Set Optional attribute status to Yes or No. Note that this status can also be changed in
the main Waiting list by double-clicking on the Optional attribute column for a certain
entry. Note also that the name of the Optional attribute is configurable by the system
administrator for all lists or for a specific list, so it may have another name in your system.
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¢ Free text can be entered in the Information box.

* Reason can be selected from a drop-down list.

¢ Depending on the settings in the system administration, a waiting list entry can be
deleted automatically, if the New outcome status is set to Closed. In the system
administration, you can also choose to show a warning before the entry is deleted, in

which you can overrule the setting and not delete the entry.

Edit waiting list entry

4% The outcome status "100a, Referal closed’ will close the waiting list entry immediately after saving.
I.,\h /,I For the waiting list ‘Atesttype’, the default action after closing an entry is deletion.
= Do you want to delete the waiting list entry?

Yes Mo

¢ When you click Save, the dialog will close.

This procedure can be used to move a client from one waiting list to another.

91

© Auditdata - 2025, ID: 20.0040/36



User Guide

5.7 Exporting waiting lists to Comma Separated Values (CSV)

Navigation -> Waiting list.

Select a Waiting list from the drop-down menu.
Functions -> Export CSV

A window will open called Create CSV file.

o)) Create CSV file x

Save in: |DThis PC j = FEEE g

i, Folders (7) P

Cluick access

' 3D Ohbjects
Deskt
=siop . Desktop
=
Libraries

: IEI Documents
' Downloads

Network r
e Pusic
W

File name: | j Save |
Save as type: |C5Vfiles (*.cav) j Cancel

* Give the CSV file a File name and choose where to save the file.

e Select Save to store the file in the selected location. This file will have a .csv extension.

e The CSV file that is created will contain all the data for the selected waiting list, no matter
what filters have been applied to that waiting list.

* To open the CSV file using Microsoft Excel, start Excel and use one of the Open dialogues.

* You will need to change All Excel files to All Files in order to find the .csv file.

File name: waiting list > Al Files -

Tools = [ Open |v] ’ Cancel ]

¢ The file will now open in Excel and can be adjusted as required.
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6 Client lists/Trials

Click the button below to access our training materials.

Lists of clients can be created to be used for research or clinical trials, the name is configurable
as Client lists or Trials by your System Administrator. To access Client lists/Trials select
Navigation-> Client lists/Trials or press Ctrl+Shift+L.

The Lists tab will display all lists and these can be filtered by checking the relevant Status box
to Show planned, Show active, Show closed and Show only assigned to me.

Highlighting a list and then selecting the Members tab will display all the clients that have been
assigned to that list.

Lists | Members

Mew Edit Copy | Delete || &2
Status
M Show planned M Show active Show closed Show only assigned to me
Startdate | Enddate | Status | Title | Responsible | Type | Min. clients| Act. clients
01/01/2016 | 01/02/2017 | Active | Title 4 | USER NAME29. 444 g

09/01/2020  09/01/2021 | Planned | Test list| SYSTEM ADMINISTRATOR
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6.1 Creating new Client lists/Trials

e To create a new Client lists/Trials, select the New button. A Create Client list window

opens and the Title for the new list can be added.

+ A Start date and End date for the list can be added; a double click will insert the current

date while a right click will open the calendar.

« A minimum number of clients for the list can be added to the Min. clients field. The

actual number of clients field called Act. Clients will be inactive.

¢ Your System Administrator can set up the Type of list which can be selected from the

drop-down menu.

¢ The person Responsible for this list can be selected from the drop-down menu of users.
¢ The Status of the list can be selected from the pre-defined drop-down menu. The options

are Planned, Active and Closed.
« AComment can be added to explain the list.
e Select Save or Cancel to return to lists without creating a new one.

Create Client list >

Cancel

Title | |

Start date End date
Min. clients Act. clients
Type

Responsible  SYSTEM ADMINISTRATOR -

Status Flanned hd

Comment

¢ The new list will now appear in Auditbase.

Lists | Members

09/01/2020 | 090142021 | Planned | Profound loss | SYSTEM ADMINISTRATOR
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Status

B Show planned Show active Show closed Show only assigned to me

Start date | End date | Status Title Responsible Type| Min. clients | Act. clients
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6.2 Editing Client lists/Trials

e To edit a Client list/Trials, highlight the required list and select Edit. All options are then
available to edit as required.
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6.3 Adding clients to Client lists/Trials

Clients can be added to a list using the F3 search function.

Clients can also be added to a list by highlighting the list and selecting the Members tab.
To add the active client to the list, select the Add selected client button.

A confirmation window will appear, select Yes to add the client or No to go back to

Members.

Message

I{’g—"\l Do you want to add the selected client to the selected Client list?
k. 4

Yes Mo

¢ The client will now appear on the list with the default status set by your System
Administrator.

Lists | Members

Add selected client Search and Add clients Remaove Change sfatus (<]
Status List
- Profound loss 09/01/2020 - 09/01/2021
Parameter #1 -
Parameter #2

- -

Clients in the Client list: 1, Filtered: 1, Min clients needed: 20

SelectAll No entries selected
Hospital no. Mame |Distance| Status |Date added User |F'i|:1ure|Parameters|Gender| MHS no.
T18765 MR JOHM SMITH Mot asked | 09/01/2020 | SYSTEM ADMINISTRATOR | Mo Male 888858888

» Search and Add clients will open the F3 search window and clients can be searched for

using the advanced criteria and added to a list.
e If client(s) are in a list already with intersecting dates or are deceased, the system will

warn and give the option to exclude these from the new list.

 |f you need to remove a client from a list, highlight the client and select Remove.

» The Status of a client on a list can be changed by highlighting the client and selecting
Change status or by clicking into the Status field directly on the table. A new status from
the drop-down list can be selected. This drop-down list is defined by your System
Administrator.

Change status >

Save Close

Mew status for selected 1 client(s)

Mot asked -

© Auditdata - 2025, ID: 20.0040/36 96



User Guide

* The list can be refreshed by selecting the = putton.

* Alist can be filtered by selecting from the drop-down menus labelled Status, Parameter
#1 and Parameter #2.

o [f afilter is applied, this is shown in the List information.

Clients in the Client list: 9, Filtered: 3, Min clients needed: 444
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7 Booking

Click the button below to access our training materials.

Go to Navigation -> Booking to open the booking module.

In this module, you can find and access all information that has been saved in the database for
the client you are working with. The Booking module handles client appointments, including
group appointments, and reservations.

Information can be represented by either the Resource plan or the Time plan. Appointments of
various kinds may be registered here.

An appointment can be booked either by searching for the next available timeslot or by double
clicking and thereby booking directly. The client must be selected before an appointment can
be booked. However, group appointments can be made without selecting a client.

Appointments can be booked from a number of dialogs in Auditbase, for instance from Referral
or Waiting list.

To edit an appointment or reservation, double-click it and modify as required.

Read more in the following chapters.
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7.1 Booking list

Go to Functions -> Booking list to display a list of the day's appointments for the selected
resource.

These appointments can be filtered as required by resource or time and sorted by time or
hospital number.

The list specifies time, client or activity and resource, sorted in time order and then in resource

order.
Booking list X
Date | 09/01/2020 M Show client/group appointments M@ Show reservations AM only PM only Print Close
«| Sort by time Sort by Hospital no. Resource - All Resources - -

Time MNHS no. Hospital no. Appointment name Resource Appointr
08:00-08:15 88588888 T18765 MR JOHM SMITH Charlie 1
08:00-08:15 T1110 MRS FIRSTNAME 110 LASTNAME110 Resdf 1
08:00-08:15 TEaas13 niu Stassy 2
08:15-08:30 88588888 T18765 MR JOHM SMITH Resdf 2
09:00-09:15 88585888 T18765 MR JOHM SMITH Res4f 1
13:00-14:30 T123026 MR FIRSTNAMEZ3026 LASTNAMEZ3026 Charlie 1
< >
General note Daily note

FY rFe
b -

Click Print to print list. When printing the list the phone numbers of the patient, available from
the client information module, will be demonstrated under the patient appointment.
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Booking list
Selected date: 09/01/2020
[X]Client appointments Reservations [ |AM only [ |PMonly
Belonging to- All
Time Hospital NHS no. Name Resource Appointment Information
no.
08-00-08-15 T18765  B8888888 MR JOHN SMITH Charlie 1
Tel: 99999 999999 Work: Mob :
08:00-08:15 T1110 MRS FIRSTMAME110 LASTRes46 1
Tel: 99999 999999 Work: Moab - +1232323
08:00-08:15 TBB5613 nlu Stassy 2
Tel: Work: Moab -
08:15-08:30 T18765 58658808 MR JOHN SMITH Res46 2
Tel: 99999 999999 Work: Moab -
09:00-09:15 T18765 58658808 MR JOHN SMITH Res46 1
Tel: 99999 999999 Work: Moab -
13.00-14:30 T123026 MR FIRSTNAME23026 LAS Charlie 1
Tel: 99999 999999 Work: Mob :
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7.2 Resource plan

» Select View -> Resource plan to view the Resource plan.

e The date is shown at the top of the screen.

* Times are located on the left of the screen in timeslots. The start and end time can be
modified by the System Administrator to suit the requirements of the department.

e The System Administer can migrate Auditbase from the default 15-minute appointment
units to using 5-minute appointment units permanently. Generally, the 5-minute unit
setting has slower performance than the 15-minute unit setting because three times as
much information is being transferred, processed and displayed. If migrated users have
both zoom and scale options for changing the view, while using 15-minute units users
have only the zoom option.

e The scale options are 5, 10, 15, 20, or 30-minute slots altering the units displayed on the

left-hand time column. It is possible to change the scale view by using the 4 15 min.

button or the following shortcuts which are displayed when the button is selected. Ctrl+K
to Scale up and Ctrl+L to Scale down.

Zoom in Ctrl+|
Zoom out Ctrl+0
¥ 100%
125%
150%
200%
Scale up Ctrl+K
Scale down Ctrl+L
5 Minutes
10 Minutes
n 15 Minutes
20 Minutes
30 Minutes

Using zoom the size of the booking area can be increased by the selected percentage.
This size can be adjusted using the Zoom in and Zoom out options which have the
keyboard shortcuts of Ctrl+L and Ctrl+0 respectively. These same options are available
from Selected zoom on the View ribbon at the top of the page. The zoom and scale
selections are remembered if a user logs off from Auditbase.
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Time CHARLIE Trev BERTA JUDITH ALAN | JAKE
08:00 |eald ke MISS. TESTINA K iz DR. ALAN HARPER LA MR. JAMES SCOTT [JA MR. JAMES SCOTT  |r L/ & FATHER DERF FRED
08:15 |l K i TESTER k& WA LA B L

08:30 |w L i e K& WA WA W LA

08:45 6Ll K ki WA Wé i LA

09:00 &ALl K K WA WA i LA

09:15 |en Ll K K & MISS. BETSY WA WA i Ll

09:30 |6 Ll K K & HARPER LA WA B L

09:45 |m L K K& WA WA b L

10:00 [e L K K& LA WA ]

10:15 el K K & MRS. EVELYN WA WA i Ll

10:20 |6 L K K & HARPER WA WA B L

10:45 [m L K K& WA WA ]

1100 |m L K K& LA WA ]

1115 CJ K K o MISS. MARIN HINKLE | LA WA vl
1130 |m L K K& WA WA b Ll

1145 |m L K K& LA WA b Ll

1200 [eald K k& i ] i L

1215 |m L K K Ll L ot

12:30 [m L K ot E] E} ot

12:45 |mll K E el E B Lol

1300 |jo} E K Ll 3N

1315 (i} E K lu# DR HERB MELNICK | LIA DR. HERB MELNICK | [

1330 |m L K K Ll WA b Ll

1345 |m L K K LA LA b Ll

14:00 |m L K K LA LA b Ll

1415 |m L K K LA LA ]

1430 |m L K K LA LA ]

14:45 |m L K K LA WA b Ll

15:00 [m L K K LA WA b Ll

1515 |m L K K LA WA ]

1530 enlu K k ' DR. CHRIS LYER WA WA i L

15:45 |l K K iz WA LA N

16:00 |l 4 K iz LA LA B L

16:15 |ealy k k N L B

16:30 en [ K K | L B

16:45 |1 L K K L L # L

17:00 |8 L K K ] ] # L1

1715 |l K K W L # L

17:30 |8 L K K W L # L

17:45 |8 L K K W L # L

Time CHARLIE Trev BERTA JUDITH ALAN JAKE

08:00 WSS, TESTINA DR.ALAN WR. JANES WR. JAMES FATHER DERF

0815 A L] k. b reerer b 82 fareer LA St L5 Sorr BF Lol &% Freo
L K de K i FIF:Y MF: BF Lol

e B K, s K i LA Ay b LA

L k K LA, LA, BF L&
0 gt Ll K k LA Ll BF Lol

L ‘ K & 9 LIA LAl

%930 pn L] K K & LA LA EF L]

45 gy || k k LA, Ll EF Ll

190 g L K, K i LA LA BF L]

10215 Bh ) K K i HES.PE\;{ELYN LIJH LIJH BF i

139 g L K, K i LA LA BF L]

10..45 eh L) K ki L A L A eF L

bh L] k k i L& L& B L

1 L ¢ K IR LA LA vl -
e Ll i ki Lol F:Y BF L

LN k. K & Ll & Ll & BF Lu]

= ew L] K K & Ll Ll EF L1

12:15 Bh ] K K | L] &

20 1 L] i &} &} &} Bl

5 g i ot ot ot BF Ll

:2:2 It It k L DR.HERB L DR. HERB =L

13:30 & jat k. L)% i ek )P weinex  [BF L
20 gn [ K k. BF Lo

1245 gn E E Lol Lol By BF L

400 g ] k k Ll ¥ B L
15 g L i i Lol A Lol A BF Ll
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¢ When highlighting a slot in the table (the field is marked in dark blue), the whole of the
corresponding timeslot will be highlighted to the left for a clear overview.

¢ Resource names are located from left to right near the top of the screen. Each resource
column has a drop-down list of the resources in the system.

¢ Three dots at the end of the resource name allows you to choose the resources.

Trawy |

¢ Clicking on a resource will display them in the column.

Resdb ' e
STUDENT MURSE Travy
ﬁ D, MS FIRSTHMAMEZ7310 LASTMAMEZT 310 Stassy

Tl Charlie
% Res109
v Resdf
ﬁ [ I |

e [f another resource is selected from the list, the current resource will swap places with
the selected resource. It is not possible to have the same resource on screen more than
once.

¢ You can add or remove Resources from the view by going to the Settings ribbon and
selecting Resource setup.

¢ Timeslots on a resource column can be empty or filled with either timetable or
appointment symbols if there is an entry for a specific time.

¢ On the Resource view between the Timetable and Appointment symbols, two new
symbols for Location and Department can be seen if they are enabled by the System
Administrator.

¢ The full length of client appointments will appear as a light blue colour covering the
duration of the appointment. Reservations are shown as mauve with group appointments
showing as green. Multi-resource appointments are shown in peach colour.

¢ These colours can be suppressed by the system administrator for the whole site or by a
user in their user specific options.

¢ Text in booked appointments will be in black except for Video Appointments which use
blue text to distinguish them. When the selected appointment is a Video appointment the
text will be in yellow rather than white.

¢ Placing the mouse cursor over an appointment, a tool tip will show the length of the
appointment and the client‘s name.

Bl
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: . AuditBase 5 - [Booking]

Eile Edit View Functions

|| client 0000001 COLONEL CHARLIE HARPER -1&] (=]| 5| user SYSTEM ADMINISTRATOR Location |l locations ~ll~o
= 13:00-14:45 CHARLIE | Mo fiter] - |.|||# || General || Daily |[[L-]| 2| £ 15 min.
xg' Time CHARLIE Trev . BERTA JUDITH ALAN i JAKE
Er'_ 08:00 gy IA MISS. TESTINA TESTER 4+ MISS. TESTINA TESTER B E BF L) BF L (3]
] e K LA BE e 14 oF L & L bF 1]
ok LA B E e 14 oF L & L bF 1]
e K LA B {1} Meeting Bk BF L o Ll [
el L CE ] b K L] o L bF L]
IA Bl HE BF L o L b L
IA Bl HE BF L o L b L
IA Bl HE BF L o L b L
I, REV. CHRISTOPHER K () b K BF L o Lul B Ll
T ROBIN m B BF L B Lol i L]
I m Bk BF L o Lol b Lol
I m ik oF L oF Lol b Lol
I Fu Harper family 1 BF L o Lol L]
I R 1 oF L o Lol L]
I R 1 oF L o Lol L]
Ii W o L COLONEL CHARLIE o L COLONEL CHARLIE b L COLONEL CHARLIE
Ta W Ll HARPER gl A HARPER el £ HARPER
ITa ek eFLl A EATTI-Y AT
h S K FLl A AN LAY
I= EE B L] e L ke L
j ) COLONEL CHARLIE K EBF Lil B Ll BF 1]
I B K BF L N — R
I HE BF Ll B Lol Calendar &J
I B E BF Ll & Ll |
I ) B K BF L N
L Wi b L | | August 2016 =
I ) K BF L L3N]
It EE BF L] o L
{‘E BRE BFH BFH 25 26 27 28 29 30 M
i [ b 3
I‘: BE BF L B Lol 12 3 456 7
It BE B L o L g 9 10 11 12 13 14
15 16 17 18 19 20 21
22 23 24 @826 27 28
29 30 1 1 2 3 4
T Today: 25/08/2016
I

e If an appointment’s client name cannot be displayed in full, three dots will be shown
indicating that an appointment is present.

Time | Travy |
08:00 K, 2-1PAED

08:15

08:30

08:45

09:00

0915

09:30

09:45

10:00

10:15 Qg C, MRS FIRSTHNAME2G786888883858825838588 LASTHA. .
10:30 Fit C, MR FIRSTNAME 13050 LASTHAME 13050
10:45 fit C, MRS FIRSTMAME24246 LASTMNAMEZ24246
11:00 £ C, MR FIRSTNAMEZ2787 LASTMNAME2787T
11:15

11:30 fit C, MR FIRSTNAME25461 LASTMAME 25461
11:45 [fe] C, MR FIRSTNAME 10504 LASTNAME 10504
12:00 Fi C, MR FIRSTNAME20268 LASTMAMEZ20268
12:15 Z, MST FIRSTNAMEZ7 705 LASTNAMEZ27 705
12:45

13:00

¢ Placing the mouse cursor over the highlighted appointment will display a tool tip of the

appointment time/duration and the client’s name.

7.2.1 Resource set up

e The user can set up a personal view of resources in the appointment book.
e To activate the setup, select Functions -> Settings -> Resource setup from the Booking

module.
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¢ Defined and active resources are shown in this window and can be checked to be listed in
the columns of the appointment book.

* When checked as Show, a column will hold the resource's name.

* When checked as List, the resource's hame will be visible from the drop-down menu in
the columns.

¢ When checked as Book, the resource's name will appear in the resource list when
booking appointments.

¢ Click on the Up and Down arrow buttons to define the resource’s position in lists.

» Click Save to store a new or changed resource set-up in the database. The changes will
take effect as soon as Save is selected.

* Reset to default resource view will load the defaults and the list can be adjusted to one
of the users if necessary.

Resource setup >

Save Close

User |S‘r’STEr-.«1ADMINISTR&TOR v| Resetto default resource view | 4w | W

Shnw| List|Elnnk| Resource |Lﬂcatinn(s}lDepartment[s} ~
Trawvy Location1 |Departmentt
Stassy LocationZ2 | Department?
Charlie

Res109

Resd4b

Res68

Res70

Reshd

Res7s

Res73

Resg2

Res75

Res71

Res72

Res105

Res63

Resa5

Res106

IR REERNE R R EHEEREE]ER R RO
| &R EEEEEEEEEEDE] AR R RO
IR REERNE R R EHEEREE]ER R RO

Showing Resources will be overruled by Location, Department and Clinic filtering. Grey row calor
indicates resource is filtered out

7.2.2 Clinic filters set up

Resources on the Booking screen can be filtered by timetable symbol and/or location and/or
department to show specific clinics or groups of resources working on the same clinic. These
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filters do not override any restriction to resources based on location.

To set up filters, the extended user right Booking: Setup clinic filters is required. Your System

Administrator can provide this extended right. Once the filter has been set up, it will be
available to all users. Setup clinic filters is to the right of the filter drop down menu.

[Mo filter]

» Select New and enter a Name for the Selected filter.

» If Location or Department is required, select these from the drop-down menus.

» [f Multiple locations or Multiple departments are required, a new window will open
where the Locations/Departments can be selected.

» Timetable symbols can be selected by checking the box next to their name or you can

w .

Select All. Move the symbol selection to the right-hand box by using the arrow. Symbols
can be de-selected from the filter by checking the box and moving the symbol back to the

left using the arrow.

Clinic filters

Mew Copy

Delete

Close

“~ v
filter 1

Selected filter
MName filter2

Location All locations

filter2

-

Department Department1 -

Timetable symbaols: SelectAll

SelectAll

| Available symbols

~

1 1

22

Ol nNTS

" ENT CLINIC

[JH SAv - C&B - Dref/AGR
] PAED Hearing Aid Clinic
1@ PAED Transition

[1F SAVERMNAKE PAEDS
M TIDWORTH

[/ wiltshire PHAC

[J& 123

1@ FAIRFORD ENT

| Selected symbols

[JE PAED Assisting
[ COMMUNITY PAEDIATRICS
@ test

» Afilter can be copied by selecting a current filter and choosing the Copy button.
¢ You will be asked if you wish to make a copy of the current filter.

© Auditdata - 2025, ID: 20.0040/36

106



User Guide

Clinic filters

k. 4

Yes Nao

I/g_'\l Do you want to make a copy of the selected fiter?

e Select Yes.

¢ The name of the filter will then have - Copy after its name. You can modify and rename
the filter then Save to create a new filter.

e [f afilter is no longer required, highlight the filter then Delete to remove it.

¢ To exit the filter setup, select Close.

¢ These will now be available to all users.

7.2.3 Using Clinic filters

Clinic filters allow the use of filters that just show resources who have certain timetable
symbols, locations or departments for that day. For example, a filter set up to show ENT clinics
will only show resources that are timetabled with the various ENT symbols.

These filters do not override any restriction to resources based on location.

¢ Select the filter from the drop-down list of filters.

e The Booking screen will change to reflect the filter selection.

) Auditbase - [Booking]
Fle  Edit

reate

Wednesday 25/04/2007

] Client T126785 MRS FIRSTNAME26786833888888888888 - | 8 | >[5 |User  SYSTEM ADMINISTRATOR | Muttiple o

I -

ene

i || pany | 2] /@ 15 min

ings
~ Multiple departments .~ (£ P

73 G, MISS FIRSTNANE456 LASTNAWE456
}i C. MRS FIRSTNAME25521 LASTNAME25521

[ C. MISS FIRSTNAME26063 LASTNAME26063

(] C, MST FIRSTNAME28504 LASTNAME28504
C. MISS FIRSTNAME28104 LASTNANE23104

B8R

5 C, ST FIRSTNAME27780 LASTNAME27780
0 95 C, S FIRSTNANE28686 LASTNANE28686

GORERROORDNNRRIEE

. MISS FIRSTNAME25454 LASTNANE25464

] C. MISS FIRSTNAWE27108 LASTNAWEZ7 108
HIR FIRSTNAWE26286 LASTNAIE26288

WIR FIRSTNAME22651 LASTNAME22651

#
1§ MRS FIRSTNANIE2530 T LASTNANE26301

ST FIRSTNAME27581 LASTNANEZ7561

=]
R FIRSTNANE13170 LASTNAMET3170

f

i

c.
c.
i
c.m
G, M
C, ST FIRSTNAME28897 LASTNANE28897
i
C. I
C.m

ST FIRSTNAME25207 LASTNAME26207

1222

0&15-10:15
PHYSIO

R S, MR FIRSTNANET694 LASTNAVET694

R S, MR FIRSTNANE19122 LASTNAVE9122
R

115 S, MR FIRSTNAME4946 LASTNAME4946

15 5. 1IRS FIRSTNANES279 LASTNAHNES279
En S, M IRSTNAMES6S LASTNAMEGES

® S, MRS FIRSTNAME15280 LASTNAWE 15250

R
R
R
R S, MRS FIRSTNAWE26288 LASTNANE26288
R

S, MST FIRSTNAME28904 LASTNANE28904

of
% D, MST FIRSTNANE28905 LASTNAVE28305
2

=
5 [1me Traw Stassy Res68
2 [os00 K 2-3+5A7 A SETUP
2 |os1s JPD @ SAVBKD £ PHYSIO 945, MR FIRSTNANE2S701 LASTNANE28701

08:30 iy %

08:45 2

09:00 %

0915 51227 5, MASTER FIRSTNAWE25340 LASTNAME25340

/2 2 75, MSTFIRSTNAME29102 LASTNAME29102

50275, MISS FIRSTNAME29105 LASTNAWE29105

IRS FIRSTNAMEQ 133 LASTNAMES133

512 2 7'8, MISS FIRSTNAME25793 LASTNAME25793

(312 2 7 S, MRS FIRSTNAME1023 LASTNAME1023

(i¥2 2 7 S, MSTFIRSTNAME26864 LASTNAME26854.
57007 8. MRS FIRSTNAME17306 LASTNAME17306

512 2 7 5. MRS FIRSTNAME20026 LASTNAME20025

11227 . MSTFIRSTNAME23071 LASTNAWE23071

¢ Three dots at the end of the resource name allows you to choose the filtered resources.

Trawvy

¢ Clicking on a resource will display them in the column.
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Trawvy

K, 2 -3+5A
JPD @ SAY BKD

¢ If no resources are contained within the filter, Auditbase displays a blank resource plan.

¢ You must either choose a different date or filter to display resources.

0.‘) Auditbase - [Booking]
File Edit View Functions

m 5 B DB o o® &5 B

Booking list | Client's entries | Reservations | Client to waiting list | Client to group appointment | Efficiency analysis  Booking | Appointment | Referral  Mewtask  Settings

Functions Statistics Create Settings

E Client T126786 MRS FIRSTNAME267 81 - .-°~\ * Hl|user SYSTEM ADMINISTRATOR Multiple locations. ~ Multiple departments - Q 9

Wednesday 25/04/2007 | ||| General Daly ||| |/® 15min

Lonebinen
E
E
3

¢ Ifyou try and view a Client’s entries when the appointment does not display due to a

filter, you will receive an information message.

Message

The appointment you are trying to wiew in Booking is not available because:

o A
= 1

- The Clinic filter you hawe applied does not include this resource.

Would you like to go to that date in the Booking screen to change your view settings?

Yes Mo

¢ You will need to select Yes to go to the appropriate date and then change the filter

settings. No will take you back to Client’s entries.
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7.3 Time plan general

» Select View and click on either Large booking view, Standard view, or Large grid view to
choose the preferred view

o)) Audithase - [Booking]
Eile Edit View Functions

& & & 8 &

Make new = Search for new Edit Move | Bulkmove Copy @ Cancel | Delete  Make @ Schedule | Copy
Booking Timetable

E Client  T126786 MRS FIRSTNAME2678! -2 = (B |user SYSTEM ADMINISTRATOR Multiple locations ~ | Multiple departments... = Q ')

z Wednesday 25/0412007 Travy | .|| general || paiy |||m=|[2]|[® 15 min| [ B [EH

é Time ‘ Location Department |Hospital no ‘NHS no. | MName L‘V| Sl Telephone | Information |Reasun‘ Referenced by

& 08:00 All All 2- 3+5AY K 99.9.99 0

- 15 Al All JPD @ SAV BKD 99.9.99 30X
30 Al All
45 Al All
09:00 All All
15 Al All
30 Al All
45 Al All
10:00 All All
15 Al All T1456 MISS FIRSTNAME456 LASTNAME4SE X| |[C|99999 999999 | JOO( )OO X0CL & JOCOO00C J00C
30 Al All T125521 MRS FIRSTNAME25521 LASTNAMEZ25521 |X| | C| 99999 999999 | @000 1000 )X
45 Al All
11:00 All All T126063 MISS FIRSTNAMEZ6063 LASTMAMEZ6063 | X| | C JOOOC 0000 30000 99
A5 Al All
30 Al All T128594 MST FIRSTMAME28594 LASTNAMEZ28594 |X| | C 000000000 99-9-99
45 Al All T128104 MISS FIRSTMAMEZ8104 LASTMAMEZ8104 | X| | C 9 JO0COO0 0COOCC G DOCC)
12:00 All All
15 Al All T127780 MST FIRSTMAME27780 LASTNAMEZ27780 |(X| C
30 Al All T128686 M3 FIRSTMAMEZ8686 LASTNAMEZ8686 (X | C| 99999 999999 | XX JOOGHXK
45 Al All
13:00 All All T125464 MISS FIRSTNAME25464 LASTMAMEZ25464 | X| | C 9 J000C00 00000 - X000GC

15 Al All

Resource

Stassy
Charlie
26 27 28 28 30 31 1 |Resioa
2 3 4 5 6 7 8 |Res4b
9 10 11 12 13 14 15 |Rests

Res70
16 17 18 19 20 21 22 [Roces

23 24 25 26 27 28 29 |Res73

A
REERRREERRRRR

30 1 2 3 4 g [ Res73 RRRRRRRRRRRRRRRRIB\IBII!IIBIR
Res82
Ty Today: 09/01/2020 Res75 85 3% 5% 5 BN 5555 5 55 5 B3 5 o B B B 58

Res71
# Booking or Timetable Res72
Res105
B TimeTable Resfl ARG S R R R BB RMEEBR R ERRRRRR RIER R [ mersrmms
B Booking Res85

Res106
Show in separate rows Res102
Res98
Res87 T B i B T B T B i A e B
Res47 020 [ 1 P10 2 e e e i = e e e o
Resd1
Res8B

e The different views can also be chosen by using the toolbar buttons on the top right:

e Standard view (displaying both the booking view and the grid view). Keyboard
shortcut Shift+F7 can be used for fast access.

m Large grid view (displaying a larger grid view with a smaller booking view). Keyboard
shortcut F7 can be used for fast access.
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i Large booking view (displaying one large booking view). Keyboard shortcut Ctrl+F7
can be used for fast access.

To adjust the size of the bottom half of the screen, the user should hover over the split
line and drag to resize the screen. The timeplan will remember the size that it has been
edited to if the screen is restored down and returned to full size.

Contact your System Administrator to set which view Auditbase defaults to when
opening the Time plan view.

¢ The different columns in Time plan can be moved, so you can decide in which order the
columns should appear.

e Let your mouse hover over the bottom line of the column header and the mouse cursor
changes symbol‘ﬁ’.

* Now click and drag the column to the relevant location.

e The time span will reflect the hours selected in System Administration -> Workstation
settings.

¢ The System Administrator can migrate Auditbase from the default 15-minute
appointment units to using 5-minute appointment units permanently. Generally, the 5-
minute unit setting has slower performance than the 15-minute unit setting because
three times as much information is being transferred, processed and displayed. If
migrated users have both zoom and scale options for changing the view, while using 15-
minute units users, have only the zoom option.

¢ The scale options are 5, 10, 15, 20, or 30-minute slots altering the units displayed on the
left-hand time column. It is possible to change the scale view by using the button or the

following shortcuts which are displayed when the *4 15min.| putton is selected. Ctrl+K to
Scale up and Ctrl+L to Scale down.

* Text in booked appointments will be in black except for Video Appointments which use
blue text to distinguish them. When the selected appointment is a Video appointment the
text will be in yellow rather than white.

Zoom in Ctrl+I
Zoom out Ctrl+0
® 100
125%
150%
200%
Scale up Ctrl+K
Scale down Ctrl+L
5 Minutes
10 Minutes
n 15 Minutes
20 Minutes
30 Minutes
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Using zoom the size of the lower Resource area can be increased by the selected percentage. This size
can be adjusted using the Zoom in and Zoom out options which have the keyboard shortcuts of Ctrl+I
and Ctrl+0 respectively. These same options are available from Selected zoom on the View ribbon at
the top of the page. The zoom and scale selections are remembered if a user logs off from Auditbase.

If a scale is set that prevents individual appointments from being displayed, the time band that
is affected is shown as grey and <Multiple content> is displayed if there is more than one
appointment and <Partial content> if just one. Moving the mouse cursor over the multiple
content will display a tool tip showing the appointment times and the associated client.
Changing the scale will show the full information for the appointment.

Time| Locaion | Department |Hospital no.|NHS no.| Name L|v|s]
0300 | Al All <Multiple content=

20 Al All -

40 Al All

09:00 Al All

20 Al All

40 Al All

10:00 Al All <Multiple content>

200 Al All <Multiple content=

40 Al All -

11:00 Al All T126063 MISS FIRSTNAME26063 LASTNAME26063 X C
20 Al All T128594 MST FIRSTNAME28504 LASTNAME28594 X C
40 Al All <Multiple content>

A scale that does not allow the start or end time of an appointment to be displayed will have the
start and end times highlighted in grey. The tool tip will display the full appointment times.
Changing the scale will display the full information for the appointment.

Time| Location | Department |Hospitalno.| NHS no. | Name L|v|s]
45 Al All
12:00 Al All
15 |Al Al
30 Al Al T113559 MRS FIRSTNAME 13559 LASTNAME13559 | X |C
45 Al All T15790 MRS FIRSTNAMES790 LASTNAMES790 %] |C
13:00 Al Al T11124 MR FIRSTNAME1124 LASTNAME1124 %] [C
15| All Al

Location1 | ] Department? | T18765 MR JOHMN SMITH

7
45 |1 Location1 |‘] Department T
14:00 7 Location1 |l Departmentt —~lI-
15 |“1 Location |1 Department? —ll=
30 |1 Locationt |1 Department

If a 15-minute appointment cannot be displayed fully in the resource area due to the selected
scale, a half symbol is displayed showing that the full appointment cannot be shown. Moving
the mouse cursor over the symbol will display a tool tip giving details of the appointment and
the client.
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¢ Choose which symbols you would like to view in the Time plan by checking the box next to
either TimeTable or Booking. Both sets of symbols can be seen by checking both boxes.

# Booking or Timetable

W TimeTable
M Booking

Show in separate rows

¢ Resources are shown to the right of the calendar. Symbols for these resources can be
seen in separate rows by selecting Show in separate rows. This will show four rows of
symbols with Timetable at the top, then Location, then Department, with Booking
symbol at the bottom. This order is described by a tool tip that can be seen by placing the
mouse cursor over the Show in separate rows label.

Resource 0a

ApmE AR RAGERAM AL FATIAL  DADEDADADIDADA0R0 DD 0D
ResRa AR RSRCR R RC R B RR TR R R RCR B R R R R RC R B R R R T RTRCR B RRTR R ASRCR
BCATRATRTACATACRTATR R TRCR TR TR TR AR TR AR TR TR TR R AR TR AR TR AR R TR TR R
RE 5 ? ':I mﬁmﬁiﬂ]‘l’ Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Eﬂ]‘mmmmlﬁ"aliﬂr Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l'
20 000D 20090 T 0YD
i 5 25955 95555 555
00T T J FMGTT mmsiz:  To050m 777 My
Res54 T oM e M P e e e e e T e e e

Al R e D el A e AR A e A e S 4 A L

Contact your System Administrator to set which symbols to view as a default in the Time
plan.

¢ To save the user configurations you have made, click on the menu View -> Save window
setup and your specific settings for the Time plan view as well as the symbols view will be

saved.
o)) Auditbase - [Booking]
File Edit View Functions
E o E —_— 0-0
g2 Z 2 B8 © @& B = 5 Sl -
oA HC) & @, 4 ~
Resourceplan || Timeplan View all day = Cazlendar  Symbollist | General note | Daily note  Selected zoom  [Largebooking = Large grid | Bookingonly  All resources | Oneresource  Save window setup
Plan Wiew Zoom Timeplan view Resources Settings

112
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7.4 Time plan, All resources

e Select View -> Time plan.
e Select View -> All resources. For fast access, use Ctrl+8 or double-click on a date.
¢ You can switch between the One resource and All resources views in three ways:

° using the View ribbon menu item
° using F8 or Ctrl+F8
° clicking on either a date or a Resource

¢ The day is shown at the top of the screen. Resource names are listed to the right in the
lower section of the screen.

¢ Time intervals for a selected resource are shown in the upper section of the screen. The
start and end time can be modified by the System Administrator according to the
demands of a department. The content of the table represents the appointments for the
resource

¢ The grid in the lower section represents timeslots with either timetable or appointment
symbols where a timetable or appointment has been created for a resource.

5) Auditbase - [Booking] = X
Hle  Edt | Vew | Functions
P 1 = aa
g B @ % B 8 B =
Resourceplan Tmeplan Viewslldsy | Clendsr | Symbollit | Generalnote | Daiynote  Selected zoom  |Large booking| Lsrge grid | Booking only | Al resources | One resource  Save window setup
Plan View Zoom Setting:
i crient 118765 MR JOHN SMITH -2 =|Eluser  SYSTEMADMINISTRATOR | Mul ~| Multiple departments
_ | | Thursday 0510472007 Res46 INo filter] MR Daily [[=2 [ | ® 15min.
£ | [FreLomion]Deparmenriospiaimo s mo] Name TCVo] Toephone | e =
S Al
Z 2o
5 A Al
2 A Al T124557 DR FIRSTNAME24557 LASTNANE4Z57 | X| |S
s A Al —i-
1200 A1 Al —i-
15 Al Al
Al Al
s A Al Tizs824 1S FIRSTNAWE2882¢ LASTNANE2852¢ | X| |5 | 99999 899999 XX, X000 -XI00C 0000000 X000 00X 0K
1400 A1 Al —i-
5 AL Al —i-
N A Al —i-
s A Al Ti28463 RS r X |s
1500 A1 Al —i-
5 A Al —i-
N A Al —i-
6 AL Al T128455 1R FIRSTNAWE2B455 LASTNANE28455 | X| | D 89999 999999 XX KXKGO00X
1500 A1 Al —i-
5 A Al —i-
2 A Al —i-
5 A Al T128458 VR FIRSTNAME28458 LASTNANE28458 |X| | S 99999 099999 XX )0X00000K
17o0Al Al —i-
5 Al Al —i-
2 A Al Ti28885 RS FIRSTNAVEZ8885 LASTNAVE28885 X | S 99899 999999
s A Al ~EMMALREC APPLICATION 2000000000
| April 2007 L. | =
R
T
2 27 28 29 30 31 1 |Res
2 3 4@ 6 7 8 |Res
s 10 11 12 13 14 1 [Res e
1617 18 10 20 21 22 [hew
23 24 25 26 27 28 29 |Res
B 3 4 oS
T Today: 0910112020 e
Reso:
+) Booking or Timetable o
[ fimeTable] s
 Booking i ¢
Res.
Showin separate fows <

e Choose which symbols you would like to view in the Time plan by checking the box next to
either TimeTable or Booking. Both sets of symbols can be seen by checking both boxes.

#| Booking or Timetable

M Booking

Show in separate rows
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¢ Resources are shown to the right of the calendar. Symbols for these resources can be
seen in separate rows by selecting Show in separate rows. This will show four rows of
symbols with Timetable at the top, then Location, then Department, with Booking
symbol at the bottom.

>
Resource 03 |I:IQ
Mﬂ AR g Ra Ma R Ra Mg
R p o R RAGAS RAGA A, Aefigfid  DpDRDRD R0 R0R0 R0 0 R0 R0 R0 R R0 R0 G/mI M
ResGg ARTRIRTATRR TR RR RSB RR R R R R R R AR R R R R R R R R R R R R R R R TR AR
ACARACA AR A AR A BRT AR RTR AR TR R TR R TR R AR R R R R R R AR R TR A
RE g ? D mﬁﬁmimt Em'l' Em'l Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Emtmmmmlauﬂliml' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l Em'l' Em'l' Em'l' Em'l'
222 222 2Y LR
] 59555 5575
DplpDplp t o7 1 TR T ApRpipts S A Im T MM
Res54 T3 P i g e i i i i e e e TETIET T M e e e e
AT AR TR e AR A 18 1A 148 A A v A SO A 1 1A A L

Unlike the Resource view where you can alter the number of Resources shown and the width of
each column changes, the height of each Resource in Time plan is fixed. The system shows a
maximum number according to the screen resolution and the view option selected. With Time
plan there are two view options showing either 20 or 35 Resources when using the recommended
screen resolution. Your System Administrator can reduce this number, or you can adjust the
screen resolution to make Auditbase smaller, but you cannot increase it. If you use a larger
screen resolution, the number of Resources will not increase, the diary at the top will expand.

The System Administrator has three options:

* To have faster visible performance when changing dates and slower when scrolling
through resources.

¢ To have a faster refresh when scrolling resources and slower when changing dates.

* To have a faster refresh when scrolling resources and faster when changing dates.
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7.5

Time plan, One resource

Select View -> Time plan.
Select View -> One resource. For fast access, use Ctrl+8 or double-click on a date.
You can switch between the One resource and All resources views in three ways:

° using the View ribbon menu item
° using F8 or Ctrl+F8
° clicking on either a date or a Resource

The resource name is shown in the toolbar at the top of the window. The dates are listed
to the right.

Time intervals for a selected resource and date are located in the upper section of the
screen. The start and end time can be modified by the System Administrator depending
on the demands of a department. The content of the table represents the appointments
for the resource.

o)) Auditbase - [Bocking]
Eile Edit WView Functions
Fo E = 00
5 Ee| @ 2 & BB = B &
Resource plan | | Timeplan View all day = Calendar | Symbollist | General note | Daily note  Selected zoom | Large booking = Large grid | Booking only  All resources | One resource | Save window setup
Plan View Zoom Timeplan view Resources Settings
E Client  T18765 MR JOHN SMITH - |R|Z B user SYSTEM ADMINISTRATOR Multiple locations. v Multiple departments... v (XX 7
_ | Thursday 05/04/2007 Resd6 | Mo filter] + | |||f5]|| ceneral || Daiy || 2|2 || & 15 min.| | M| E
é Time|Lﬂcatmn|Department Hospital no |NHS no. | Name |L‘V| Sl Telephone | Information
B EEL Al
ES
12:00 All All
15 Al All
300 (Al All T124557 DR FIRSTNAME24557 LASTNAME24557 |X| |S
45 Al All —I—
13:00 All All —Il-
15 Al All
300 (AN All
45 Al All T128824 MS FIRSTNAMEZ28824 LASTMNAME28824 |X| | S (99999 999999 | XK. JCO0CK - J0COCX00CO0C J0COC 0O 000
14:00 All All —1l-
15 Al All —Il-
30 (Al All —I—
45 Al All T128463 MRS FIRSTMAME28463 LASTMAMEZ28463 | X | S |99999999999 | XX J0CO0CO0(
15:00 All All —Il-
15 Al All —Il-
300 (Al All —Il-
45 Al All T128455 MR FIRSTNAMEZ28455 LASTNAME28455 | X | D|99999 999999 | )X XCO0CO0C
16:00 All All —Il-
15 Al All —I—
300 (AN All —Il-
45 Al All T128458 MR FIRSTNAME28458 LASTNAME28458 | X | S| 99999 999999 | )X J0CO0CO0
17:00 | All All —I—
15 Al All —Il-
30 (Al All T128885 MRS FIRSTMNAME28885 LASTNAME28885 | X |5 |99999 999999
45 Al All ~EMMALREC APPLICATION H0C 0G0
- LU = UsaeeeE.s'?.sgs.ss.ss.s'.::s.ss.ss.s'.:.:asBsas‘;szasasas‘;;uum RN T T
2620 28 29 80 = Srirdalplele R RUGIAR IR lR DD DRORORDRCADADRDADRDRD RO AD D DA M
2 3 4 48 6 7 8 |08/04/2007
9 10 1 12 13 14 15
16 17 18 19 20 21 22
23 24 25 26 27 2B 29 |07/04/2007
3 1 2 3 4 5 6
- yToday: 09/01/2020
08/04/2007
Booking or Timetable
TimeTable
Booking 09/04/2007 BB BT BT BT BT BT BT BT BT BB BB B BB BB R RO RO RO RO RO RC RO RO R B B BB B BB
«! Show in separate rows
B4 B B B B BB B B BB B B BB BB BB B BY B B BB B0 B0 BB B0 B B BB B BB B
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¢ The grid in the lower section represents timeslots with either timetable or appointment
symbols where a timetable or appointment is created for a resource.

* All symbols for the single resource can be seen in separate rows by selecting Show in
separate rows. This will show four rows of symbols with Timetable at the top, then
Location, then Department, with Booking symbol at the bottom.

Resource 08 09 [10 |11 hz2 13 4 5 6 |17
09/04/2007 AU RCR AR R R ROR RO BB R BTRRCBCRTR B TRORCRTRR B TROR R RR R TR BB RR R R R
BB BB BB B B BB B B BB B BB 3 By By 08:00-18:00 ANNUAL LEAVE |,
10/04/2007 [ B H BB B B B BB B B B B B e B A IR R IR [RIR IR IR R R RIRIR IR R IR
E RS 2 Re o o Ra R P EIEAEACA S AR MMM MY el el el B Rl REGEE RS R
1110412007
1210472007 K T e A S e e e S S A e T v
Ll PITRIRERRDRPRORNGR KPS FIMMR RETEHEEMMMMMMMM
1310472007
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7.6 Booking information

Information about every appointment or reservation is accessed by right-clicking the respective

appointment or reservation.

Referenced by

Reason

Qutcome status

Current outcome
Appointment not linked to referral

Linked Waiting list

Details

Hospital no. T117850; NHS no.: -
MR FIRSTNAME 17850 LASTNAME17850

99 J0000( 000(

000000

JO0O0000MK -

Booking information *
Client: MR FIRSTNAME 17850 LASTNAME 17850 Time: 03/09/2020 9:30 - 9:45 Attached actions Close
Appointment  [@  ENT NEW PATIENT MOULD~ Location All {no location) Letter:
Verbal:

Timetable Department All (no department) Video appt:
Made by: SYSTEM ADMIMISTRATOR on P3/09/2020  Aftnd. with
Resource(s) TRAVY Status

[no status] -~

* Apptarranged

Q, Cancelled

B, Being seen
Stages condition:

Stage 1 | Stage 2 | Stage 3 | Stage 4|

-

Status change Delete

*, Appt arranged 03/09/2020 14:18 [1m]
L, Arriwved 03/09/2020 14:1% SYSTEM ADMINISTRATOR

Information History of changes

FY

-

Add/Edit/Delete

Im

Delete

Obs no. | SNOMED code [ICD10 code | Date | Add. | 8| Text| Comment

Client observation or procedure | Visit charge

The window holds information about the following topics, some of which are covered in further

detail in separate sections below:

e Date and time

¢ Client name at the top and details, such as personal number and address at bottom left
¢ The resource who made the booking

e The user and date of appointment creation

e Timetable, Location (if enabled), Department (if enabled) and appointment symbol
e Letter printed or verbally notified; marked with X

¢ Video Appointment: marked with X

¢ Attnd. with can show the relative that attended the appointment with the client - click
the Browse button to select from a pre-defined list of relatives or add a new relative

e Referenced by such as referencing institution
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¢ Appointment status - see below

¢ Appointment Outcome - see separate section

e History of Appointment Changes

e Further Information about the appointment, e.g. special preparations to be made by the
audiologist in advance. The information can be modified in the window if required.

¢ Client observation or procedure

¢ Visit charge

In the dialogue box, a status can be associated with the appointment/reservation. The possible
statuses to be assigned to the appointment/reservation are defined by the system
administrator.

The appropriate status can be chosen from the Status list, a default status may be configured
in System Administration for when the appointment is booked. Status change history is seen in
the Status change section, showing the duration in waiting or ‘being seen’ status for instance.
When the status has been selected the window closes and the appointment status will be
updated on the booking screen.

Note: If so configured by your system administrator, when setting a status for an
appointment, Auditbase may prompt you to also set an Appointment outcome, if the
appointment is linked to a referral or waiting list. The user may or may not overrule this
mandatory action depending on settings in system administration.

If the appointment contains several stages, they are seen alongside their conditions in the
Stages condition area. The condition of each stage can be changed by right-clicking the
corresponding cell. After modifying a stage condition, the dialogue box is closed.

Outcome status can be selected in the drop-down list. The code is used to describe the
outcome of the appointment. The possible values are defined by system administrator.

Linked waiting list can be viewed from the dialog. This is a read only field.

Double-clicking any appointment symbol on the lower grid will open the Edit booking window
where any feature of the appointment can be adjusted. If changes are made, the Print letter
window will open on saving.

7.6.1 Client observation or procedure

If the appointment has an observation or procedure attached, it will appear in the lower table
on the Client observation or procedure section/tab in the bottom of the dialog. From here you
can also Add/Edit/Delete the observation or procedure. When adding an
observation/procedure, select the required one from the list and click the Add to client button.
Should further observations/procedures be required, repeat the process. Upon completion click
Save. To delete or edit an observation/procedure, select it in the lower table.

Note: When deleting an observation or procedure from Booking information, it is removed
completely from the client record and not just from the appointment.
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7.6.2 Visit charge

Visit charge features are primarily used in Sweden. If this is enabled (in System administration)
the lower part of the dialog is split in two tabs - Client observation or procedure and Visit
charge.

On the Visit charge tab, the following is shown or controlled:

* Booking code, identifying the appointment, used e.g. in connection with self-check-in

¢ Anonymous number, used to call patients in the waiting room without compromising the
patient’s privacy or violating privacy regulations

¢ Client identity verification, used to register if and how the patient’s identity has been
verified

¢ Waiting room, showing what waiting room will be used for the visit. It can be pre-filled
based on rules configured in System administration

¢ Appointment fee, can also be pre-filled based on rules configured in System
administration

¢ Prohibit Self-check-in, showing if self-check-in is allowed for the patient. Can be pre-filled
based on symbol or locked if the patient has protected identity.

* Print visit receipts, allows the user to select and print one or more of the following

documents
° Anonymous number
° Roadmap or route directions from present location to selected waiting room, and
° Payment receipt

Booking code 2472 Client identity verified Mot verified hd
Anonymous number

Waiting room -
Appointment fee DIAGMNOSTIC - E35.00

Prohibit self check-in Print visit receipts

Client observation or procedure | Visit charge

7.6.3 Attached actions

To view any clinical actions, documents or IMPs attached to an appointment, click the Attached
actions button in the upper right corner of the Booking information dialogue box. A list of
attached clinical and other actions will open in a separate dialogue box.
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Attached clinical and other actions b4

Client MR JOHMN SMITH Detach Close

Appointment  fif 09/01/2020, GWH 1 st, Stassy

Attached clinical and other actions Select all
|»‘«|:ti0n date|.a\|:1i0n typel Description

09/01/2020 BKB test

7/ 09/01/2020 AB Words {

[1/ 08/01/2020 SIR test

To detach an action from the appointment, select the check box beside the action, and then
click the Detach button; to select all actions attached to the appointment, click Select all. In
the warning message Do you want to detach the selected data from the appointment? click
Yes to complete the operation.

To return to the Booking information dialogue box, click Close.

NOTE: You will not be able to detach a posting from the appointment.
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7.7 Calendar and refresh

The calendar can be used to select the working date.

* In the Resource plan, the calendar can be closed or opened using the [4] button on the
menu bar or by pressing Alt+C. In the Time plan, the calendar is always shown.

e Today's date is highlighted in blue and displayed at the top of the screen.

¢ To change the date, move the month and years along using the arrows and click on the

relevant date. This will refresh the booking screen.
e For quick access to a specific month, click on the name of the month displayed in the

calendar and a drop-down box will appear.

Calendar

X

January
February
March
April

May

June

July
August
September
October
MNovember

December

0

J January 2020

3

i_') 10
6 17
3 24

0 3

7

4
hh
18
25
1
8

o

Calendar *

EN January 2020 i‘ |

003 1 2 3 4 5
B @ 8 LIy 10 1 12
13 14 15 16 17 18 19
20 21 22 23 24 25 28
27 28 29 30 31 1
3 4 5 6 7 8

T Today: 09/01/2020

(L= L)

e For quick access to a specific year, click on the year displayed in the calendar and two

arrows will appear, making it easier to toggle between years.

¢ The text at the bottom always displays the current date. If you click on this text, the
calendar will refresh to today’s date.

Contact your System Administrator to set the booking screen to auto refresh at a

configurable duration.

e To refresh the symbols and statuses on screen immediately, click on the Refresh
booking button.

7> || @ 15 min.

Charlie

Refresh booking
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7.8 Booking a client directly

* Press F3 to search for the client or Ctrl+F3 to make a quick search.
¢ Select the date, if required.
¢ Or double-click on a time slot under the time and resource you require.

If a client is selected, the Client appointment tab is automatically active. To make a
reservation, switch to the Reservation tab.

Make booking *
Advanced booking Offer declined Save Close
Client appointment | Reservation | Group appointment e

# Mo recurrence
Hospital no  T128343 Daily
MName MR FIRSTNAME28343 LASTNAME28343 Weekly
Phone Mobile: abcd Monthly
Video appointments accepted Annually

Infarmation ||

Reason = Referenced by -

Location All {no location) Department All (no department)

Single resource
Symbaol Resource All locations Date Time End
72 Duration
I fram?1 Stassy )
[ to Charlie L ~
(M ENT new patient mould~ Resdf : :
3 PHAC new patient mould~ Resh8 V|d§0 Tl L
B4 SAV ENT audia Res70 Appointment stages
[m] S4Y EMT new patient mould: Resh4 Mame Descr
£ ittt Res78
. St 1 5 le st 1
CLEAR Res73 [|Stage Ample S1age
A oWH 1 st Resg2 [ Stage 2 Sample stage 2
A GWH 2nd fit~~ Res75 [~ | Stage 3 Sample stage 3
A<y i
7r GWH Audio assess~ Res71
72 GWH Audio review~ Res72 Lot semple staged
23 GWH Direct referral~ ¥| |[Res105 hal

* When making a booking directly, the new appointment will pick up the Location and
Department from the Booking module. The Location or Department cannot be changed in
the Make booking window as the information is gathered from the timetable.

¢ From the drop-down lists, select appointment Reason and referencing institution if
required. Note that if the dialog is opened from Referral or Waiting list, reason is pre-
selected.

* When a patient has been offered an appointment but has declined, before the
appointment is made, then there is the option to select “Offer Declined”. In selecting this
option the appointment will be recorded in client entries as “Offer Declined”.

Note: Your system administrator can configure the system to make Reason a mandatory
selection.
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Reasons can be outdated by your system administrator, in which case they do not appear
in the list of reasons.

e Select the appropriate appointment Symbol. Out-dated symbols and resources are not
shown in the lists. Additionally, if a location is selected in the toolbar, the system filters
out symbols and resources associated with any other location.

¢ Select the Resource or resources.

¢ |f more than one resource is selected and one or more are unavailable, you will receive a
Make Booking information window stating which resource(s) have already been booked.
Selecting Yes will save the appointment for the free resources. Selecting No will return
you to the Make Booking window where you can change your choice of resources.

¢ You can modify the date. If you set the date to a date in the past, the same day when an
appointment is already made or if an appointment is made in the future, the system
displays a warning when you save. However, the system administrator can switch these
warnings off.

¢ Adjust the appointment duration if necessary. The default duration for an appointment is
set by the System Administrator. Options for the minute part of the duration are set by the
System Administrator and can be from 5 to 55 minutes.

¢ The start Time and End time can be entered manually in 5 minute units.

¢ Check the checkbox if the appointment is to be a Video appointment. If the Video
appointments accepted is not checked, which can be set for the client either here or on
the Client Information screen, and an email address or mobile phone number are not
recorded for the client, then a warning may appear if configured by your System
Administrator.

e Select the Appointment stages, if required. The default stages setup is pre-selected.
When the client arrives, you can keep track of the appointment by viewing the conditions
for these stages in the Day view window, Workflow view. Note that if a location is
selected in the toolbar, the system filters out stages associated with any other location.

By default, the system selects the resource, the date and start time from the slot you
double-clicked to initiate the dialog. You can also select the duration of the appointment in
hours and minutes, and the system calculates end time automatically. If the duration for
the selected symbol is specified by the system administrator, this duration will be pre-
selected.

 |f arecurrence is needed you can also choose Daily, Weekly, Monthly or Yearly
recurrence.

e Selecting a recurrence flips open an additional column where you can edit the recurrence
settings.

¢ The total number of appointments to be generated or an end date of the appointment
sequence must be specified.

¢ The Booking default method is Book all possible, which means booking un-booked slots
only. This is the recommended setting, but it can be changed according to your
requirements.
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# Day 9

ofevery 1 manth(s)

The First -
Thursday -
of every 1 manth(s)
Selected days V|-~

End of recurrence

# End after 1 QCCUITences
End by date 09/01/2020

Book method
Book all possible
« Book if all resources can attend

All must be available for any to be booked

e Clicking on Advanced booking will flip open an extra table in which you can add or
remove resources from the appointment.

¢ To add resources, select the resources in the resource list above and click Apply.

¢ To remove resources, select the resources in the advanced table and click Remove.

Resources Apply Remove
Resource Time Duration Symbol

=Mare resources=

Trawy 12:45-12:00 Oh 18m E@PHAC new patient mould~

Stassy 12:45-12:00|0h 15m E@PHAC new patient mould~
e Click Save.

* When making, copying or editing an appointment, if the selected slot is not the client’s
default Location or Department, you will be warned.

Make booking

Location Location3 is not this client’s prefemed location. Are you sure you want to save 7

Yes Mo
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¢ If the appointment is made that is split over two different Locations, you will not be able
to save the appointment. You cannot book an appointment in a timeslot with a different
Location or with Resources in different Locations as the same appointment cannot take

place in more than one location. If you attempt to do this, an error message will be
displayed.

Make booking it

Timeslots for the appointment have been scheduled for
. different locations: Location2, Location3.
Cannot save.

¢ There is no restriction on making an appointment across two different Departments.

¢ Adefault appointment status may be applied, configured by your System Administrator,
when the appointment is booked.

¢ The Print letter window appears - fill in the relevant fields and click Print or click Verbal
appointment. The time and date fields can be edited if configured by your System
Administrator.

Print letter *
Verbal appointment Client list Print labels Open in Word Preview Send | .. Close
User USER MAMEES ~  Location for letter |-3 Location3 Dept. for letter 3 Department3
Client MR JOHN SMITH 1 letter selected Date ofvisit  09/01/2020 Time 1315

L etter name Type Letter-specific additional information, editable for single letter selection only

| £/| 11-03-19_test_template WS Word
19/02/2015 all variables M3 Word

B 23/06/2016 all variables M3 Word

B 29/10/2015 all variables M3 Word

B DMA- PAEDIATRIC Booking defined

B DMA- PAEDIATRIC Booking defined

B EST_TEST MS Word

 New WS Ward

_Testtemplate 22/0R/2018 M3 Word Additional information for all selected letters

_Testtemplate 28/02/2019 MS Word

B TEST_04/06/2018 MS Word

: User letter test Admin defined

Highlighted letter
Name 11-03-19_test_template Letter recipients Add Remave

Tl N
Type MS Word ype ame
MR JOHM SMITH

Saving to Documents

General Practice DR JP RING

Save letter after printing or emailing Save letter read-only

Appointment Address

On emailing to multiple recipients  Send single email -
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Recurrent booking

For a recurrent booking, if the selected slot is not the client’s default Location or Department,

you will get a warning to that effect and will be asked if you are sure you want to save the
appointment.

Make booking

Location Location3 is not this client’s prefered location. Are you sure you want to save?

4 l L

Yes Mo

If there are further conflicts, you will be shown the appointments that conflict and will have a

choice to either Save only appointments matching the client’s preference or to Save all
appointments anyway.

If the Location or Department of some instances of a recurrent appointment is different from

the initial instance, then you will be prompted to create them all or just the ones matching the
initial instance.

X

For the following appointments the location or department is
A notthis client's preferred location or department:

10/01/2020
110112020
1200112020

# Save only appointments matching the client's preference

Save all appointments

QK Cancel
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7.9 Printing an appointment letter

Letters can be printed directly or when making an appointment. To print a letter directly, select
a filled appointment slot and click the Letter button from the Booking screen. This can also be
accessed from File -> Print letter.

Select the letter (or letters) to be printed and click Send. If the default destination is printer,
selected letters will be sent to the printer.

Print letter X
Wi Print labels Open in Word Preview Send Close
User SYSTEM ADMINISTRATOR - Location for letter 2 Location2 - Dept. for letter  All departments -
Client 1 letter selected Video appt.: Date of visit Time
Letter name ‘ Type Letter-specific additional information, editable for single letter selection only
06/11/2014 all variables M3 Word -
| [19/02/2015 all variables M3 Word
23/06/2016 all variables I
29/10/2015 all variables Print X
DNA- PAEDIATRIC Printer
| |Hearing center [CISIN [\ AUDITUADC\UA HP LaserJet CM2320 UA  [Rd Properties
Hearing center
1_04/06/2018 Status:  Ready
| |User lefter test Type: HP Universal Printing PCL 5 s
- Where: Auditdata Ukraine letters
— Comment: [~ Printto file -
— Printrange Copies
: @ All Number of copies 1 Elf
— " Pages  from: |1 to:
— r
L s 111 o2 33
| hd
Highlighted letter oK | Cancel
Name DNA.- PAEDIATRIC Add Remove
Type Name
Type Booking defined

Saving to Documents

Save letter after printing or emailing Save letter read-only

Address -

Appointment

0On emailing to multiple recipients  Send single email

Before printing, a letter may be previewed on the screen. To do this, click the Preview button in
the Letter dialogue.
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7.10 Making a reservation

e To create a Reservation, select the Reservation tab. Note that the system selects this
tab automatically if no client has been selected.

¢ Enter a title for the reservation and phone number, if required.

¢ Enter information, select appointment symbol, reason, booking resource, appointment
symbol, date and time range in the same way as for client appointment.

* Press Save to save the reservation.

¢ Reservations are shown in purple on the Booking screen.

e Stages are not supported for reservations.

¢ To search for a reservation, select a resource and type part of the name of the
reservation.

¢ When hitting Search all reservations matching resource and name of reservation are
listed and can be selected and shown by hitting Show in appt. book or by highlighting
and double clicking.

© Auditdata - 2025, ID: 20.0040/36 128



User Guide

7.11 Searching for a reservation

You can search for a Reservation, for example, a meeting. Search in the Functions menu,
Reservations.
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7.12 Making a group appointment

To create a Group appointment, select the Group appointment tab.

¢ Enter the client group name.

» To specify the clients to be included in the group, click Edit group.

e The selected client, if any, will be present in the list.

e To add more clients to the list, press Add. The system opens the Client search dialog,
where clients can be searched and selected for the list. When you select a client, the
system will prompt you to enter an appointment reason and information.

¢ To remove a client from the list, press Remove.

* To change the appointment reason and information for a highlighted client, press Edit.
Note that by highlighting a client in the list, you force the system to change the global
selected client.

¢ To print the list, press Print.

e Back in the Group appointment tab, enter information, select appointment symbol,
reason, booking resource, appointment symbol, date and time range in the same way as
for client appointment.

* Press Save to save the appointment. After saving, the system displays the Print letter
dialog, where you can print appointment letters for all (or selected) clients.

e Group appointments are shown in green on the Booking screen.

Stages are not supported for group appointments.
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7.13 Booking clients using 'Search for new booking'

When free time for a resource cannot easily be found, the system can search for available time

from the Search for new booking item.

e Press F3 to search for the client or Ctrl+F3 to make a quick search.
¢ Click Edit -> Search for new booking. This will open the Search for booking dialog.

Search for booking x
« Client appointment Reservation Graup appointment | 5 Close
MName MR FIRSTNAME17850 LASTNAME17850 Information
Hospital no T117850 Reason -
Phone Home: 99999 999999 Referenced by -
Video appointments accepted
Waiting -~ Appointment fee -
room
Prohibit self check-in
¢! Resource Group Timetable symbol Booking symbol )
Duration
Travy | |ANY SYMBOL - 11 _ Search
Stassy NO SYMBOL 2 0 |~ hours 15 ~ min.
Charlie 11 I from1
Res109 2 3 |"m-] Video appointment
Resdf = NTS M ENT new patient mould~ Date range
Res68 SLENT CLINIC 3 PHAC new patient mould~ From To
ResT0 [ 54V - C&B - Dref/ AGR B4 54V ENT audio
Res54 [Mtest [m 54V ENT new patient moul 0210912020 [} 031102020 [}
Res78 B COMMUNITY PAEDIATRIC | * titit1 e
Res73 G PAED Assisting "CLEAR
Resd2 {l PAED Hearing Aid Clinic B GWH 1 st 4] 4 S
Res75 PAED Transition fif GWH 2nd fit~—~
ResT1 fll SAVERNAKE PAEDS 77 GWH Audio assess~
Res72 W TIDWORTH ¥|  B2GWH Audio review~ Resource search method
Res105 0% GWH Direct referral~ All resources are available
Res63 Location ER GWH Earmould " ) i
Res95 : EF GWH Earmould fit * Anyresource Is avaliable
All locations - e
Res106 fif GWH Exchange
Res102 ZEEET £d GWH Follow up el e
Res98 ¥| 2 Department2 | A GWH Follow up ad-hoc -
Resaurce After Before | Duration (hours) | Duration (min ) | Timetable| Location | Departme| Found loci Found deg Date Day ¢
=MNew criteria=
< >

¢ Select the Reason for the appointment.

The Video appointments accepted setting for the client can be seen and set from this

screen.
Select the Resource (or resources) you want to book for the client from the Resource list.

Alternatively, select from a resource Group to search for the first available appointment
for a resource from the group.

A Resource search method should be selected. Choosing All resources are available
will search for all selected resources and only display slots where all the resources are
available. Choosing Any resource is available will display an available appointment
where any of the selected resources are available.

© Audi

131

tdata - 2025, ID: 20.0040/36



User Guide

¢ Select the appropriate Timetable symbol or symbols, more than one symbol can be
selected. Select ANY SYMBOL if a specific timetable symbol is not required or NO
SYMBOL if the time is not covered by the timetable to be searched.

» Select a Booking symbol for the appointment to be created.

¢ Adjust the appointment Duration if necessary. The default duration for an appointment is
set by the System Administrator. Minute options for Duration are set by the System
Administrator.

e Change the Date range as required. Dates can be entered manually, or the calendar at
the right of the From and To fields can be used.

¢ Enter number of 15-minute Units to be booked.

¢ AlLocation and /or a Department can be selected from the drop-down menus when
searching for a new appointment. If a specific Location or Department is not required, All
locations or All departments can be used. The patient’s default Location and
Department will be automatically selected when a new search is started, but his can be
overwritten by selecting from the drop-down menus. The Location and Department is
shown in the search results.

e Click Search.

¢ The system fills the table with the selected criteria and performs the search.

¢ Clicking Apply fills the table without performing a search. Use Apply when you want to
review and/or change criteria before searching.

¢ Inthe table, you can do the following, if required:

¢ Verify or modify the time After and time Before as required.

¢ Verify or modify the Duration of the appointment.

» Click Search.

¢ Verify the found time slot. If the first slot displayed is not appropriate, click on the
Navigation arrows to show the next available time. The rightmost and leftmost buttons
shows the first available timeslot for the next and previous dates respectively, whereas
inner buttons “scroll” through timeslots in the current date.

e Verify or modify the found From and To time.

e Click Save.

¢ Click appointment Letter and either send the letter or click Verbal appointment.

If Visit charge features are enabled in System administration (Invoice definitions/Preferences)
some additional functions will be available in the dialog:

» Waiting room, showing what waiting room to be used

¢ Appointment fee, can be pre-filled based on rules configured in System administration

¢ Prohibit self-check-in, shows if self-check-in is allowed for the patient. Can be pre-filled
based on symbol or locked if the patient has protected identity.
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7.14 Booking an appointment from waiting list

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

¢ Navigation -> Waiting list.

¢ Select the relevant waiting list from the drop-down list or click on Clients entries and
select the required entry.

¢ Select the client's entry on the waiting list and click Book. The selection may be done by
clicking the grey area at the beginning of the row.

Client's entries Journal | Referral | Export Book  Search and book | Letter | To Clientlist |Addt0 list Edit Delete Print | Mew outcome status || 2
Waiting list Registration period Selection
Selectall Clear all
TGW - AUDIO ASSESSMENT +1 - to electa
1 entry selected 4| »
Appointments Qutcome status and Clock action

Waiting li Apply defaults
Mext Previous Outcome Al ¥ Clock Counting+Suspended - 2 lfrom _V_a_leg = Y

Date Active wait Waittime | Outcome status | Clock acti{ Hospital no. Name Postcode DOB MNo.
£/ ? -587 20b, Cancelled - Counting | T12278 MRS FIRSTMNAMEZ2278 LASTHNAMEZ PC:4541 12/05/1959 1
. 19/01/2011 |468 w, 1d -416 203, Decision to| Counting MR FIRSTNAME468687 LASTNAME4E PC:208 01/10/1998 2109075 G.P. letter- FF

007 | 630

¢ The cursor changes appearance in the booking screen to indicate that you are in the
process of making a booking for the client.

¢ Use the Calendar to select the date for the appointment.

¢ Click under the resource column at the time of the appointment you want to book.

e Select the appropriate appointment Symbol.

¢ Adjust the appointment Duration if necessary. The default duration for an appointment is
set by the System Administrator. Minute options for Duration are set by the System
Administrator.

» Select Appointment stages, if required.

» Click Save.

¢ Click appointment Letter and either Print the letter or click Verbal appointment.

e The system will then return you to the Waiting list module so that another appointment
can be booked.
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7.15 Search and Book from the waiting list

It is possible to search for available appointment slots and book appointments directly from the
Waiting list.

To do so:

1. Navigate to the Waiting list module
2. From the dropdown, select a relevant Waiting list
3. Choose a Client for whom the appointment will be booked

O Client <X>T130763 MISS FIRSTNAME30763 LASTNAME30 - | & |5 | Buser SYSTEM ADMINISTRATOR L3 Location3 v Al departments ~| x| 2
Navigation Clients entries Journal | Referral | Export Book | Search and book  Letter | To Client list | Add to list Edit
B Favourites — — -
é;\ Referral Waiting list Registration period
£ Booking TGW - PHAC Permanent loss e - to
@ Documents a attachments
\Waiting list 6 Appointments Outcome status and Clock action
AB Audiogram Mext - Previous v Outcome Al ¥ Clock Mot closed or nullified |«
£ NOAH module selection
/iy Aftention list Date Active wait Wait time | Outcome status | Clock acti{ Hospital no. Mame
£ NOAH session browser
16/03/2010 520w, 0 d -468 Counting | T190100 | FIRST EXTRAMORE LAST
Individual client | |231032010| 519w, 0 d 467 Counting | T129779 | MST FIRSTNAME29779 LASTNAME29779
-2 Glientinformation : 06/04/2010 | 517w, 0 d -465 Counting |T112441 | MISS FIRSTNAME12441 LASTNAME1244
- Paediatric | |190412010(515w, 14 -463 Counting |T123116 | MST FIRSTNAME23116 LASTNAME23116
-£=] Joumnal 23/04)2010 | 514w, 4 d -462 Counting |T112842 | MST FIRSTNAME12842 LASTNAME12842
0] Documents and attachments | |241052010| 510w, 14 -458 Counting |T125237 | MISS FIRSTNAME25237 LASTNAME2523
55, Referral | | 04062010/ 508w, 4. -456 Counting | T11632 MST FIRSTNAME1632 LASTNAME1632
A Clients entries | [11/0612010 | 507 w, 4 d -455 Counting | T141108 | MISS FIRSTNAME41108 LASTNAME4110
DB | [141062010 507w, 1 d 455 Counting | T121523 | MISS FIRSTNAME21523 LASTNAME2152
. ng;omj::;m and procedures || 1810612010| 506w, 4 d 454 Counting | T11629 | MST FIRSTNAME 1620 LASTNAME1620
') Hearing Therapist | |1a/06i2010 /506w 4 d -454 Counting |T17289 | MISS FIRSTNAMET289 LASTNAMET289
%] Medical history | |21108i2010 /506w, 14 -454 Counting |T141406 | MST FIRSTNAMEA41406 LASTNAME4140§
55 Direct referral HA(adult) | |25/06i2010|505w, 4 d -453 Counting |T124407 | MST FIRSTNAME24407 LASTNAMEZ4407
-.{a) Tinnitus 25/06/2010 | 505w, 4 d -469 Counting |T119655 | MISS FIRSTNAME19655 LASTNAME1965
.. # surgery | |o2i07r2010| 504w, 4.0 -452 Counting [T110119 | MST FIRSTNAME10119 LASTNAME10119
fi] HI Satisfaction Questionnaire <

In the “Search for booking” pop-up window:

1. Specify the search criteria

2. Click Search

3. Verify the appointment time slot

4. Save for the appointment to be recorded in the Office timetable
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Search for booking 4
# Client appointment Reservation Group appointment e Save Close
Mame MISS FIRSTNAME30T63 LASTNAME307T63 Information 1y FU - Feb 1192542 - 12 month fu92452aid not working
Hospital noT130763 Reason ++Patient self referral -
Phone Home: 99999 999999, Mobile: 99999 999999 Referenced by -
) Resource Group Timetable symbol Booking symbol n _—
uration
Travy PRIl ANY SYMBOL i Py _ Search
Stassy |NO SYMBOL J2 —~0 [vrhours 15 |~ -min.
Charlie 11 Il from1 Date range
Res100 22 [ to1 From To
Resdb = MNTS [M ENT new patient mould~
Resfa EFENT CLIMNIC ittt 23M212019 230112020
Res70 B COMMUNITY PAEDIATRIC "CLEAR Navigation
Res54 G PAED Assisting i BWH 1 st g
Res78 {fll PAED Hearing Aid Clinic ff GWH 2nd fit~~
Res73 PAED Transition 77 GWH Audio assess~ 4 4 2322019 4
Res8?2 A SAVERMAKE PAEDS A3 GWH Audio review~
Res75 B TIDWORTH DR GWH Direct referral~ Resource search method
Res71 Wiltshire PHAC Ef GWH Earmould :
- 2l = All labl
Res72 123 €2 GWH Earmould fit resources are avarianie
Res105 fif BWH Exchange Any resource is available
Resf3 Location Fil GWH Follow up
Res95 1 Location1 A GWH Follow up ad-hoc
Res106 } L% GWH Lost aid Enpivey [Esne
Res102 Depariment L£ GWH Lost aid impression
Res98 ¥ All departments R GWH Repair hd
Timetable symbol| Location |Department|Found location |Found depatment Date Day ofweek| Starttime | From | To |Resource|Bool
ANY SYMBOL || Locationd | All ‘| Location ‘| Departmentd 23M2/2019 | Monday 08:30-16:00 0830 0845 Trawy 11
< >
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7.16 Export to MS Outlook

It is possible to export bookings for a single resource for a user specified period to Microsoft
Outlook (version 97 or later). All existing appointments in Outlook will be deleted for this period.

NOTE: Export can be disabled by a site-level option in the Administration tool, Calendar and
Booking settings.

The prerequisites for performing this action are:

¢ The logged on user must be defined as a resource
¢ The booking screen must be active

With the Auditbase System appointment book displayed on screen, select File->Export to MS
Outlook and the system will now start communication with Microsoft Outlook.

A window will appear notifying the user if Outlook was successfully initialized or with an error
message if not.

Copying appointments/reservations is done for a user specified period (default 30 days back in
time-180 days ahead) with selection of which resource's appointments/reservations to be
exported.

Click OK to open a dialog for the user to answer if all previous appointments in Outlook for the
selected period should be erased/overwritten or if Auditbase System
appointments/reservations should be added and maybe overlap existing
appointments/reservations.

Once finished, a status of the export will be shown if successful or not.

The operation can be performed whether or not Outlook is open. The installed version must be
97 or later and it must be configured for the workstation.

The following will appear for exported appointments in the MS Outlook calendar:

e Subject: Client Appointment [patient ID from Auditbase appointment]
e Start- & end-time: [Time from Auditbase appointment]

¢ Reminder: Switched off

¢ Show time as: Busy

Note:

e PHONE:
not displaying
¢ INFORMATION:
[Information from Auditbase appointment]

The following will appear for exported reservations in the MS Outlook calendar:
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e Subject: [Reservation name from Auditbase reservation]
e Start- & end-time: [Time from Auditbase reservation]

¢ Reminder: Switched off

¢ Show time as: Busy

Note:

e PHONE:

[Phone number from Auditbase reservation]
¢ INFORMATION:

[Information from Auditbase reservation]
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7.17 Moving an appointment

¢ Select the appointment you wish to change from the main booking screen. The client’s
name will now be highlighted on the screen.

e Select Edit -> Move or Edit -> Search and Move.

¢ The cursor changes appearance in the booking screen and the start time of the
appointment is highlighted to indicate that you are in the process of changing a booking
for the client.

e The symbols for the existing length of the appointment are maintained until the new
appointment has been made but the client name is not shown.

¢ Click on a new date in the Calendar.The Search for New option can also be selected if a
suitable date is nhot known.

» [f the Search and Move option has been chosen, the Search for new booking window
opens and can be used in the usual way.

¢ Click on the appropriate time slot and resource on the date.

¢ Click on the appointment Symbol; adjust the appointment Duration if necessary. The
default duration for an appointment is set by the System Administrator. Minute options
for Duration are set by the System Administrator.

e Click OK.

¢ If a moved appointment breaches the target date for a referral, a breach warning will be
displayed.

¢ Click appointment Letter and either Send the letter or click Verbal appointment.

You can also delete and copy appointments from the Edit menu.

4} Audithase - [Booking]

File Edit WView Functions
|IQI |l,|1~ |I‘_+I_. %l |I_—|."'+"’ E.% |.]EI |-- I |- @ E“%
» + + @
Make new | Search for new Edit Move | Search and move | Bulk move = Copy | Cancel | Delete  Make | Schedule | Copy

Booking Tirnetable

Note: When saving or modifying an appointment, the current date and time will be
recorded with the appointment, if so configured in the system administration.
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7.18 Changing the Appointment Status and Outcome Code

¢ Highlight an appointment you want to change the status or outcome code for on the main
booking screen and right-click it.

¢ Select Outcome status in the drop-down list. The Current outcome can be seen in the
Booking information dialogue box. This is taken from the referral attached to the
appointment. This is always today's current outcome, regardless of whether the
appointment itself is in the future or past.

e Select the appropriate appointment Status. The Status change list will show the duration
that the appointment has been in each status.

¢ The status letter is now seen in the main booking screen next to the appointment.

Booking information *
Client MR JOHN SMITH Time: 09/01/2020  12:45-13:00 Attached actions Close
Appointment @ PHAC NEW PATIENT MOULD~ Location All (no location) Letter:
Timetable Department All (no department) Verbal:
Made by SYSTEMADMINISTRATOR on 09/01/2020  Atind. with
Resource(s). TRAVY Status
3 12:45 Stassy [no status] -
* Apptarranged
0, Cancelled
B, Being seen i
Referenced by Stages condition:
Reason
Status change elete
Outcome status g Delete
= %, Bppt arranged 0970172020 17:34 [13m]
SUSP - Suspended T |, nrrived 09/01/2020 17:51 SYSTEM ADMINISTRATOR
Current outcome
Appointment not linked to referral
Linked Waiting list
Details
Hospital no.: T18765; NHS no.: 86888588 -
MR JOHN SMITH ; i
History of changes
99 Information ry g
XOO00K -
JOCOOO00XK - -

Note: When saving or modifying an appointment, the current date and time will be
recorded with the appointment, if so configured in the system administration.

An appointment status can be deleted if it has been set in error. Highlight the status and the
Delete button becomes active. Select this and the status will be removed from the list.

Status change Delete

*, Appt arranged 08/01/72020 17:34 [18m]
09/01/2020 17:51 SYSTEM ADMINISTRATOR
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7.19 Changing who the client attended with

On the Booking Information screen, details of whom the client attended with can be added.

Right click on an appointment.

Select the [ Iicon at the end of the Attnd. with row. You will be presented with three
options:

Create New - Will enable you to add a relative or other contact. Fill in the relevant fields
and click Save.

Select from list - If a client has relatives or other contacts attached to their client
information, by selecting this option you will see a list which you can select from and
attach to the appointment. Highlight the required contact and click Select. If the contact
does not appear in the list, a new one can be added by selecting Add. Contacts can be
edited by highlighting the contact and selecting Edit. A contact can be removed from the

list using the Delete button.

e Clear field - This will clear any entry in the Attnd. with field.

© Auditdata - 2025, ID: 20.0040/36

Booking information =
Client: MR JOHN SMITH Time: 09/01/2020  12:45-13:00 Attached actions Close
Appointment @ PHAC NEW PATIENT MOULD~ Location All {no location) Letter:
Timetable Department All (no department) Verbal: ﬁ
Made by: SYSTEMADMINISTRATOR on  09/01/2020 Attnd. with E‘
Resource(s) TRAVY Status Create new
3@ 12:45 Stassy [no status] 2 Select from list
* Apptarranged Clear field
0, Cancelled
B, Being seen i
Referenced by Stages condition:
4
§
Reason =%j
| 4
Status change Delete 4
Outcome status E
*, Bppt arranged 09/01/2020 17:34 [18m] B4
SUSP - Suspended - 09/01/2020 17:51 SYSTEM ADMINISTRATOR .%é
Current outcome BMEZ3026 e ]
Appointment not linked to referral "“% %l
Linked Waiting list *%%
23
Details :%%
Hospital no.: T18765; NHS no.: 88888888 s et
MR JOHN SMITH - " 23
History of changes
09 Information ry a ]
. . 5
JOOOOO00X - > 33
=33
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7.20 Locating and viewing a previous appointment
Use this function to locate or examine a previous appointment in the appointment book.

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

¢ Select Functions -> Client’s entries to open the client's appointments and waiting lists
window.

¢ Highlight the appointment you need to view.

¢ The list of appointments includes Date, Time, appointment Symbol and Status, booked
Resource and appointment Reason.

e Select Show in appt. book. The system will display the Booking screen for that date with
the appointment highlighted. You can then edit the appointment if required.

¢ To view any clinical actions, documents or IMPs attached to the appointment, click the
Attached actions button. A list of attached clinical and other actions will open in a
separate dialogue box where you can detach them from the appointment if needed.

* To delete cancelled actions—they appear in grey—from the history, select them in the list
and click the Delete from history button.

¢ When you right-click on an appointment, you can see the Appointment Information for an
appointment, including information for an outdated resource.

Client's appointments and waiting lists x
Client MR JOHN SMITH Close
Appointments list - 42 item(s) History of changes Aftached actions Show in appt.book

Date |Time|Loc.|Dept.| Appt. |Status|Resource Reason |SMS1|SI\-182|DecIined offer Symbo ~
12/01/2020 | 11:15 I *  |Res4f from1
2020|09:00 y * 3

Z Charlie

09:00 1 = | Charlie 1
09/01/2020 | 16:30 f A | Stassy GWH 1 st
09/01/2020 | 13:45 E]| * Stassy PHAC new patieni
09/01/2020 1215| 3 3 1 * |ResB4 1

09/01/2020 (1215 32 3 Res109 |++GP direct referral PHAC new patieni

09/01/2020 | 12:45 A | Trawy PHAC new patienl «»
< *

Waiting list entries - 7 itemi(s) Add Edit

Wait time| Date| Waiting list| Information A
186 | 18/0E TGW - PHA
8 06/03 TGW - AUD
14 06/03 TGW - CAL(
-21 16/08 TGW - Audil
9 16/08 TGW - CAL(
13 09/01 TGW - DON

an AN TEGRE Al

¢ This window also displays the appointments and waiting list entries for the selected
client.

e The list of waiting list entries includes Wait time, Date, Waiting list type and Information.

¢ A waiting list entry can only become active if selected from the Waiting list module. Click
Show in waiting list to make the entry active in the main Waiting list, so that the entry
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can be reviewed and edited. There an entry can be created or edited by clicking Add or
Edit, respectively.

¢ [f you select an appointment from the Appointments list and Show in appt book but
either the Location/Department or Clinic filter does not show the selected appointment,
you will see an information message letting you know which needs to be adjusted.

Message

The appointment you are trying to view in Booking is not available because:

- The Clinic fiter you have applied does not include this resource.

Would you like to go to that date in the Booking screen to change your view settings?

Yes Mo

Message

The appointment you are trying to view in Booking is not available because:

i Y

- The location(s)/department(s) you have selected to show does not include this resource.

Would you like to go to that date in the Booking screen to change your view settings?

Yes Mo

¢ You will need to select Yes to go to the appropriate date and then change the filter
settings. No will take you back to Client’s entries.
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7.21 Cancelling an appointment

Client's appointments display any appointments in the appointment book. When a client
cancels an appointment, you can cancel it in the system and still keep a record of the
appointment on the screen using this procedure:

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

¢ Select Functions -> Client's entries, to view details of forthcoming and previous
appointments

¢ Highlight the appointment you wish to cancel.

¢ Click on Show in appointment book. This will display the diary screen for that date. You
can now select the resource for the appointment.

e Highlight the client.

e Select Edit -> Copy booking.

¢ The cursor changes appearance in the booking screen to indicate that you are in the
process of making a booking for the client.

e From the drop-down list of resources, select Cancelled or the name of the resource used
to mark cancelled appointments.

e Click in the Cancelled column and click OK.

¢ The cancelled appointment is now listed in the Cancelled column as an appointment
made with the resource Cancelled.

¢ Right-click on the client in the Cancelled column and change the appointment status to
Cancelled.

e Highlight the original appointment again on screen and select Edit -> Move booking or
Delete booking and return the client to the waiting list if required.

Appointment cancellation can also be supported by moving an appointment to a historical view
in the Client’s Entries. This can be configured in two ways; by setting appointment statuses
that will activate the process or by configuring the appointment move action to activate the
process.

An appointment status can be set to prompt a user to remove an appointment to a historical
view so it is not viewed on the Booking screen. Cancelled appointments are viewed on Client's
entries and Referrals and are shown in grey text and read-only to differentiate them from
active appointments.

Appointments can be cancelled and still be seen in Client entries and Referrals (but not Waiting
lists), so they no longer need to be copied into a “Cancelled” resource column to retain details
of the cancelled appointment. There are two processes for cancelling an appointment.

7.21.1 Changing the appointment status

On changing the appointment status of a booked appointment to a cancelled status, a booking
information message will indicate if the appointment has clinical actions attached to it and that
the appointment has been cancelled and enquire if the user wishes to continue with the
appointment move procedure.
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Booking information X

@™%  You have assigned a status Q, Cancelled associated with cancellation to this appointment, this means the appointment will move from the Booking screen to a read-only record in Client’s Entries.
I\ 7 Do you want to continue 7

Press 'es to create a read-only record in Client’s Entries.

Press Mo to keep the appointment on the main Booking screen.
Press Cancel to cancel changing the status.

Yes Mo Cancel

¢ Select Cancel to cancel assigning the status and keep the appointment at the original
date and time slot

¢ Select No to retain the cancelled appointment in its original appointment date and time
slot

¢ Select Yes to create a read only record in Client’s entries.

In case of any attached clinical or other actions the following screen opens:

Detach clinical and other actions x>

This appointment is referenced by the following clinical data:

Action date| Action type |Descripti0n
09/01/2020 | BKB test

09/01/2020 | AB Words test

09/01/2020 | IR test

This appointment is referenced by the following other data:

Date| Data ‘q.rpe| Description

Press OK if you want to detach the clinical actions and individual OK Cancel
managament plans and delete the appointment

Once you have selected OK, a further information box appears to allow you to add to a waiting
list.

x

The appointment has been moved to the history. Do you want
to rebook the appointment to another slot or put the client on
Waiting list?

# Rebookthe appointment

Put the client on Waiting list

Cancel
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* Rebook the appointment - Takes you back to the booking screen so that the

appointment can be re-booked. If the re-book option is selected, a letter sent to a patient

may include the date and time of the cancelled appointment.

e Put the client on Waiting list - Opens the Add to waiting list dialogue box. If a client has

been booked from a waiting list, Auditbase will remember the original settings.

It is possible to enable an Automatic journal entry, which can define/insert a combination of

variables of the cancelled appointment into the Journal automatically.

Journal events X

Selected event

1407
Appointment moved to Canceled storage

Keywaord

APPOINTMENTS -

Prampt for user input Allow 10 cancel event Save unsigned

Appointment PHAC NEW PATIENT MOULD~ with TRAVY on 09/01/2020 12:45 - 13:00 was moved to ~
cancellation history having a status of Q/ Cancelled

W

Bl z][v] E=I= HEM [2][=][=
Client's appointments and waiting lists >
Client MR JOHN SMITH Close

Appointments list- 42 item(s) History of changes Aftached actions Delete from history Show in appt.book

Date |Time|Loc.|Dept.| Appt. |Status|Resource| Reason |SMS1|SMSQ|DecIined 01Ter| Symba &
10/01/2020 | 09:00 1 * Charlie 1
B

09/01/2020 | 13:45 3 * Stassy PHAC new patieni
09/01/2020 1315 3 | 3 1 *  |Res54 1

09/01/2020 (1315 2 3 3 * Res109 | ++GP direct referral PHAC new patieni
089/01/2020 | 12:45 3 Q | Travy PHAC new patient
09/01/2020 (12:45 3 Q  |Stassy AC atient
09/01/2020 | 09:00 1 * Res46 1 W
< >
Waiting list entries - 7 item(s) Add Ed Wi

Wait ime | Date| Waiting list| Information A
-186 18/06 TGW - PHA

8 06/03 TGW -AUD

-14 06/03 TGW - CALY

-21 16/08 TGW - Audiy

9 16/08 TGW - CALY

13 09/07 TGW - DON

an AoIN< TOWE Al v
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If the entry needs to be removed from this list for any reason, then the Delete from history
button can be selected once an entry has been highlighted.

N.B. Cancelled appointments appear in grey on the patient’s Client entries list. Right
mouse-click on the relevant appointment to open the Booking information screen, which
shows historical details of the cancelled appointment.

7.21.2 Highlight, Edit & Move appointment

Highlight an appointment and navigate to Edit and Move booking.

Booking

I@I Are you moving appointment due to patient cancellation? f so, would you like to record the original appointment in the Client’s Entries” historny?
-

Yes Mo

Select No

¢ Select appointment symbol and length, then click OK.
¢ Appointment will be moved to a new slot after the Letter print screen has been OK’d.
¢ No record of the cancelled appointment will be recorded in the client entry.

Select Yes

If there is only one appointment status associated with cancellation that status will be applied

automatically. If more than one status is associated with cancellation, you will be offered a
choice.

Highlight and select (or double click) the appointment cancellation status from the list of
potential statuses, as defined by the system administrator.

Select cancellation status *
Select
Code Description
K Kate completed
a Statusa

e Select appointment symbol and length, then OK.
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¢ The appointment will be moved to a new slot after the required action has been taken on
the Letter print screen. A letter sent to a patient may include the date and time of the

cancelled appointment.

¢ Arecord of the original appointment is saved in client entries.

N.B. Cancelled appointments appear in grey on the patient’s Client entries list. Right
mouse click on the relevant appointment to open the Booking information screen to show
historical details of the cancelled appointment. These details cannot be changed.

7.21.3 History of appointment changes

This will need to be activated within System administration.

In the appointment dialog box, pressing the History of changes button will open a pop up box.
The pop up box will contain a logged history of changes made to the selected appointment. The
text log will include appointment creation date, time and user creating the appointment,
appointment start date/time and its duration. It will also include the appointment symbol,
information and outcome status if one has been selected. These will be listed by date and
under username of the person logged in at the time of creation or change. The log can be

cleared in Administration.

Appointment change history

Client MR JOHM SMITH

Close

15

Attached actions Close

t2020-01-10 10:56:28 SYSTEM ADMINISTRATOR
Start date and time:

Old: 2020-01-10 13:15:00

MNew: 2020-01-10 14:00:00

Duration:

Old: 0 hours 15 minutes

MNew: 1 hours 15 minutes

Resource(s):

Old: Res109

MNew: Charlie

2020-01-10 10:52:31 SYSTEM ADMINISTRATOR
Start date and time:

Old: 2020-01-09 13:15:00

New: 2020-01-10 13:15:00

2020-01-09 17:39:22 SYSTEM ADMINISTRATOR
Appointment created

Letter.
Verbal

History of changes

-

-
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7.22 Viewing a resource’s schedule

Select File -> Print schedule.
Select the Resource.

Enter the date range.

Select Print or printing Preview.

Print schedule >
Preview Print Close

Fesource

From 01012020 | To | 19/01/2020

MU SCRL

Schedule - Charlie

01 January 2020 - 19 Januvary 2020

9, January 2020 - Thursday
Time Hosp No NHS No Subject Duration
200 - 8:30 T18765 EEEERREES MR JOHN SMITH (1) 0:30
Home: 03099 900009
13:00 - 14:30 T123026 MR FIRSTNAME23026 LASTNAME23026 (1) 1:30
Home: 99999 999909
10. January 2020 - Friday
Time Hosp Ne NHS No Subject Duration
9:00 - 10:30 T18765 88888888 MR JOHN SMITH (1) 1:30
Home: 98999 999999
14:00 -15:15 T18763 EEEERREES MR JOHN SMITH (PHAC new patient mould-) 1:15
Home: 999990 000000
11. January 2020 - Saturday
Time Hosp No NHS No Subject Duration
8-00- 8-15 Ti110 MRS FIRSTNAME110 LASTNAME110 (PHAC new patient n 0:15
Home: 99999 090000 Mob: +1232323
9-45 - 11:15 Ti110 MRS FIRSTNAME110 LASTNAME110 (1) 1:30
Home: 99009 000000 Nob: +1232323
12. January 2020 - Sunday
Time Hosp No NHS No Subiject Duration
10:30 -12:00 Ti110 MRS FIRSTNAME110 LASTNAME110 (tol ) 1:30
Home: 99090 000000 Mob: +1232323
13. January 2020 - Monday
Time Hosp No NHS No Subject Durati on
9-:00 - 9:15 T18765 88888888 MR JOHN SMITH (2) 0:15
Home: 99990 000000
Print date: 10 January 2020, AuditBase user: ST SADM Page 1 of 1
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7.23 Booking statistics

This is a simple count of the number of appointments for a selected Resource or all Resources

over a specified date range.

Booking statistics >
Erint Close
Resource Charlie ~ From 01/01/2019 to  10/01/2020
Procedure Time Amount

1 23h 0m 22

2 1h 30m 3

EMT new patient mould~ Th Om 1

GWH 1 st 2h 30m 2

GWH 2nd fit~~ 1h 0m 2

GWH Earmould 15m 1

GWH Follow up 30m 1

PHAC new patient mould~ 2h 45m ]

SAY ENT audio 45m 3

SAV ENT new patient mould~ 15m 1

from 30m 1

to 1h 0m 1

unngl 15m 1

Go to Functions -> Booking statistics in Booking.
Enter the Date from and to and select a Resource.
Select Show and a list will be displayed showing the Resource, Procedure, Time (in 15
minute blocks) and Amount or number of procedures.

Print will send the list to the default printer.

7.23.1 Appointment ordinary statistics

¢ The Appointment ordinary statistics show time used for appointments per date and

statuses.
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To open the Appointment ordinary statistics dialog, select Functions -> Appointment
statistics -> Ordinary statistics from Booking.

Enter a date interval to show statistics for a required period of time.

Select Resource in the drop-down list if statistics on a single booking resource are
required. Default is All resources.

Select a symbol in the drop-down list if statistics on a single appointment symbol are
required. Default is All symbols.

Select statuses: initial in the From drop-down list, intermediate in the Via list (optional),
final in the To list.

Click Refresh to calculate the statistics.

Click Print to print the calculated results.

Click Export to file to export the result.

7.23.2 Appointment advanced statistics

The Appointment statistics advanced window is accessed via Functions-> Appointment
statistics -> Advanced statistics from Booking.

Here you can calculate advanced appointment statistics using specified criteria.

You can calculate the total number of client appointments grouped by different
appointment attributes.

Grouping by the following appointment attributes is possible: Resource, Reason, Symbol,
and Status. Calculation of subtotals is also possible.

Use the Grouping section to specify how to sort the statistics and which total and
subtotals are required. The attribute selected in the first drop-down list gives the first
sorting criteria of the statistics, the selected attributes in the second and subsequent
drop-down lists are the next sorting criteria.

The Subtotal check box near the first drop-down list means that the first-level subtotal
will be calculated by the attribute selected in the first drop-down list. The check boxes
near the second and subsequent drop-down lists mean subtotals in the first-level total
calculated by the attributes selected in the corresponding drop-down list.

For example, assume that Reason is selected in the first drop-down list, Resource in the
second, Symbol in the third, Status in the fourth and the Subtotal boxes are checked for
first and second drop-down lists. In this case, the statistics will be sorted first by reason,
then by resource, symbol and status. Statistics will include totals by reason and subtotals
by resource for each specific reason.

Check the Show detailed rows check box if you want to include the client appointments
the statistics is based on, in the statistics.

All other options in the Calculation criteria are filtering the criteria for the statistics calculation:

Resource: you can specify which appointment resources should be included in the
statistics. At least one resource must be selected. Select all selects all resources.
Symbol: you can specify which appointment symbols should be included in the statistics.
At least one symbol must be selected. Select all selects all symbols.
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¢ Reason: you can to specify which appointment reasons should be included in the
statistics. At least one reason must be selected. To include appointments without reason,
select [No reason specified]. Select all selects all reasons.

e Status: you can specify the status for the appointments to be included in the statistics. At
least one status must be selected. To include appointments without status, select [No
status specified]. Select all selects all statuses.

¢ Date range: use this to include only appointments in a specified date range. Empty date
in the range means unlimited interval.

¢ Time range: appointments with start time within a specified time range will be included.

¢ Age interval: appointments for clients with age within a specified interval will be included
in the statistics. Empty value in the range means unlimited interval.

When all criteria have been specified, press Calculate to calculate the statistics. The result is
shown in the Result table below. Detailed rows are shown in black and (sub) total rows are
shown in blue.

Press Print to print the results.

You can export the results to a comma-separated (CSV) file by pressing Export to file and
selecting a target file in the opened dialog to get results exported into the selected file.
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7.24 Printing/Emailing a letter

TLS1.2 security level is supported for emailing.

* Press F3 to search for the client or Ctrl+F3 to make a quick search.
e Highlight the appointment.
e Click Letter.
e Select a letter name or names if you want to print multiple letters, by checking the box in
the left-hand column.
¢ In the case of a letter for a group appointment, addressees must be selected by entering
check marks in the table activated by clicking on the Client list button. Note that the
system automatically selects all clients in the group.
Print letter x
Verbal appointment Client list Print labels Open in Word Preview Send | Close
User USER NAMETE ~  Location for letter | 2 Location2 - Dept. for letter 3 Department3 -
Client MR JOHM SMITH 1 letter selected Date ofvisit  10/01/2020 Time 14:00
Letter name Type Letter-specific additional information, editable for single letter selection only
| [11-03-19_test_template MS Word
- 19/02/2015 all variables M3 Word
23/06/2016 all variables MS Word
| 29/10/2015 all variables M3 Word
: DMA- PAEDIATRIC Booking defined
|| DNA- PAEDIATRIC Booking defined

EST_TEST M3 Word

Testtemplate 22/06/2018 MS Word Additional information for all selected letters
N Testtemplate 28/02/2019 MS Word
- TEST_04/06/2018 M3 Word
: User letter test Admin defined

Highlighted letter

Mame Mew Letter recipients Add Remaove
Type Name
Type NS Word i —
MR JOHN SMITH
Saving to Documents
General Practice DR JP RING
W Save letter after printing or emailing Save letter read-only
B Save letter content Documenttype  client letters -
Save as text
Date sent Address
Save in RTF format Appointment :
# Save as Word document 10/01/2020, PHAC new patient mould~
On emailing to multiple recipients  Send single email -

"

M3 Wort

¢ Select the User to sign the letter. If only one resource is booked for the current
appointment and this resource has an association with a user, this user will be pre-
selected in the list.

¢ Whether date and time are automatically set and cannot be changed depends on the
setting in Administration chosen by your System Administrator.

 If you are printing/emailing a single letter, a part of the pre-configured letter text can be
changed in the Letter-specific additional information field.
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¢ The name of the employee or further information for all letters can be added in the
Additional information for all letters textbox. The additional information will be printed
at the bottom of the standard letter.

e [fthe letter is a Word template, you can edit the letter in Word by clicking Open in Word.

¢ Default settings on how to save and letter recipients for each letter template can be set
up in the Letters dialogue, which you access from the Booking module -> Functions ->
Settings -> Letters. More on this in the following chapter.

¢ Edit the saving settings under Saving to Documents if necessary.

¢ The saving settings allow you to save the letter to the Documents and attachments
module after you have printed it.

¢ If you save the letter with content, saving in RTF (available for Booking defined templates)
or Word format (available for Word templates) will take up more space on the server than
if you save as text, which does not include images etc. Unless you really need to save
images and formatting from documents, you should choose a plain text format. Text
documents will lose all formatting but are still easy to read and edit.

e Check Save letter read-only if you do not want the letter to be editable after you have
saved it. However, users can be granted the extended user right of “Documents: Remove
read-only flag” by the system administrator.

e The Document type will only show the document types set up as patient letter document
types.

¢ Date sent may be configured in the letter template to automatically be filled out as the
current date. This date will be shown in the Documents module. You can change the date
manually, if you are not sending the letter on today’s date.

* Name and address values can appear in upper case or mixed case according to a setting
in Administration

e The Appointment which the letter is about will automatically be displayed.

o Edit Letter recipients by clicking Add if necessary.

¢ Select a recipient and click Remove if necessary.

e If emailing a letter, it will, by default, place itself in the body of the email as opposed to
becoming an attachment to the email. This can be altered by using the browser button

next to Send on the floating box | 5&N°

¢ If emailing the letter to multiple recipients, select whether to send as a single email or as
multiple emails in the On mailing to multiple recipients drop down. If sending as
multiple emails, you can decide to change for each if you wish to send as body text or an
attachment using the browse button above. If sending as body text you can amend the
text for each individual recipient. In this case you also alter the subject of the email by
clicking into the subject field on the table for each recipient.
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Send single email

Customize print and/or email X

OK Cancel

m [ Select all B Update contacts with email address modifications

| @ Type Name Email address

uditdata.com

B Send as attachment with following body text Subject
Text

Send separate emails

Customize print and/or email X

OK Cancel

Select all B Update contacts with email address modifications

Type Mame Email address

son a
O General Pract| DR JP RING oleksandrp@auditdata.com

B Send as attachment with following body text Subject
Text

e Click Preview if you want to preview the letter before printing/emailing. If you are
previewing a Word letter, Microsoft Word will open and a floating window will appear. The
letter can be adjusted as required and can then be printed/emailed by selecting Send or
the single Print icon at the top of the floating box. In the case of Send the appropriate
number of letters will be printed/emailed. Select the browser button next to Send to
make changes to the default send setup. Recipient email address can also be added or
amended here and any amendment can be pulled through to the related contact.
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 |f the letter needs to be saved without printing, Save and close will save the letter as a
document and close both the floating window and Word.

¢ If previewing is not required, click Send to print the letter on the default printer as defined
by the system administrator or to email as defined by the default settings.
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7.25 Designing a letter

Letters *

Mew booking defined template Mew WS Word template ave Delete Close

Letter list | Edit booking defined template

Letter template name Type | Eluoking| WL | Referral| Save after printing |Atlach letter to appt.| Set sent date to currt. | Document type | Save content | Save read onl »
01AudVars MsWord |[] O client letters
06.06.2018 MS Word |[] O O O O O O
1 Booking de[] O O O O
1 Address MsWord |[] O O client letters
11-03-19_test_template MS Word O O O O client letters O
123 MS Word |[] O O O O O O
19/02/2015 all variables MS Word client letters Word doc O
1Separate letter MsWord |[] client letters Word doc [l
1Single letter MS Word  |[] client letters Word doc [l
23/06/2016 all variables MS Word client letters Word doc [l
23423 MS Word |[] O O O O O O
291002015 all variables MS Word [ 1 1A fA M FA client letters Waord doc I s
<
Selected template
Name Location ~|  Department All departments -
M Available in Booking M Available in Waiting list M Available for Referral receipt
Saving lefter Default recipients Add Remove
By default, save letters of this template after printing or emailing Type Name

t, save letters read-only On emailing to multiple recipients Send single email

You can design a letter by going to Functions -> Settings -> Letters in Booking. The dialog
gives you a flexible layout, variables in fixed format and complete flexibility when editing letters
in Word.

e The Letter list contains all letter templates that are currently available.

¢ You need an extended user right given by your system administrator to modify existing
letter templates.

e You can either define a New booking defined template or a New MS Word template.
New document templates will be created as DOC or DOCX depending on the settings in
the Administration tool.

¢ The booking defined templates are templates created in Auditbase, with already defined
building blocks set up by your system administrator. The Word templates are created in
Word, which gives you complete flexibility when it comes to the layout.

e The Location and/or Department where an appointment takes place can be added to a
letter as a variable in the Letter specific information folder. This is shown on the
Location and Department fields on the Letter dialog. These replace the Hearing Centre
variable which will be read-only when an appointment has a Location on the Booking

156
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screen. The old Hearing Centre variable will still work. If an appointment does not have a
Location and/or Department it can be added here.

If the Location and Department Filtering option is installed, Letters can be filtered by
Location and/or Department with Location groups and multiple locations options. This
filtering is made on the main Toolbar.

Click Save to save a new or changed letter in the database.

The Delete function will remove a letter from the database.

7.25.1 New booking defined template

Booking defined letter templates are defined in Auditbase and available from the Booking
module and from waiting lists.

Click on New booking defined template and start out by entering name, location,
department, availability, default saving settings and default recipients of the letter under
Selected template (marked by red square in above screen shot).

To edit a booking defined template, choose the letter in the list and make your changes
under Selected template and the tab Edit booking defined template.

You can choose whether or not the letter should be Available in the Booking module
and/or Available in the Waiting list module.

The saving settings allow you to save a record of any letter sent with or without content,
along with a record of to whom and when it was sent.

If you uncheck By default, attach letter to appointment, the letter is attached to the
appointment that the letter is about.

If you choose not to uncheck By default, set date of sending to the current date, the
date field will be left empty on the letter.

If the template contains the audiogram graph variable, a window will open to allow the
user to select which audiogram is to be used. The number for the audiogram variable
(there can be up to four) will appear at the top of the Audiogram List dialog. A variable is
available to show a combined audiogram or split audiogram with separate right and left
graphs.

If you save the letter with content, saving in RTF (available for Booking defined templates)
or Word format (available for Word templates) will take up more space on the server than
if you save as text, which does not include images etc. Unless you really need to save
images and formatting from documents, you should choose a plain text format. Text
documents will lose all formatting but are still easy to read and edit. RTF will keep all
formatting, but increase the file size, and is harder to edit later because of a frame setup.
Uncheck By default, save letters read-only if you do not want the letter to be editable
after you have saved it. However, users can be granted the extended user right of
“Documents: Remove read-only flag” by the system administrator.

Enter text and variables on the tab Edit booking defined letter.
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Letters *

Mew booking defined template Mew M3 Word template Edit Save Delete Close

Letter list | Edit booking defined template

‘ariable name Insertvariable | Template name |,lkpp0intmem— general - GWH Print test

-Appointment Booking code
-Appointment Referenced by attribute
-Appointment anonym. number

Appointment date Hosp Mo. #Primary identification code#  NHS No. #NHS number# -
Appointment date (long format)

Appointment duration Date: #Current date (long formati#

-Appointment duration number of hours

-Appointment duration number of minutes

Appointmentinformation #ames

-Appointment outcome code #Streatt

-Appointment outcome description #Client Postcode#

-Appointment outcome name h
-Appointment outcome reporting code -
-Appointment reason ) i

Appointment resource name Date: #Appointment week day##Appointment date (long format)# at
-Appointment resource user full name H H

Appointment resource user phone #Appointment time (AM/PM format) #

-Appointment resource user title =
-Appointment symbaol name

-Appointment time -~
-Appointment time (AM/PM format) The appointment will last approximately #Appointment duration number of hours# hour
Appointment type text #Appointment duration number of minutes# minutes and you will be seen by the

-Appointment week day . X X X . .
Replaced appointment date #Appointment resource user title#. You are welcome to bring a friend or relative to this

Replaced appointment date (long format) appointment with you.

Replaced appointment resource name

Replaced appointment resource user full name There are pay and display car parks at the hospital, please allow time to park your
Replaced appointment resource user phone vehicle. On arrival please report to the Audiology Department in the North Wing on the

Replaced appointment resource user title - - -
Replaced appointment symbol name 3rd floor, where every effort will be made to see you as near to your appointment time as

Replaced appointment time

Replaced appointment time (AM/PM format)

[ Client data

[* Currentissued accessories -
[ Currentissued devices -
[ DHI questionnaire results

[ General information v -

-

-

¢ Aseries of predetermined variables are available for you to enter.
¢ Once a variable has been selected, place the cursor at the required position and click the
button Insert variable. The name of the variable will appear with # marks at either side.

It is important that you do not edit the variable words inside the # marks, or the variable
will not function correctly.

e You can insert variables in 3 ways:

¢ Place the cursor at the required position inside the building block/text field and double-
click on the variable.

¢ Place the cursor inside the building block/text field at the position you wish to insert a
variable and click on Insert variable.

¢ Click and drag the variable into the required position inside the building block/text field -
it is important that you hold the mouse still above the variable before you click and drag
the variable into the required position.

¢ The different text boxes in Booking defined templates can be formatted with the Report
Builder. For more information on this, contact the Auditdata support office.
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¢ To look at the layout, select Print test and a letter will be printed with the variable names
displayed.
¢ The letter can then be saved and a new letter defined.

7.25.2 New MS Word template

¢ Click on New MS Word template, which will open Word and you can create the Word
template as you need. New document templates will be created as DOC or DOCX
depending on the settings in the Administration tool.

'9' O = Document2 - Word Andrey Shustov

File Home Insert Design Layout References Mailings Review  View  Help p | Mevdesumen nts

,E_rﬂ [E] outline 1 IE [ Ruler O\ D B | EInewwit Not related to any activity =R 2
@ <)

ElDraft < | [ Gridlines H Arrange| Name / Comments

Read | Print  Web Learning | Verical Side o Zoom 100%
Mode Layout Layout Tools toSide | L Navigation Pane > | EHsplit | Results template =
Views Immersive | Page Movement Show Zoom = A
| I
Save as new document of type
[2! Lettertemplates -
Send .. Saveandclose Cancel 2
#Appointment date (long format)# Variables
#Appointment duration# [ Appointment data -
-Appointment Booking code
-Appointment Referenced by atfribute
-Appointment anonym. number
Appointment date

-Appointment date (long format)
-Appointment duration

-Appointment duration number of hours
-Appointment duration number of minutes
-Appointment information
-Appointment outcome code
-Appointment outcome description
-Appointment outcome name
-Appointment outcome reporting code
-Appointment reason

-Appointment resource name
-Appointment resource user full name
-Appointment resource user phone
-Appointment resource user title
-Appointment symbol name
-Appointment time

-Appointment time (AMPM format)
-Appointment type text

Annnintmeant waesk dav v
Insertvariable Insertvalue -
Page1of1 6words [ English (United States) —ETEr E - 1 FI005%

¢ The variables will remain hidden until you expand them using the arrows, keeping them
hidden by default will make this dialog open faster.
» Variables can be nested in folders to help reduce the initial list.
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Variables

[ General infarmation

[ Implant data

[ Letter specific information
[ Measurement

[* Latest audiogram data

- [ Latesttympanometry data
rTympanometer |0
rTympanometry ECY L
rTympanometry ECY R
rTympanametry MEP L
rTympanametry MEF R
rTympanametry SCISA label L
rTympanaometry SCISA label R
rTympanaometry SCISA unit L
rTympanaometry SCISA unit R
rTympanometry SCISAvalue L
FTympanometry SCISAvalue R
rTympanametry audiogram date
FTympanametry audiogram number
rTympanametry audiogram type

FTympanametry date
rTympanametry frequency L

FTvrmnannmeatre frennenrey B

You can insert variables in the Word template in 3 ways:

° Place the cursor at the required position in the document and double-click on the
variable.

° Place the cursor inside the document and click on Insert variable.

° Click and drag the variable into the required position in the document - it is
important that you hold the mouse still above the variable before you click and drag
the variable into the required position.

If the template contains the audiogram graph variable, a window will open to allow the
user to select which audiogram is to be used. The number for the audiogram variable
(there can be up to four) will appear at the top of the Audiogram List dialog.

Name and address values can appear in upper case or mixed case according to a setting
in the Administration tool.

When finished with your document, click on Save and close.

To close without saving, click on Cancel.

Back in Auditbase, you can now edit the name, availability, saving settings and default
recipients under Selected template.

You can choose whether or not the letter should be Available in the booking module,
Available in the Waiting list module or Available as a Referral receipt.

The saving settings allow you to save a record of any letter sent with or without content,
along with a record of to whom and when it was sent.

If you check By default, attach letter to appointment, the letter will be attached to the
appointment that the letter is about.

If you choose not to uncheck By default, set date of sending to the current date, the
date field will be left empty on the letter.
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¢ If you save the letter with content, saving in RTF (available for Booking defined templates)
or Word format (available for Word templates) will take up more space on the server than
if you save as text, which does not include images etc. Unless you really need to save
images and formatting from documents, you should choose a plain text format. Text
documents will lose all formatting but are still easy to read and edit. RTF will keep all
formatting, but increase the file size, and is harder to edit later because of a frame setup.

e Uncheck By default, save letters read-only if you do not want the letter to be editable
after you have saved it. However, users can be granted the extended user right of
“Documents: Remove read-only flag” by the system administrator.

* Word templates are editable in Word by choosing the letter in the list and clicking Edit.

7.25.3 Default recipients
It is easy to add or remove default recipients of letters.

¢ Choose the letter in the list.
* To remove recipients, choose the recipient you want to remove and click Remove.

Default recipients Add Remaove

Type Mame

All rels. and other contacts marked as

¢ To add default recipients, click on Add to select which group or specific recipients you
want to add as default recipients of the letter.

Add default recipient to letter template ot

Add Cancel

Select recipient

B Referral referring agent

All relatives and other contacts marked as CC

All professional contacts
B Specific professional contact type Registered Practice -
W Specific referring agent

Specific relative or other contact Mother
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¢ You can add the selected Client.

* You can choose to add All relatives and other contacts marked as CC in the Client
information module under the tab Contacts.

¢ You can add All professional contacts.

¢ You can add just a Specific professional contact type.

¢ You can add a Specific referring agent.

¢ And you can add a Specific relative or other contacts, even if they have not been
marked as CC in the Client information module.

e The changes you have made are automatically saved to Auditbase.

e The full list of recipients can be added to the letter by using the variable List of recipients
under Letter specific information either when editing a booking defined template in
Auditbase or when adding variables in an MS Word template.
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7.26 Making timetable

Timetable functionality can be restricted to line managers by the system administrator.

Timetables now consist of not just the Timetable symbol representing the clinic type but also
the Location and Department symbols if these are used. All locations(No Location) and All
departments(No department) can be used if Location and Department Filtering has not been
set up. If there is to be no change in Location or Department, the [No Change] option can be
selected. This will not overwrite any existing Locations or Departments.

As the Location of an appointment can be used in a Letter, if the Location of an existing
appointment is changed when making the Timetable, the user will be requested to generate
new appointment letters for all affected clients.

Timetable symbols have a default Location and Department set up in the System
Administration tool. When making a timetable, if Location filtering is licensed, the default
Location or Department for the selected symbol can be taken as the default or, by checking
Select location/department from Booking screen as default, the default Location and
Department is taken from the toolbar in the Booking screen.

If part of the timespan selected is occupied with appointments having a different Location or
Department then the new selection will not be applied.

Timetable details can be entered via one of the following three functions:

e Direct editing
e Scheduling
e Copying

Direct editing
Select a date in the Calendar.

¢ Select Edit -> Make timetable or press F9.

Select timetable, location, department and length X
Duration
1w hours 30 ~ min.

Select location/deparment from Booking screen as default
*) Only enabled for single location and department selection

Symbol Location Department

NO SYMBOL

[f PAED Hearing Aid Clinic
PAED Transition

Fl SAVERMAKE PAEDS

B TIDWORTH

% Wiltshire PHAC

All (no location)

All (no department)

11 (MO CHAMGE] (MO CHAMGE]
22 [+ Test group123 Department1
- NTS L 2 Location3 2 Department2
St ENT CLINIC '+ Test group 2 3 Department3
[ SAV - C&B - Dref/ AGR 4 Testd

. Taw Hill

BB COMMUNITY PAEDIATRICS 2 Location2

Gl PAED Assisting 4 Testd
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e Select a symbol in the list and enter the number of 15 minute time slots.

o If activated, select a Location the appointment relates to. The location symbol will display
next to the timetable symbol on the booking page.

o If activated, select a Department the appointment relates to. The department symbol will
display next to the location symbol on the booking page.

e [fyou are in Resource plan, click the timeslot on the resource you want to create.

e Ifyou are in Time plan, click a timeslot on the resource/time grid.

¢ In both cases, the system marks the requested number of timetable slots by the selected
symbol.

¢ When in Time plan the system automatically defaults to showing only Timetable symbols.
However, you can check the box next to Booking under Display symbols to see Booking
symbols as well.

¢ Once you click to make the specific timetable, you are prompted to turn off Booking
symbols again for the system to be able to enter the Timetable symbol.

Warning x

TimeTable symbols cannot be applied unless the ‘Display
symbols'is setto TimeTable’. Change the symbol view and
apply the new TimeTable symbols?

Diont show this message again

Cancel

¢ Click OK and the booking symbols are automatically turned off and your new Timetable
symbol is visible in the time grid.
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7.27 Scheduling timetable

e Select Edit -> Schedule timetable.

Schedule timetable *
Apply Save Close
X Select location/depariment from Booking screen as default Date
Resource Timetable symbol . . .
*)Only enabled for single location and department selection 10/01/2020
LETH - | | NO SYMBOL ~ .
Charlie 11 Location Department )
Duration
Res109 22 All (no location) All (no department)
Res46 = NTS MO CHAMGE] [NO CHANGE] Starttime End time
Res68 kY ENT CLINIC [+ Test group123 - Departmenti
Res70 B SAV - C&B - Dref/ AGR 2 Department2
Res54 [T test [+ Testgroup 2 3 Department3
Res78 B COMMUNITY PAEDIATRICS tf] Location 4 Testd )
Res73 [l PAED Assisting . Taw Hill Hours Minutes
Resg2 @ PAED Hearing Aid Clinic 2 Location2 1 - 0 -
Res75 @l PAED Transition 2 Testd
Res71 A SAVERNAKE PAEDS
Res72 B TIDWORTH
Res105 B wiltshire PHAC
Resd3 123
Resd5 v FAIRFORD ENT
Recurrence Schedule method
. Do not overwrite existing timetable, location and
Daily | Weekly | Monthly | Annually department symbols
#| Every 1 day(s) Overwrite existing symbols only where appointment
is not booked
Every weekday . -~ ) ; )
Overwrite existing symbols even if appointment is
booked and re-generate letter
*) Overwritting timetable symbol only does not
End of recurrence re-generate letter
# End after 1 OCCUITences # Prompt for each conflict
*) Location will not be saved to appointment slots ifit
End by date 10/01/2020 causes the appointment to appear in different

locations

¢ Select Resources in the list.

¢ Select a Timetable symbol. Note that outdated symbols are not shown in the list.

¢ [f activated, select a Location the schedule will relate to.

¢ If activated, select a Department the schedule will relate to.

e Select Date and enter Duration.

e Set Recurrence if required. If the Monthly tab is chosen, you use the arrow buttons to
add multiple criteria.

e Choose the desired Schedule method - the default is ‘Prompt for each conflict’.

* Apply to create timetable and leave the window opened.

¢ Save to create timetable and close the window.

As the Location of an appointment can be used in a Letter, if the Location of an existing
appointment is changed when rescheduling the Timetable, the user will be requested to
generate new appointment letters for all affected clients.

When scheduling a Timetable there are options to control whether symbols that are already in
Booking should be overwritten or not. Any appointments that have already been created will not
be split between more than one Location or Department.

The list of options is the following (including comments):

165
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¢ Do not overwrite existing timetable, location and department symbols - Any existing
timetable symbols will not be overwritten and there will be no warning; if part of the
timespan selected is occupied with appointments having a different Location or
Department, then only the part of the timespan that is available will be updated with
timetable, location and department symbols.

¢ Overwrite existing symbols only where appointment is not booked - Any existing
timetable, location and department symbols will be overwritten only where there is no
appointment booked;

¢ Overwrite existing symbols even if appointment is booked and re-generate letter.
*) Overwriting of timetable symbol only does not re-generate letter - If an appointment
has been booked next to a timetable symbol, the symbol will be overwritten but you will
be asked if you want to send a new letter to the client if the Location is changed;

¢ Prompt for each conflict.
*) Location/department will not be saved to slots with appointments if that causes
appearing the same appointment in different locations/departments - If there is a
conflict between the timetable you are scheduling and the existing timetable symbols,
you will be asked to confirm the change. Appointments will not be booked if the
appointment location and department clashes with the timetable location or department.

Timetable symbols have a default Location and Department set up in the System
Administration tool. When scheduling a timetable, if Location and Department Filtering is
licensed, the default Location or Department for the selected symbol can be taken as the
default or, by checking Select location/department from Booking screen as default, the
default Location and Department is taken from the toolbar in the Booking screen.
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7.28 Copying timetable

¢ This facility may be used for duplicating the timetable to further days or weeks.
¢ Select Edit -> Copy timetable.

|
i If any changes to appointment Locations are found, requiring new Lefters to be created:

Apply Save I # Wam before copying timetable Moiify after changes are made, for faster processing | Closs

Copy from resource Copy to resource(s)
Trawy - All
| &) Saleciion Begin | 25/12/2019
Copy from Travy -
52 = [2019 & Stassy | Occurrences 1
Week 192 []20%9 15 Charlie Dateinterval  25/12/2019
Date interval ~ 23/12/2019 - 2911212019 Res109
Resds
Res6g
W Monday Res70 * Copy to weeks
W Tuesday FRQES‘?; Selection of weeks
es
B Wednesday ResT2 Begin wee End week Every
W Thursday Resg2 v |52 |2019 & |52 [ | 2019 [ 1
(N Overwrite existing timetable Dateinterval 2311212019 - 29/12/2019
B Saturday
B Sunday M All days *) Location/department will not be saved to slots with appointments ifthat causes

appearing the same appointment in different locations/departments
*) Change of location/department for all booked times|ots will cause re-generation of
booking letter

¢ Now you can choose when to get notified if changes to appointment Locations are found,

which requires new letters to be created
° |If necessary to speed up the process of Copying timetable, use the option “Notify
after changes are made...”

¢ |In Copy from resource drop-down list, select a resource the timetable is created for,
which is to be copied to another resource. Select [duplicate] in that list where the
timetable is to be duplicated for a resource or resources.

¢ In Copy to resource(s), select resources the timetable should be created (copied) for.

* When copying a timetable, you have the option to overwrite or not overwrite the
Timetable, Location and Department symbols (Overwrite existing timetable).

° |f you choose to overwrite the timetable and if the Location or Department of an
existing appointment is changed, when copying the Timetable, you will be
requested to generate new appointment letters for all affected clients.

° If you choose not to overwrite the timetable then only if all four symbols are empty
will the Copy action take place for a particular timeslot.

¢ In Copy from, specify source days’ timetable should be copied from.

¢ In Copy to days or Copy to weeks, specify target date range If two or more weekdays are
selected, only Copy to weeks is available.

¢ When you select the Copy to days option, you can specify the days when the timetable
should be copied to.
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¢ Click Edit pattern. The system opens the Recurrence window where recurring days can
be specified on a Daily, Weekly, Monthly or Yearly basis.

¢ If you select Copy to weeks, you can specify copying on weekly basis. Week number
range and sequence of week numbers can be specified.

¢ Apply to copy timetable and leave the window opened.

e Save to copy timetable and close the window.
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7.29 Bulk move from Resource to Resource

When a resource is going to be unavailable and you need to move appointments in bulk from
one resource to another, the Bulk move facility can be used.

Edit -> Bulk move.

Select the From resource and the To resource from the drop down lists of resources. By
default, the active Resource will be selected.

Select the from Date and the to Date using the calendar icon or by entering a date.

By default, the active date will be selected.

The appointments that can be moved will be highlighted in yellow. If an appointment
cannot be moved, the appointment will stay in its original position and will not be
highlighted.

If a highlighted appointment is not to be moved, click on the appointment and it will move
to left in its original position.

The left and right arrows can also be used to move all appointments from one resource to
the other.

You can decide if letters should be printed Never, If location or department is changed
or For all moved appointments.

Once you have made your selections, Save will move the appointments to the selected
resource.

Once this has been done, the appointments cannot be moved back except by restarting
the bulk move option.

If all the appointments could not be moved from the From resource, the Bulk move
appointments window will stay open so that further moves can be made.

Close will shut down the Bulk move appointments window.

Bulk move appointments X

Travy A To Res109 - Click on a highlighted yellow appointment to

exclude it from bulk move, or to include it again
1000112011 | 7] Date 101012011 | [5]

N N N N SN NN Y

e .k e

=

K2-2 [08:00 Print letters
08:15 ) Mever
*, FATHER FNAME221 08:45

8, MST FIRSTMAME46587 L... Iflocation is changed
SMAME12 09:0i

For all moved appointments

EEEE
2

5, MISS FIRSTNAME46592 L
34

S, MST FIRSTNAME46594 L.
10:45

1115 B D, M3T FIRSTNAME46595 L.
11:30 B

12:00 S, MST FIRSTNAME43686 L...
#5C, MRS FIRSTNAME14782 L 1215

s aaaaiaaan wanan
=1
w
S

, MISS FIRSTNAME465388 L.
, MISS FIRSTNAME46593 L.
, MST FIRSTNAME4G666 L.
| MASTER FIRSTNAME422
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000
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Sraixion
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If an appointment is a multi-resource appointment, it can only be moved if the locations match
or there is no location set up in the To resource.

Reservations cannot be moved using this method but must be moved individually.
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7.30 Efficiency Analysis

The Booking screen can be analysed to search for empty slots, unscheduled appointments or
appointments in the timetable within a date range or slots that cannot be completely filled by
appointments types of a defined length. Clients that have multiple earmoulds can also be found here.
These are found on Booking -> Functions -> Efficiency analysis. There are several tabs which look for
specific information.

The Efficiency analysis window can be collapsed to make viewing the Booking screen easier. This is
done by using the arrows at the top right of the window. This creates a floating panel which can be
moved to anywhere on the screen that is convenient. The same arrows can then be used to expand the
windows.

Once a filter has been created it can be saved with a name. Once Save has been selected a window will
appear which will give you options depending on whether this is the first time the filter has been saved
orif itis being updated.

Save filter X

Save Close

‘Save to the current filter <Ba|ance>§

Rename the current filter
« Save as anew filter
Name Balance

Save as the default filter

* You will need to give the filter a Name and decide if this filter will be the default filter by selecting
Save as the default filter.

e If you do not want to Save this filter, select Close to shut the window without saving.

* To modify a current filter, choose one from the drop-down list of Saved filters, make any required
modifications and then Save as...

» A Save filter window will appear with options to either Save to the current filter, Rename the
current filter or Save as a new filter. You can also decide if this filter will be the default filter by
selecting Save as the default filter.

7.30.1 Unbooked time

e Enter the required date range. This can be done by entering a date in the Date: from and to fields
or by right clicking on the fields and selecting a date from the calendar.

* Timetable symbols can be selected by checking the box next to their name or by checking the
Select All box and then using the arrow to move them to the right. The ‘no symbol’ option is not
available; timetable symbols must be applied to search for gaps.

* Resources can be selected by checking the box next to their name or by checking the Select All
box and then using the arrow to move them to the right.

* Once symbols and resources have been selected, the Show result button is highlighted in yellow
to show that the analysis can be run.

e The result of the analysis is shown in the bottom section. To navigate to a particular time slot,
double click on it and you will be taken to the empty slot.
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Efficiency analysis - Unbooked time

Unbooked time | Unscheduled appts | Missed appts | Many earmoulds | Missed review appts

Typical appointment duration 0

hours

Filtering
Saved filters  Balance Save Save as... Delete
Date:from | 310172018 | to  28/02/2020
Timetable symbols: Select All Selectal
| Symbol ~ [ Symbol
[ BAHARAC [O= BALANCE
[J CLEAR1
[J= NOCLNIC >
[JE OADADULT P
[JE 0AD PAED
& PAED 02
[J PAED U3 v
Resources: SelectAll SelectAl
Available resources | Selected resources A
[] George [ JAKE
[J| CHELSEA
» [/ walsh
< [ ALAN
[] ROSE
[J BRIAN
[J/ EVELYN v

Only include time ranges which cannot be filled with appointments of the comrect duration

0 min.

Result - Double click on a row to navigate to thattime interval Print

Date |Resource| Symbol
11/12/2018 | CHARLIE = BALANCE |09:00-17:00
18/12/2018| CHARLIE = BALANCE |09:00-17:00
2412/2018| CHARLIE = BALANCE |08:00-12:00
2512/2018| CHARLIE = BALANCE |09:00-17:00
31/12/2018| CHARLIE = BALANCE |08:00-12:00
07/01/2019| CHARLIE = BALANCE | 08:00-12:00

Time interval

» |f you want to see only time slots that cannot be completely filled by an appointment of a
set duration, select the check box and set the Typical appointment duration.

B Only include time ranges which cannot be filled with appointments of the correct duration

Typical appointment duration

1 '+ hours min.

¢ The results will now be filtered to show only slots that cannot be filled completely by the
set duration. In this example, a one hour and 15 minute empty slot will be shown because
a one hour and 15 minute appointment cannot completely fill the empty slot. A two hour
slot would not be shown as two one-hour appointments can fill the empty slot.

Result - Double click on a row to navigate to that time interval

Print

Date |Resource[ Symbol |Timeinterva|

11/12/2018 |CHARLIE |z BALANCE |09:00-17:00
18/12/2018 | CHARLIE = BALANCE |09:00-17:00
24/12/2018 CHARLIE = BALANCE 08:00-12:00
25/12/2018 CHARLIE = BALANCE 09:00-17:00
31/12/2018 | CHARLIE = BALANCE 08:00-12:00
07/01/2019  CHARLIE = BALANCE 08:00-12:00

¢ This panel can be further collapsed so that maximum screen can be seen without the

need to re-start the analysis.
¢ Appointments can now be adjusted or moved to maximise the use of the available time.
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¢ The results of the analysis can be sent to a printer using the Print button. The print out

will show the results by resource and then by date.

7.30.2 Unscheduled Appointments

The result of this tab will show the number appointments for client above the normal requirement for

that appointment type.

e Enter the required date range. This can be done by entering a date in the Date: from and to fields

or by right clicking on the fields and selecting a date from the calendar.

e Appointment symbols can be selected by checking the box next to their name or by checking the
Select All box and then using the arrow to move them to the right. The ‘no symbol’ option is not
available; appointment symbols must be applied to search for appointments.

Efficiency analysis - Patients attending multiple unscheduled appt types

Unbooked time | Unscheduled appts | Missed appts | Many earmoulds | Missed review appts

Filtering

Savedfiters  =<Mew filler= - Save Save as..

Date from 3011272018 | o | 301272020 Show result
Unscheduled appointment types: B SelectAll

| symbol - | Symbol A

OE COMMASSESS/REM F(I 15T IFNSSUE

[JW WALK IN REFAIR [+ F~ PR HAREPAIR

[JA ASSISTING PAEDS 3 [ IMPLANT ANMUAL RV

[JTa TINNITUS ASSESS P 1 F IMPLANT FU

[T TINNITUS FU [T SWITCH ON

[JE CLINICAL MOM PT 15 SURGERY

118 ADMINISTRATION W

1 & IMPLANT ASSESSMENT

Minimum number of appointments: 1

List of patients selected by params above (Appis total not including Group Appts)

Hospital no.,  NHS no. MName |.ﬁppts. total
111 111 1111 COLOMEL CHARLIE HAR
T121220 FRED 1

Result - Double dick on a row to navigate to that appointment

7.30.3 Missed Appointments

Show All
Date Rasnurc&| Symbol lStatus Time interval
24/04/2019 |CHARLIE I 1STIFNSSUE D 12:30-13:15
04/01/2019 |BERTA P~ PRHAREPAIR 11:15-11:45

>

The result of this tab will show appointments that have a certain appointment status.
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» Enter the required date range. This can be done by entering a date in the Date: from and to fields
or by right clicking on the fields and selecting a date from the calendar.

o Statuses indicating unattended appointments can be selected by checking the box next to their
Description or by checking the Select All box and then using the arrow to move them to the right.

e The Minimum number of appointments can be set so that patients that have missed multiple
appointments can be seen.

e Patients that need to be excluded from the result due to their alert or parameter settings, can be
excluded by selecting the Exclude patients with alerts and parameters button which will open a
window where Alerts (with a Code) and Parameters (without a Code) can be selected.

Select alerts and parameters X

Exclude patients with alerts and parameters Apply
SelectAll SelectAll

‘ Code| Description A Code | Description

Om Moved

| Wheelchair 4

O 2 Person lift 4

] War Pensioner

arT Transport

[P Private Patient v

o If an Alert or a Parameter has been selected, then the exclusion message is shown.

|  Exclude with alerts and parameters | Alert and param. exclusion is on

¢ Once Show result has been selected, a List of patients selected by params above
(Appts total not including Group Appts) is shown in the window.

List of patients selected by params above (Appts total not including Group Appts) Export

Hospital no.| NHS no. Name DNA'ed appts. total| Appts. total

111 111 1111 COLONEL CHARLIE HARPER 6

¢ By selecting one of these patients, the appointments for the selected patient is shown in
the bottom window.
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e The Export button will open a window where the results can be saved as a CSV file so that
it can be opened in Excel.

Result - Double click on a row to navigate to that appointment Show All
Date ‘Resource Symbol ‘Status‘Time interval
13/11/2019 |BERTA |H HEARING TEST|C 10:30-10:45
13/11/2019 | CHARLIE |H HEARING TEST|C 10:30-10:45
06/11/2019 | BERTA SURGERY C 10:00-11:00
3/11/2019 | CHARLIE SURGERY 10:00-11:0C

12:15-13:00
12:30-13:15

08/10/2019 | CHARLIE [T 1ST IFASSUE
24/04/2019 | CHARLIE I 1STIFASSUE

O 0|

¢ Double clicking an appointment will show that appointment in the Booking screen.

7.30.4 Many Earmoulds
This tab shows patients that have a minimum number of earmould visits over a date range.

» Enter the required date range. This can be done by entering a date in the Date: from and to fields
or by right clicking on the fields and selecting a date from the calendar.

e The Minimum number of earmould visits can be set.

e Show result will display patients that have a number of earmould visits equal to or greater than

the set number.

List of patients selected by params above (including number of earmoulds) Export

Hospital no.| NHS no. Name EMs total

111 111 1111 COLONEL CHARLIE HARPER | 2

7.30.5 Missed Review Appointments

This tab will show patients that have attended an initial appointment but not the review or follow up
appointment.

e Enter the required date range. This can be done by entering a date in the Date: from and to fields
or by right clicking on the fields and selecting a date from the calendar.

« |nitial appointments types can be selected by checking the box next to the appointment Symbol.
The right facing arrow will move the symbol to the right-hand box which is used as the filter.

e The number of days after the initial appointment can be set using the Review appointment must
occur from, to days after the initial appt fields. This can be set to a maximum of 999 days after
the initial appointment.

e Review appointment types can be selected by checking the box next to the appointment Symbol.
The right facing arrow will move the symbol to the right-hand box which is used as the filter.
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* Patients that need to be excluded from the result due to their alert or parameter settings, can be
excluded by selecting the Exclude patients with alerts and parameters button which will open a
window where Alerts (with a Code) and Parameters (without a Code) can be selected.

Select alerts and parameters X
Exclude patients with alerts and parameters Apply |
SelectAll SelectAll

| Code| Description A | Code | Description

O(m Moved

O Wheelchair 4

O 2 Person lift 4

[l War Pensioner

O Transport

[P Private Patient e

e [fan Alert or a Parameter has been selected, then the exclusion message is shown.

| Exclude with alerts and parameters | Alert and param. exclusion is on

¢ Once Show result has been selected, a List of patients selected by params above
(Appts total not including Group Appts) is shown in the window.

¢ By selecting one of these patients, the appointments for the selected patient is shown in
the bottom window.

List of patients selected by params above (Appts total not including Group Appts) Export

Hospital no.| NHS no. Name Appts. total

MASTER ANGUS JONES
0000022 Dr. LINDAHARRIS
T121220 FRED

N 1

e The Export button will open a window where the results can be saved as a CSV file so that
it can be opened in Excel.

Result - Double click on a row to navigate to that appointment ShowAll
Date | Resnurce[ Symbol ]Status]Time interval

13/11/2019 |BERTA |H HEARING TEST|C 10:30-10:45

13/11/2019 | CHARLIE |H HEARING TEST|C 10:30-10:45
06 2019 | BERTA SURGERY 8 10:00-11:00
06 0 ~HARLIE SURGERY 10:00-11:0C

08/10/2019 | CHARLIE [T 1ST IFAISSUE
24J04/2019 | CHARLIE I 1STIFASSUE

12:15-13:00
12:30-13:15

[w RN RRSRE

¢ Double clicking an appointment will show that appointment in the Booking screen.
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8 Referring agents

To open Referring agents go to Navigation -> Referring agents. You can also call this window
from other modules where you select a referring agent, for instance Referral and Client
information.

The system supports the following default referring agent types:

* Agency

¢ Audiologist

¢ General Practice (GP)

¢ An individual referring agent
e ENT (Ear- Nose- and Throat specialist)
e School

¢ Health visitor

¢ Onward referral

e Paediatrician

o SALT

e Other

More referring agent types can be defined by the System Administrator.

Referring agents *
MNew Edit Select Close
Search
Paostcode GP Code Practice Code Type - Include outdated
CCG + CCGCode + Mame Surname = Part of full name Search
Type |CCG | Title |First‘ Surname/Mame Address Postcode Infon ~
General Pract 50H DR M AITCHISON HILARY COTTAGE SURGERY, KEBLE LAWNS, F PC:6373
General Pract 5QF DR |SMN |ALBERT BURDWOOD SURGERY, WHEELERS GREEM \ PC:8362
Dther ALISON STAGG
General Pract 5QE (DR A 3 VALE AVENUE, WANT PC.6376
General Pract 5555¢ DR AL | ALLIK 123 STR, SOME CITY, ABC 1234 CITY
General Pract DR |AD |AM 123 STR, HOME CITY
Other AMANDA CARROLL MERCHISTON SURGERY, HIGHWORTH ROAD, PC:3523
Other AMAESTHETIC COMSULTANT | TGW
General Pract CF AMDERSON MERCHISTON SURGERY, HIGHWORTH ROAD, SN2 4BF
General Pract 5K3 DR M AMDREWS ELM TREE SURGERY, 24AHIGH STREET, SHRIPC:5392
Health visitor AMN SEYMOUR
General Pract 5K3 DR K APPLEGATE HAWTHORMN MEDICAL CENTRE, MAY CLOSE, ( PC:6406
General Pract 5K3 DR ASH KINGSWOOD SURGERY, KINGSWOOD AVENUE PC:3336
Other ATTOTI COMNSULTANT PHYSICIAM, DOME v
7 P T PPy ——— -
Address: 3 VALE AVENUE, WANTAGE, OXON Postcode: PC:6376 City:
CCG: OXCCG CCG code: 50QE Practice code:  K84074

MNUM SCRL

You can search for Referring agents by the following criteria:
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¢ Postcode

¢ CCG (Clinical commissioning group) code
e CCG name

e GP code

¢ GP practice code

e Agent type

e Surname or part of full name

Your System Administrator can configure which field the cursor should default to for faster
access to searching.

Your system administrator configures if the different referring agent types are an individual or
an organisation.

By default, the system does not include outdated agents in the search result. To include
outdated agents, check the corresponding box.

When you have specified the relevant search criteria, click on Search. Agents meeting the
search criteria will be listed in the table.

You may also use the ‘Word wheel’ functionality to search, see the section on ‘Sorting and
saving listing screens’.

© Auditdata - 2025, ID: 20.0040/36 178



User Guide

8.1 Edit or add a referring agent

* To add a new referring agent, click New. If you wish to edit a referring agent, highlight the
referring agent and click Edit.

Phone number:
Fax number:
Email

Preferred comm.
method

Edit referring agent ot
Delete 0 Close
Agenttype 7] mawigua
Title DR Organization
First name A
Last name ALLEM
Full name DR AALLEM
Compose full name Decompose full name
Address 3 VALE AVENUE -
WANTAGE
OHOM
w
Postcode PC.B376

olepus@auditdata.com

Site default (Only email, past if email is not avai| -

Information

GP Code 3453544441

Practice Code Ke4074

LiE OX CCG -

CCG Code 5QE v Outdated agent
External systemid 5444

e Select an Agent type.

e Each agent can be either an Individual or an Organization. This is defined by selecting
the corresponding option.

¢ [f Individual is chosen, enter the title, first name or initials and last name in the
appropriate fields, or enter the full name in the Full name field and use the Decompose
full name to break it down according the name format in Auditbase Administration.
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 Compose full name and Decompose full name allow names made suitable for
addresses after they come from PAS and to be shown in different ways according to need,
specifically as ‘Dr A Adams’ in addresses and as ‘Adams A’ when sorting in a list.

¢ To automatically fill in the full name with the information entered in the other fields, click
on the Compose full name button.

¢ To extract the information from the full name field, click on the Decompose full name
button. The system decomposes the full agent name as defined by the system
administrator.

¢ An agent can be marked as Outdated by selecting the relevant check box. The system will
not include this agent in search results unless required by the user.

e Enter an email address for the agent then from the drop-down list below this, select the
agent’s preferred method of receiving letters and documents

e Enter other relevant information for the agent, and click OK to save the Referring agent
with the new or altered information.

¢ Depending on the settings in the System Administration tool, a referring agent can exist
more than once at the same practice with different postcodes.

¢ Click Delete button to delete an agent from list.

¢ Click Close button to end the session with no action.
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9 Measurements

Click the button below to access our training materials.

The Measurements menu contains commands for accessing audiometry measurements:

e AB Audiogram starts a new audiometry measurement session. For more information
refer to Entering a pure tone audiogram

* ABR and OAE screening and diagnostics opens a new window for entering ABR (Auditory
Brainstem Response) and OAE (Otoacoustic Emissions) screening and diagnostic data.
Please refer to the ABR and OAE screening and diagnostics topic for details.

 Noah module selection opens Noah4Auditbase, an Auditbase subsystem that interacts
with Noah 4, and displays the list of Noah modules available. For more details on
Noah4Auditbase, please refer to Noah4Auditbase subsystem.

* Noah session browser opens the Sessions and actions panel of the Noah4Auditbase
subsystem.

¢ Open latest fitting action to open the appropriate fitting module if installed.

¢ Shortcuts to installed measurement modules are also available if required, for instance
Aurical Audiogram.

5-F7 Measurements
=] AB Audiogram
ABR and OAE screening and diagnostics
&) NOAH module selection
----- (=] Other speech test
&) NOAH session browser
-2 Open latest fitting action
B-&5 NOAH measurement modules
. Noah 4 Audiogram Module
&3 Primus Module

Auditbase stores audiograms by the date entered by the user, but Noah stores audiograms by
the date entered onto the system. To avoid old audiograms being used by Noah, any
audiograms entered into Auditbase with a date other than the current date will not be linked
into Noah. This will prevent Noah pulling an outdated audiogram through to other modules. For
further details please contact your local Auditdata support.

If an audiogram is saved in a Noah measurement module with a date before today, Auditbase
will save this and it will be linked to Noah.
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An audiogram saved from Noah Aud with a “Date of evaluation” in the past will be listed in the
Auditbase Audiogram list with a text like this: “Transcription of 10/07/2006 Audiogram Data”.
The date in the Auditbase audiogram list and the Noah session list will be the current date.

Audiograms with historical dates

If an audiogram is saved from Auditbase with a past date, the text in the Auditbase Audiogram
list will be Audiogram not linked to Noah (it is not available from the Noah environment). The
date in the list of audiograms will be the past date.

Noah Audiogram formats 100, 200 and 500 can be read, depending on settings in the System
Administration tool. Auditbase saves in 200 format, Auditbase cannot edit a 500 format even if
saved by Noah Aud.

Audiometer

The correct communication protocol is necessary to be able to configure audiometers. The

correct protocol can be selected in System Administration. Core audiogram data made by a
Noah module or panel cannot be edited in Auditbase except when created by the Noah Aud
module in format 200. The following data can be updated:

* Weber - on the main audiogram graph and on the separate tab;

¢ Setting notes for thresholds using right click menu;

¢ Information (notes, ear drum status etc.).

¢ If there was a note on a threshold, and users continue measurement and remove
the threshold, the note must be removed too;

e Referral;

e Vestibular;

¢ Speech in noise;

¢ Others;Surgery;

e Symbols which can be added to the audiogram using Import tymp;

¢ Simultaneous run of measurement and tymp is NOT needed.

e Entering tympanometry data manually on the Tymp tab;

¢ Import tymp data;

e Tympanometry reflexes - it is possible to add these using the mouse as well as by
using Import tymp and Measure tymp;

e Symbols which are allowed to be added to the audiogram include “Forehead bone
measurements”. These symbols are not included in the public part of Noah. The list of
symboils is included below:

¢ Bone / Other / Unmasked Left;

e Bone / Other / Unmasked Right;

¢ Bone / Other / Unmasked Left Not reached;
¢ Bone / Other / Unmasked Right Not reached;

e Compare tab

Tympanometry data

New Tympanometry algorithm for extracting data from Noah.
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9.1 ABR and OAE screening and diagnostics

¢ From the Navigation area, select Measurements -> ABR and OAE screening and
diagnostics.

e Toview and edit existing tests for the patient, choose a test from the drop-down list.

e Click on New, if you want to fill in a new test.

¢ You can edit the Date of test if needed.

e Age at test is calculated and fixed when saving.

* A special button is available for attaching the measurement to or detaching it from an
appointment. The button has a picture which reflects the state of the measurement:

iy +
either attached ( == ) or not attached (=~). In addition, the button has a tooltip that

displays detailed information about the measurement linking.

Attach appointment et
Attach Close
Diate | S].rmtml| Description Resource Status "
130162020 | IF fromd Res46 *
13/01/2020 7 2 Charlie *
1000112020 E| PHAC new p Charlie *
1040172020 1 1 Charlie *
090112020 3 PHAC new p Stassy *
09/01/2020 1 1 Reshd * o

e Ifthe appointment is linked to a referral, then the Referral stage, where the appointment
took place, will be shown here.

¢ Test type can be selected from the drop-down menu.

¢ Machine can be selected from the drop-down menu. This list will be defined by your
System Administrator. Yes, No or N/A can be selected to show the In-patient status.

e Transducer type can be selected from the drop-down menu. TDH or Insert phones can
be selected from the hard-coded options.

¢ Protocol can be selected from the drop-down menu.

¢ Outcome can be selected from the drop-down menu.

* The name of the Screener can be shown by clicking on the == button and selecting either
a user or a referring agent.

e Fill in the test and click Save.

¢ Print will send a copy of the report to the printer.

Please note that everything is measured in dBnHL.
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ABR and OAE screening and diagnostics X
Client MR JOHN SMITH Print New Save Delete Close
Tests - Created by SYSTEM ADMINISTRATOR M
Date oftest 10/01/2020 Age attest 79y &5 Referral stage Mot linked to appointment
Test type ~ Screener .| Machine ~ Transducer type I:I
In-patient  N/A - Protocol » Qutcome -
— RIGHT —LEFT
- OAE TE/DP - OAE TE/IDP
Automated ABR - - - - R -
Click ABR - dBnHL - - dBnHL
0.5kHz Tone Pip - dBnHL - - dBnHL
1kHz Tone Pip - dBnHL - - dBnHL
2kHz Tone Pip - dBnHL - - dBnHL
3kHz Tone Pip - dBnHL - - dBnHL
4kHz Tone Pip - dBnHL - - dBnHL
Bone conduction - dBnHL - - dBnHL
Cochlear microphonics - at dBnHL - at dBnHL
0.5kHz CERA - dBnHL - - dBnHL
1kHz CERA - dBnHL - - dBnHL
2kHz CERA - dBnHL - - dBnHL
3kHz CERA - dBnHL - - dBnHL
4kHz CERA - dBnHL - - dBnHL

Hearing Screening responses and key referral info can be recorded and then audited with a set
of Crystal Reports. These are found with other reports in Navigation -> User Reports -> Hearing
Screening and include the following:

¢ |n and Out Patients screened

¢ Number of screening sessions per patient

¢ Patients referred for diagnostic assessment
¢ Patients referred for targeted follow up
¢ Patients screened before some age

¢ Patients screened by particular screener
¢ Patients screened.
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9.2 Entering a pure tone audiogram

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

¢ Select Navigation -> Measurements -> AB Audiogram.

 [f configured by system administrator, the system opens the last audiogram. Select File ->
New to create a new audiogram.

¢ The audiogram can be shown in either split, single, large or custom format where custom
has a default zoom size that can be varied under the Zoom menu. The default mode is
defined by the system administrator. See How to toggle between split, single, large or
custom audiogram formats.

¢ Select the appropriate measurement symbol found in the centre of the screen for split
mode or right part of the screen for large mode.

e Enter the audiogram by clicking on the required threshold point.

e Right-clicking on a point will bring up a window where you can change the status of the
point to Not Reached etc.

e You can input information for right and left ear, comments to the measurements result
and in general and choose an audiogram type that are set up by your system
administrator.

° The audiogram type can be set as a mandatory field for saving a record.

¢ Select the Show in Viewer checkbox if you want the audiogram to be accessible from the
Auditbase Viewer.

e Select File menu, then Save.

o After an audiogram is saved, the Created date/time field will be filled in
automatically.

¢ Check date and Audiologist (Made by), change if necessary.

 Click OK.
[ Client T117575 MST FIRSTNAME17575 LASTNAME17575 - | 8 |5 H User John Smith All locations ~ | All departments - Q ?
Measure
10 125 250 500 1000 2000 4000 8000 SRT Ds DSN NORMAL T 0 125 250 500 1000 2000 4000 8000 SRT D8 D3N
[ Symbol 2
0 100 e} e 0 100
10 a0 | AC MASKED > 10 a0
BCUNMASKED A\
20 o o s O 20 e VSR SRS 80
0 e L BC MASKED ] T
20 \O/O " UeLum o 70
40 ] UCLM B 4 B0
50 5o M oMeLum M s 50
= ucLm [ |
60 40 60 40
% SF ]
70 EUIEy - 70 30
80 20 |® RIPSY B 80 20
0 1 | RIPSYH " w0 10
# R CONTRA *®
100 0 100 0
110 110
120 120
130 130
140 140
Audiogram type Right Left
~ [ Show in Viewer Threshold notes Comments Edit Mean values
Air 30 Bone Air 23 Bone
\
Reliable Watermark Info P ————— -
Eardrum status k
Audiometer no Created by
Created datefime 6/24/2024 13:05.53 Normal Normal
® Information | Referal | Speech | Speechinnoise @ Tymp | Compare | Graphical Speech | Others | Vestibular | Surgery
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If you enter audiograms via the device interface, the measuring points will automatically
be transferred from the audiometer used for measuring.

¢ To enter the measurements via the device interface, select the menu item Functions ->
Measure or click Measure.

¢ The button Measure turns yellow when active. Press Measure again to finish the
measurement.

Measure

NORMAL

{?| Symbaol
O AC

@ AC MASKED
FAY BC UNMASKED
A MOT REACHED
| UNCERTAIN
. CROSSOVER
C BC MASKED

L ucLum

UCL M

4 MCL UM

B mcLm

S sF

® SFM

® RIPSY

= RIPSYM

e R CONTRA

¥, on B o TPLYY VDX XD

* When using the Primus audiometer with insert headphones, measurement symbols will
be displayed using air conduction symbols. Right click on the curve to see if the
audiogram was carried out using TDH or Insert transducers.

e [f applicable, select the value for the Reliable flag: Reliable, Unreliable or Blank.

o If applicable, select the audiogram watermark. Unreliable and Estimated watermarks are
available by default. Additional watermarks can be configured in the Administration tool.
Selected watermark will display across the audiogram and appear on any printed copies.
The watermark will not display on an audiogram in Noah. If showing the audiogram to a
client and not wanting them to see the watermark, go the View tab and click Hide
watermark.
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<)) Auditbase - [AB Audiogram - 6/13/2024, no. 1]

File View Functions

== Masking levels Il web, —]

B8 E 5 E‘. H Masking levels U weber 3 world sounds =]

= Ol & Masking cursor [ Speech banana

BRI | single | Large | Custom | Selected zoom | NN [0 phoneme ; ounds D Morm-curve Age/Gender percentile curves  Irend graphs | Tympscale | Meanvalues | Hide watermark | Fitting ranges

Views Zoom Graph Options Other

The Auditbase keeps the Reliable flag values and the Watermark values consistent. If
you are setting the flag value or the watermark value to 'unreliable’, the other value
'becomes' unreliable as well.

In addition to pure tone graphs, an audiogram can contain results of the following
measurements as part of the audiogram:

Speech measurements.

Extended speech measurements in graphical representation.
Vestibular measurements.

Other measurements.

9.2.1 Saving Audiograms

Once the audiogram has been completed, select Save from the File menu to store the
audiogram.

When saving an audiogram, a dialog with client's name, system date and signature of
logged on Auditbase System user is presented.

If you want to have a Noah representation of the audiogram, select the check box Save
audiogram in Noah. This can be unchecked if you do not want to save to Noah. If the
audiogram has been saved using Measure, this must be deactivated before Save to
Noah can be unchecked. Save audiogram in Noah cannot be unchecked if a
measurement with the Noah audiogram module launch protocol v1 is in progress but it
can be unchecked for Protocol v1 and Protocol v2 measurements if the full screen mode
was not used. These protocols are set by the System Administrator.

If you want to sign the audiogram after saving it, select the check box Sign audiogram
now.

As default, Auditbase System will suggest the audiogram to be saved - and identified - by
the system date which may be altered by right clicking in the Date field to open calendar.

Change of signature - Auditbase System user - is done via E and selecting from list.

If another staff member performs the client hearing level investigation, you can select
this person as Examined by user on the Information tab. The system administrator
defines whether this field is visible.

When more audiograms are saved by the same date, they are numbered consecutively;
DDMMYYYY1, DDMMYYYY2.

There are no limits to the number of audiograms for a client.

Click OK to save the audiogram with the suggested or changed parameters or press
Ctri+S.

Retrieving saved audiograms from database is done via the File menu, Open.
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¢ A dialog with lists of audiograms saved for a selected client is presented. The audiograms
are displayed with audiogram name, date, no., whether or not it is signed, audiogram type
and comments. A Preview option is also available. This will open the selected audiogram
in a separate window so that it can be previewed before being opened.

¢ To retrieve the client’'s most recent audiogram without selecting in the list, select File ->
Open latest, or press Ctrl+L.

¢ In the Administration tool, the system can be configured to open the client’s most recent
audiogram automatically.

9.2.2 Signing audiograms
You can sign an audiogram when you save the audiogram.

¢ This functionality can be switched on or off by the system administrator.

¢ You can also sign an existing audiogram from Functions -> Signh audiogram.

¢ You are reminded to link the Audiogram to an appointment when signing.

* Previously signed audiograms can be linked to an appointment if required.

¢ You can see whether an audiogram is signed, in the main window of the audiogram, in
the Open audiogram dialog and in the Noah browser.

Note: If you sign an audiogram, the audiogram cannot be edited.

If a signed audiogram is edited or deleted in Noah, the link to the Auditbase audiogram will
be broken.

9.2.3 Deleting audiograms

Deleting an Auditbase audiogram can be done from the Functions menu but only by a user that
has been granted the extended user right Delete Audiogram or linked Noah audiogram by the
System Administrator. By selecting the Delete audiogram button, a window opens and the
audiogram can be chosen from the list and Delete can be used to delete the audiogram. Close
will close the window without deleting an audiogram.

Another button on the Functions ribbon to Delete linked Noah audiogram will delete the Noah
action associated with the selected audiogram, but this is an extended user right that must be
granted by the System Administrator. This action will be refused if a Noah fitting is based on
Noah action.
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9.3 How to toggle between split, single, large or custom
audiogram formats

¢ In the audiogram screen, select View -> Split audiogram, Single audiogram, Large
audiogram or Custom audiogram as required.

% 0)) Auditbase - [AB Audiogram - 6/13/2024, no. 1] - O X
File | View | Functions
et B Masking levels [ wWeber |
BE E 5 _F. 3 = i X warld sounds =]
— P ®\ & Masking cursor Speech banana [ A Z
spitt | single | Large ||Custom| Seleciedzoom | ETEReRERTREE 10 ohoneme soun s S Weimicinie]  Age/Gender percentile cuves  Trend graphs | Tympscale  Meanvalues | Hide watermark | Fitting ranges
Views v m%;g Graph Options Other
Client  T117575 MST FIRST 0 NAME17575 -9 User John Smith Al locations ~ Al departments - 9
A
Symbal list Measure
125 250 500 10 60% 00 8000 SRT DS DSN Audiogram type
L I e e B 1T T 1 B Show in Viewar

e Custom audiogram has a default zoom size that can be varied from the Zoom menu,
which is only available when Custom is the selected view. The percentage of zoom refers
to the audiogram only and is based on how large the audiogram would look on a
1024x768 screen resolution. It defaults to the zoom level set by your system
administrator. This view is intended particularly for working with a device interface.
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9.4 Other view options

In the View ribbon choose to display Masking levels, Masking cursor, extended range up to
140dB, Speech banana, phoneme sounds and world sounds. The content of the latter two can
be configured by your system administrator who also can set up if the Masking cursor should be
turned on by default.

9)) Auditbase - [AB Audiogram - 6/16/2024, no. 1, PTA]

File View Functions

—_— EJ Masking levels ] Weber —]
[} T - ;?3 World sounds -“ % . E
@ E 5 5." & Masking cursor [ Speech banana [ EZ|
Split Single Large  Custom Selected zoom % e At e [arﬂ Phoneme sounds E Morm-curve Age/Gender percentile curves Trend graphs Tymp scale Mean values | Hide watermark Fitting range:
Views Zoom Graph Options Other
Client T117575 MST FIRSTNAME17575 LASTNAME17575 - e User John Smith All locations ~ Al depariments -
L] AIZ|B
Navigation
B Favourites
=32 Device list )
i Repair list 10 125 250 500 1000 2000 4000 8000 SRT DS DSN i
+[38 Purchase orders N
= Requisition F
5] AB Audiogram 0 100
10 90
Individual client
o ; 20 80
-3 Clientinformation |
-{i Paediatric |
£2] Journal 30 2 o 70
] Documents and attachments \\ /
40 TS L T % x 80
55 Referal
-2 Client's entries \\ / 1
[ Device list 50 e 50
-E4 Observations and procedures
= Earmoulds 60 40
[f] Medical history
20 Hearing Therapist 70 30
-5, Direct referral HA (adult)
{12 Tinnitus 30 k. 20

Audiogram static norm curves can also be shown from the View menu. Such curves are defined
in Auditbase Administration: a specific curve can be selected for a specific workstation to be
displayed as default. All available norm curves are listed in the Norm-curve pop-up. You can
switch between them as required.

Based on data from ISO 7029 users can now display age and gender specific dynamic hearing
loss distribution percentile curves. The percentile value used can be chosen in Auditbase
Administration on a site level. The curves can be enabled or disabled on a Workstation level in
Administration.

Special considerations:

¢ If the patient has no DoB (date of birth) or the age is out of range of the ISO 7029
standard there will be no percentile curves. Curves are generated for ages 18-80.

¢ If the patient gender is not set to 'Male' or 'Female', there can be no curve generated
since there is no ISO 7029 data.

e [f the clinician wishes, they can override the automated gender-based curves and view
curves from the ISO standard for another gender for a particular patient’s audiograms.

¢ If the clinician wishes, they can turn off the curves during review of a particular patient’s
audiograms.

Clicking the Mean values button opens the dialog with mean values for the selected
audiogram. Mean value configurations are set within Auditbase Administration.
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6/16/2024, no. 1, PTA X
Mean value Air | Air | Bone | Bone
Fletcher index 38 |43

High frequency mean |33 43

9.4.1 Fitting ranges

On clicking the Fitting ranges button, the floating dialog appears with a list of manufacturers'
devices. Each device has a configured fitting range that can be applied to the audiogram to see
if that device is suitable for the selected patient. At the bottom of the dialog, users can view
additional information which may be helpful when working with a particular device (e.g., age
restrictions).

It is possible to keep the dialog open and use the corresponding fitting range as reference when
looking through different audiograms of the same patient or when switching between patients.
Arrow keys can be used to move up and down the fitting ranges.

Fitting ranges configured as groups in the Administration tool are organised as folders in
Auditbase. Clicking into the folder, opens it up displaying the items in that group.

You can select the fitting side (Right, Left or Both). In split mode, the range for the affected ear
and the opposite ear is distributed between two graphs. In single view, the colours for the
affected and the opposite ear are shown on the same graph.

|
File | View Functions
. wels U W
& 5 B Ses Lo e N O =) =
| — - £ Masking cursor [ Speech banana
Split  Single Large Custom  Selected zoom S Norm-curve  Age/Gender percentile curves  Trend graphs | ympscale  Mean values | Hide watermark |Filting ranges
- R Extended range | [af] Phoneme sounds - - -
| Views Zoom Graph Options Other
[L] | Client T110025 MRS FIRSTNAME10025 LASTNAME10025 - 9_\ 5 | B || User SysAdm Alllocations ~ All departments - ¢ ?
|
| Measure
| 10 125 250 500 1000 2000 4000 8000 SRT DS DSN NORMAL - 10 125 250 500 1000 2000 4000 8000 SRT D3 DSN
| ‘ = Symbol fed
0 100 [ S 0 100
10 Fitting ranges X 90
20 80
20 Fitting side R L= = 70
\ D
| a0 O——0— TMed-El Synchrony CIS - Unilateral - X“ﬂx\ 60
50 ) [ Bone conduction X\‘X 50
| \ Med-El Soundbridge - Sensorineural
| 80 < Med-El Soundbridge - Conductive X 40
\ Med-El Bonebridge \
| 70 o Ved-El Adhear ¢ 30
| 20 Med-E| Bonebridge - Unilateral 20
Cochlear Europe Baha 6 Max
| ao Cochlear Europe Osia System 10
[ Cachlear Europe Baha 5 Power
100 Cachlear Europe Baha 5 0
| Cochlear Europe Baha 5 SuperPower
| 1o v
| 120 Age 5years or older -
130
140
-
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The dialog can be resized to best fit your screen. It can also be collapsed when needed by using

2

the collapse control (-~ /). To view available range colours, click

R L  Affected side
Airand bone conduction

Bone conduction only
Air conduction only

Contralateral
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9.5 How to view previous audiograms

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

¢ Navigation -> Measurements -> AB Audiogram.

e Select File -> Open.

e The audiograms are displayed with audiogram name, date, no., whether or not it is
signed, audiogram type and comments.

° The audiogram list is a configurable list where column position width and multiple
sort order can be saved for the logged-on user or for a site when saved by the
SYSADM user.

° The Audiogram list is resizeable by dragging any of the four borders to the required
size.

e Make the changes you wish to the table and right-click anywhere in the table.

» Select Save user view.

¢ Click on the audiogram to be viewed.

¢ Click Select. Alternatively, click on the required audiogram and it will be selected in the
background module. Double clicking an audiogram will select it and close the window
automatically.

Audiogram list 4

Select Close

Audiogram Mao. [ Signed | Type | Comments | Preview | Surgery

Bl Audiogram changed in AB 1

Bl AURICAL Plus Audiogram changed 12/02/2010 1 Preview
Bl MewaAudiogram Q7282010 1 Preview
Bl Mewaudiogram 03172010 1 Preview
B AURICAL Plus Audiogram changed 08/06/2009 1 Preview
Bl Audiogram not linked to MOAH 05/06/2009 1 Preview
Bl MewaAudiogram Q22172008 1 Preview
Bl Audiogram changed in AB 08232007 1 Preview
Bl Audiogram Changed in AB 09/28/2005 1 Preview

e The Audiogram list can be left open when changing clients, and the list of audiograms for
the newly selected client will be displayed. The Audiogram list will remain in the same
position when clients are changed, including after Auditbase is restarted.

To open the latest audiogram:

e Select File -> Open latest or click the button Client’s latest audiogram in the tool bar
from anywhere in Auditbase B,
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Speech R Speech L
SRT Mask. UCL || SRT Mask. UGL | Bing
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e The audiogram title bar includes client identifier code, client name, date, number and
audiogram type.

¢ Displaying Tympanometry and Speech data on this dialog can be switched on or off in
Auditbase Administration.
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9.6 Viewing more than one audiogram at a time in the same
graph
To view up to 4 audiograms superimposed on top of each other.

¢ From the audiogram screen, select File -> Open.

e Select the first audiogram to be viewed and click OK.

¢ Select the Compare tab.

e Select up to 3 audiograms from the drop-down lists which display the audiogram date,
number and type.

¢ Click on each colour box and choose the colour required by clicking on it.

¢ Click Refresh to display the selected audiograms.

* To close the screen and return to the original audiogram, click Clear all.

Add in
Audiogram Colour
12/02/2010, 1 -

I
=
0712812010, 1 i |
[

03/17/2010, 1 -
Refresh Clear all

View side by side

To view up to 4 audiograms side by side:

e With the Compare tab active, click View side by side. Displaying Speech data on this
dialog can be switched on or off in Auditbase Administration.

e Select an audiogram in the drop-down list for each of the 4 audiograms. The last 4 of the
client’s audiograms are pre-selected by default.

¢ Click Preview or Print as required.
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9.7 Adding notes and comments to an audiogram

To add comments to an audiogram:

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

¢ Navigation -> Measurements -> AB Audiogram.

e Select File -> Open or add an audiogram.

¢ On Information tab, select Edit or Alt+R.

¢ A Comments window opens. Comments can be added to the audiogram and they will be
displayed when printed.

¢ OK to save the comments.

To add a note to an audiogram:

¢ Press F3 to search for the client or Ctrl+F3 to make a quick search.

e Select Measurements -> AB Audiogram.

» Select File -> Open or add an audiogram.

¢ Right click on the threshold you wish to add a note to.

¢ One of the options is Set note.

¢ Select from the drop-down list which note is to be added. These notes are defined by your

System Administrator.
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9.8 Tympanometric tab

Discrete tympanograms and reflex thresholds can be entered for the Tympanometric
measurement or data can be transferred directly from: the Zodiac 901 connected to a COM
port or from Noah sessions created by any module using the Noah Tymp 100, 500 or 501 data
format, e.g. Otoflex module, Otowave, Titan, GSI Suite, Capella module or the Zodilink module.
Data from any module that stores tympanometry in the standard Noah 100 or 500 format can
be measured or imported see below.

One of the 3 tymp curves imported from Noah sessions or direct from Zodiac can be set as
default for printing and Audiological Summary Reports. If none is set, the system will default to
the highest number of curve sets available.

Since no Noah standard exists for Tympanometric data no other Noah modules can be used
unless the manufacturers work with Auditdata to define a standard protocol.

Import of data can only be done when not in an audiogram measurement mode.

¢ Use Measure button to open the Tymp module configured in Administration which will
automatically import into Auditbase on saving.

¢ Use the button Import tymp to import data from the instrument or a Noah session. Up to
three tymp curve sets can be represented. Choose between curves in the drop-down box
Selected curve.

¢ The date of the measurement can be changed manually when importing from a Noah
session.

¢ If reflex thresholds have been measured, these thresholds will be drawn as thresholds in
the pure tone audiogram.

e The scale factor for the tymp curves is read from the default setting in Administration
settings -> Workstation -> Audiogram. To overrule this default setting, select View ->
Tymp scale. The scaling is reset to default when selecting a new audiogram or a new
client.

¢ You can print the pure tone audiogram and tymp information in one report. Select File ->
Print and choose Audiological Datasheet. Either split or binaural audiograms can be
printed.

e Imported tymp data can be reset in Functions -> Reset tymp data. Reset option is
available to senior users (clinical staff) who were granted this right via Auditbase
administration.

Note: It is not possible to create reflex thresholds with the Capella module.

When importing data directly from the Zodiac instrument the Zodiac should be connected to the
PC via a COM port.

The following parameters will be imported along with the tympanograms if they are available:
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e ECV = Ear Canal Volume: volume unit

e SC = Static Compliance (mmho)

¢ MEP = Middle Ear Pressure (daPa)

e Gradient: (daPa)

e Tymp Width = Tympanometric Width: daPa
¢ Frequency (Hz)

e Type =A,Ad, As, B, C, D, (E)

Detailed information on the interpretation of impedance data in Auditbase.
Reflex thresholds imported to Auditbase.

The reflex thresholds that are imported directly from the Zodiac or from a Noah session created
by Otoflex, Capella or Zodilink are all interpreted using the following algorithm:

Example: Zodiac, 500 Hz stimulus, Ipsilateral:

Intensity dB HL 70 75 80 85 90

Actual deflection mmho or ml/cc/cm3| -0.01 0.45 -0.01 -0.03 -0.08

Reflex result bit False True False True True

Example: ODS/Otoflex, 500 Hz stimulus, Ipsilateral:

Intensity dB HL 70 75 80 85 90

Actual deflection mmho or ml/cc/cm3| -0.01 0.45 -0.01 -0.03 -0.08

Reflex result bit False False False True False

The way to identify the threshold value is:

If there is one and only one curve with both test Type = 'reflex' (i.e. manually measured) and the
result bit set, this is taken as a manual indication of the threshold and is thus considered the
final result. The procedure then ends here.

Otherwise:

Search all curves of test Type = 'reflex' or 'autoThresholdSearch' (can be mixed) from the
highest stimulus intensity presented and downwards for the lowest intensity curve with an
absolute positive or negative deflection value > = 0.02 or the result bit set, i.e. the last in the
search direction that is not preceded by another curve fulfilling this criterion.

Now change search direction to increasing intensities and search for the first curve that has the
result bit set. If a curve is found with the bit set, this curve (stimulus intensity) represents the
threshold. If no curve is found with the bit set, the result must be indicated as 'no threshold
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found at xxx dB HL' where xxx is the highest stimulus intensity that was presented, i.e. the
highest intensity recorded in the curves.

This procedure will identify 85 dB HL as the threshold in both examples above. Note that 75 dB
would not be considered a threshold in the Zodiac example even if the result bits for 85 and 90
dB were not set as the downward search would still stop at 85 dB.

Imported tympanograms

The tympanograms that are imported directly from the Zodiac or from a Noah session created
by Otoflex, Capella or Zodilink are all interpreted in the following way:

The tymp curve is displayed using the unit from Noah. However, if a volume unit is indicated in
Noah and the probe tone used is not 226 Hz, the tymp curve (every point of the curve) is
recalculated as:

Actual tymp = Noah_tymp * probetone / 226
and the actual unit is mmho.

Tymp baseline compensation:

Where a Noah Tymp module requires it, curve compensation can be applied even when it is
declared as already applied in the measurement.

The tymp curves are displayed baseline compensated when possible.
The curve may have been stored baseline compensated in Noah (recordMode=Compensated').

If the curve was stored 'non Compensated', the ear canal volume * probetone / 226 is
subtracted from the curve (every point of the curve) values to calculate the baseline
compensated curve. If the ear canal volume is undefined, the curve is displayed as non-
compensated.

Tymp ID can be edited manually when a tympanogram is imported from Noah or measured in
Auditbase, to make it possible to record the Tympanometer details when using different
tympanometers in the same room.

If several tymps are present and must be displayed together, all of them will be displayed as
non-compensated if one or more of them cannot be displayed compensated (if stored non-
compensated and the ear canal volume is undefined). Measurements at different frequencies
are grouped according to frequency on the same ear.

The parameters belonging to the tympanograms are determined in the following way.
Derived parameters:

The height of the peak from the baseline is denoted either Static Compliance (SC) or Static
Admittance (SA). The term SA is used for all cases except for 226 Hz tympanograms with a
volume unit (ml, cc, cm3). SA (= SC) = maxCompl - canalVolume * probetone / 226

TPP = Tympanometric Peak Pressure
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TW = Tympanometric Width: daPa
Gradient: mmho/daPa or volume_unit/daPa
ECV = Ear Canal Volume

Type =A, Ad, As, B, C, D, (E)
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9.9 Tabbed pages for other types of measurements

In addition to pure tone measurements, you can register, store and print a variety of other data.
The following data may be processed:

e For speech measurement results, select the Speech or Speech in noise tab.

e For tympanometry results, select the Tymp tab.

e For speech measurement results in extended graphical form, select the Graphical
speech tab.

e For Bing, Rinne, Jelly and Weber measurement results, select the Others tab.

¢ For vestibular measurement results, select the Vestibular tab.

@ |nformation | @ Beferral | Speech | Speechinnoize | Tump | Compare | Graphical Speech | Others | Yestibular | Surgen

Once a tab has been selected, changing the audiogram or client will not change the selected
tab. When Auditbase is re-started, the default tab is selected. If information has been stored on
any of the tabs, a green circle will indicate this.

NOTE: the number of tabs to appear in the Audiogram module can be configured by the System
Administrator. Any tab (except 'Information') can be set to be hidden from view.

Information tab

The Information tab is for storing general data for each measurement; for instance, notes,
comments, audiometer number.

Notes can be added to a particular threshold by selecting the threshold, right-clicking and
choosing Set note. These notes are defined by the system administrator and will appear on the
audiogram when it is printed.

Comments can be added to an audiogram by selecting the Edit button and inserting free text
notes. These are displayed on the audiogram when it is printed out.

Mean values, calculated for Air and Bone conduction as the average of frequencies defined by
the system administrator, for instance 500, 1000 and 2000 Hz thresholds. Mean value type to
display can be selected on this tab.

Right Left
Mean values

Air 56 Bone 46 Air EE  Bone 49

Fletcher index -

Fletcher index

High frequency mean

Mormal Mormal
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Referral tab

The Referral tab is for storing data about a referral, referring agent, and observations or
procedures. The appointment which the Audiogram is related to is shown here and can be
changed by using the Attach and Detach buttons. The referral in which the appointment takes
part is also shown.

Speech tab

The Speech tab is for storing numerical speech audiograms, including, SRT, UCL, recognition
percentages and masking levels. The following results can be entered:

¢ Type of measurement. Select from the drop-down list between Normal, Aided, Tube,
Noise or Insert phone.

¢ SRT (Speech Recognition Threshold).

e Mask. (Masking level). For masked speech recognition measurement.

¢ UCL (Uncomfortable level).

e Max recognition 1, 2, and 3: For each type of measurement, Recognition %, dB level and
masking level can be entered.

You can choose to display the speech measurement results graphically as an extension of the
pure tone audiogram. The system administrator configures this extension and its content.

The values displayed in the speech extension are the following:

e TC (Mean value of pure tone measurement)

¢ SRT (Speech Recognition Threshold)

¢ DS (Discrimination Score) or DL (Discrimination Loss). Max recognition 1 is shown as DS
or DL.

e DSN or DLN (Discrimination Score in Noise or Discrimination Loss in Noise). Max
recognition 2 is shown as DSN or DLN.

e DS, DL, DSN and DLN are treated as masked when a corresponding masking level is
specified. The following symbols are used to show values in the speech extension graph:

e For TC: air normal unmasked

e For DS and DL: air normal unmasked or masked

e For DSN and DLN: sound field normal unmasked or masked

e For DS, DSN, DL and DLN: free-field aided masked and unmasked.

Note: Masking is not used for SRT

For both pure tone measurement and speech extension the results of speech measurement
can be obtained using the Aurical module.

The data entered in the Speech tab is part of the audiogram and can be saved with the entire
audiogram.

Speech in noise
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Under Speech in noise you can register measurements of speech tests in noise with headsets.

Base calculation of Expected result and High frequency mean 10/01/2020, 1 -
Right Left
Result, % Level, dB Masking, dB Expected, % Result, % Level, dB Masking, dB Expected, %

Test1 = |+ 23 50 Test1 = |+/[12

Test2 = |- Test2 = |-

PTA4 High frequency mean value PTA4 High frequency mean value
Comment Comment

First choose which audiogram to base the expected result and the high frequency mean value
on. Choose the current audiogram or a previous one.

The values from the selected audiogram will be stored under PTA4 and High frequency mean
value.

You can make two tests, where you register the result in percentage, the level in dB and the
masking in dB. If you perform the test with an audiometer with control panel for Auditbase, the
result fields will be populated automatically. Your System Administrator can set the system up
to do this.

Use the drop-down list to qualify the result by either choosing the equal to sign (certain of the
test’s accurateness), the less than sign (the result is probably not accurate) or the more than
sign (the result is probably not accurate).

The Expected result is calculated based on the test results and the PTA4 and High frequency
mean value numbers.

Compare

The Compare tab is for viewing previous audiograms simultaneously, either together on the
main screen or side-by-side on the screen that opens when pressing ‘View side-by-side’.

Graphical Speech tab

Extended results of speech measurements can be registered in the form of a graphical speech
audiogram in the Graphical Speech tab.

¢ As for pure tone audiograms, a symbol must be selected.

¢ The symbols for the following speech measurement types are defined by the system
administrator, by default different symbols are set up according to country. The default
can be selected and then the default mappings will be used when the word list is blank
from the Noah module or when there is no mapping for the specific word list being used.

° single phoneme
double phoneme
triple phoneme
° three-digit words

[e]

[¢]
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* Additionally, different symbols can be defined for the following measurement conditions:

° normal
° aided
free-field
° binaural

o

» Different symbols can also be defined for masked and unmasked measurements.

¢ The condition is selected in the drop-down list above the symbols list.

¢ The symbols can be placed into the required position (determined by dB level and
recognition percentage) on the left or right ear graph by clicking.

¢ Show norm-curves will, if ticked, overlay the graphs with norm-curves. Up to 3 norm-
curves can be shown on each graph. The norm-curves are defined and selected in the
System Administration tool.

¢ Comments can be added to a Speech Audiogram. Selecting the right button below the
Symbol table will open a window where comments can be added. OK will save the
comment; Cancel will close the window without saving the comments. Once the comment
has been saved, hovering the mouse over the Comments button will show a tool tip with
the comment displayed.

* To see more details and edit it more precise, you can get an enlarged speech audiogram
by clicking the left button below the symbol table.

e The graphs on the Graphical speech tab will be updated when you Close the window.

* As for pure tone measurement, the results of the speech measurements can be obtained
using the Aurical module. The Max. discrim. 1 and Max. discrim. 2 measurement types in
Aurical are treated as single-phoneme and double-phoneme by Auditbase. To register
results of other measurements, the symbol must be defined in Auditbase first.

¢ Data entered in the Graphical Speech tab is part of an audiogram and saved with the
entire audiogram.

e To print a graphical speech audiogram, select the File -> Print audiogram menu item and
select one of the options for printing the graphical speech data in the Print audiogram
window.

¢ If using the Primus audiometer and your System Administrator has carried out the
necessary setup in administration, the graphical speech test curves will appear in AB
audiogram on the Graphical speech tab. If Graphical speech is not licensed then the
results will still show but only on the Speech tab as summary totals.

¢ Using the button on the ribbon users can override the Site and Workstation options for
import Graphical Speech from Otosuite Module full screen into either Graphical Speech
tab or numerical Speech tab.

NOTE: Auditbase Audiogram module does not handle binaural speech thresholds coming from
Noah.

Others tab
Results of Bing, Jelly, Rinne and Weber measurements can be registered in the Others tab.

All Bing, Jelly, Rinne results are entered as blank, +, -, F+, F- for both right and left ear.
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+ Positive
- Negative
F+ False Positive
F- False Negative

To change the value, click in the corresponding field to see the next possible value.

The Weber result is entered in the same way. The possible values are:
Not measured (blank), R (Right), L (Left), C (Centred), Uncertain, Not reached.

The values are represented by the Weber audiogram symbols defined by the system
administrator.

Data entered in the Others tab is part of an audiogram and saved with the entire audiogram.
The Bing, Jelly, Rinne and Weber results are printed on the 4 Audiograms printout.

Vestibular tab
Results of vestibular measurements can be registered in the Vestibular tab.
The following data can be entered:

¢ The name of the audiologist performing the measurements: Select the from drop-down
list of registered Auditbase users.

* Were goggles used: Select Yes or No.

¢ Spontaneous nystagmus and Positional nystagmus characteristics: Enter text up to 250
characters.

e For both left and right eye, reaction time in seconds for either 30 degrees or 44 degrees:
Enter values from O through 240 manually or use the slider.

e Comments: Enter text up to 250 characters.

e Data entered in the Vestibular tab is part of an audiogram and saved with the entire
audiogram.

¢ The results of vestibular measurements can be printed by selecting the menu item File ->
Print audiogram. Select the Vestibular measurements option in the Print audiogram
window.
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9.10 Printing an audiogram

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

e Select Measurements -> AB Audiogram.
e Select File -> Open.

» Select the required audiogram and highlight it.

¢ Select File -> Print Audiogram.

¢ Choose the required formats by checkmark and the amount of copies and click Print.
¢ Or, click Preview to preview printout on the screen before sending to printer.

Print

Preview Print Close

s

Printer
Microsoft Print to PDF

Print type
| | |1_|§ Large audiogram printout
L] |‘I—|§ Split audiogram printout
|‘I—|§ Small audiogram printout

1 & Split small audiogram printout

-

1 B Audiological summary printout

-

1 & Audiological data sheet printout

-

1 & Audiological split data sheet printout

-

1 & Vestibular measurements

-

1 & Speech audiogram with large pure-tone printout

1 IZ: Speech audiogram with split pure-tone printout
1 & Speechin noise printout

-

| | 1 IZ: Large speech audiogram with split pure-tone printout

1=

-

Place client and user identification on clipboard

If the box labelled Place client and user identification in clipboard is checked then when
printing to a PDF printer, the Audiogram date, username and client Primary code are saved to
the clipboard. If the report is to be saved electronically using a PDF printer, rather than printing
to paper, the clipboard can be pasted into the ‘Save’ dialog generated by the PDF printer to

provide a descriptive filename when saving.

This check is maintained for the user for subsequent logins until unchecked.
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9.11 How to enter into Noah

Noah can be entered from Navigation -> Measurements menu or from the Client Pathway
Overview.

B2 Measurements

=] AB Audiogram

ABR and OAE screening and diagnostic
{2 NOAH module selection

..... @ Dtherc‘ghﬂ: CiteM

O Noan(Shift: Curke M

{2 Open latest fitting action

E-£5 NOAH measurement modules

When the client is specified, go to the Auditbase Measurements menu and do either one of the
following;:

¢ Click Noah module selection to open Noah with the Modules panel expanded.

» Click Noah session browser to open Noah with the Sessions and actions panel of
expanded to view a list of the client's previous Noah sessions.

¢ Click Open latest fitting action to open the most recent fitting action if the fitting module
is installed.

¢ Click the links at the bottom of the menu representing any installed measurement
module to open that module.

¢ On slower PCs Auditbase may be logged in before Noah is fully running and usable. In this
case you Wwill receive an information message and should wait a few more seconds.
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9.12 Using Noah

In Noah, there are three sections: Client details, Modules and Sessions and actions.

'4 Noah4Auditbase - Business System
File Setup Help

@ i Name: LASTNAME120, FIRSTNAME120 (MRS) Birth date: 19-Aug-1929 Gender: Female NHS no.: Hospital no.: T1120 2z

All | Measurement | Fitting | Other
—l| Audiogram & 2 Journal &~ 7" Questionnaire
e - -
g Module / Module / Module
On the "All" tab right click on the bar to configure modules order

O] semomsnasemons

["] Sort in Ascending order

4 6/13/2024

= New Audiogram | MAKKNY| 16:40 | [B'2"" Noah 4 Audiogram Module % Delete Action @ Fast Data view
[E] cosl | MAKKNY | 16:31 | % " Noah 4 Questionnaire Module ® Delete Action @ Fast Data view
Annual check up | MAKKNY | 16:24 | % Journal Module K Delete Action @ Fast Data view

4-Figure2-1.png | MAKKNY | 16:24| % 227 Journal Module K Delete Action

I 8/30/2013
8/23/2002
F12/1/2001

The basic client identifying information is shown at the top of the Noah4Auditbase window. To

view additional client information within the Noah4Auditbase subsystem, click the button (®)

beside the title of the Client details panel. This will show the client's address and create date
and user.

Note: By default, client details for sites in UK are displayed to follow NHS CUI requirements
which assume applying a number of rules and formatting options; client details for sites
outside UK are displayed by default without meeting NHS requirements. This setting is
configurable with the System Administration tool for any country.

In the Modules panel of Noah4Auditbase the following commands are available:

¢ Click the corresponding module in the module list to start a new fitting or measurement
session.

e To customize your Module order right-click the module list and choose Arrange Module
Order to open the Module Bar Configuration dialogue box. This order is saved per user
into the database so will be available from any workstation.

¢ On the corresponding tab, view the Noah modules of the following types if available:

° All modules

° Measurement modules
° Fitting modules

° QOther modules

¢ Any Noah module opens in a separate window and is represented by a button in the
Windows taskbar.

¢ |f you want to open a Noah module when another one is running, you must return to the
Noah4Auditbase window and click the corresponding item on the Modules panel.
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¢ All Noah modules opened under Windows 7 are grouped under a single taskbar button.
Click this taskbar button to open a menu listing all the Noah modules running.

9;.1 MNoah4Auditbase - Business System
File Setup Help

@ Name: LASTNAME120, FIRSTNAME120 (MRS) Birth date: 19-Aug-1929 Gender: Female NHS no.:

Al Measurement | Fitting | Other
% Audiogram &2 Journal &’ Questionnaire
Module / Module =27~ Module

On the "All’ tab right click on the bar to configure modules order

Select the Sort in Ascending order checkbox above the session list to switch to the ascending
ordering of sessions. BSA shadow masking symbols are not included in the Noah standard:
therefore, they will not be transferred to Auditbase on saving the audiogram in Noah.

Q] semonsnascioms

[] Sort in Ascending order

4 6/13/2024
= New Audiogram | MAKKNY | 16:40 | @82 Noah 4 Audiogram Module ~ % Delete Action @ Fast Data view

COSI | MAKKNY | 16:31] %7 550" Noah 4 Questionnaire Module 3 Delete Action @ Fast Data view
Annual check up | MAKKNY | 16:24 | % %Y Journal Module K Delete Action @ Fast Data view

4-Figure2-1.png | MAKKNY | 16:24 | % Y Journal Module K Delete Action

Be aware: BSA shadow masking symbols are now included in the Noah standard 502:
therefore, they will only be transferred to and from Auditbase on saving the audiogram in Noah
if the module supports this.

For the Serial number issue from Noah dialog see Section 12.4.

On the Sessions and actions panel of Noah4Auditbase you can view a list of clients' previous
Noah sessions. The following commands are available on the Sessions and actions panel:

¢ Click on the arrow or plus icon (depending on Windows version) to the left of the session
date to view the actions. Referenced actions such as the audiogram a fitting is based on
are nested underneath.

¢ Click any action to open it with the corresponding module if installed.

» Click the Delete Action button to the right of the action description to delete it.

* Noah alerts can be opened from the Noah Session Browser.

¢ The audiogram that a fitting session is based on can be opened from that fitting session
in the Session Browser.

9.12.1 Deleting Noah actions

If you do not have the correct extended right issued, you will see an error message like the
following:
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You have not been granted the extended right 'MOAH: Delete actions’
by your system administrator. Cannot delete Noah actions

In this case, contact your System Administrator to grant extended rights for deleting Noah
actions.

If an attempt is made to delete an audiogram that has a later fitting based on it, a message will
appear denying deletion of the action.

Cannot delete the action.
¥' This action is referenced by some other action(s). Cannot delete.

Note: If you don’t have will need both an extended user right and a specific table right rights to
delete Noah actions. When the extended right is assigned the table rights are automatically set,
but table ‘delete’ rights could erroneously be removed later. If you do not have the correct table
right issued, an error occurs within Noah which cannot be caught by Auditbase and processed
correctly.

Therefore, you will see an error message from Noah like the following:

Cannot delete the action.
Security violation attempting to access

In this case, contact your System Administrator to reassign the extended right grant table rights
for deleting Noah actions which will correct this.

9.12.2 Fast Data View

If the Noah module supports it, a summary of the Noah action can be shown in a pop-up image
or PDF by clicking on the
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> Fast Data view
| icon. The icon will only appear if the module supports Fast Data View. A local

copy of this image or document will be created and you must close the preview of the image or
document for Auditbase to delete it. If you do not close the image or document, it will remain
open when changing patient and could lead to confusion.

[] Sort in Ascending order

4 6/13/2024

= New Audiogram | MAKKNY | 16:40 | &&= Noah 4 Audiogram Module ~ 3 Delete Action

COSI | MAKKNY | 16:31 | 57 &5 Noah 4 Questionnaire Module 3 Delete Action @ Fast Data view
Annual check up | MAKKNY | 16:24 | % . Journal Module ¥ Delete Action @ Fast Data view

4-Figure2-1.png | MAKKNY | 16:24| % 2 Journal Module K Delete Action

AWARNING: Do not forget to close the Fast Data View document manually since Auditbase
cannot close it automatically.

Be careful with patient content, Auditbase cannot warn users that a Fast Data View document
is still opened for a client when users select a second client.

9.12.3 Noah alerts Dashboard

On the right-hand side of the Noah toolbar the globe icon @ opens the Noah Alerts
Dashboard. Noah alerts could be created when a hearing instrument wearer activates one
using the mobile App supplied to them by their hearing instrument manufacturer and when the
Noah Mobile APl is enabled in your Auditbase by your System Administrator.

-;a Noah4Auditbase - Business System
File Setup Help

® Mame: LASTNAME120, FIRSTNAME120 (MRS) Birth date: 19-Aug-1929 Gender: Female NHS no.: Hospital no: TT1120 - &

When the Globe has a red element @'that indicates that there are one or more unread Alerts in the

Dashboard. When every Alert has been viewed by any user then the red element is removed from the
icon.

Opening the Noah Alerts Dashboard reveals the list of Alerts for all patients who the Auditbase
user has permission to view. They will not see any Alerts linked to patients who they are not
allowed to access, either due to the patient belonging to a Location that the user has no rights
to access or due to the patient having only limited named users allowed to access them.

¢ Unread Alerts are shown in bold. Alerts with the Priority flag set have a red flag next to
them.
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* When an Alert is selected the detail appears in the right-hand panel showing the
description from the patient. A specific Noah user can be assigned using the Assign

button.

';f MNoahdAuditbase - Business System

Alert Dashboard

Sort by: Most recent ~

FIRSTNAME20087 LASTNAMEZ20087
FIRSTNAME20620 LASTNAME20620
FIRSTNAME20057 LASTNAME20057
FIRSTNAME20271 LASTNAME20271
FIRSTNAME20623 LASTNAME20623
FIRSTNAME20332 LASTNAME20332
FIRSTNAME20604 LASTMAME20604
FIRSTNAME20363 LASTMAME20363
FIRSTNAMEZ20336 LASTMAME20336
FIRSTNAME19865 LASTNAME19865
FIRSTNAME20293 LASTNAME20293
FIRSTNAME19936 LASTMAME19936
FIRSTNAME19979 LASTNAME19979
FIRSTNAME19975 LASTMAME19975
FIRSTNAME19859 LASTNAME19859
FIRSTNAME20647 LASTNAME20647
FIRSTNAME20313 LASTNAME20313
FIRSTNAME19838 LASTNAME19838

From: All alerts

Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance

Hearing Performance

03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020

]

3

Patient :
Noah User :
Priority -
Category :

Received :

|_A|ert Details] |_’Se55\9n List]
FIRSTNAME20194 LASTNAME20134

Unassigned
|b
Hearing Performance

03/12/2020 14:13:46

Description :

Remaove Alert

&€ » Journal
Module

Close

Patient :
Noah User
Priority * |’
Category
Received :

Description :

Problems hearing the TV.

Remove Alert|

FIRSTNAME120 LASTNAME120

JULIE TYAS

Hearing Performance

30/11/2020 13:55:15

Session List
11/12/2020 :

= ANDSHU Auditbase audiogram
= ANDSHU Nyt audiogram

01/12/2020:
@ ANDSHU Subj1

30/08/2013 :

= TESTS:HIMSA - Noah 4 Audiogram Module
A TESTS:Amplivox Ltd
A TESTS:Amplivox Ltd

23/08/2002 :

= HILLHIMSA - Noah 4 Audiogram Module

01/12/2001 :

= LCAVILLAHIMSA - Noah 4 Audiogram Module
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Above the Alerts list the ‘From’ dropdown allows the user to filter on only the Alerts assigned to
them as well as to filter on unassigned Alerts.

'5 MNoahdAuditbase - Business System

Alert Dashboard

Sort by Most recent *

From: All alerts v

FIRSTNAME20450 LASTNAME:A! alerts

................... Performance

FIRSTMAME20284 LASTNAM
FIRSTNAMEZ20286 LASTNAM

My aleris

Unassigned alerts

Performance

Performance

FIRSTNAMEZ20200 LASTNAME20200
FIRSTMAME20134 LASTNAME20134
FIRSTMAME20379 LASTNAME20379
FIRSTNAMEZ20677 LASTNAMEZ0677
FIRSTMAME19915 LASTNAME19915
FIRSTMAME20518 LASTNAME20518
FIRSTNAME20657 LASTNAME20657
FIRSTMAME19907 LASTNAME192907
FIRSTNAME20402 LASTNAME20402
FIRSTMAME20436 LASTNAME20436
FIRSTNAME20499 LASTNAME20499
FIRSTNAME20247 LASTNAME20247

Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance
Hearing Performance

Hearing Performance

03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020

[+]

If the window is maximized then visible to the far right is the patient’s Session List to help put

the Alert in context.

) NoshiAuitbase - Business System

- 8 X

Alert Dashboard

Sort by; Most recent ~ | From: All alerts

&=

03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
ce  03/12/2020

03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
e 03/12/2020

30/11/2020

27/11/2020

7
FIRSTNAME20274 LASTNAME20274

751 75

FIRSTNAME20593  LASTNAME20593
[v.

FIRSTNAME120  LASTNAME120

A AAAAAREEEEEEEEEEEEEEEEEEEEEEE R RS

[T

Remove Alert

Patient ©  FIRSTNAME120 LASTNAME120

Category ©  Hearing Performance

Received i 30/11/2020 13:55:15

Description :

Problems hearing the TV.

Session List
11/12/2020:
= ANDSHU Auditbase audiogram
= ANDSHU Nyt audiogram
01/12/2020:
@ ANDSHU Subj1
30/08/2013 :
= TESTSHIMSA - Noah 4 Audiogram Module
A TESTS:Amplivox Ltd
A TESTS:Amplivox Ltd
23/08/2002 :
= HILLHIMSA - Noah 4 Audiogram Module
01/12/2001:
= LCAVILLAHIMSA - Noah 4 Audiogram Module
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Underneath the description is an ‘eye’ button which could open a webpage associated with the
manufacturer’s module. The Journal module icon would open the Noah Journal module if
installed.

& . Journal
@ ::J Module

Beneath that at the bottom is the ‘Remove Alert’ button. Be sure to remove Alerts that have
been acted on to avoid the Alert dashboard becoming slow to load over time as the number of
Alerts increases.

& & Journal
@ ::/ Module

Remove Alert
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9.13 Changing clients with Noah running

When taking a busy fitting clinic, you can close open Noah modules but leave Noah active and
change client in Auditbase.

¢ To do this, without closing Noah, select the Auditbase icon from the taskbar at the base of
the desktop. The global Client can now be changed.

¢ To return to Noah simply use the Noah module selection or Noah session browser
shortcuts from the Measurements menu in Auditbase and that part of Noah will become
the focus. On slower PCs, a Noah splash screen will be shown while Noah changes the
client.

&-f7 Measurements

=] AB Audiogram

ABR and OAE screening and diagnostics
{4 NOAH module selection

----- [=] Other speech test

{2 NOAH session browser

£ Open latest fitting action

@-&2 NOAH measurement modules

» If there is any module currently left open you will be told that a session is already open
and you should select the Noah Module icon on the taskbar to close it. If you were in the
process of deleting a Noah action you will also be informed that a session is open.

AB Audiogram - 10/01/2020, no. 1 x

You are not allowed to change client while you have an open NOAH session.

! ..\'

¢ While Noah is minimized the icon is hidden in the Systray (the area in the bottom right
corner where the clock is).

e The icon in the Systray is not really needed as the Auditbase Measurements menu should
be all you need.

¢ |f you do want to use the icon in the Systray, reveal it by clicking the small up arrow to
show all icons. You can configure Windows to always show the Noah icon by clicking the
up arrow choosing 'Customize’'.
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10 Onward referrals and reporting

The Onward referrals module allows you to collect patients together who are eligible for referral
to internal or external services or who need to be reported on nationally and track the status of
their progress through the referral or reporting process.

This module contains onward referral lists where patients can be added. A patient can be
added to an onward referral list automatically if their audiogram triggered an addition to such a
list, or manually, directly from the Onward referrals and reporting module, or the Onward
referrals and reporting tab in Client information.

Onward referrals and reporting can be opened from Navigation, from the Onward referrals and
reporting tab in Client information, or from the Add to list dialog following the audiogram
preview button notification.
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10.1 Automatic addition to onward referral lists

If a patient audiogram triggered a notification rule that adds a patient to an onward referral list,

users will be alerted by the audiogram preview button on the toolbar being highlighted E .On
clicking the highlighted button, the Audiogram preview dialog opens where further action can

be taken. Use *_ to see the notification.

11/29/2022, no. 5

Add to list: LRDC Severe == >
Patients up to and including 18 years old measured on at least three thresholds from

500hz, 1Khz, 2Khz or 4Khz found to have a mean hearing loss netweei?ﬂdn and 95db
HL inclusive on either ear.

Bing
125 250 500 1000 2000 4000 8000  SRT DS DSM

o 100
Jelly

20

&0

70 Rinne

Weber

40

20
20

T
50 X‘HQEQ&QZ_Q 10

Employing the ellypsis button -, you can Add/Edit onward referral and make any required
changes. You can attach the person or organisation that a patient will be referred to and
appointment to this onward referral. The audiogram that triggered the addition to the list is in
text form.

Status

Status is used to track the patient's progress in the onward referral process. The change of
status from default (Added to list) means removing the notification for that patient.

e Some statuses (e.g., referred, declined) take the patient forward in the onward referral

workflow.

e Other statuses (e.g., unsuitable, further assessment needed, to be discussed, etc.) need
some review of the audiogram and other patient information and then making some user
decision about what to do with patient addition to the list.

e Statuses with the option in Auditbase Administration 'Notify again on audiograms saved
in the future' will notify the user again if another audiogram is recorded that matches the
rule.

° When one of these statuses is applied, then if the audiogram is saved again and it
still matches the notification rule, the user will be notified again.

218

© Auditdata - 2025, ID: 20.0040/36



User Guide

Add/Edit onward referral x
The Auditbase audiogram must not be used as the sole means by which a diagnosis is oK Close
made.
Referred to |NARORA, KINGSWOOD SURGERY, KINGSWOOD AVENUE, PARK MORTH, SWINDON, PC)
Responsible user SysAdm -
At appointment 11/30/2022, 1
Audiogram 11/29/2022, no. 5

Status

Addedto list - 11/29/2022 E

Added by LRDC Severe, -

Audiogram: 11/29/2022, no. 5

-

Patient consent

Mot applicable - 12972022 E

The == control opens the Onward referrals and reporting module - > Members tab with all users
included in the onward referral list.
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10.2 Reviewing onward referrals

You can view all patients on a particular list from the Members tab. If you opened the module
from Navigation, you need to select the list first on the Lists tab to be able to see its contents on
the Members tab.

On the Members tab, you can review the members of each list. With long lists, you can filter by
Status or Responsible user, only one value can be selected at a time. The text to the right under
the description box shows how many clients are in the list and how many are visible under that
filter.

You can add new patients via the Add selected client and Search and Add clients controls.
The 'Add selected client' option will add the global client to the list. You can use the Search and
Add clients option to find other clients to add. Using parameters on that dialog, including on the
Show advanced criteria section, allows you to retrieve and add multiple clients who meet
certain criteria including from Client Parameters and from Search by hearing loss and Search
by device(s).

Lists | Members

Add selected client Search and Add clients Edit Remove Change status Letter Exportto CSV =]
Filter Onward referral
Status LRDC Severe
Added o list -

Severe hearing loss

Responsible user

SysAdm -
Clients in the onward referrals list: 3, Filtered: 3
SelectAll 1 entry selected Attach appeintment Detach appeintment
Referredto | Atappointment |Hospital no. Gender | User added | Responsible user | Parameters | Current age | Date added Status Status date Comment
3 22 T132091 20-111FIRSTNAME32991 15-LASTNAME32991 | Male SysAdm SysAdm 17y 11128 Addedto list | 11/29 Added by LRDC og|
T117240 MISS FIRSTNAME17240 LASTNAME17240 Female | SysAdm SysAdm 16y 11/29/2022 | Addedto list | 11/29/2022 |Added by LRDC Severe, Audiog
T119840 MISS FIRSTNAME 19840 LASTNAME 13840 Female | SysAdm SysAdm 17y 11/29/2022 | Addedto list |11/29/2022 |Added by LRDC Severe, Audiog

<
Other onward referrals client participates in
Title Status Status date Comment to status Respaonsible for list Type Consent Cnst. chng. date
LRDCAI Added to list  11/28/2022 |Comments SysAdm Paediatric lists Accepted 11/28/2022
Paediatric module onward referral| Referred 11/28/2022 |Comments SysAdm Paediatric module onward referrals | Not applicable  11/29/2022
UK NICE Implant guidance Added fo list  11/30/2022 SysAdm Paediatric or adult referrals Not asked 11/29/2022

Status and Client consent and the Comment to Status can all be edited directly on the row.
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Detach appointment

Date added | Status | Status date

11/20/2022 | [JETTNE |+ | 11/20/2022

11i29/2022 |Data miss 44292022

Deceased
1102912022 | b dined 11/29/2022

Further as

i
PTAon EM
Referred
Referredfi
To be disc
Unsuitable ¥

Editing onward referrals

Use the Edit button to open the edit dialog and change any of the attributes of the Onward
referral including adding an organisation or individual to refer to. These organisations and

individuals are configured in the Referring Agents dialog.

Add/Edit onward referral X
The Auditbase audiogram must not be used as the sole means by which a diagnosis is Close
made
Referred to ||'v1ARORA‘ KINGSWOOD SURGERY, KINGSWOOD AVENUE, PARK NORTH, SWINDON, PC|
Responsible user SysAdm -
At appointment 1113012022, 1
Audiogram 11/29/2022, no. 5
Status
Added to list +  11/28/2022 E
Added by LRDC Severe, re
Audiogram: 11/29/2022, no. 5
-
Patient consent
Mot applicable 1102802022 E

To select multiple clients tick each row on the left-most border. If you highlight another row that
row is added to the multiple selection while it is highlighted. The text above the list table shows

how many records are selected.
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Lists || Members

Add selected client Search and Add clients Edit Remaove ]
Filter Onward referral
Status LRDC Severe
Added to list -

Severe hearing loss

Responsible user

SysAdm -
B SelectAll 3 entries selected
Referred to | At appointment | Hospital no. Mame | Gender | Lser added | Respons
MARORA |1 * 11/30/2022, 1 |T132991 20-111FIRSTNAME22991 15-LASTHNAME32991 |Male SysAdm SysAdm
T119840 MISS FIRSTMNAME 19840 LASTMNAME 19840 Female | SysAdm SysAdm

o
I T117240 MISS FIRSTNAME17240 LASTNAME17240 Female SysAdm
v

You can edit the Status on multiple clients simultaneously by using this multiple selection and
the Change status button. See details in Status.

You can export the list of patients Onward referrals to use in Excel. You can also generate
letters to one or more patients by making a multiple selection on the list and creating a letter
based on a template which has been assigned in Documents module as being available in the
Onward referrals and reports module. Furthermore, it is possible to attach or detach
appointments for patients directly on the list by highlighting the corresponding list entry and
using the respective control.

A client can only be recorded on any particular Onward referrals and reports list once. If the
client is on multiple lists the other lists will be shown in the table at the bottom of the screen.

If the user does not have the right to see lists of some specific type, they will not be able to
select that list from the Lists tab. Patient membership on these lists will not be shown for that
user on the Members tab - > Other referrals table.

10.2.1 Status

Status is used to track the patient's progress in the onward referral process. You can edit the
Status on multiple clients simultaneously by using this multiple selection and the Change
status button.

The change of status from default (Added to list) means removing the notification for that
patient.

e Some statuses (e.g., referred, declined) take the patient forward in the onward referral
workflow.

e Other statuses (e.g., unsuitable, further assessment needed, to be discussed, etc.) need
some review of the audiogram and other patient information and then making some user
decision about what to do with patient addition to the list.
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e Statuses with the option in Auditbase Administration 'Notify again on audiograms saved
in the future' will notify the user again if another audiogram is recorded that matches the
rule.

° When one of these statuses is applied, then if the audiogram is saved again and it
still matches the notification rule, the user will be notified again.

© Auditdata - 2025, ID: 20.0040/36 223



User Guide

10.3 Managing onward referral lists
On the Lists tab, you can see Onward Referral lists that have already been added in Auditbase.

When a list is selected, the comment section below the table will display comments related to
that particular list. Each list is assigned a type and a responsible person that can be changed
via the Edit control. Users can also create new referral lists or delete existing, employing the
corresponding buttons on top. To filter out lists unrelated to yourself, activate the option "Show

only assighed to me".

Lists | Members

Mew Edit Delete | e

Show only assigned to me

Title |Resp0nsible Type
LRDC Al SysAdm Paediatric lists

LRDC Profound

SysAdm Paediatric lists
LRDC ere m

M Paediatric lists

Paediatric module onward referrals SysAdm Paediatric module onward referrals
Swedish Severe hearing loss reqgister | SysAdm Adult lists
UK MICE Implant guidance SysAdm Paediatric or adult referrals

Comment on selected referrals list
Severe hearing loss

224
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11 Client pathway overview

To open the Client pathway overview, select from the Auditbase Navigation area — Client
pathway overview.

Planned and completed actions in a referral pathway can be seen, whether you're using
referrals and appointments or not. The initial view that is displayed can be set by default.

There is an easy to use but highly flexible configuration for site and user favourite views. You
can create new actions and easily see an overview or the detail of most standard actions in a
journey.

Client pathway view
FL|II pathway - # g E‘ E

- 22/08/2019 ++TINMITUS

- 22/06/2015 ++DIRECT REFERRAL /Audio assessment
- 18/06/2015 ++AUDIO REVIEW reassessment

- 1000442015 ++AUDIO REVIEW reassessment

- 24/032015 ++AUDIO REVIEW reassessment

- 12M10/2001 ++DIRECT REFERRAL /Audio assessment
=] <No referral=

Navigation around the pathway view can be performed by using the keyboard arrow and tab
keys as well as using the mouse.

Each of the stages has two dates adjacent to the title. Stages that have already been
completed will show the stage start date and the stage end date respectively. The following
stage will show the date of the completion of the previous stage as the start date.

Referral breach warnings will be displayed as part of each stage.

=15 26/06/2007 ++AUDIO REVIEW reassessment
11{@] Assessment (26/06/2007-06/08/2007; Has been breached, status not ‘cor
#{®] Treatment (06/08/2007-25/09/2007; Has been breached. No appt)
#{®] Follow up (25/09/2007-08/06/2008)
#[@] Complsted (09/06/2008-Current}

Expanding one of the stages will display all the tests and/or forms that have been completed
for this stage.

© Auditdata - 2025, ID: 20.0040/36 225



User Guide

You will also see a list of the Planned clinical actions, which are the tests and/or forms that are
appropriate for this stage as set by the System Administrator. Any completed appointments are

also shown with any associated clinical actions.

Client pathway view
[E Full pathway - # e ==

EI- 15/06/2018 ++FITTING - from previous referral
[®] <No stage defined=
El- 15/06/2018 +AUDIO REVIEW reassessment
EID Assessment (15/06/2018-15/06/2018)
i fa] 15/06/2018 £ GWH 2nd fit~~, Res109
Y 15/06/2018
=Planned clinical actions=
E| Treatment (15/06/2018-14/09/2018)
E| Follow up (14/09/2018-15/06/2018)
E| Completed (15/06/2018-Current)
=[] =No referral=

Right clicking on any action or appointment will show a series of options.

¢ Refresh - Will refresh the entire pathway.
* Expand selected level - Will open the items in the levels below the selected one.

¢ View - Any of the pathway views can be selected by selecting View and then the relevant

pathway.

Client pathway view
T My view - a g 5| |

B8] Assessment (15/06/2018-15/06/2018)
¢ EHfr] 15/06/2018 B GWH 2nd fit~~, Res109

Refresh

t, 11-03-19_test_template
Expand selected level t testing docdf
View > Implant data stages

—— TIORGOS T
H —

. -g7 1510612018, Docum
E| =Planned clinical actions=
“-[1i] + BKB test w
=i{F] Treatment (15/06/2018-14/0¢

=-E5] <Planned clinical actions= ) Without stages
: +MNOAH action Ii:lj] Without stages and appts/dates

=|  Full pathway
1} Action types only

~
L
T

1 Actions only
My view

[ I TR e
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11.1 Changing the size of the viewing pane

Selecting an action or appointment will display the relevant information on the right hand-side
of the screen.

o)) Auditbase - [Referral] — [m] X
File View Functions
(] = O
QX 8 > ®
Detsiled = Quick  Save | Printlist Importdata Exportdata | ExporttoNoah Logoff | Exit Auditbase
Search Refertal Import/Export Client data Exit
r Client T146738 MRS FIRSTNAME46738 LASTNAME46738 - 8 & Bl User USER NAME35 All locations ~ All departments - a ?
Navigation Referral ov Client's referral | Referral answer | Clinical aclions
- Favourites
Referrals: 108858, 05/01/2011, ++DIRECT REFERRAL / Audio assess Client name MRS FIRSTHNAME46738 LASTNAME46738 Refresh Cancel
Client pa‘thway view Book Search and book Add to list Add observation Print referral Print receipt Print answer New Save Delete
@ Full pathway - ‘ Selected referral
PathwaylD | 0002-1644-8953 Edit Waiting list entries Aftach Detach Edit Show in waiting list
RTT start date 05/01/2011 Age atstart 65y Waittime 0 Wait time Date Waiting list Informati
@[&] Assessment (05101/2011-15102/21 | Referal date 10112/2010 Other date 06/01/201
 [E] Treatment (15/02/2011-06/041201" | Treaiment ype ~+DIRECT REFERRAL / Audio assessment -
EI Follow up (06/04/2011-21/01/2011 Reason
[@] Complated (31/01:2011-Current) "GP airectreferral M
Customer SWINDON PCT - S >
Referred by DR JFROST, WESTROF SURGERY, HOME FARM, H Appointments Aftach Detach Edit ing
Refering agent ref. Date | Time | Symbol [ Statug Resource
Medical priority - |3r0120m [1818]) Bk S Resks ++GP direct refe
Referral handling -
Information Put on waiting list Booked directly Edit
108858 -gp C & bref - < >
-
Observations and procedures Detach Edit
Interview SEL@TIER Obsno. | SNOMED code | Date  [Add]S] Text
-
-
< >
Registered by USER NAME11 a >
O individual client CoEeEie
- Outcome 100, Referral closed Clock  Closed Referral stages
- : i Adive length: | 3w 5d
% Client pathway view — 30012011 171915 Addnew] | History Mame |Targetdate andwamlngsl Current A g
Auto assigned as default successor for the status 34b, Referr Assessman 150212011 o RIT end date 0120
é Clinic management Comment 9 : Treatment | 06/04/2011 ] RTT end date set by outcome status
. New outcome status 100a, Referral closed - Followup | 05i10/2011 O v | 34b, Referred to consultant (ENT)
E Stock management
= uUsertasks
e
ppp  PPPlist
T [«

The size of the left and right-hand panes can be changed. Drag the Navigation area left or right
from its right border edge. Click and drag the border using the mouse to re-size the viewing
panes. Increasing the size of the Navigation area will allow complete viewing of available icons.
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11.2 Icons
11.2.1 Stages

Each stage has an icon which are coloured differently depending on if the stage has been
completed or is the current stage.

° |:| - Incomplete stage
* El - Complete stage
° EI - Current stage

11.2.2 Actions

Each type of action has an icon. These icons are coloured if an action has been completed.

Client pathway view
Al:tiontypes only v| Q g =5

&[] Audiogram

E-£2) NOAH action

(':]:. Earmould impression
-6 Document

They are uncoloured if the action has not been completed.
11.2.3 Appointments

An appointment icon will change depending on if the appointment has an action linked to it or
not

o lu| 12/27/2013 ## VS5 Test Follow Up, ResS5 _ Annnintment does not have a linked action

o [u] 1212014 B TestFollow Up, Res46 _ ppnointment does have a linked action
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11.3 Actions linking to appointments

On several types of actions, auto-linking to appointments can be provided. Examples include
such action types:

SalT tests
Documents
Questionnaires
Stock actions
Earmoulds

Auto-linking settings are defined in the system administration tool.

If such a clinical action is created, the most relevant appointment will be attached. If only one
appointment occurs for the client that day, and the appointment start time is earlier than the
current time, then the action will be attached to that appointment. If it is not clear which is the
most relevant, for instance if there is more than one appointment on the same day or none at
all that day, a dialogue box will open asking you to attach the most appropriate appointment.

Each dialogue box for such action has a special button for attaching the action to or detaching
it from an appointment. The button is equipped with a symbol which reflects the state of the

iy +
action: either attached ( == ) or not attached (=~). In addition, the button has a tooltip that

displays detailed information about the action linking.

To attach an appointment, click this button and an information dialogue box will open where
you can Attach the correct appointment to link to the action. The button icon now changes to
show an appointment is attached.

Attach appointment >
Attach Close
Date | Symbnll Description Resource Status L]
13012020 | I |from1 Resdf *
130112020 7 2 Charlie *
1000112020 3 PHAC new p Charlie *
1000112020 1 1 Charlie *
09/01/2020 3 PHAC new p Stassy *
090112020 1 1 Resad * W

If the appointment is linked to a referral, then the Referral stage, where the appointment took
place, will be shown here.

© Auditdata - 2025, ID: 20.0040/36 229



User Guide

9)) Auditbase - [Client pathway view]
File

A& 8 8 B A

Detailed Quick Import data  Exportdsta | ExporttoNoah Logoff | Exit Auditbase

Search Import/Export Client data Exit
|E Client <T>T18765 MR JOHN SMITH -l & Z||H|user SYSTEM ADMINISTRATOR Multiple locations: ~  Multiple departments_. |« Q ‘7
N.a\ngatnon aon Client MR JOHN SMITH Compare results Mew Delete
= Favourites -
&5, Referral
] Documents and attachments Tests 09/01/2020, 1, L: HAT, R: HA1, +10 dB1 ~  Created by SYSTEM ADMINISTRATOR -
FL Waiting list Date oftest 09/01/2020 Age attest 79y oo Referral stage  Assessment
] AB Audiogram —
A\ Attention list : 107017, -
’ Appointment attached: *, 1040172020, PHAC new patient mould~
5, User reports Not administered 0
£ Booking
% i Left ear HA1 - Right ear HA1 -
NOAH b
H @ sesslor.l row;er Presentation level T0dBSPL - Test condition Audition + lipreading122 -
@ Open |atest fitting action -
Client pathway view :I:\Ss:)leva\ (signal=  +10 dB1 - Moise type
Full pathway - @ g = Lists Used

MNumber of Sentences Presented 16 E

Optional calculation of results

22/08/2019 ++TINMITUS

2210612015 ++DIRECT REFERRAL /Audia assessment Number of Key Words Presented 9 E % of Key Words Correct 56
E-@ 18/06/2015 ++AUDIO REVIEW reassessment Number of Key Words Correct |5_E
E{&] <No stage defined=
- rﬂ 10/01/2020 @ PHAC new patient mould~, Charlie Motes
£ [i] BKB test

E] 18/06/2015 ENT new patient mould~, Travy
[£% 1810612015
10/04/2015 ++AUDIO REVIEW reassessment
24/03/2015 ++AUDIO REVIEW reassessment -
12/10/2001 ++DIRECT REFERRAL /Audio assessment
[ <Mo referral>

o) - .
S Individual client

& Client pathway view

{2) Clinic management
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11.4 Pathway views

At the top of the Client pathway overview, you can choose the type of View from a drop-down list
T
I I__.I:I

and save that view as your default. These views have icons showing if they are a global view *

. . . o
a site view , Or USer view # .

Client pathway view

Full pathway - ¢ g =) E
Implant data stages
Full pathway

S Wy view

(48] ~.ction types only] sment
(T} Actions only

() without stages

-:]:3:- Without stages and appts/dates

# - Configure View (Shortcut = F4). See the details of the selected view and configure
your own.

i

=/ - Refresh View (Shortcut = F5). When an action is added to or moved on the pathway
you can refresh using this button and your view of any expanded sections will be
maintained.

- Save defaults (Shortcut = F6). Save the position of the vertical bar and the current
view as default.

* =P view missing actions in a pathway. Run a crystal report displaying user defined
missing actions for selected Treatment types.

If changes are made to any element of the overview outside of the Client pathway overview, a
message window will appear advising you of this and whether you want to refresh the overview

or not.

Client pathway view

I@I The client pathway overview was modified outside. Would you like to refresh?
k. *

Yes No
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11.4.1 System default views

There are a number of system default views set by Auditbase System which can be used as
templates for site default views or user specific views. You can view in detail how each template

view is made using the Configure o button mentioned below.

¢ Implant data stages - For use with Implant module licenses only.

¢ Full pathway - Displays all referrals, clinical actions and appointments in Stages
including planned actions.

¢ Action types only - Displays the action types with actions attached showing the date of
the action.

Client pathway view
(3 Action types only it - IS A=

®-] Audiogram
=[] BKB test
1] 09/01/2020, BKB test, L: HA1, R: HA1
~[£1] 0110412015, BKB test, L: HA1, R:
=[] AB Words test

5 Pre-Op assessment form
#-[:i] Glasgow questionnaire, part 1
=[] Glasgow questionnaire, part 2
[ i] Medical history
-2 NOAH action
#{ia] Stock: Issue article
@ Stock: External aricle registered
#{ia] Stock: Return article to stock
@ Stock: Return aricle to repair
#-65] Document
- 4 OtoSurgery Pre-op
- 4 OtoSurgery PostOp 2-5m

Switch on / Review session

< >

¢ Actions only - Displays all actions grouped by action then in date order, newest action at
the top.
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Client pathway view

(5 Actions only - | g ==

5 10/0142020, 1, Audiogram changed in AB

@ 10012020, NOAH action, Audiogram changed in AB
g_d 10/0142020, Document, Mew

[i] 09/01/2020, SIR test

[i] 09/01/2020, AB Words test, L: HA1, R: HA1

[i] 09/01/2020, BKB test, L: HA1, R: HAT

) 2210512019, Pre-0p assessment form

5 110312019, 1, Aided, AuditBase audiogram

@ 110372019, MOAH action, AuditBase audiogram
,Q;_“J 11032019, Document, 11-03-19_test_template
@ 08/03/2019, Document, Test_PCT

[i] 28/02/2019, Medical history

[i] 28/02/2019, Glasgow questionnaire, part 2

[i] 27/02/2019, Glasgow questionnaire, part 1

[i] 2010212019, Glasgow questionnaire, part 1

5 211012015, 2, AuditBase audiogram

@ 21102015, NOAH action, AuditBase audiogram
5 211012015, 1, AuditBase audiogram

@ 21102015, NOAH action, AuditBase audiogram

< >

* Without stages - Displays referrals with attached actions and appointments but no
referral stages.

Client pathway view
[E] without stages - Q E o) | =

- 03/04/2008 ++PAEDIATRIC ASSESSMENT
- 310142008 ++PAEDIATRIC ASSESSMENT
- 02/01/2008 ++PAEDIATRIC ASSESSMENT
- 211112007 ++PAEDIATRIC ASSESSMENT
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¢ Without stages and appts/dates - Displays referrals and actions but does not shows
stages or appointments.

Client pathway view
] without stages and appts/dates o E ==

- 032/04/2008 ++PAEDIATRIC ASSESSMENT
- 310112008 ,++PAEDIATRIC ASSESSMENT
- 21112007 ++PAEDIATRIC ASSESSMENT

11.4.2 Configure Views

By selecting the Configure button o , views can be configured and saved. A Configure view
window will open.

Configure view

Preview Save Site view Delete view Close

MName |Fu|l pathway
Grouping level options

| | Referrals | | D Show planned actions
|—I [®] Referral stages
|—I fi] Appointmentsidates
|—l [] Action types
L [] Clinical actions
Advanced filtering options

M Show stages containing no data
- Current stage will be shown even with no data

M Show appointments not attached to referrals (and their attached actions)
- Referral selection will be based on start date

B Show actions not attached to appointments group by date
- Referral selection will be based on start date

The global views cannot be changed. The view must be saved as a site or user view. Making any
adjustments to the view will cause the name to be changed to remind you to save as site or

user view.
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Name |Mndiﬂed. rename to save | |

Grouping level options can be chosen by checking or unchecking the relevant boxes. Planned
actions which have not been completed can be shown by checking the Show planned actions
box.

There are additional filtering options which are shown in the section titled Advanced filtering
options. The filter will be active if the relevant box is checked.

Advanced filtering options
B Show stages containing no data
- Current stage will be shown even with no data

B Show appointments not attached to referrals (and their attached actions)
- Referral selection will be based on start date

M Show actions not attached to appointments group by date
- Referral selection will be based on start date

* Show stages containing no data - Stages will be shown even if there is no data
associated with the stage.

e Show appointments not attached to referrals (and their attached actions) - If there
are appointments which are not attached to a referral, the appointment will still be
shown.

e Show actions not attached to appointments group by date - Actions which are not
attached to appointments will be grouped by the date of the appointment.

Once you have made changes to the view, you can preview it before saving by selecting the
Preview button. Once you are happy with the correct layout, you can give the view a Name and
Save site view. The view will then be saved in the list in alphabetical order.

11.4.3 Missing Actions Reports

Selecting the printer symbol F from the Client pathway view pane will open a choice of two
system reports.

¢ Planned clinical actions by specialist
¢ Planned clinical actions by planned stage end date

— Planned clinical actions by specialist

— Planned clinical actions by planned stage end date
|

Using these reports will allow you to identify incomplete actions within an individual client
pathway or multiple clients’ pathways.

Multi selection fields
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To report on multiple values from multi-selection fields, each value is clicked on and moved to
the Selected items box using the arrows adjacent to the box. When a value is transferred to the
Selected items box that value will be reported on and anything left in the Available items box
will not be reported on.

Missing actions in pathways X
Current filter ~
=New filter= - Save Save as .. Deleta
Missing actions in pathways
Run report
Filtering clinical actions
Specialist gnored
Available items: Selected items:
Audiology tests and measurements
SalTtests
ToD tests
General
»
4
AddAll Remaove All
Additional clinical action types gnored
Available items: Selected items:
Audiogram -~
BKB test
BKB Sentences test (Adaptive or Mon adaptive)
AB Waords test
CUNY test [ 3
VEAtest
Commaon phrases test 4
Mr. Potato test
CAP test
CEPS test
SIR test v
Add All Remove All
Treatment type |I|
Available items: Selected items:
++AUDIO REVIEW reassessment -
++DIRECT REFERRAL /Audio assessment
++FITTING - from previous refarral
++NEOMNATAL ASSESSMENT
++PAEDIATRIC ASSESSMENT [ 2
++TINMNITUS
ENT Hearing aid referral 4
PAEDIATRIC hearing aid journey (PHAC)
SPECIALISED TEST REFERRAL
Testtreatment type
% DO NOT USE -AUDIO ASSESSMENT v
AddAll Remove All v

Above each Selected items box is a check box titled Ignored. This remains checked until a
value is moved into the box. If values are not moved across to a Selected items box and that
box remains empty, no filtering will be done on that selection and all parameter values will be
included in the report.
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Selected items:

Remaove All

Lists

If there is a list of possible values which could be used in multiple reports (such as Assessment
appointment symbols) these can be defined in Lists set up in System Administration -> Other
definitions -> Lists for report parameters.

Show List Items

When a parameter is a list of items, you can view the items by clicking on the Show list items
button. The button will only appear when you have selected a value containing a list.

Although the list items will be shown, you cannot make changes to the list from here. This must
be done from within System Administration since the same list may be being used in other
reports and to make changes will affect all the reports it is used in.

Report Filters

To save report value selections you have made, click Save. You will be asked to give the
selections a Filter name.

Save report filter >

Save Close

Save to the current filter <1=
Rename the current filter

# Save as a new filter

Mame

W Save as the default filter

Once you have done this, the report selections are saved as a named Filter and can be
accessed from the Current filter drop down list.
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Multiple Report Filters

You can create differing versions of the same report and save them as Filters. To do this, open
the report you wish to adjust the parameters on. Change the values and click Save as. Give the
filter a name.

Save report filter >

Save Close

Fename the current filter

#| Save as a new filter

Mame Planned Report

Save as the default filter

This will now be available in the Current filter drop down box along with your original report set-
up. Saving each report change as a filter will mean they are all there to be re-used in the future.
There is no need to keep re-building reports with varying values.

You can also direct Auditbase as to which report should be the default.

Save report filter *

Save Close

Fename the current filter

# Save as a new filter

Mame Default

Save as the default filter

The report will always open the default report as standard.

If you have made changes to report parameters but have not saved them, you will be asked if
you wish to save them if you re-open the User reports list or exit Auditbase.

Run and refresh

The Run report button will highlight yellow as soon as a parameter is changed. This will alert
the user to the need for refreshing the existing report output. Clicking on the Run report button
will generate a new output for CSV reports.
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Missing actions in pathways

Current filter

1 [Defauli] hd Save Save as .. Delete
Missing actions in pathways

The white space to the right of the parameter lists will display the running dialogue and its
progress. If the report data is short, the dialogue will only flash onto the white area before
disappearing. A Stop button will display along with the report dialogue in order that the process
can be brought to a halt if it is taking too long to complete.

A LOG file is included in the output file in case there were errors which can be reported to
Support. If the report ran without errors, then it does not need to be retained and can be
deleted.

The reports consist of several parameters which you will need to populate with variables in
order for a report outcome to be achieved.

The two reports have different groupings in the output layout, specialist or planned stage end
date;

¢ Planned clinical actions by specialist
¢ Planned clinical actions by planned stage end date

Report Parameters

 Filtering Clinical Actions - Specialist - Variables available here consist of tests and
measurements grouped into specialist areas according to the standard Tests menu
grouping.

¢ Additional clinical action types - Variables here allow you to add additional
measurements and tests not included in the first Parameter.

¢ Client Professional Contacts - Referring agents who are linked to at least one patient on
the Additional Professional Contacts on the details tab.

* Treatment Type (Mandatory field - Must be populated) - Select the treatment type(s) you
wish to report on.

e Other variables allow you to look at patients with only certain alerts, GP’s, PCT’s and
Customers

The report outcome layout uses Crystal Reports. If required a custom version of this layout can
be produced by the support office at the normal rate.
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o) Auditbase

Planned clinical actions by specialist

Printed: 05/03/2020

Full name Hospital no. NHS no. Patient Patient RTT start Current Treatment type Treatment stage Stage status Stage Stage Stage Planned Action
keyworker age date outcome end date end date end date clinicalaction completion
status planned planned in fact date
year
meonth
Audiology tests and measurements
FIRSTNAMEEZ5 LASTNAMES25 T1825 Unknown 23 200212020 10a, Awaiing  ++AUDIC Assessment ument 01/04/2020  April 2020 BKE test
keyworker frst ACTIVITY REVIEW
reassessment
FIRSTNAME3264 Ti3ge4  11nnImINn DRGJ 20 D2/07/201% 100a, Referral  ++AUDIO Asszssment Completed 18/03/2020 yarch 08/02/2020 BKB test
LASTNAMEZ864 BARRON closed REVIEW 2020
reassessment
FIRSTNAMEZS64 T13864 111111111 DRGI 20 0207/201%  100a, Referral  ++AUDIO Treatment urent OT/05/2020 May2020 NOAH action
LASTNAMEZ884 BARRON closed REVIEW
reassessment
FIRSTNAMES25 LASTNAMES2S T1825 Unknawn 29 2000212020 02, Awaitng  ++AUDIC Treatment Not start 21/D5/2020 May2020 NOAH action
keyworker frst ACTIVITY REVIEW
reassessment

11.4.4 No referral

If an action or appointment is not linked to a referral, possibly because the department is not
using referrals, the action or appointment will be added to <No referral> and will be grouped by

appointment date under <No stage defined>.

=] =No referral=

El{___| =Mo stage defined=
~[7] 25/03/2003 B BATTERIES 3, Res73
~[¥] 1112/2002 R GWH Repair, Res73
2 2810/2002
~[¥] 12/07/2002 R GWH Repair, * Res56
~[¥] 27/06/2002 Em GWH Earmould, * Res65
FHET 27/06/2002
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12 Earmoulds

Click the button below to access our training materials.

To access the Earmoulds window, enter Shift+Ctrl+E or go to the Navigation area ->

Earmoulds.
Earmoulds - MISS, FIRSTMAME41844 LASTMAME41844 X
Search Print Label Earmould list Waiting lists entries Print stat Open with latest Close
Client
Hospital no.  T141844 Mame MISS. FIRSTNAME41844 LASTNAME41844 Comments on client -
Transport -
Moulds
Wanufacturer Adult Paediatric Re-mould Date of impr. Sentto manu.  Ready Issued
- 04082021 |5
Copy right to left
RIGHT LEFT
Mould +* Mo Mould + No
Eardrum Eardrum
Material -+ Vent Waterial -~ \Vent
Sound channel width length Sound channel width length
Currently worn Manuf. ID Currently worn Manuf. ID
Comments on mould(s) Allocated aid Hold for
Action
- -
Waiting list
Booking
Post
- - Priority
History
Customer SWINDON PCT - A
User SYSTEM ADMINISTRATOR -
Audiogram -

Delivery location  Default EM name
Address line 1 Default EM line 1

Address line 2 Default EM line 2

Centre number EM_C1

Postcode EM PO

Any activity regarding earmoulds for a client is listed by date and on-going number when more

earmoulds are entered for a client on the same date.

The following functions are available:

Label
entered.

workstation with a different centre number.

Produces an earmould label which automatically contains all the information

Centre number will be stored with the earmould ONLY when the earmould
label is printed. If the Centre number comes from Workstation settings the
stored value will be changed if the label is printed a second time from a
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New

Clears all details so a new earmould can be entered.

Save

Saves the earmould details.

Delete

Removes the earmould from the client.

Print

Produces an earmould report including the attached audiogram.

Print stat.

To extract statistics from the Earmould module, press Print stat. There is
also the option to export these statistics to .csv files.

Waiting list
entries

Click this button to display the Client's appointments and waiting list
entries window where you can review, create, or edit Waiting list entries.

Search

Click this button to open the Search earmoulds window. Enter the mould
number in the Earmould number field, select Search and either double click
the required mould or choose Select.

The search dialog will show the centre number and can be filtered on the
centre number for easier searching over multiple locations. The default
number for the filter comes from the centre number used on that
workstation but can be changed here.

The delivery address is taken from Location where specified. If Location is
not specified then the default address in the System Administration ->
Earmould settings is used.

Earmould
list

Opens the Earmould list, which displays a list of earmoulds, either Paediatric
or Adult, filtered within a date range, either Date of impression, Date ready
or Date Issued. Earmoulds that are Not Ready or Not issued can be shown
by checking the appropriate box allowing you to narrow the results to
earmoulds that were Ready or Issued in a certain period or have yet to be
ready or issued out.. To view the lists, select Show. To select an earmould,
highlight the mould and click Select or double click the mould. To print the
list, click Print.

The client’s Location can be shown in addition to the Delivery Location. This
must be enabled using the Show client location check box above the table.
The state of this check box will be saved for the user including after
restarting Auditbase. Note the warning that showing Client Location can
cause a reduction in the speed of popluating the Earmould List.

Open with
latest

Check this box to have the Earmould dialog open with the latest earmould
order displayed automatically.

The following information can be viewed and edited in the window:

Manufacturer

When a manufacturer is selected the Earmould Types and Materials
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available can be restricted if a relationship between Types, Materials
and Manufacturers is configured in System Administration by your
System Administrator. This allows users to be selecting only from the
Types and Materials supplied by the chosen Manufacturer.

Hospital no.
and Transport

These are added from Client information (see Client information).

Earmoulds

Lists the selected client's previous earmoulds.

Eardrum right
and Eardrum
left

A free text box to enter details about the ear canal and eardrum.

Mould right and

Select the required earmould(s) from the dropdown lists.

Mould left
Material A specific earmould material can be selected from the drop-down menu.
Vent Enter the vent size

Sound channel
width

Width of sound channel

Sound channel
length

Length of sound channel

Currently worn If a previous earmould is the client's preferred one this can be recorded
as Currently worn. On the Client Information page, the most recent
Currently worn is shown rather than latest issued.

Manuf. ID The Manufacturer ID as they use it can be recorded with the mould.

Copy right to Check box to copy Mould, Material and Eardrum information from right

left to left ear.

User The logged in user, but can be changed manually if required.

Date of impr. The date of the impression. Entered automatically by Auditbase but can

be manually changed. An appointment can be linked to the earmould by
Drate of impr.

. . ) 100112020 25
selecting the link button to the right of the date .The

client’s previous appointments will be shown and the appropriate
appointment can be attached by double-clicking it or selecting and
clicking on Attach.

Appointment
attachment

With this button, you can attach the earmould to or detach it from an
appointment. The button has a picture which reflects the state of the
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earmould: either attached (=) or not attached (<=). In addition, the

button has a tooltip that displays detailed information about the
earmould linking.

Sent to manu

The date the impression was sent to the manufacturer.

Ready The date the mould returns from the manufacturer.
Issued The date the mould was issued to the client.

Paediatric Check box to identify a paediatric earmould.

Adult Check box to identify an adult earmould.

Action Waiting list, Booking, Post and Priority check boxes.
Re-mould Identifies an earmould that is being re-issued to a client.

Comments on
mould(s)

Comments in this free text box will be printed onto the earmould label.

Comments on
client

Can be used to add comments about the client.

Allocated aid Enter details about hearing instruments that need to be allocated to this
particular client or mould.

Hold for Enter details about special instructions regarding who the mould must
be given to when the mould returns.

History Enter details about the earmould’s history, for instance date of
earmould repair.

Customer A customer, usually a Trust or CCG, can be selected from the drop-down
menu.

User The user creating the earmould is pre-selected but can be chosen from
the drop-down menu if the appropriate rights have been awarded by the
System Administrator.

Audiogram The drop-down list contains the selected client's audiograms. You can

select an audiogram in this list and it will be printed with the earmould
report. Click Show to activate a window for the audiogram review.

Centre Number

The Centre number is editable and is filled by default with the
workstation value. This value is saved when the earmold is first saved.

Post Code

The Post code is taken from the delivery address which is usually only
used in conjunction with the Repair module.

© Auditdata - 2025, ID: 20.0040/36

244



User Guide

12.1 Entering Earmould details

* Press F3 to search for the client or Ctrl+F3 to make a quick search.
¢ Go to Navigation area-> Earmoulds.
e Click on New.

Address line 2 Default EM line 2

Earmoulds - MISS, FIRSTMNAME41844 LASTMAME41844 *
Search Prin Label Earmould list Waiting lists entries Print stat. Open with latest Close
Client
Hospitalno.  T141844 Mame MISS. FIRSTNAME41844 LASTNAME41844 Comments on client
Transport
Earmoulds w| | Delete MNew Save
Moulds
Manufacturer Adult Paediatric Re-mould Date of impr. Sentto manu.  Ready Issued
MINERVA -~ 04072021 | S5 070712021
Copy rightto left
RIGHT LEFT
Mould EM 2101 - SOLID~ACRYLIC HARD ~ Mo Mould EM 2101 - SOLID~ACRYLIC HARD ~ No.
Eardrum Eardrum
Waterial * \Vent Material ~ \ent
Sound channel width length Sound channel width length
Currently worn Manuf. ID Currently worn Manuf. ID
Commenis on mould(s) Allocated aid Hold for Action
Waiting list
Booking
Post
Priority
History
Customer SWINDON PCT -
User SYSTEM ADMINISTRATOR A
Audiogram -
Delivery location  Default EM name Centre number EM_C1
Address line 1 Default EM line 1 Postcode EM PO

e Inthe Eardrum right and left fields you can write about the condition of the eardrums and

ear canals.
¢ Select earmould type from the earmould right and/or left lists.

¢ Check that the correct username is displayed in the User field. Use the drop-down list to

modify, if necessary.
¢ Select the Manufacturer from the drop-down list.
 [f applicable check one or both boxes Post and Priority.
¢ If applicable check one of the boxes Adult or Paediatric.

¢ [f enabled by the system administrator and the earmould requires a letter to be sent to

the client when it is returned, check the Re-mould box
¢ If necessary, enter comments in any of the 4 comment fields.

Comments on mould(s) box will be printed
on the earmould label.
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¢ [f required, enter Ventilation channel characteristics, and Sound channel width and
length

 [f left mould is the same as right mould, check Copy right to left to copy all
characteristics of the right mould to the left mould.

e Click Save.

¢ An automatic identification number for the earmould will now be added by the system.
This feature can be disabled by the system administrator, and manual identification
numbers can be added.

e [fthere is a need to review client’s waiting list entries while filling earmould details, click
Waiting list entries button.
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12.2 Entering information to show the earmould has been sent
to the manufacturer

This can be done when entering earmould details:

e Enter the date in the Sent to manu box.

¢ Click Save.
Drate of impr. Sent to manu. Ready lssued
100012020 | 25
LEFT
’;duuld * Mo,

If this is done at a later date, for instance if the moulds are sent off in batches:

Navigation -> Earmoulds.
Click the Earmould list button.
Enter the required date range.

e Click Show.
Earmould list >
Paediatric Adult Print Close
Date of impression; 10/01/2018 to  10/01/2020 Earmould centre number:
Date ready: to Mot ready Filter on code
Select all Select Fill ready date
Right No. | Left No.| Date of imp. | Sentto manu.| Date ready | Hospital no.| NHSno. | Client name
09/01/2020 09/01/2020 | 09/01/2020 4084432 Ms. 11
09/01/2020 T1120 MRS FIRSTMAME120 LASTNAME120
111002019 | 09/01/2020 | 09/01/2020 | 4084432 M. 11
MAN2019 | 1M/10/2019 09/01/2020 4084432 M1
21/08/2019 Q222222 Father Test firstname Test surname
29/07/2019 T15825 MRS FIRSTMAMESE25 LASTMAMESE25
125 126 | 13/03/2019 | 13/03/2019 R897596 9589544444 | Mr. J0CC0CCO0CCO0CO0NCO0G0OGCNI CL
789 03/07/2018 03/07/2018 | 03/07/2018 D568978 5555555555 Mr testdf_1
14/06/2018 T146087 MRS FIRSTMNAME46087 LASTNAME4G0
14/06/2018 T111190 MR FIRSTMAME11190 LASTMAME1119(
14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMNAME120 LASTNAME120
2 22 14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMAME120 LASTNAME120
14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMAME120 LASTNAME120
14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMAME120 LASTNAME120
14/03/2018  14/03/2018 * CLIENT PERMANENTLY DELETED *
4 >

¢ Double-click on the appropriate client.
¢ Click on Sent to manu. and enter the date.
¢ Click Save.
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12.3 Entering information that the mould has been returned
from the manufacturer

Navigation -> Earmoulds and click Search.

Enter the earmould number from the earmould label.

Click Search.

Highlight the appropriate client name.

Click Select.

Double-click on the Ready box. The current date is automatically entered. If set up by the
System Administrator, an Automatic Journal Entry will be entered into the Journal.

If the Re-mould box was checked, the send letter window box automatically opens and
you can select the appropriate letter to send to the client.

If the Re-mould box was not checked, click on Save.

If you want to put the client on a waiting list, use the Waiting list button at the top of the
screen.

Or you can close the earmould page and book an appointment for the client in the
booking screen.

12.3.1 Booking back multiple Earmoulds

¢ Open the Earmould List and run the search based on earmoulds which have not been

marked as Ready. This is done by selecting the Not Ready box and then clicking Show.

e Select the earmoulds which are to be returned by clicking to the left of the Right No.

¢ Select Fill Ready date

Earmould list X
Paediatric Adult Print Close
Date of impression: to  10/0142020 Earmould centre number:
Date ready: to Mot ready M Filter on code
Select all Fill ready date
RightNo.lLeﬂ N0.|Date of imp.|Sentto manu. | Date ready |Hospital no.| MNHS no. | ~
09/01/2020 | 09/01/2020 | 09/01/2020 4084432 Ms. 11
] 09/01/2020 T1120 MRS FIRSTMAME120 LASTNAME12(
B 1M 0/2019 | 09/01/2020 | 09/01/2020 | 4084432 MS. 11
B TM02019 | 1110/2018 09/01/2020 | 4084432 Ms. 11
] 21/08/2019 Q222222 Father Test firstname Test surname
B 29/07/2019 T15825 MRS FIRSTMAMES825 LASTNAMES!
B 125 126 |13/03/2019 [13/03/2019 R897596 9589544444 | Mr. X00CO0000CGCOOCOO00CCON0N
B 789 03/07/2018 (03/07/2018 03/07/2018 | D568978 5555555555 | Mr. test df_1
B 14/06/2018 T146087 MRS FIRSTMAME46087 LASTNAME:
B 14/06/2018 T111190 MR FIRSTNAME11190 LASTMNAMET
B 14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMAME120 LASTHNAME12(
B 2 22 14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMAME120 LASTHAME12(
B 14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMAME120 LASTHNAME12(
14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMAME120 LASTHNAME12(
: 14/03/2018 | 14/03/2018 * CLIENT PERMANENTLY DELETED .,
< >
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Paediatric Adult Print Close
Date of impression: to | 10/01/2020 Earmould centre number:
Date ready: to Mot ready M Filter on code
Select all Show Select Fill ready date
Right N0.| Left N0.| Diate of imp. | Sentto manu.| Date ready | Hospital no.| NHS no. ~
09/01/2020 |09/01/2020 4 M3. 11
{ 0 Enter 'Ready’ date |
11/10/2019 | 09/01/202 MS.11 |
] 1111062019 | 111107201 e | G MS. 11 '
7 21/08/2019 Father Test firstname Test surname
7 29/07/2019 ‘Ready date: MRS FIRSTMAMESE25 LASTNAMESE
| 425 126 |13/03/2019 | 13/03/201 444 | Mr. 2000C0000C0000C000000000C0
| 730 03/07/2018 | 03/07/2018 | 03/07/2018 | D568978 | 5555555555 | Mr. test df_1
B 14/06/2018 T146087 MRS FIRSTMAME4G6087 LASTMNAME:
B 14/06/2018 T111190 MR FIRSTNAME 11190 LASTNAMET
] 14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMAME120 LASTMAME12(
] 2 22 |14/06/2018 |14/06/2018 | 14/06/2018 | T1120 MRS FIRSTMAME120 LASTMAME12(
] 14/06/2018 |14/06/2018 | 14/06/2018 | T1120 MRS FIRSTMAME120 LASTMAME12(
] 14/06/2018 |14/06/2018 | 14/06/2018 T1120 MRS FIRSTNAME120 LASTMAME12(
: 14/03/2018 | 14/03/2018 * CLIENT PERMANENTLY DELETED ,
< >

¢ Insert the date you wish to identify as the date earmoulds were ready and then select
Save. Note: The date will automatically populate with the date on the PC calendar.
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12.4 Viewing a client's previous earmould impressions

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

¢ Navigation -> Earmoulds.
* From the Earmoulds drop-down list, select the date of impression you want to view from

the list.
¢ All details of this earmould will now appear on screen.

Earmoulds - MRS FIRSTNAME2278 LASTNAME2272 x
Search Print Label Earmould list Waiting lists entries Print stat. Open with |atest Close
Client
Hospital no. T12278 Mame MRS FIRSTNAME2278 LASTNAME2278 Comments on client -
Transport -
Earmoulds - Delete New Save
Moulds G, 15/06/2009
5, 30M2/2008 Date of impr. Sentto manu.  Ready lssued
Copyr 4, 26/06/2007 Re-mould  10/01/2020 ||t
3, 06/04/2004
[R'GHT 2, 27/06/2002 | LEFT
Mauld 1, 11/04/2000 Mo. Mould ~ Mo,
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12.5 Attaching audiograms to printouts

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

¢ Navigation -> Earmoulds.

¢ Select the appropriate earmould by selecting date from the earmoulds drop-down list at
the top of the page.

e Select an audiogram in the drop-down list.

e Click Save.

e Select Print.
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12.6 Earmould barcodes

In the Earmould module you can search for an earmould either by user input or with a barcode
scanner. When using the barcode scanner, a unique earmould barcode is needed. This barcode

can be printed out from Auditbase, if so set up in Auditbase system administration.

¢ Click on Label in the Earmould module.
¢ Alabel will be printed followed by a barcode if so configured by your system
administrator.

Client name: MRS FIRSTNAME1966 LASTNAME1966
Hosp No: T11966 NHS No:

Impression date: 10/18/2010

Barcode (not transformed): &!101018-7724

Barcode (transformed):

¢ The label contains information concerning the patient’s earmoulds such as the earmould

numbers, type of earmoulds, as well as a hospital number and the audiologist who has

worked on the patient. Comments and notes can also be added to the label.
¢ Once the barcode has been printed, use a barcode scanner to find the earmould in

Auditbase System.

Search earmoulds >

Search Select Close

Earmould number. 123 Earmould centre number: |

Clients found: M Filter on code

Hospital no.| MNHS no. Mame |Date of im
T14438 MRS FIRSTMAME4438 LASTNAME4438 30/0320°
T14438 MRS FIRSTMAME4438 LASTNAME4438 30/0320°
T14438 MRS FIRSTMAME4438 LASTNAME4438 30/0320°
To99444  |1233211233 | Father Tname Fname 28/03/20- ¥
< >
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13 Paediatric Module

Click the button below to access our training materials.

The module contains information related to a client defined as a child or young person. The
module is only accessible when you have selected a client whose age corresponds to the limits
set up by the system administrator.

To access the module, go to Navigation area -> Paediatric or press Ctri+Shift+P.

When either Client search (F3) or Client quick search (Ctrl+F3) is activated from the Paediatric
modaule, it is only possible to create a new paediatric case for a person below the age limit
defined by the system administrator.

If a client aged below the limit is selected, you can add or modify paediatric information. If the
client does not have an existing paediatric record, the paediatric module is left empty and you
cannot enter or save data.

When merging clients that have a Paediatric Module record, only the record belonging to the
Major will be retained after merging. Please ensure you have copied all important data from
the Paediatric Module record of the client to be merged into the Paediatric Module record of the
Major client before merging.
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13.1 Entering data in the Paediatric module

* Press F3 to search for the client or Ctrl+F3 to make a quick search.
¢ Navigation -> Paediatric, or press Shift+Ctrl+P.

To create a new Paediatric record for a client the client must be aged below the limit set by

the system administrator.

¢ Using the tabs at the top of the screen enter the data required in each field.
¢ The tab to be presented at start-up is defined by the system administrator.
¢ Auditbase will prompt you to save information as you leave each tab or the module.

13.1.1 Contact Information

The information in the Contact tab is meant to give a quick overview of relevant contacts for the

child.

Contact information | Referral information | Audiogram | Risk analysis | Consultations | PCHI | Clinical inf.

Consent to share information with education

Yes Mo Withdrawn Refused

Consent to share information with social services

Yes Mo Withdrawn Refused

Consent comments

HV/SHN

HV/ SHN comments

Key worker

Key worker comments

Audiologist

Community paediatrician

SALT

GP
REGISTERED PRACTICE, HOMEGROUND SURGERY, NORTH SWIND( |

GP comment

Comments

ENT consultant

TOHI

Head of TOHI sernvice

School contact

Comments

Child development centre

Comments|

Play group

Mursery school

School

School type

The information on this tab is a combination of drop-down lists and free text. The content of the

drop-down lists can be edited in the following way.
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Right-click on the drop-down arrow of the fields you want to edit.

Click New.

Add the required name for the Text box.

Click Apply.

Click Close.

The required name will now appear in the drop-down list and can be selected via clicking.

The fields that are edited in this way are: TOHI (Teacher of the Hearing Impaired), Head of
TOHI, SALT (Speech and Language Therapist), Community Paediatrician.

Audiologist is a drop-down list of the users on the system.

ENT Consultants and School Information are added from lists.

The ENT Consultant may be transferred from the Client Information screen if configured
to do so by your System Administrator. Any change here may affect the ENT Consultant in
the Client Information module.

Click on the button at the end of the field and select the required option:

Create new allows you to add a new referring agent, for instance a school, doctor or
health visitor. Fill in the referring agent screen as required.

Select all opens the search window, where you can enter search criteria. Highlight the
referring agent you wish to select and double-click or select to add them to the client
record.

Select from list opens the search window and automatically displays all agents. Highlight
the referring agent you wish to select and double-click or select to add them to the client
record.

Clear field removes the currently selected referring agent from the client record.

Change to the information is saved to the database by clicking Save from the File menu
or pressing Ctrl+S.

13.1.2 Referral information

A dynamic overview of referrals through time is obtained from this tab listing date, agent,
reason(s) and notes.
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Contact information || Referral information | Audiogram | Risk analysis | Consultations | PCHI | Clinical inf.

Previous referrals

Date Agent Agency Reason
02/21/2008 | * AA-CHECK GP ++Patient self referral
02/27/2008 | * AA-CHECK GP AUDIOLOGY referral
Date of referral : 02/21/2008 Reason for beginning

Referring agent
* AA-CHECK GF, PLEASE REQUEST GP NAME

Reason for ending

Referring agency -

Episodic conclusion

Referral reason

++Patient self referral -

Information

concerns with S+L

The drop-down lists for Reason for beginning and Reason for ending are defined by the
system administrator.

Previous referrals are listed in the box. Click on the referral to see the information. This tab is a
combination of drop-down lists and free text.

Select the reason from the Referral reason drop-down list.

Select other referral reasons from the Reason for beginning and Reason for ending
drop-down lists.

Enter further information in the text boxes.

Referring agent and Referring agency are added from lists.

Click on the button at the end of the field and choose the option required, see Contact
information for further information on how to enter data.

Selecting New referral from the Functions menu and entering information in the fields
followed by saving, will store a new referral to the database.

Selecting a referral from the list of previous referrals followed by selecting Delete referral
from the Functions menu removes the referral from the database.

Changes to the information are saved to the database by clicking Save from the File
menu or pressing Ctrl+S.

13.1.3 Audiogram

Audiograms entered in the system are displayed in the Audiogram list box.
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Contact information | Referral information | Audiogram | Risk analysis | Consultations  PCHI | Clinical inf.

Audiogram list

3/26/2018, nr: 1 - * HL SPL dB(A)

1011212015, nr 1

10/8/2015, nr: 1 Audiogram [ 125 [ 250 [ 500 [ 750 [1000[ 1500  2000] 3000] 4000 6000[ 3000
2010003 . 3/26/2018, no. 1

Q345015 2
S54i508 . 1 AIR NORMAL, RIGHT 40 | 40 | 40 | 40 | 40 | 40 | 40 | 40 a0 | 40
21012009, nr: 1 - BONE NORMAL, RIGHT 65 | 85 | 65 | 65 | 85 | 65 | 65

AR MORMAL, LEFT 35 35 35 35 35 35 35 35

BOMNE MORMAL, LEFT 50 50 50 50 50 50 50 50 50

MORMAL -

o] Symbol
O Ac

@ AC MASKED
£\ BC UNMASKED
L BC MASKED
L ucLum

M4 MCL UM

% sF

* SFM

W RIPSY

| ]

* RCONTRA

*om @ e w2 U X X

Comments

e To view an audiogram, click on the date to display it numerically.

e To enter a new audiogram, click on the symbol required on the left-hand side of the
screen and type the numeric values in the audiogram table.

e Various tests, VRA, ABR, SSEP and Distraction can be entered.

e These tests result in audiogram thresholds for the frequencies using HL, SPL or dB(A)
calibration.

e Each special test (with a set of thresholds) will be interpreted as an audiogram curve with
its own corresponding symbol set in the audiogram module. Before a curve can be
entered as new, calibration must be selected.

¢ All values are converted into HL before they are stored in the database structure.

e The curve type Estimated audiogram is a type that does not refer to a specific test. The
intention is that the audiologist determines the thresholds for the estimated audiogram
by viewing the values from the obtained special tests.

e The values for the estimated audiogram can then be entered as HL, SPL or dB(A)
calibrated thresholds. All thresholds must be entered using the same calibration.

* When an estimated audiogram is saved, it is stored in the database structure as a pure-
tone normal audiogram with a hard-coded note (10) on each threshold. This results in an
audiogram that can be used in Noah for hearing instrument fitting, see How to enter into
Noah

e The audiogram information can be viewed in Table or Graph mode so instead of entering
thresholds as numerical values, the graphical display can be used as well. Choose the
mode from View -> Table mode or Graph mode. The functionality is similar to the
Audiogram module. By highlighting the dates in the Audiogram list box, you can decide
which audiograms to view in both modes.

¢ Values can be entered in HL, SPL or dB(A).
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¢ In both the tabular and graphical view, the audiogram can be viewed from the audiogram
module and all other places where the audiogram is present.

¢ In both layouts, the mean values for 500, 1k, 2k Hz or 500, 1k, 2k, 4k Hz are displayed.

¢ Changes to the information are saved to the database by clicking Save on the screen,
from the File menu or pressing Ctrl+S.

Note: If a new audiogram is chosen the client cannot change the audiogram mode to
graph. If the client is on graph mode then selecting a new audiogram is not possible.

13.1.4 Risk Analysis

From the Risk Analysis tab, the user can enter risk parameters from observations about the
child explaining the hearing problem.

Contactinformation | Referral information  Audiogram | Risk analysis | Consultations | PCHI | Clinical inf.

Last updated Confirmed syndromes
11/28/2022| Add/Remove
MNewborn hearing screening test Mame
None
B Passed Referred Mot done
Health visitor distraction test
Passed W Referred Mot done
Parental concern Risk factors
Add/Remove
Name
Progressive Noise-induced
Hearing status
Weight at birth (ka) Date of birth Gestation in weeks
3.00 1211812004
Progressive Congenital/neonatal
Family history
W Yes Mo Yes H No

Postnatal cause

Date of post natal cause

SCBU /NNU /NICU
Age of post natal cause

Where some of the fields require predefined input, the date fields are automatically filled with
dates retrieved from the database. Each saving of risk information retrieves the system date
from the database to update the Last updated field. The Date of birth field is retrieved

from Client information/Date of birth.

Newborn hearing screening test and Health visitor distraction test can be unchecked or
checked to indicate whether the child passed the test, has been referred for further or testing
has not been performed at all.

Information to be filled is the child's Weight at birth in kilograms, Hearing status, Operations,
Family history, Parental concern. Both Risk factors and Confirmed syndromes can be added
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by clicking Add/Remove and selecting appropriate items in the lists of those defined via the
System Administration tool -> Paediatric definitions -> Risk factors -> Syndromes.

All selections and texts can be corrected and updated to the database reflected in the Last
updated field.

Changes to the information are saved to the database by clicking Save from the File menu or
pressing Ctrl+S.

The drop-down lists for Syndromes and Risk factors are defined by the System Administrator.

13.1.5 Consultations

This tab is used to write information related to each of the child's visits to the clinic. The child
can have several consultations, so with all the information on these tabs referring to a
consultation, the user can enter information about future consultations and also view
information from past consultations.

For onward referrals, use the Onward referrals and reporting module.

Contact information | Referral information | Audiogram | Risk analysis || Consultations | PCHI | Clinical inf.

Visits Otalgia: Onward referrals
Date Time | Symbol | Status Resource A

Please use the Onward referrals and reporting

g | screen
03/23/2018 1215 ml 5 Charlie
03/23i2018 1615 5 Charlie
10/10/2015 | 10:15 [m Travy Otorrhoea
10/09/2015 | 9:45 Z Trawy
02/10/2009 | 10:00 T 5 Resg2
01/06/2009 | 11:45 Z s Res&2 v I
General development
Aetiology:
MNaormal Delayed Mot ascertained
Speech/language development
Mormal Delayed Mot ascertained
Snorer/mouth breather: LOEENE
Colds: Operation:

School advice given

Yes Mo

Information to family Care plan - post consultation

Date and Time of each consultation is automatically transferred from the appointment book,
with the name of the resource with whom the appointment is scheduled.

Updating the information of a consultation is done by selecting the appropriate date and time
from the list which enables the fields to be filled with information on the tab.
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Free text can be added to respective fields:

e Snorer/mouth breather

e Colds

e Otalgia

e Otorrhea

¢ Aetiology

* Otoscopy

¢ Operation

¢ Information to family

e Care plan - post consultation

¢ The appointment is booked by selecting this in the Functions menu and filling in
information in the appointment dialog (Booking).

Also from the Functions menu, a consultation can be deleted once it has been selected from
the list.

Changes to the information are saved to the database by clicking Save from the File menu or
pressing Ctrl+S.

13.1.6 PCHI (Permanent Childhood Hearing Impairment)

By entering the date of the first appointment, observations and procedures and hearing
instrument issue in the date boxes and pressing TAB, Auditbase will calculate the Age in
months at these stages for you. Auditbase uses the date of birth entered in the client
information module to make these calculations.

Contactinformation | Referral information | Audiogram | Risk analysis | Consultations | PCHI | Clinical inf.

A f.5,1,2 4 kHz bett
First audiology professional HEEDE A Zhefter ear

Date 021412005

Age 0 Year(s) 1 Month{s) 27 Day(s) MNotes
Diagnosis

Date 03152007

Age 2 Year(s) 2 Month(s) 25 Day(s)

Hearing aid issue

Date 412712012

Age 7 Year(s) 4 Month(s) 9 Day(s)

Free text can be filled in for the average of .5, 1, 2, 4 kHz in the better ear and notes.
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Changes to the information are saved to the database by clicking Save from the File menu or

pressing Ctrl+S. Changes to any of the fields are made by correcting dates or text and saving to
the database.

13.1.7 Clinical information

This tab presents an overview of the client’s clinical status. Sorted by date, the medical
condition, investigations and immunisations are listed in the three tables.

Contact information | Referral information | Audiogram | Risk analysis | Consultations | PCHI || Clinical inf.

Significant medical conditions /illnesses

Date ICD 10 Description

Test observation

Investigations

Date Investigation Result
1112842018 |High Freq Tymp

Vaccinations & Immunisations

Date Immunisation

¢ To add information, double-click a row in the table.

¢ Enter new clinical information or delete existing information in the window box.

¢ The system date is given to the date field by default and from the drop-down box you can
select between the clinical information defined by the system administrator in the
Administration tool.

e Changes to the information are saved to the database by clicking Save from the File
menu or pressing Ctrl+S.

¢ Information is deleted by double-clicking the respective entry in the table and pressing
Delete in the dialog box.
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13.1.8 Deleting Paediatric information

When paediatric information for a client needs to be deleted from the database, Delete from
the Edit menu holds this function and the user is warned that carrying out this action cannot be
undone.

Pressing Yes to the security question erases all paediatric information for the client from the
database.

Pressing No ends the deleting session without erasing paediatric information for the client from
the database.
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13.2 Paediatric review report

To access this report in the Paediatric module:

¢ Select View -> Paediatric review report.

» Select unaided audiogram.

» Select aided audiogram.

e Hearing instrument information is taken automatically from the client's device list.
e Enter hearing instrument details.

¢ Click Print.
Paediatric review report / MR JOHN SMITH (T18763) x
Print Close
Mumber of copies to print 3
Select unaided audiogram 1000172020, 1
Select aided audiogram 110032019, 1
Hearing Aids
Type right NHS SUPPLIES, ITE10MR
Type left BERMAFOM, test
Right Left
Uservolume 23 20
Settings
Serial number 1234432 1234433
Audiologist  SYSTEM ADMINISTRATOR -
Conclusion
-
-
TOHI [W] :Community Paediatrician:
B ENT SALT
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13.3 Printing

You can preview or print a full report of the information you have entered in the Paediatric
Module.

¢ Select File -> Print or press Ctrl+P.

¢ Select which pages to print:

¢ Printall

¢ General paediatric information (Family + Contact information)
¢ Referral information

e Audiogram

¢ Consultation

¢ Significant medical conditions/illnesses

¢ Investigation

¢ Immunisation

¢ A printout will be sent to the default printer.

OR

e Select Print preview. A copy of the report will be displayed on screen.

* When Preview is presented on screen, the file can be exported to Format and
Destination selected in the Export dialog followed by OK to carry out selection or return
to Preview by hitting Cancel.
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14 Stock

Click the button below to access our training materials.

All articles, such as hearing instruments, spare parts and services, can be managed in the
Stock module.

The Stock module has relations to invoicing and other additional facilities for purchasing,
ordering, repairing, etc.

To open the Stock module, select Navigation -> Stock or use Ctrl+Shift+S.

In the Stock tree view, all devices are shown in the hierarchy Group/Manufacturer/Article.

%)) Auditbase - [Stock]
File Edit Functions Statistics Settings

ftem | Atide | Group Searchseriaino. Search Batch/lot  Registerforstock  Add externalftems  Newstatus Bulkiransfer Batteryissue Fastaccessoriesissue  Purchase orders  Add senicetoorder  History Printbarcode | New task
information External items
’E Client T117575 MST FIRSTNAME17575 LASTNAME17575 - g ¥ B User John Smith ‘AH locations | Al - ¢ ?
Navigation <) Stock tree Stock list Search New status Device List Invoice Reguisitions Verification
&- Favourites
-2 Devics st Supplier Model Stocktipes
i~if Repairlist ~ [Testmanu Etest group ~
L5 Erem e (2)Testmanu ITET0LL BATTERIES IN STOCK (Batteries in stock)
et 123456789 ITETNR FITTED/EXCHANGED (1ssued)
SPECIAL TECH. AIDS (Quantity) ITEML POSTAL BATTERIES (Issued batteries)
-] AB Audiogram BATTERIES (Quantiy-Accessory) (3)Testhanufacturer 5E101 pel
[ Stock PROCEDURES (Sevice) pe2
Senice-Accessary pe3
COMMERCIAL HEARING AID (Serial No.) ned
Stock management EARMOULD ACCESSORIES BE103 pes
[ Stock ELBOWS BE105 LOAN (Lent outto dlient)
[ - LEADS, RECEIVERS & SHOES v s ' [TEACHERS OF THE DEAF (Lent outto other) v
LB

Show discontinued

Show discontinued

"2 Requisition
i1 Repairlist

Show discontinued Filter by a part of a

3
2

A& O

L0 Purchase orders Aficle information Serial number RKG00259 BatchiLot 54115
Article ID 50254 ~ Modfieddats: 672024 o
No ordered: 0 Receiver:
Aftcle type: Versian Onledby
Version Colour BROWN -
NHS price s Type
Internal art. no Label <) Serial no.
NHS art no tem o
Basic purch. price: § 46.69 BatchiLot 54115 IR T
Discount % Recyded No
Basic sales price: 546,69 Sales price: $47.26
Supplier &M HEARING LTD Warranty expires
Supp artidleno:  GHB023 Purchase prics:  §46.69 Fiter batchiot
Purchass date:  GH7/2024
Retum date
Warranty code: 24
Edititem
< tem 5 outof 5 )y

In the Stock list view, you can see all devices in a table.
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9)) Auditbase - [Stock] - [m] X
File  Edt | Functions | Stafistics  Settings
[ [ w ) 2 5 B B i G B B =
B v = T o B e & v =l =
) Q ) 2 » B B G » o& =
ltem | Atticle | Group  Searchserialmo. Search Batch/lot = Registerforstock  Add external items  Newststus Bulktransfer Batteryissue Fastaccessoriesissue  Purchase orders Add service to order  History  Print bar code | New task
Information External items
[C]| Client  T117575MST FIRSTNAME17575 LASTNAME17575. BEAEIE: John Smith Al locations ~+| All departments -] 2
Navigation Stock tree * Stock list Search New status Device List Invoice Reguisitions Verification
&- Favourites
-2 Device list EREEE
i~if Repairlist Group [ Manuracturer Aficle Supplier a1t no ~
i-[2 Purchase orders NHS HEARING AID (Serial No.) | NHS SUPPLIES | ITETIMR GHB 0081 [BATTERIES IN STOCK (Batteries in stock)
- FITTED/EXCHANGED (Issued)
I Requisition NHS HEARING AID (Sefial No,) | NHS SUPPLIES |ITETIML I5°5 313polkpo P OSTAL BATTERIES (1ssued batieries)
i~ ABAudiogram NHS HEARING AID (Serial No.)  NHS SUPPLIES BE101 GHB059 pet
- Stock NHS HEARING AID (Sefial No) | NHS SUPPLIES BE1018 ve2
23
| [NHSHEARINGAID (Serial No) |NHS SUPPLIES | BE101G GHBO48 zet
Stock management NHS HEARING AID (Serial No.) | NHS SUPPLIES | BE102HF GHB 104R pes
i-[& Stock NHS HEARING AID (Sefial No.) |NHS SUPPLIES | BE103 GHB043 7 JLOAN (Lent out to diient)
= ~ [TEACHERS OF THE DEAF (Lent outto other) v
LB S PO T T T o P YT e e = — Ty
-2 Requisition Show discontinued Filter by a part of artcle name ) srow dscontinues
b7 Repair list
[8 Purchase orders Aticle information Serial number RKG00259 BatchiLot 54115
Article 1D 50264 Wodified date: 611712024
No ordered 0 Receiver:
Aricle type: Version: Order by:
Version: Colour BROWN P
NHS price s Type:
Internal art. no Label + Serialno.
NHS at no item no.
B e ST B 27 e e
iscoun ecycle o
Basic sales price; 5 46.69 Sales price: $47.28
Supplier ABNM HEARING LTD Warranty expires
Supp. article no:  GHB023 Purchase price:  § 46.69 Filter batchilot
Purchase date: 511712024
Battery: CcPasg 54115
Retun date
Warranty code: 24
Edit tem
] tem 5 outor 5[ p
[o) = .
R&EH A pp

Auditbase remembers the last opted-for view. When the Stock module is reopened, the view will
be in the same mode as it was previously selected by user.

By default, discontinued items are filtered out. They can be included in the list when the "Show
discontinued" option is selected.

In the Filter field, you can enter any part of the device name and all related items will be
displayed. In the Stock tree view, the search is conducted within the chosen Group and
Supplier. In the Stock list view, the search is comprehensive and the output will include items
from all Groups and Suppliers.

In the upper section the Stock module lists the Group, Manufacturer, Article, and Stock type
that are used for selecting the specific item to work with.

Selections are made from left to right over the available lists:

Group

Contains definitions of for example hearing instruments, spare parts, accessories and services.
Groups are defined by the System Administrator. Each group is managed and identified by
Serial no. or as Quantity or Service.

Depending on the group selected in the list, the displayed information in the lower part of the
screen will change. For example, selection of a serial number controlled group will show Article
Information, Order by and Search. Selection of a quantity controlled group will show Article
Information and Items found. Selection of any group identified as service shows Service
Information.

Manufacturer
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Shows the manufacturers of articles of the group selected in Groups. For example, for the
Hearing instruments group, the list can contain manufacturers as Auditdata, Widex, and Oticon
etc. A new manufacturer can be added or existing manufacturers modified, when the group is
selected, from the menu Functions -> Settings -> Manufacturers.

Article

Lists the sub-category of Manufacturer. For example, for Hearing instruments, the Auditdata
manufacturer, the Article list contains stock articles produced by Auditdata. Articles are defined
in Functions -> Settings -> Articles.

Stock type

Identifies the physical location or current status of an item. For example, when a supply of
articles is delivered, the new purchased items should be registered as In stock.

Changing a stock type for an article implies that an article has moved from being In stock to
being Issued to client or maybe temporarily For repair from the status Issued to client. The
same applies to other stock types for example Spare parts.

NOTE: Changes in the status of items create clinical actions. If you have attached them to
appropriate appointments, they can be seen on the Clinical actions tab of the Referral
module.

Stock types are defined by the System Administrator.

For a quantity controlled group, items can be deleted no matter which stock type status they
have.

Miscellaneous

The headings for Manufacturer and Article can be defined by the System Administrator. For
example, you can see that for Spare parts, the heading for the lists changes to Type and Series.

Any selected article shows Article information with product ID, quantity ordered, type, codes,
prices and discount, supplier and supplier article number and if you have selected a group
identified serial number, you will also see a version number.

Information about external and internal product codes, lowest stock level, lowest stock level at
bulk buy or collective purchasing, type, version, etc. can be attached to an article.

If an HI has the status Lent by employee, you will see the employee’s name under the Article
information, when the article is selected in the main Stock window.

Read more about the Stock module in the following chapters.
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14.1 New status

To change the status of an item, select a group, manufacturer, article and stock type. Find the
item and click New status. In the opened New Status dialog, select the new stock type, specify
the required details and press Save.

Note: The status of devices and accessories can also be changed from the Devices tab of
the Client Information module.

Mew status for senal number: 11233445, NHS SUPPLIES, ITETTMR X

Client MR. JOHM SMITH Print Settings OK Cancel

From stock type Aricle name Ear Date

STOCK - GWH (In stock) ITETIMR W R L MNiA  28M1/2022 Recycled

Location User
Al locations - SYSTEM ADMINISTRATOR HI Satisfaction questionnaire wanted
To stock type History comment Price Invoice type

FITTED/EXCHANGED (lssued) £58.14 Invoice type 1 -
LOAM (Lent out to client) ;
TEACHERS OF THE DEAF (Lent o Reason to issue

SENT FOR REPAIR (Repair) -
DAMAGED (Lost) ltern information Invaice

OBSOLETE (Lost) 133

Louisa's sorting (In stock) to customer

RECONDITIOMED (Issued)
REPLACEMENT (lssued) # to client
STAFF DEMO'S (Lent out to ather)
STOCK - PAEDS (In stock-=lssuec
Sent to manufacturer (In stock)
UNTRACEABLE (In Stock)

4

Show discontinued

If the change of stock type is the issuing of an instrument, the instrument will be given the
status Issued and this will be registered for the selected client. Simultaneously the issue is
registered for invoicing.

If so configured by your System Administrator, it might be mandatory to select the Reason to
issue (used especially in Denmark). The reasons are listed by a four-digit code using letters and
numbers. They are sorted alphabetically in order to make the selection easier. No other priority
sorting is supported. You can select the code by using number and letter keys on your
keyboard, when the drop-down list is selected. Each key press will select the next character in
the code. Once selected, the Reason to issue code will then be shown on each posting related
to this type of issue and inside the invoices.

All changes of status will be registered in the history of the item which is displayed via the menu
Functions -> History.

In addition, changes of status automatically create clinical actions, namely:

¢ When the new stock type of a device is of the Issued category and its current stock type is
not of the Repair or Lost category, a clinical action of the Issue article type will be
created, meaning that the device is issued to the client.
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¢ When the new stock type of a device is of the Issued category and its current stock type is
of the Repair category, a clinical action of the Issue article from repair type will be
created.

¢ When the new stock type of a device is of the Issued category and its current stock type is
of Lost category, a clinical action of the Issue article from lost type will be created.

¢ When the new stock type of a device is of the Lent out to client category, a clinical action
of the Lend out article type will be created.

e When the new stock type of a device is of the In stock category, and the device is
associated with the client before this transaction meaning that the current stock type is
either of the Issued or Lent out to client category, a clinical action of the type Return
article to stock will be created.

NOTE: A device can be moved to stock directly from another stock type, or from a stock
type of the Lent out to other category, or from the Repair category. However, in such
cases there is no client associated with the device, and a transaction like this will not be a
clinical action.

e When the new stock type of a device is of the Repair category, and the device is
associated with the client before this transaction meaning that the current stock type is
either of the Issued or Lent out to client category, a clinical action of the Return article
to repair type will be created.

NOTE: A device can be sent to repair directly from stock. In such a case, the current stock
type is of the In stock category and there is no client associated with the device. Therefore,
a transaction like this will not be a clinical action.

¢ When the new stock type of a device is of the Lost category, and the device is associated
with the client before this transaction which means that the current stock type is either of
the Issued or Lent out to client category, a clinical action of the type Record lost article
will be created.

NOTE: A device can be registered as Lost if it is currently not associated with a client. A
transaction like this will not be a clinical action.

The New Status dialog can also be called by scanning a barcode of a device already registered
in the system.

When a new status is selected you can change the Print settings for each status.
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Default print setting for 'FITTED/EXCHAMNGED (lssued)’ d
Clear Print Preview 0K Cancel
Headline text
Print addressee
test headline )
# Client
MW Print article price Number of copies | g Supplier
M Print supplier data
Body text
Test2 -
-
Lower body text
Testp -
-

NOTE: If you have attached clinical actions to appropriate appointments, such clinical
actions can be seen on the Clinical actions tab of the Referral module.
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14.2 Issuing a quantity controlled hearing instrument from

stock

¢ Press F3 to search for the client or Ctrl+F3 to make a quick search.

e Select Navigation -> Stock or press Shift+Ctrl+S.
¢ Select Group.

e Select Supplier.

¢ Select article/instrument type.

¢ Select the current stock type for the instrument, for instance Stock existing users.

¢ Click New status.

¢ Select the new stock type, for instance Issued.
e Select right or left if required.

¢ Click OK.

[Test Quantity Group

Test Serial No. Group

Test Senvice Group

MNHS HEARING AID (Serial No.)

SPECIAL TECH. AIDS (Quantity)

[TestArtemiD

BATTERIES (Quantity-Accessory)

PROCEDURES (Senice)

Service-Accessory

COMMERCIAL HEARING AID (Serial No.)

EARMOULD ACCESSORIES

ELBOWS

LEADS, RECEIVERS & SHOES

SERVICES v
Show discontinued

M| Show discontinued Show discontinued

Filter b

v a part of article na...

9}} Auditbase - [Stock] — [m] X
File Edit Functions Statistics Settings
& BB e A s
Pao Nl > (Z i
Detailed | Quick |mpertdata Exportdata | Exportto Moah Logoff | Exit Auditbase
Search Import/Expert Client data Exit

I Client  13/06/1990 MR. JOHN SMITH - | &= Bl user SYSTEM ADMINISTRATOR | All locations ~ | All departments - (gx|?

« Stock tree Stock list Search Mew status Device List Invoice Requisitions Verification

Group Manufacture Aricle Stock types

Group 1 A |(3)Testmanu TELE COIL, CHAIR In Stock 1 ~

Serial Mo. Group 1 [TRAMSETT MINI IMKL. MIK. |ssued 1

Service group 1 [TRANSETT MINI SCART Lent outto client 1

Stock group 1 Repair 1

STOCK - GWH (In stock)

BATTERIES IN STOCK (Batteries in stock)
FITTED/EXCHANGED (Issued)

POSTAL BATTERIES (Issued batteries)
LOAM (Lent out to client)

[TEACHERS OF THE DEAF (Lent outto other
SEMT FOR REPAIR (Repair)

DAMAGED (Lost)

OBSOLETE (Lost)

Louisa's sorting (In stock)
RECOMNDITIONED (lssued)
REPLACEMENT (Issued)

STAFF DEMO'S (Lent out to other)

STOCK - PAEDS (In stock->Issued) o
T Show discontinued

Article information

ltemns found

Article information

Reduce quantity

© Auditdata - 2025, ID: 20.0040/36

271



User Guide

14.3 Issuing a serial number controlled hearing instrument
from stock

¢ Press F3 to search for the client or Ctrl+F3 to make a quick search.
¢ Go to Navigation -> Stock or press Shift+Ctrl+S.
¢ Select the device to be issued by scanning the barcode.

OR
¢ Select Group, for instance, NHS hearing aid.
e Select Supplier, for instance, NHS supplies.
e Select article/instrument type (model), for instance, BE101B.
e Select the current stock type for the instrument, for instance, STOCK - GWH.
¢ Enter the batch/lot number in the Filter batch/lot box.
¢ Enter the serial number of the instrument in the Filter serial numbers box.

It is important that you enter the serial number of the instrument you are going to issue in
the Filter serial numbers box before you issue the instrument. This will enable tracking of
serial number controlled instruments in the system.

5) Auditbase - [Stock] - ul X
File Edit Functions Statistics Settings
= 7 = = = i B 3 B =
=] = oo = =
S > B G @ G& B
b sea 0. Search Bateh/Lot | Register for stock s Newstatus Bulltransfer Batteryissue Fastaccessorlesissue Purchaseorders Add senice to order  History  Printbarcode  Newtask
External ftem:
L] Client T117575 MST FIRSTNAME17575 LASTNAME17575 - g > B user John Smith All locations | All departments - Q 2
) Stocktree Stock list Search Hewstatus | Device List Invoice Reguisitions Verification
Group Supplier Model
(61 ~ [(Testmanu Cjtestgroup ~
lQuantity 2 (@)Testmanu ITE10ML BATTERIES IN STOCK (Batteries in stock)
INHS HEARING AID (Serial No.) 1123456789 ITE11MR FITTEDEXCHANGED (lssued)
SPECIAL TECH. AIDS (Quantity) ITE11ML POSTAL BATTERIES (Issued batieries)
BATTERIES (Quantity-Accessory) \(3)Testhlanufacturer BE101 pel
IPROCEDURES (Service) pe2
[Senice-Accessory pe3
(COMMERCIAL HEARING AID (Serial No.) ped
EARMOULD ACCESSORIES pes
ELBOWS BE105 LOAN (Lent out ta client)
LLEADS, RECEIVERS & SHOES BE18 EACHERS OF THE DEAF (Lent out to other)
ELS&J&SDACCESSOR\ES v BE19 v EEA?’IESEFEF’:\R (Repair)
Show discontinued Show discontinued Show discontinued Filter by a part of article name v Show discontinued
Article information Serial number RKG00255 Batch/Lot 54115
Article ID: 50264 - Modified date: BM7/2024 -
No ordered: 0 Receiver:
Article type: Version Order by.
Version Colour: BROWN Date
NHS price: $ Type
Internal art. no.: Label: + Serial no.
NHS art. no Item no.
Basicpurch. price: § 46.59 BatchiLot 54115 e TS
Discount: % Recycled: No

Basicsales price:  §46.69 Sales price §47.26 RKG00255]
Supplier: A&M HEARING LTD
HB023

Warranty expires:
Supp. article no.: Gl Purchase price: ~ $46.69 Filter batchilot
Purchase date: 6172024

Battery. cras 54115
Return date:
Warranty code: 24
Edititem
ST ttem 1 outof: 1 ®

* When the serial number of the device is found, click New status.
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New status for serial number. RKG00255. NHS SUPPLIES, BE101B X
Client MST FIRSTNAME17575 LASTNAME17575 Print Setings oK Cancel
From stock fype Article name Ear Date

STOCK - GWH {In stock) BE101B R L m s 06172024 Recycled

Location User

jAll lncarlons e Jofn Smith T HI Satisfaction questionnaire wanted
To stock type Histary comment Price Invoice type

FITTED/EXCHANGED (Issued) ~ o $47.26 Invoice type 1 -
POSTAL BATTERIES (Issued batteries)

type1 Reason to issue

type2

type3 - 1a01 -
type4 ltem information Invoice

types

LOANM (Lent outto client) - : 0

TEACHERS OF THE DEAF (Lent outto othe 0 customer

SENT FOR REPAIR (Repair)

DAMAGED (Lost) .

LOST

OBSOLETE (Lost)

Louisa's sorting (In stock)

REPLACEMENT (Issued)

'STAFF DEMO'S (Lent outto other)

STOCK - PAEDS (In stock-=lssued) W

Show dizcontinued -

¢ Select the new stock type, for instance Damaged - your System Administrator can create
a default ‘next stock type’ for each Stock type to speed this up.

¢ Select the right or left ear. N/A can be used for articles that are not assigned to a
particular side. If N/A is selected, it will appear as - in the Device list.

e Select the Invoice type - your System Administrator can create a default Invoice type for
the whole site and for an individual workstation to speed this up.

e Select who to invoice to - your System Administrator can save a default invoice for the
whole site and for an individual workstation to speed this up.

e OK.

¢ If configured by the System Administrator, the system shows a confirmation request.

Stock transaction confirmation X

You are going to issue (lent out - in case of lending out) the following stock article
NHS SUPPLIES, BE101B, RKG0D0255

to the following client:

T117575 MST FIRSTNAME17575 LASTNAME17575

Details are the following:

MNew stock type: FITTED/EXCHANGED (Issued)

Side: NiA Date: 06/17/2024

Invoice type Invoice type 1 Invoice to Client: T117575 MST FIRSTNAME17575 LASTNAME17575
Price $47.26

Return date:

Is the above information correct?
Click Commit to issue (system will make stock transaction)
Click Edit to return to "New status” dialog and change some information

Click Abort to cancel stock transaction

Commit Edit Abort

« Commit to issue, Edit to edit data, Abort to interrupt.
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14.4 Issuing devices from Stock after fitting in Noah

In order for devices to be issued from Noah once you have properly programmed and fitted the hearing
instrument, it is important that you have:

» Correctly selected the new instrument you wish to fit.
e Saved the Noah action.
* Closed the fitting software.

The process reacts on a new or updated saved Hearing Instrument selection action.
In order for the Stock transaction confirmation window to open successfully, you should:

¢ Ensure Auditbase is NOT minimised to the task bar.
¢ Ensure Noah is NOT minimised to the task bar.

If Auditbase is minimised and you have already saved the fitting process and closed the fitting software,
maximise Auditbase again and the confirmation window will appear.

If Noah is minimised, you have already saved the fitting process and closed the fitting software, click on
the Audit Base screen and the confirmation window will appear.

If you close the Serial numbers found in Noah dialog without issuing, the dialog will not be displayed by
simply connecting to that aid again in the Noah module, a change must be made to the hearing
instrument selection in the fitting module and that change saved before the dialog can reappear.

A pop up box will appear when pressing Close without having completed the stock transaction when
issuing a hearing aid via Noah within Auditbase.

The warning will ask:

I@ Are you sure you wart to close the issue dialog without making the suggested stock transaction|s)? You will be asked to provide a reason why you are cancelling the issue.
If you confirm that you wish to close the issue by selecting Yes, an Automatic Journal Event will be fired

asking you to provide a reason why the event is being cancelled. This can be configured by your System
Administrator.
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OK

Selected event

1464
Users rejected issuing device after fitting in NOAH

Keyword
GENERAL -

Issue after fitting in NOAH was activated but rejected by the user SYSTEM ADMINISTRATOR. The devices »
found in NOAH were the following: Serial number: 23243543554, Manufacturer: Not found, Article: Not

found, Ear side: R; Serial number: 2343535356, Manufacturer: Not found, Article: Not found, Ear side: L;
PLEASE PROVIDE A REASON FOR CANCELLING THE ISSUE

tw
=]
(=]
]
(1]
]
0
O
||
-
i
i

After closing down Noah, the system may check whether any fitting actions were performed, if
so configured by your System Administrator. A list of the articles found will be displayed.

| Client MR. JOHN SMITH Proceed Close

| M Open’Accessory issue’ automatically B Open Device list' if another current device is found

Serial number Manufacturer Aricle Ear side Stock type Patient Hospital no. Action

] 543554 NHS SUPPLIES ITE10ML R |STOCK- GWH (In stock)

2343535356 ) i . ) ) ) En New status
123214124 |
|35223532523523 Client MR. JOHN SMITH Print Settings OK Cancel én New statue

1433532532525 én New statue
| 4563646643 From stock type Article name Ear Date |

| 432423455666 STOCK - GWH (In stock) ITE10ML HR L MiA 28(11/2022 Recycled

en New status

en New statue
Location User |

| Alllocations - SYSTEM ADMINISTRATOR HI Satisfaction questionnaire wanted
| To stocktype History comment Price Invoice type

| Repair1 ~ < £6936 Invoice type 1 hd
FITTED/EXCHANGED (Issued)

| ILOAN (Lent outto client) Reasontoissue

| [TEACHERS OF THE DEAF (Lent o & -
| [SENT FOR REPAIR (Repair) ltem information Invoice

DAMAGED (Lost)
| |OBSOLETE (Lost) to customer
1 |Louisa’s sorting (In stock)
| |RECONDITIONED (Issued) # to client

4

REPLACEMENT (Issued)
| |STAFF DEMO'S (Lent out to other)
1 |STOCK - PAEDS (In stock-=lssuec
| |Sentto manufacturer (In stock)

| INTRACFARI F (In Sinck)

Show discontinued -

¢ In the column called Action, you can choose what to do with the articles. Place your
mouse in the cell and an arrow appears, from where you can choose an action in a drop-
down list.

¢ Once you have chosen actions for all articles found, press ‘Proceed’, where after all
articles are processed one by one.

¢ The article being processed is now highlighted in the background.
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Client MR. JOHM SMITH

Proceed Close
| ‘M Open‘Accessory issue’ automatically M Open ‘Device list if another current device is found
Serial number Manufacturer Article |Ear side‘ Stock type | Patient Hospital no. Action
NHS SUPPLIES| ITE10ML R FITTED/EXCHANGED (Is= JOHN SMITH T1625 - Processed

123243543554
§ 2 56

L

==Not found=>

Register for stock - G12, MANUFACT x
* Stocktree Stock list Save Cancel
Group Manufacturer Articles Stock types Serial no
G12 OTICON MEDICAL || test group ~ STOCK - GWH (In stack) 2343535356 -
PHILIPS BE102H BATTERIES IN STOCK (Batteries in
Semvice-Accessory PHONAK ITE10ML TEACHERS OF THE DEAF (Lent ou
COMMERCIAL HEARING AID (Seria) RESOUND Louisa's sorting (In stock)
EARMOULD ACCESSORIES SIEMENS TET1ML STAFF DEMO'S (Lent out to ather)
ELBOWS Sivantos BE101 UNTRACEABLE (In Stock)
LEADS, RECEIVERS & SHOES Sonova BE101B
MISC. HA ACCESSORIES Starkey BE101G
SERVICES UKJENT BE102HF
TINNITUS DEVICES UNITRON BE103
VIEMMATOMNE BE105
WidexAS BE13
EEEVE ~ =c 1o v
Show discontinued Show discontinued Filter by a part of article T
Use alphabetic characters in the sequence for this manufacturer, B, |, O, @, S and Z will be skipped -
Warranty
Purchase date | 18/06/2024 Warranty months
E; Warranty code: 24
Aricle 1D 50144 Item information
P Supplier art no. | GHB 008M -
Purchase price  Digscount on purchase MNet purchase price LT T
£5314 - = £58.14 BatchiLot
Basic profit 1.24% Battery CP41
K Colour
Calc Sales price £58.86
Version
Label A
Type Interface connection

¢ The above is an example of an article needing a new status.

¢ The second article in the example is issued to the wrong patient and needs to be issued
to the correct patient. This will be done in two steps: return the article to stock and issue
the article to the new patient.

¢ If you try to cancel creating a new status for the article in order to return it to stock, you
will be warned that you cannot issue the device without returning it to stock.

¢ The third article in the example has been set to SKip (duplicate) as it is a duplicate of
another article.

» The fifth article in the example has been set to Register for stock, then New status,
since the stock type was Not found, and therefore the Register for stock window is
opened.

Serial numbers found in NOAH x
Client MR. JOHM SMITH Proceed Close
B Open ‘Accessory issue’ automatically B Open Device list' if another current device is found

Serial number Manufacturer Article |Earside| Stock type Patient Hospital no. Action
436457457547 R ==MNot found== Register for stock, then Mew status
ASTASTATEATAT L ==hot found== Register for stock, then Mew stE%
43636463463 R ==Not found=>= Regster for stock then New statug]
3464363636436 L <<Not founds> g:iilster external item
3264575758758 R ==Mot found== Register for stock, then Mew status
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¢ The serial number is filled in automatically.

¢ Press OK and the New status window appears.

¢ Fill out the new status and the article is issued to stock.

¢ If the patient already has a current serial controlled device for a particular ear, when
issuing from Noah, a setting in System Administration may open the device list for
returning the old device. This can be set per workstation so should be disabled if a user
regularly issues more than one serial controlled device per ear.

Note: Changes in article status create clinical actions. If you have attached them to
appropriate appointments, they can be seen in the Clinical actions tab of the Referral
module.
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14.5 Edit item

To change details for an item, open the Edit item dialog by selecting Edit -> Edit item or clicking

Edit item.

Edit item - serial no. 'RKG00235', MHS HEARING AID (Senal Mo.), MHS SUPPLIES, BE101E

Aricle has been recycled

Bar code

Product ID

User John Smith

Warranty code:

- App. 1D

24

Save Cancel
Serial no. RKG00255 BatchiLot ‘ 54114 ‘
Purchase price $46.69 ltem number
Sales price B47 26 Battery CP43
Purchase date 081712024 & Colour ‘EIROWN ‘
Warranty Expires 5 Type ‘ ‘
Label
\ersion

Interface connection

Itern information

The following item details can be changed:

¢ Serial number; in this case the system changes the serial number in postings if any for

the item. Invoiced postings can also be modified if configured in the Administration tool
e Purchase date if the user has the corresponding right granted
¢ Purchase and sales prices

¢ Warranty checkmark and expiration date

* Recycled flag (it is possible to mark a serial number controlled article as Recycled. This
means that the article has been invoiced already and can be reused for another client.
You can mark an article recycled from Item information or when changing the article’s
status in the New status-dialogue.

* Warranty code (Danish)

e Batch/lot number
¢ |tem number

e Battery

¢ Colour

e Type

e Label

¢ Version

¢ Interface connection flag

¢ [tem information
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e Barcode: select Product ID from a Product ID barcode list specified for the article. This ID
is used by the system to identify the item by scanning an item barcode.

At the bottom of the dialog, name of the user is seen in read only mode. This is a user who
recently performed an action with the item.

¢ Click Save to save the changes.
e Click Delete to delete the item from the database. Note that this in only possible for items
in stock.
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14.6 Reduce quantity

When you have selected a stock group and related manufacturer, article and stock type, the
number in that stock type can be reduced. Go to Edit -> Reduce quantity.

¢ The dialog window shows the number of items for the selected article available in
selected stock type.

¢ Enter the relevant number and press OK to reduce the number of items.

¢ Deletion must be confirmed before it is complete.

e The stock group must be defined as Quantity type from the Administration tool -> Stock
definitions -> Stock group for this option to be enabled.
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14.7 Add external item

The Add external item window is initiated by selecting Functions -> Add external items -> Add
serial numbers or Add amount controlled articles.

In the Stock tree view, all devices are shown in the hierarchy Group/Manufacturer/Article.

Register external articles X
o Stock tree Stock list MRS FIRSTNAME46830 LASTNAME46830 Cancel
Group Manufacturer Articles Stock types Serial no
G1 MNH3 SUPPLIES FILTER GREEN FITTED/EXCHANGED (Issued) -
NHS HEARING AID (Serial Mo.} FILTER RED POSTAL BATTERIES (Issued batteri
Senvice-Accessory RECOMDITIONED (Issued)
COMMERCIAL HEARING AID (Seria REPLACEMENT (lssued)
EARMOULD ACCESSORIES
ELBOWS
LEADS, RECEIVERS & SHOES
WMISC. HA ACCESSORIES
SERVICES
TINNITUS DEVICES
Show discontinued Show discontinued Fl T
Use alphabetic characters in the sequence for this manufacturer, B, |, 0, Q, S and Z will be skipped -
Warranty Ear R L NiA
Purchase date  11M17/2022 Warranty months
Expires Warranty code: 42
¥ Show details
In the Stock list view, you can see all devices in a table.
Register external articles % x
Stock tree = Stock list MRS FIRSTMNAME46830 LASTNAME46830 Cancel
Group Manufacturer Article Stock types Serial no
EARMOULD ACCESSORIES NHS SUPPLIES |FILTER GREEM FITTED/EXCHANGED (Issued) -
POSTAL BATTERIES (Issued batteri
EARMOULD ACCESSORIES NHS SUPPLIES |FILTER RED RECONDITIONED (lssued)
EARMOULD AC S NHS SUPPLIES |FILTER YELLOW REPLACEMENT (Issued)
Show discontinued Fl T
Use alphabetic characters in the sequence for this manufacturer, B, |, O, Q, S and Z wil be skipped -
Warranty
Ear R L /A
Purchase date | 11/17/2022 Warranty months
Expires Warranty code: | 42
¥ Show details

By default, discontinued items are filtered out. They can be included in the list when the "Show
discontinued" option is selected.

In the Filter field, you can enter any part of the device name and all related items will be
displayed. In the Stock tree view, the search is conducted within the chosen Group and

Supplier. In the Stock list view, the search is comprehensive and the output will include items
from all Groups and Suppliers.

Optional fields (e.g., price, article ID, item information) are hidden behind the Show details
button.
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rice Aricle ID 50284 Item information

Purchase price  Discount on purchase Net. purchase price Item number

5066 - = 50.66 Battery

Basic profit 0.00% Colour Yellow

Calc Sales price 50.66 Version
Label

Type

Interface connection

The dialog is used to register on stock issued items, for instance when a client brings a device,
which is purchased elsewhere, for repair.

You can register Warranty information, Price information, Item information, side of Ear, etc.

For serial numbers, the functionality of the dialog is the same as for the Register for Stock
dialog, with the exception that in this dialog, you register devices directly to stock types of the
Issued category.

NOTE: The system will display a warning message if the serial number being registered already
exists, even if it is associated with another article or manufacturer. This is aimed at preventing
the creation of duplicate entries in stock, including duplicate article definitions. This warning
only occurs when creating new devices, not when changing the serial number on existing
devices.

For quantity controlled articles, the functionality of the dialog is the same as for the New Status
dialog.

NOTE: Changes in article status create clinical actions. If you have attached them to
appropriate appointments, they can be seen in the Clinical actions tab of the Referral
module.
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14.8 Moving single articles of stock

* Press F3 to search for the client or Ctrl+F3 to make a quick search.
¢ Navigation -> Stock or press Shift+Ctrl+S.

* Select Group.

e Select Supplier.

¢ Select the article/instrument type.

¢ Select the current location of Stock type.

¢ Enter the serial number in Filter for serial numbers box, if required.
¢ Click New status.

¢ Select the new stock type.

¢ Check the number to be moved and click OK.
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14.9 Moving single articles of stock using a Barcode reader

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

Navigation -> Stock or press Shift+Ctrl+S.

Scan the hearing instrument barcode.

If the hearing instrument is already registered in stock the New status window will open.
Select the new stock type and click OK.

The system will read either the European standard barcodes known as EHIMA bar codes, GS1 long
barcodes or GS1 2D barcodes known as Matrix or QR codes (providing the barcode scanner supports
this type of barcode).

Note: Some barcode scanners will not activate if the mouse cursor is in a read-only text field. If
you find the scanner does not seem to action a barcode, try moving the mouse cursor to an
editable field or list box.
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14.10 Barcode scanning functionality

The system will read either the European standard barcodes known as EHIMA bar codes, GS1
long barcodes, or GS1 2D barcodes known as Matrix or QR codes (providing the barcode
scanner supports this type of barcode).

The typical EHIMA barcode device label looks like the one below. Please note that it consists of
2 barcodes, both of which must be scanned:

4 GN ReSound A/S o~ <
B2 Cavagaion R IIIIIIIIIIIIII NN 3
DK~ 2750 Ballerup 8 (01) 05704819243966 é
GTIN. (01) 03704818243965 PN ﬂ II
SN: (21) 1686672298 i é
HI,IFCSE1~ DIW,0PEN,MBL (21) 1686672298

The typical 2D barcode device label can look like this:

Issue: 012
2409591

The typical 1D long barcode device label can look like this:

i~

Technical principles of scanning barcodes

The barcode scanner attached to a PC simulates typing on the keyboard. Text input from the
scanner contains a sequence of symbols encoded in the barcode.

To let the system distinguish between the users’ typing and the typing emulated by the scanner,
the scanner must be configured to produce the prefix and suffix strings. These strings must be
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further specified in the Auditbase Administration tool (For details, see Auditbase Admin Guide,
section on ‘Bar code settings’).

Information the system gets from the barcodes

After the barcode scanning is recoghized, the system takes the following information for
processing:

¢ Manufacturer code

¢ Device model (article) code

¢ Device serial number

e Batch/Lot number (only for 2D barcodes and 1D long barcodes)

IMPORTANT note for EHIMA device barcodes:

¢ Both barcodes contain important product-identifying information, so both must be
scanned for the intended processing.

e The 2"% barcode contains the device serial number prefixed by the ‘21’string. This
‘21'string is an integral barcode part, and that is how Auditbase recognizes the serial
number. Therefore, ‘21’ is only removed by the system when both barcodes have been
scanned.

° The existing functionality in Auditbase is NOT intended for scanning only the
barcode part of the EHIMA full barcode.

If the content of the recognized string of symbols cannot be interpreted properly (e.g., the
format is wrong), the system displays an error message about the wrong barcode detected at
scanning.

Processing the recognized data

Manufacturer code, article code and the device serial number are processed by the system in
the following way:

¢ The system will search for the manufacturer using the manufacturer code. If the code is
not found, manual selection will be suggested. After the selection, the code will be saved
to the selected manufacturer (the system will use the saved manufacturer code for all
subsequent searches).

¢ Then, the system will search for an article within the manufacturer. If the article is not
found, it will suggest manual selection. After the selection, the article code will be saved
to the selected article (the system will use the saved article code for all subsequent
searches).

¢ Finally, the system will search for the recognized serial number. If the device with that
serial number is found in Stock, the system will assign a New status for that device.
Otherwise, it will initiate Registering to Stock.
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14.11 Bulk transfers of stock

Large numbers of serial controlled articles can be moved from one stock type to another by

using the Bulk transfer option. Articles can only be moved from a stock type with an 'In stock'
category to another type of the same category OR to a stock type of the 'Lost' category.

* Navigation -> Stock or press Shift+Ctrl+S.
¢ Choose Group, Supplier, Article and Stock type to move the stock from.

¢ Functions
e Bulk Transfer

Stock bulk transfer

Source stock type

STOCK - GWH (In stock)

Close

X

Select serial numbers (Step 1)
Group

G1

MNHS HEARING AID (Serial Mo.)
Senice-Accessory

COMMERCIAL HEARIMNG AID (Seri
EARMOULD ACCESSORIES
ELBOWS

LEADS, RECEIVERS & SHOES
MISC. HA ACCESSORIES
SERVICES

TINMITUS DEVICES

Devices in stock Select all

Supplier
(1)Testmanu
(2)Testmanu
GMRESOUND
123456789

NHS SUPPLIES

(3)TestManufacturer

Selected devices

|Seria| numeer

Model

[ test group
BE102H
ITE10ML
ITE1T1MR
ITE11ML
BE101B
BE101G
BE102HF
BE103
BE105

W Select all

2 |

[ NBG41775
[ NBG41776
[ NBG41777
[ NBG41778
[0/ NBG41764
[ NBG41765
[ NBG41766
[ NBG41767

Device

NBG27965, BE101,
NBG27955, BE101
» NBG27959, BE101,
NBG27960, BE101,
4 NBG27964, BE101,
NBG41774, BE101

NHS SUPPLIES
, NHS SUPPLIES
NHS SUPPLIES
NHS SUPPLIES
NHS SUPPLIES
, MHS SUPPLIES

Transfer selected devices (Step2)

Location
} Location1
New stock type

Sent to manufacturer (In stock)  Jid

User

SYSTEM ADMINISTRATOR

History comment

4

Add to item information

Transfer

» Select Group, Supplier and Article and the serial numbers for the articles that are in
stock will appear in the Devices in stock window.
¢ Select the required articles to transfer by checking the box next to the serial number.
Select all can be chosen.
¢ Once the articles have been chosen, use the arrow to move them to the Selected devices

window.

» At this stage, articles can still be moved back to Devices in stock by unchecking Select
all, checking the required serial number and use the back arrow to de-select an item.
¢ Select Location (only an option if your site has the appropriate license).
» Select New stock type from the drop-down menu. Only stock types with the stock
category of In stock will be displayed.
e Information can be added to the History comment and Add to item information boxes.

e Transfer

¢ A confirmation message will appear letting you know how many articles were transferred.
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Stock bulk transfer X

& stock tems have been successfully transfemed

—

¢ OK the information message.
e Further articles can then be transferred or Close the transfer window.
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14.12 F10 Fast battery issue

Iltems in one stock group can be set up as a quick stock issue group by the System
Administrator. If this is set up, use the following procedure:

e Press F3 to search for the client or Ctrl+F3 to make a quick search.

e Press F10.

e Select Manufacturer.

e Select Article.

e Manufacturer and Article will depend on the Group which has been selected for Fast
battery issue when the Groups were set up.

e The Date and Signature are automatically filled in but can be manually changed if
required.

¢ The Invoice type is optional and is not generally used.

¢ The Customer must be selected.

e The client's name is displayed. If this is not required, check the Invoice without client
reference box, and the client's name will disappear.

¢ Choose the number of items that are having their status changed and enter the New
NHS serial number if required.

NOTE: Changes in article status create clinical actions. If you have attached them to
appropriate appointments, they can be seen in the Clinical actions tab of the Referral
module.

Click on OK and the information will be saved and the window will close.
If you want to close the window without saving, select Cancel.

Battery issue x
Client MRS FIRSTMNAME10T LASTMNAME107 Print Settings QK Cancel
Manufacturer Article Date User
{5)Testmanu 13 10/01/2020 full name tests?77? hd
(B)Testmanu 675
NHS SUPPLIES 675 COCHLEAR IMPLANT ) )
312 Mo. ofitems Invoice type
10 1 Invoice type 1 -
AATMMNAE00)
AAAIMMNZ400) )
Invoice
Customer
*) to customer v
to client Invaice without client reference
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14.13 Search for a serial number

¢ Navigation -> Stock or press Shift+Ctrl+S.
e Click Search.

Search for serial no. >

Search | Searchin NOAH — Close

Serial no. | 234 |

Cluantity found 5

Found items
Serial no. 234 4 Previous || Next P
Group MHS HEARIMG AID (Serial Mew status History
Manufacturer MHS SUPPLIES Select
Article ITET1ML

Stock type FITTED/EXCHAMGED (155U
Location All

Recycled No

Client
Hospital no. T1106 Change to
Mame MRS FIRSTMAME106 LASTHNAME106

e Enter the serial number. Or scan the number using the barcode reader.

» Click Search.

* Note that the complete serial number is not required to search. As with a client search, if
the first part of a serial number, for instance F412, is entered, Auditbase will display all
serial numbers beginning with F412.

¢ The system shows the number of found items in Quantity found. You can scroll through
them by clicking the arrow buttons.

¢ When you select an item, you can click New Status to open the New Status dialog.

e The History button initiates the History dialog for the item selected.

¢ Click Select to show in the main Stock screen.

¢ Another way to search for a serial number is to select the relevant Group, Supplier,
Article and Stock type, then enter the serial number in the Filter serial numbers field.
The information for this item will appear in the box below.

¢ You can also search by entering the first part of a serial number. If more than one item is
found, the system shows the number of found items below the item information box and
arrow buttons scroll over the items.
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14.14 Search for serial number in Noah

» Navigation -> Stock or press Shift+Ctrl+S.

e Click Search.

Search for senal no.

Search

Search in MOAH | Close

*

Serial no. 234

Cluantity found
Found items
Serial no.

Group
Manufacturer
Article

Stock type
Location

Recycled

Client
Haospital no.

Mame

4 Previous MNext P
Mew status History
Select

Change to

e Enter the serial number. Or scan the number using the barcode reader.

¢ Click Search in Noah.

* Now you can search for the serial number in Noah fitting actions.
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Search NOAH for serial number >

Search in MOAH fitting actions Close

MOAH fitting actions

Search

Serial number: 234 | M Suspend search on most recent occurrence found
Date from: 130112019 to;  13/0142020
Client Hospital no. | MHS nao. Action date\time Action description Username

+ The Date from field is automatically set to a year since today’s date and the to field is set
to today’s date.

¢ Check the box Suspend search on most recent occurrence found to stop the search at
the most recent match.

¢ Click Find next to continue the search.

e Select a fitting action and click Close to return to the Search window, where you can enter
a New status, see the History or Select the article to show it in the main Stock module.
The client will also change in Auditbase, if different from the previously selected client.
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14.15 Search by batch/lot number

The batch/Iot search functionality allows users to quickly locate devices from a specific batch
and transfer them between different stock types. For instance, if the devices in a particular
batch/lot are malfunctioning and need to be returned to the manufacturer for replacement,
using this functionality optimizes stock management and customer notification. Additionally,
users can create lists of clients who should be notified if there are issues with devices that have
already been sold or lent out.

To do so, navigate to the Stock module > Functions and click Search Batch/Lot on the top
toolbar.

0)) Auditbase - [Stock]

File Edit Functions Statistics Settings
=l m [+ s |_¢l? |_\|§’u
O\ Q @ g (]
tem Article | Group  Search serialno. | Search Batch/Lot | Registerforstock  Add external items  Mew status  Bulk transfer  Battery issue  Fast accessories issue  Purchase orders
Information I"\’ External items

Enter the Batch/Lot number and click Search.

Below you will see all articles from that batch/Iot. You will see a list of all articles from that
batch. If the articles belong to different stock types, choose the one you intend to process.

Bulk transfer
For bulk transfers, follow these steps:
1. Inthe “Stock items” section, select the relevant items.

2. Click the corresponding control for bulk transfer.

Search for Batch/Lot X
BatchiLot 54116 Search Close
Filter found stock items

W Selectall articles Select all stock types
Group Manufacturer Article | Stock
v |NHS HEARING | NHE SUPPLIES BE101B [v | STOCK - GWH (In stock)
[~ | 8entto manufacturer (In stock)
Stock items
B Selectall 3 BaichiLot 54116 Bulktrangr Clients to list
Group Manufacturer Article Serial no. Stock ‘Hnspna\ no.| NHSno ‘ Client
v |NHS HEARING | NHS SUPPLIES BE1018 RKG00260 STOCK - GWH {In st
v |NHS HEARING | NHS SUPPLIES BE1018 RKG00261 STOCK - GWH {In st
[¥ | NHS HEARING | NHS SUPPLIES BE101B RKG00262 STOCK - GWH (In st

3. Choose the location and the new stock type for the transfer. The devices you selected on
the previous screen will be preselected here.

4. Verify the list of devices to be transferred and click Transfer.
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Close

Stock bulk transfer
Source stock type STOCK - GWH (In stock)
Select serial numbers (Step 1)
Group Supplier Model
G1 (1)Testmanu [Jtest group
MNH:S HEARING AID (Serial No.) (2)Testmanu ITETOML
Senvice-ACCessory 123456789 ITET1MR
COMNERGIAL HEARING AID (Serial No) TET 1ML
EARMOULD ACCESSORIES (3)TestManufacturer BE101
ELBOWS BE101B
LEADS, RECEIVERS & SHOES BE101G
MISC. H& ACCESSORIES BE102HE
SERVICES BE103
TINNITUS DEVICES BE105
BE18
BE19
BE301
BE34
BE34BASEEFA
BE36
BE37
BE37D
BE38
BE38B
BE30FX
BES2
e
Devices in stock Selectall Selected devices m S
Serial number Device [
[~ |RKGDD189 v RKG0D0280, BE101B, NHS SUPPLIES
[~ |RKGD0256 v RKG0D0261, BE1018, NHS SUPPLIES
[~ |RKGD0257 v RKG00262, BE101B, NHS SUPPLIES
I~ |RKG00258 »
[~ |RKGDD259
[~ |RKGD0250 4
[~ |RKGO0251
[~ |RKGDD252
[~ |RKGDD253
[~ |RKGDD254

Transfer selected devices (Step2)
Location

All locations

New stock type

Sentto manufacturer (In stock)

User

John Smith

History comment

Add to item information

Transfer

5. If the transfer is completed without any issues, you will see a success message.

Stock bulk transfer

Adding clients to the list

When you need to notify groups of clients, use the Clients to list option:

1. Click the respective control.

3 stock items have been successfully transferred

2. Inthe dialog that appears, select a pre-created list (e.g., a device recall list).
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01/01/2016 | 02/01/2017  Active |Title 4

USER NAMEZ29 444 6
ohn h

3. The added clients will appear in the corresponding list in the Clinic Management

module.
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Search for Batch/Lot
Batchilot S4114 Search Close
Filter found stock items
W Selectall articles Select all stock types
Group Manufacturer Article Stock
v |NHS HEARING | NHS SUPPLIES BE1018 [~ | STOCK - GWH (In stock)
v |FITTED/EXCHANGED (Issued)
Stock items
W Selectall 2 Batchilot 54114 Bulk transfer Clients to list
Group Manufacturer Article Serial no. Stock Hospital no. MNHS no Client
[¥ | NHS HEARING | NHS SUPPLIES BE101B RKG00251 FITTED/EXCHANGED (Issued) T1106 5555554444 FIRSTNAME106 LASTNAME106
[¥ | NHS HEARING | NHS SUPPLIES BE101B RKG00255 FITTED/EXCHANGED (Issued) T117575 FIRSTNAME17575 LASTMNAME17575
Add clients to Client list X
Select Close
Choose Clientlistto add 2 clients
Startdate | Enddate |Staus|  Title Responsible | Type | in. clients | Act clients
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9)) Auditbase - [Client lists]

File

C% C?i E a ©, Import from Noah CQ'U

Detailed | Quick  Import data | Exportdata % Exportto Neah Log off = Exit Auditbase

Search Import/Export Client data Bt
E‘ Client \H’Q\H}:”“ User John Smith ‘N\\ucatmns ~ | All departments -laf?]
Navigation ® | usts | members

|[mswessae |

SearchandAdd clients | ‘ ‘ Remove ‘ ‘ Change status ‘ ‘

-2 Requistion s L=

145 AB Audiogram Notasked - Recall devices 11412024 - 11812024

-l Stock Paramster #1 -
Clinic management
£ Booking Parameter #2
(28) Day view - v
EL Waiting list Clients in the Client list: 0, Filtered: 2, Min clients needed:
&, Referral overview Selectll No entries selected
- Invoice Hospital no Name Distance| Status |Dateadded| User |Picture [Parameters [ Gender| NHSno
i % R O E TS T1106 VRS FIRSTNAME106 LASTNAME106 Notasked |06/17/2024 |John Smith | No Female | 5555554444
F %" gls_e"’;‘_":"s TH17575 | MST FIRSTNAMEA7S75 LASTNAME17575 Not asked |06/17/2024 | John Smith |No uale
b jentlist

~[E] Onward referrals and reporting

Other Client lists client parficipates in

[ Start date | End date [ Status | Titie |

[Type [Min. diients [ Act clients |
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14.16 Iltem and article information

e Select Functions -> Item information to open a window to enter information about an
item, for instance settings and special conditions.

¢ Select Functions -> Article information to open a window to enter information about an
article, for instance settings and special conditions.
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14.17 Register for Stock

Registering items to increase stock is done manually or by using a bar code reader.

Navigation -> Stock or press Shift+Ctrl+S.
Select Group and Manufacturer.
Select Functions.

Select Register for stock manually and add the relevant items. You can use different
types of views to find devices you want to register. NOTE: Registration cannot be done for

groups of articles, an article must be selected.

° |nthe Stock tree view, all devices are shown in the hierarchy
Group/Manufacturer/Article

Register for stock - NHS HEARING AID (Serial No.), NHS SUPPLIES

X
=) Stock ree Stock list Save Cancel
Group Manufacturer Articles Stock types Serial no
G1 (1)Testmanu [test group P STOCK - GWH (In stock) RKG00263 -
NHS HEARING AID (Serial No.) (2)Testmanu ITE10ML BATTERIES IN STOCK (Batteries in stock)

Senice-Accesso 123456789 ITE11IMR typet
COMMERCIAL HEARING AID (SerialNo.)  [EEIENEN=S ITE1IML type2
EARMOULD ACCESSORIES (3)TesiManufacturer BE101 type3
ELBOWS typed
LEADS, RECEIVERS & SHOES types
MISC. HA ACCESSORIES TEACHERS OF THE DEAF (Lent out to other)
SERVICES Louisa's sorting (In stock)
TINNITUS DEVICES STAFF DEMO'S (Lent outto other)
STOCK - PAEDS (In stock->Issued)
Sentto manufacturer (In stock)
UNTRACEABLE (In Stock)
Show discontinued Show discontinued 3 e | ¥
Use aiphabetic characters in the Sequence for this manufacturer, 8, |, 0, Q, 5 and Z wil be skipped >
Warranty
Purchase date oanTI2024 Warranty monifs
Expires Warranty code: 24
¥ Show details
° Inthe Stock list vi [l devi in a tabl
N the STOCK lISt VIEw, YOU Can see all deviCes In a table.
Register for stock - NHS HEARING AID (Serial No.), NHS SI}?PLIES X
Stock free < Stocklist Save Cancel
Group | Manufacturer Article Supplier art. no A Stockiypes Serial no
G1 ENTERFIC 44 1 STOCK - GWH (In stock) RKG00263 -
G1 ENTERFIC LOUDSPEAKER R1 | 76567 BATTERIES IN STOCK (Batteries in stock)
NHS HEARING AID (Serial No.} | NHS SUPPLIES |ITE10MR GHB105M :;EZ;
NHS HEARING AID (Serial NoJ | NHS SUPPLIES | ITET0HL GHB 106P type
NHS HEARING AID (Serial NoJ | NHS SUPPLIES |ITETIMR GHB 008M typed
NHS HEARING AID (Serial NoJ) |NHS SUPPLIES | ITETTML 64 Aldpolkpo

types

TEACHERS OF THE DEAF (Lent outto other)
Louisa's sorting (In stock)

STAFF DEMO'S (Lent outto other)

STOCK - PAEDS (In stock->Issued)

Sentto manufacturer (In stock)

) NHS SUPPLIES
0.) NHS SUPPLIES
NHS SUPPLIES

BE101 GHBO59

NHS HEARING AID (Serial No.) |NHS SUPPLIES | BE102HF GHB 104R. UNTRAGEABLE (In Stock)
NHS HEARING AID (Serial No.) |NHS SUPPLIES |BE103 GHB043

NHS HEARING AID (Serial No.) |NHS SUPPLIES | BE105 GHBO22

NHS HEARING AID (Serial No.j |NHS SUPPLIES |BE18 GHBOD3 >

Show discontinued Filter by a

Use alphabetic characters in the sequence for this manufacturer, B, |, 0, Q. 5 and Z wil be skipped

Warranty
Purchase date 0611712024

Warranty months

Expires Warranty code: 24

¥ Show details

By default, discontinued items are filtered out. They can be included in the list when

the "Show discontinued" option is selected.

In the Filter field, you can enter any part of the device name and all related items
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will be displayed. In the Stock tree view, the search is conducted within the chosen
Group and Supplier. In the Stock list view, the search is comprehensive and the
output will include items from all Groups and Suppliers.

° To see additional fields, click "Show details".

Article 1D 50264 Item information
Supplier art no. GHB023
tem number

84669 - = $46.69 BatchiLot 54116

Basic profit 123% Battery CP4g

Colour WHITE
Calc. Sales price $47.26

Version

Type Interface connection

Your System Administrator can define whether the type is Serial number or Quantity
controlled.

¢ When scanning any new item with the bar code reader, the system will open the Register
for Stock dialog automatically. Once opened the Manufacturers that the manufacturer
element of the barcode has been used for before will be highlighted in blue. The user
must select either one of these or a another one if the item comes from a different
manufacturer (Note that due to HIMSA rules it is allowed for manufacturers to supply
items as OEM to other manufacturers while retaining the original manufacturer's
barcode). If only one Manufacturer has been used previously with the manufacturer
element of this barcode that(than?) Manufacturer will be preselected.

* |f registering for stock using a bar code scanner, the Group and Manufacturer must be
selected before scanning bar codes as the same Manufacturer could exist in multiple
stock groups.

e Barcode reading can be done on serial numbers only. Users can scan just the serial
number part of a barcode rather than the Manufacturer and model (article). This allows
users to search for the device using the barcode and to register the device when the
manufacturer is already selected.

¢ When registering for stock the following fields can be filled in:

Type: Serial number

* Available articles of the selected group/manufacturer are listed together. Select the
Article and Stock type, this is generally Stock or In Stock, depending what it has been
called and enter the Serial number of the Articles that are being registered.

¢ A number of articles can be entered by separating the numbers with a comma, i.e. FG6
453678,BH1 678125 to register these two articles. Ensure that there are no spaces
after the comma or it will be taken as a character.

¢ Aseries of numbers can be entered by separating the first number in the series and the
last number in the series with a semicolon, i.e. 100;120 will add all serial numbers
between 100 and 120. Ensure that there are no spaces after the semicolon or it will be
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taken as a character. Certain letters can also be used in the sequence if enabled for that
manufacturer, see the text on the dialog for details.

¢ The Warranty date can be added by selecting the Warranty check box and adding the
number.

* The Purchase price incl. vat and Sales price incl. vat is automatically entered from the
Article information. Batch/lot is taken from the barcode if it is included in the barcode.
Purchase price and batch/lot number are manually adjustable if required. Battery and
Colour are also automatically entered if they have been set up and can be changed.

e When registering a Serial Number controlled device to Stock, Users can select the Stock
Category “Lent out to other” and register a device to the Employee’s hame.

NOTE: The system will display a warning message if the serial number being registered
already exists, even if it is associated with another article or manufacturer. This is aimed
at preventing the creation of duplicate entries in stock, including duplicate article
definitions. This warning only occurs when creating new devices, not when changing the
serial number on existing devices.

¢ Save the entry, and more can be added.

Type: Quantity

Add articles to stock - SPECIAL TECH. AIDS (Quantity], AB TRANSISTOR e
Close

Aricle Stock type Article ID

TELE COIL, CHAIR, STOCK - GWH (In stock)

TRANSETT MINI INKL. MIK. BATTERIES IN STOCK (Batteries in stock)

TRANSETT MINI SCART HOLDING STOCK Cluantity

Louisa's sorting (In stock)
STOCK - PAEDS (In stock-=1ssued)
Sentto manufacturer (In stock)
UNTRACEABLE (In Stock) Purchase date
STOCK - DV BOX

STOCK - OUTREACH 1162022
STOCK - SAVERNAKE
From repair sample
Auto created -1

Auto created - 14

Auto created - 16

Auto created - 17

Auto created - 21

Auto created - 22

Auto created - 24

Auto created - 28

Auto created - 7

Auto created - 8

Show discontinued

e The Stock registration window is opened and a list of available Articles is displayed.
Select the Article and Stock type, this is generally Stock or In Stock, depending what it
has been called and enter the number of Articles that are being registered. When
registering for stock it is now possible to hide the discontinued stock; if you wish to show
the discontinued stock then the button should be selected and the discontinued items
will be shown.
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e The Purchase date is automatically entered as the current date but can be changed
manually if the user has the corresponding right granted.
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14.18 Stock verification using a barcode reader

¢ Navigation -> Stock verification or press Shift+Ctrl+V.

» Specify the parameters needed in the Session list tab; choose which stock you would like
to verify based on Locations, on categories of In stock, Repair and Lost, and on Stock
Groups, Manufacturers, Articles and Stock types. Either one or all of each criterion must
be selected. Selected criteria appear in the lower boxes.

0)) Auditbase - [Stock verification] - O x
Eile Functions

2 2 BB 8 8 b A A

o, ok = > © U =

Detailed | Quick  Sawe | Printlist |mportdata = Export data  Exportto Moah Logoff | Exit Auditbase

Search Stock verification Import/Export Client data Excit
[LJ| Client <T>T18765 MR JOHN SMITH -2 = |Bl|user SYSTEM ADMINISTRATOR All locations A

Session list | Session details

Stack verification sessions I | New Save Delete Print Export

Comments Created by
- SYSTEMADMINISTRATOR

-
Stock to be verified
M All locations Categories All stock groups All manufacturers All articles All stock types
& Test group 2 B In stock G1 - Auto created-1 |
Location MHS HEARING AIC Auto created - 14
Taw Hill B Repair Service-Accessory Auto created - 16
Location2 COMMERCIAL HE Auto created - 17
Testd M Lost EARMOULD ACCE™ Auto created - 21 |7
All locations a In stock - - - - -
Repair
Lost
- w b w - -
Lock stock for verification
Complete session Completed by an

Cancel and discard session

Summary of conditions

Verified Mot in Auditbase Other stock Mot verified

 Click on Lock stock for verification in order to prevent stock modification by other users
while verifying.
¢ Now scan the barcodes one by one.
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(1987654
[/ a76543

COMM PHOMNAK
COMM PHONAK
COMM PHONAK

[ #TEMP#1( NHS K NHS SUPPLI
[ #TEMP#1( NHS K NHS SUPPLI
[ #TEMP#1{ NHS H NHS SUPPLI
[ #TEMP#1( NHS K NHS SUPPLI
[1 #TEMP#1( NHS K NHS SUPPLI

PICO ¢ Auto creaté Mot verifie
PICO ¢ STOCK - C Mot verifie
PICO ( STOCK - C Mot verifie
BE19 | Auto creaté Mot verifie
BE34 | Auto creats Mot verifie
BE101 Auto create Mot verifie
BE38 Auto creaté Mot verifie
BE38 Auto creats Mot verifie

Oil Audithase - [Stock verification] — O =
File Functions
O O = =
5 = o
o, ok = =3 e -»
Detailed | Quick  Save | Printlist |mportdata | Export data | Exportto Neah  Logoff | Exit Auditbase
Search Stock verification Import/Expert Client data Exit
| Client <T=T18765 MR JOHN SMITH - || A | X[ Bl |User SYSTEM ADMINISTRATOR All locations -
Session list || Session details
Refresh Print
Select all 1 IS Registe C ge Delete Search in NOAH Add device
Serial Mo. | Group | Manufacturer | Article | StockType | Condition ~

[/ 123456 | COMM WIDEX LOGO| Auto create Mot verifie
[] #TEMP#1{ NHS F NHS SUPPLI BE101 Auto create Mot verifie
[/ 32032 MHS F NHS SUPPLI BWE4 | STOCK - C Mot verifie
[ 32041 MHS F NHS SUPPLI BW&4 | STOCK - C Mot verifie W
Last scanned barcoda
Stock group SN o &
Manufacturer Stock type
Aricle Condition
Summary of conditions
Verified 0 MNotinAuditbase 0 Other stock 0 Notverified 6827

e After each scan, the system recognizes the scanned barcode and searches for the
scanned serial number on stock.

¢ Depending on the search result, the scanned articles are given a condition.

¢ The following conditions are possible:

Verified - the article is on stock and has been scanned

Not in Auditbase - the article has been scanned but is not available on stock neither in the
stock that has been locked for verification nor in the stock that hasn’t been locked

Other stock - the article has been scanned but it was found in the stock that hasn’t been
locked for verification

Not verified - the article is on stock but hasn’t been scanned yet (this is the initial status for all
articles on stock)

303

© Auditdata - 2025, ID: 20.0040/36



User Guide

¢ During the scan, the Summary of conditions is shown.

¢ Once the conditions are shown, the statuses that are not satisfactory can be edited i.e. by
moving the article to a different stock type with the New status button or using the
Register for stock button to register those articles to stock that are Not in Auditbase.
Change condition can be used to change the outcome of the verification manually.

NOTE: Changes in device status create clinical actions. If you have attached them to
appropriate clinical actions, they can be seen in the Clinical actions tab of the Referral
module.

¢ With Add device you can manually add a device, if for instance a barcode cannot be read.
Once the session is saved, the system searches for the device and changes its condition.

¢ Once the verification is finalised, go back to the Session list-tab.

¢ You may add comments to the session, a hote about the result or to a colleague who is
working with you.

¢ You can now export the session data to a CSV file by clicking Export. The current date will
be the 15t row, site name (which is retrieved from the system administration tool/General
settings/Database site name) is the 2nd row, the number of detailed rows is the 3" row
and headers on the table columns on the Session details-tab is the 4t row. The
destination file now contains the values that are visible on the Session details-tab.

¢ Click on Complete session to save the changes made and open up the stock for other
users.
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14.19 Requisition

The requisition window is for an audiologist to fill in, if a particular hearing instrument should be
ordered for a client or for keeping stock level(s).

Ordering items for stock follows one or more steps involving System requisition and Purchase

orders.

Requisitions

Close

New requisition
Date 06/17/2024

Select article

| For selected client

MRS FIRSTNAMES2 LASTNAMES2

User

John Smith

NHS HEARING AID (Serial No.}
'SPECIAL TECH. AIDS (Quantity)
BATTERIES (Quantity-Accessory)
Senice-Accessory
ICOMMERCIAL HEARING AID (Serial No.)
EARMOULD ACCESSORIES
ELBOWS
LEADS, RECEIVERS & SHOES
MISC. HA ACCESSORIES
'SERVICES

INNITUS DEVICES

123456789

(3)TestManufacturer

Show discontived

Show discontived

Group Manufacturer Article
(1)Testmanu [Jtest group ~
(2)Testmanu

To create a new requisition:

Quantity 1 Colour Audiogram 4/5/2020, no. 1

Initial registration to in-house - stock type Deliver by 06/11/2024 toarive 7 | days before next appaintment Clear

Toin stock ock type = fLentoottn o 61182024, 1 Save
= Tolent outto employee Employee John Smith -
Requisition list
Exportto CSV Mew purchase order

O.uanmy|Am:\e |D| Model description Deliver by ‘ Culuur‘ Deliver to |Husuna\| NHS no Audiogram Client name Employee Stock type Ordered by
1 50146 NHS SUPPLIES, BE102HF  06MT7/2024 | 06/M1/2024 John Smith T1106 5555554444 | 12/11/2018,no. 1 MRS FIRSTNAME106 LASTNAME106 | John Smith | TEACHERS OF T John Smith

1. Choose whether an article(s) is due for selected client or no client using the check box at

the top.

2. Select an article from Group/Manufacturer/Article going through the hierarchy as it is
displayed in the Stock module.

3. Specify quantity (mandatory).

4. Define colour (optional).

5. Choose an Audiogram if it is needed on Order form for the manufacturer. This option is
only available for selected client and defaults to the latest audiogram.

6. Select a Stock type for the initial registration of the article (within a session, this value is
remembered inside the form). Opt for either of the following:

e Toin Stock

¢ To Lent out to Employee (Employee will default to the current user. When
requisitioning for yourself, use this default as a fast option).

7. Deliver by

¢ When selected client is chosen, the next appointment appears. The 'Deliver by'
date is set by the System Administrator for a specified number of days before the
client's next appointment. This date can be altered manually.
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¢ If the requisition is not created for a selected client, the 'Deliver by' date should be
entered manually.

8. Clear removes all selections.
9. On Save, the new requisition appears in the 'Requisition list' table below.
¢ |f more articles are required from the same manufacturer, clicking Save will clear
the Article, Quantity, Colour and Deliver by fields which are then free to specify
additional articles for the Requisition list.
* Note that Group, Manufacturer and Stock type will keep the information.

On the Requisition list table, all the details of the Requisitions are shown (Stock type, Deliver by
date, Audiogram date, Patient identifier, etc.):

¢ The table can be re-ordered as usual by selecting a column and moving it to the desired
position. To save the modified table configuration on user level or site level, right-click
anywhere on the table and choose the appropriate option.

u Uzer view

Site default view
Application default view

Select sort order

Save user view
Save site default\%w

¢ Yellow highlighted quantity is editable.

The Requisition list can be exported to CSV. An extended right in the Administration tool
controls this, and the export is logged in the security log.

Delete an existing order form line (done when ordered) by clicking on it and then clicking
Delete.

The New purchase order button will open a 'Purchase order' form for whichever requisition is
selected in the table.

NOTE: The Requisitions window can be resized as needed. The modified size is retained after
restarting Auditbase.
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14.20 Purchase orders

The 'Purchase orders' dialog is used to order requested articles. To open the dialog, select
Functions -> Purchase orders from the Stock module or click on 'Purchase orders'in the
Navigation menu.

) Auditbase - [Stock]

File Edit Functions Statistics Settings
- tI..--h e =] —¢|}? b =
Q, Q @ 4 e
tem | Article | Group = Searchserialno. = Search Batch/Lot = Registerfor stock  Add external items  New status = Bulktransfer Battery issue | Fast accessories issue  Purchase orders  Add semvice to order = History = Print bar code | Mew task
Information External items

The dialog contains:

Show orders list button that opens the list of existing orders.
'Order details' section where order information is entered.

1

2.

3. 'Order status' section designed for order tracking.

4. 'Requisitions and articles' table listing requisitions that can be included in the order. For

existing orders, the lower part of the dialog will show the 'Order details' table.
5. Print, New, Save and Cancel controls.

Purchase orders and deliveries

Client RS FIRSTNAMEQ2 LASTNAMES2 Print Ty e Cancel

Create/Edit Purchase orders | Register deliveries | Delivery status oveniew

Show orders list

Order details

Supplier AGMHEARING LTD - M For selected client Note
Order ID Order type A
Your reference Delivery week Order date 06/1712024
Referring agent Terms of delivery VAT -
Deliver to Location - Packaging TP number
Delivery time Immediate Terms of payment 30 days Special instructions
Hospital order no. Tender date Number of lines
Order status Tender no. Batch no.
Order approved Order fully received ot

Requisitions and articles below orderfwarning-levels

Audiogram Req. date Next appointment date Ordered by Hospital Client name NH:

Quantity | Article ID | Supplier art. no Model description Deliverby | Colour | Unitprice | Total price
RS FIRSTNAMES2 LASTNAMES2

NHS SUPPLIES, BE101B 06/11/2024 $46.69 546 69 4/5/2020, no_ 1 06/17/2024 06/18/2024 11:45:00 John Smith

14.20.1 Create/edit/print a purchase order

Create
To create an order:

1. Click New on the 'Purchase orders' dialog
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W

N O

10.

11.
12.

Purchase orders and deliveries X

Client | MRS FIRSTNAME®2 LASTNAMES2 e = P

Create/Edit Purchase orders | Register deliveries | Delivery status ovenview

Show orders list
Order details

Supplier ABM HEARING LTD - W For selectsd dlient Note
Order ID Order type ~
Your reference Delivery week Order date 061712024
Referring agent Terms of delivery VAT -
Deliverto Location1 - Packaging TP number
Delivery time Immediate Terms of payment 30 days Special instructions
Hospital order no Tender date Number of lines
Order status Tender no Bateh no
Order approved Order fully received —

or New purchase order in the 'Requisition' form.

Requisiion list
Exportto CSV Mew purcnasErder Delete

Quantity [ Article ID Wodel description Date Deliver by | Colour Deliver to Hospital | NHS no. Audiogram Clientname Employee | Stocktype Ordered by

50264 | NHS SUPPLIES, BE101B 06/M7/2024  06M1/2024 John Smith MRS FIRSTNAMES2 LASTNAMES2 John Smith | TEACHERS OF T John 8mith
1 50146 | NHS SUPPLIES, BE102HF  06/M17/2024 | 06/11/2024 John Smith T1106 5555554444 1211/2018, no. 1 MRS FIRSTNAME106 LASTNAME106 | John Smith | TEACHERS OF T|John Smith

Select the required supplier from the drop-down list.

¢ Coming from the Requisition form, the supplier and requisition will be preselected.
Select the type of order (optional).
'For selected client' filter will display requisitions for that client only.

e This filter is only available if the global client has been selected on the main screen.
Specify order details in the 'Order details' section.
Choose 'Deliver to' from the list of Locations.
Click Note to enter any comments for the article.
Highlight the requisitions to be ordered. Multiple requisitions can be highlighted by
clicking and holding down Ctrl or Shift.
Save. The order is now assigned a unique reference (DD-MM-YYYY, No.) and entered into
the Existing orders list.
On Save, the 'Order details' table is shown at the bottom of the 'Purchase orders' form. In
the 'Order details' table, fields highlighted in yellow are editable (e.g., Quantity, Received
quantity, Requisition date, Colour, Deliver by).

¢ Change the number of articles and colour as required.

¢ Changes can be made directly in the table by clicking the corresponding cell.
Fill 'Received’'to complete the receipt of the order without triggering Stock Registration.
'Order fully received' is ticked automatically when the received quantity matches the
ordered quantity.

Edit
Existing orders can be updated.

To update an order:
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1. Click the button Show orders list. This will open a separate pop-up with the list of orders.
2. Use filters to quickly find your order:
e Choose supplier to show orders for a certain supplier.
¢ Select the relevant order type to display orders only of this type.
e Toview all orders, select Include fully received orders. Fully received orders are
excluded by default.
¢ If necessary, use additional column filtering on table columns (NOTE: All Order
columns can be pre-filtered).

Refresh = if some of the list content has changed (e.g., an order received a new
status or more orders have been added).

Use the . icon to dock and undock the dialog within the 'Purchase orders' form.

3. Once the order has been selected and the relevant information loaded into the 'Purchase
orders' form, you can make the needed changes to your order.
¢ Forinstance, orders can be approved and marked as received by selecting the
Order status check boxes. When the orders are received, the received quantity can
be entered in the column next to the quantity ordered.

Print
To print an order, click Print.

You can choose a Standard printout template or you can configure a Word document template
to be used for printing purchase orders. For more information on templates, refer to Documents
and attachments.

NOTE that your order must be patient-related to use Word templates.

To add a template to the 'Print pop-up menu'

Go to the Documents and attachments module.

Select your template in Document type > All template documents.
Go to Functions > Properties.

Tick Available in module - Purchase order.

Save.

orwNE

To apply a new template

1. Go back to the Purchase order screen.
2. Select your order from the Orders list (Navigate to the list using the Show orders list
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button).
3. From the Print menu, choose the newly added template.

If you do not need a certain template to be shown in the 'Print pop-up menu', follow steps 1-3
from the procedure above and remove the selection from Available in module - Purchase

order.

If the Purchase order has been printed out as a document, this document will be attached in
the Printed area of the 'Order details' section of the 'Purchase order' form.

¢ You can open this order printout to make changes, or detach if it is no longer needed.

Purchase orders and deliveries X
Client RS FIRSTNAMES2 LASTNAMES2 Print New Save Cancel
Create/Edit Purchase orders | Register deliveries = Delivery status oveniew
Show orders list
Order details
Supplier AN HEARING LTD Mot
Order ID 45 Order type -
Your reference Delivery week Order date 06/1712024
Referring agent Terms of delivery VAT -
Deliverto Location - Packaging TP number
Delivery time Immediate Terms of payment 30 days Special instructions
Hospital order no. Tender date Number of lines
Order status Tender no. Batch no.
W Order approved Order fully received Printed 6/17/2024, Headed letter template I:
Open
Order details
Detach
Quantity| Supplier art. no Model description Deliver by | Co\uur‘ Received | Unitprice | Total price Audiogram Req. date Next appointment date Ordered by ‘Huspnal| Client name
1 GHBO23 NHS SUPPLIES, BE101B 06M1/2024 0 $46.69 $46.69 41512020, no. 1 06/17/2024 06/18/2024 11:45:00 John Smith T192 MRS FIRSTNAMEQ2 LASTNAMES2

14.20.2 Register deliveries

After devices have been received, they should be registered as delivered on order and
registered to stock. To do so, go to the Register deliveries tab.

There are two ways to enter device information:

* With a barcode reader
e Manually
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Purchase orders and deliveries x

Client RS FIRSTNAMEO2 LASTNAMES2 Cancel

Create/Edit Purchase orders || Register deliveries | Delivery status overview

Supplier ABM HEARING LTD - Requisition date from  05/18/2024
Manufacturer NHS HEARING AID (Serial No.), NHS SUPPLIES - Article BE101B -
Register to stock

Filter by Client o Order ID | 45 T

Quantity | Supplier art. no Model description Received | Unit price | Total price Stock type Ordered by | Req. date | Colour | Hospital no. | NHS no. | Order ID | Deliver by | Delivered to Clientname
1 GHB023 NHS SUPPLIES, BE101B |0 ACHERS OF THE DEAF (Lent out to other) | John Smith | 06M17/2024 92 5 06/11/2024 |Location1 | MRS FIRSTNAMES2 LASTNAN

< >
Register delivered requisition items to stock
Serial number(s) Batch/Lot
RKG00248|
Initial registration to in-nouse - stock type | TEACHERS OF THE DEAF (Lent outto other) v Ear R LW N
Employee | John Smith -
Lend outto patient - stock type  LOAN (Lent out to client) - Register to stock %

To register, follow these steps:

1. Search an ordered requisition by selecting Supplier, Manufacturer and Article. When you
scan the barcode with a reader, all these fields will be filled automatically.

2. Select a requisition

» For faster selection, filter by Client or Order ID.

3. Enter a serial number of the delivered item. Several serial numbers need to be separated
by commas without additional spacing. To separate a range of numbers, use a semicolon
without additional spacing.

e Each item needs to be registered separately.
e When using a barcode reader, the serial number of the device is filled
automatically.

4. Choose 'Initial registration to in-house - stock type' and employee if registered as 'Lent out
to employee'

¢ For patient-related items, additionally select 'Lent out to patient - stock type' and
ear side.

5. Click Register to stock

e Each stock transaction needs to be confirmed if this is configured in the
administration tool.

» Additionally, information on delivered items can be attached to patient
appointments and registered in journal.
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Stock transaction confirmation

You are going to issue (lent out- in case of lending out) the following stock article:
[NHS SUPPLIES, BE101B, RKG00248

to the following client:
T192 MRS FIRSTNAME92 LASTNAMES2

Details are the following

Return date:

Is information above correct?
Click Commit if correct (system will make stock transaction)
Click Skip to cancel the current stock transaction

Click Abort to return to "Purchase orders” dialog and change some information

Commit Skip Abort

Mew stock type: LOAN (Lent out to client)

Side NIA Date: 06/17/2024

Invoice type Invoice ta: Client: T192 MRS FIRSTNAME92 L ASTNAMES2
Price: $46.69

14.20.3 Delivery status overview

The Delivery status overview can be used to review the status of existing deliveries (e.g., partial,

missing, complete).

Users can filter results by:

e Supplier
¢ Delivery date
o 'Delivery from ... to...' can limit the number of orders by specifying the date range
when these deliveries are expected.
¢ Whether only a part or the entire order is missing
° 'Show not delivered only' check box is selected by default to limit the list to
outstanding deliveries. You may clear this selection to see old orders.

Requisition date

o 'Requisition date from' defaults to the date ONE month from the current date. It is

used to remove old irrelevant records from search results.

Purchase orders and deliveries x
Client RS FIRSTNAMESZ LASTNAMEDZ =
Create/Edit Purchase orders  Register deliveries | Delivery status overview

Supplier A&M HEARING LTD - Requisition date from  05/1812024

Delivery from to Show not delivered only =]

Quantity [ Supplier art no | Wodel description Received | Unit price | Total price Stock type Ordered by | Req. date | Calour [ Hospital no. |MHS no. | Order ID | Deliver by | Deliveredto Client name

1 GHB023 NHS SUPPLIES, BE1018 |0 84660 34669 | STOCK- GWH (In stock) John Smith | 061712024 40 0612212024 | Location1

1 GHB023 NHS SUPPLIES, BE1018 |1 546,60 546.69 John Smith_ 061712024 T117578 44 06/11/2024 _ Location! _ MIST FIRSTNANE17575 LASTNAME

NHS SUPPLIES, BE101B |1 thel| John Smith_ 0617/2024 92 5 06/11/2024_Location] MRS FIRSTNANES2 LASTNAMES2
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14.21 Purchase statistics

In this window, statistics of article purchases is retrieved. To open the dialog, select Statistics -
> Purchase statistics from the Stock module.

Purchase statistics for serial numbers

Erint Exportto C3

Close

Search parameters
Group Manufacturer

MHS HEARIMNG AID (Serial Mo.)
Senvice-Accessory
COMMERCIAL HEARING AID (£
EARMOULD ACCESSORIES
ELBOWS

LEADS, RECEIVERS & SHOES

SERVICES

G1 NHS SUPPLIES

Period
From  14/01/2019
To 1410142020

Mode

Summary of articles
# Summary of article groups

TINMITUS DEVICES

Statistics

Detailed

Manufacturer |Man. code

Article group | Aricle |»\rt. code|0uamit3t|T0taI Price

NHS SUPPLIES

BEA1 (BOOKLET) 1 £0.13

Intotal A Total price £0.13

Statistics are calculated based on registered devices in stock.

Selecting Group lists the Manufacturers defined in this group.

Selecting two and more groups selects all manufacturers of these groups and clears the
list of manufacturers. Select or deselect a group by clicking on it in the list.

If a single group is selected, one or more, or all, manufacturers from the list can be
highlighted.

Add or deselect manufacturer(s) by clicking in the list. Selecting none of the
manufacturers implies selecting all.

You can specify whether statistics should be done on Summary of articles, Summary of
article groups or Detailed. Summary calculates totals per manufacturer/device,
Detailed shows serial numbers.

Specifying a purchase period in From and To limits statistics to the selected date range.
Click Show to calculate the statistics. The results of the calculation are shown in the
Statistics table. Below the table the total number of purchased devices and the total
purchase price is shown.

When statistics are calculated, you can print the results by clicking Print.

Detailed statistics can be exported to a comma-separated (CSV) file by clicking Export to
CSVv.
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14.22 Stock statistics

To open the dialog, select Statistics -> Stock Statistics from the Stock module. In this window

statistics for activities in stock are retrieved.

Stock statistics

Close

Statistic type  Serial numbers
Filtering
Savedfilters  MNew filter [Defaul] - Save Save as
Group Manufacturer Select all Article W Selectall
Quantity 2 |l 11 anufacturer 1

test
Service group 1

Stock group 1

Test Quantity Group

Test Serial Mo. Group

Test Service Group

MHS HEARING AID (Serial Mo.)
SPECIAL TECH. AIDS (Quantity)
TestAtemID

BATTERIES (Quantity-Accessory’
PROCEDURES (Senvice)
Senvice-Accessory

Oplions and conditions

7/ m Show discontinued

B Show discontinued

« In total Peritem Recycled articles only

Current status + Transactions Date from  01/01/2022 = to  11/16/2022

<! Totals on articles Totals on article groups

Delete

Exportto CSV | | Print
MNew stock type Previous stock type

DV BOX
OUTREACH
SAVERMAKE

To repair sample

From repair sample

Auto created - 14

Auto created - 16

Auto created - 17

Auto created - 21

Auto created - 22

Auto created - 24

Auto created - 28

Auto created - 7 hd

POSTAL BATTERIES (Issued bat
LOAM (Lent outta client)
TEACHERS OF THE DEAF (Lent
SENT FOR REPAIR (Repair)
DAMAGED (Lost)

LOST

OBSOLETE (Lost)

HOLDING STOCK

Louisa's sorting (In stock)
RECOMDITIOMED {lssued)
REPLACEMENT {lssued)

STAFF DEMO'S (Lent out to other
STOCK - PAEDS (In stock-=lssuy ™

User Allusers M

Mew stock type Manufacturer | Article |0ty‘ Price | Article type

STOCK - GWH (In stock) Manufacturer 1 | Aricle 1 1
STOCK - GWH (In stock) Manufacturer 1 | Article 2 2| $134.00 HAFITTING
STOCK - GWH (In stock) Manufacturer 1 |Aricle 4 | 1 $0.00 | REHABILITATION

BATTERIES IM STOCK (Batteries in stock) | Manufacturer 1 | Aricle 3 1

Average price $31.40

523.00 STAYE DRY TUBING

§0.00  PRESENTATION BOX

Total transactions 5 Total price  $157.00

The leftmost list contains stock groups. Depending on the group selected, statistics are
calculated for serial numbers, quantity-controlled articles or services.

It is possible to save all selections and options made on the Stock statistics dialog as a filter in

order to run the same statistics when needed.

On the Save filter dialog, you can create a new filter, update and rename the current filter, or

make your preferred filter the default.

Save filter *
Save Close
Save to the current filter =MNew filter=
Rename the current filter
# Save as a new filter
Mame | Filter 10|
B Save as the default filter
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14.22.1 Statistics for serial numbers

Statistics for serial numbers can be calculated in total (summary statistics) or per item
(detailed statistics) by selecting the corresponding option.

Detailed statistics can be calculated with or without mention of a client by selecting or
deselecting Client reference.

Select Recycled articles only to calculate statistics for the recycled devices only. This can
be calculated for current stock status or on the basis of transactions by selecting this
option. If this option is selected, statistics can be restricted for a time range and user-
performed transactions.

One or more manufacturers can be selected by clicking in the Manufacturer list.

All manufacturers can quickly be selected by checking the Select all box.

Statistics will be filtered for the selected manufacturers.

If a single manufacturer is selected, one or more articles of this manufacturer can be
selected by clicking in the Article list.

All articles can quickly be selected by checking the Select all box.

Selecting more than one manufacturer implies selecting all the articles from these
manufacturers.

For Current status statistics, one or more stock types can be selected in the Stock type
list.

For statistics based on transactions, one or more stock types can be selected in the New
stock type and Previous stock type lists.

14.22.2 Statistics for quantity-controlled articles

Statistics for quantity-controlled articles can be calculated for current stock status or
based on transactions by selecting the corresponding option.

If the statistics are calculated based on transactions, statistics can be limited to time
range and user-performed transactions.

Individual transactions with client details can be shown by selecting Per item with client
reference. The result will show the client’s details alongside article information.

One or more manufacturers can be selected by clicking in the Manufacturer list. All
manufacturers can quickly be selected by checking the Select all box. Statistics will be
filtered for the selected manufacturers.

If a single manufacturer is selected, one or more articles of the manufacturer can be
selected by clicking in the Article list. All articles can quickly be selected by checking the
Select all box. Selecting more than one manufacturer implies selecting all articles from
these manufacturers.

For Current status statistics, one or more stock types can be selected in the Stock type
list.

For statistics based on transactions, one or more stock types can be selected in the New
stock type and Previous stock type lists.
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14.22.3 Statistics for services

e Statistics for services are calculated on the basis of transactions.

¢ Statistics can be limited to time range and user-performed transactions.

¢ One or more manufacturers can be selected by clicking in the Manufacturer list. All
manufacturers can quickly be selected by checking the Select all box. Statistics will be
filtered for the selected manufacturers.

¢ [f a single manufacturer is selected, one or more articles of the manufacturer can be
selected by clicking in the Article list. All articles can quickly be selected by checking the
Select all box. Selecting more than one manufacturer implies selecting all the articles
from those manufacturers;

¢ Invoiced services only can be included by selecting this check box.

» Clicking Show activates a search in the database and a listing on screen and the totals
calculated are shown in the result table.

¢ The set of totals depends on the statistics type selected. Total quantity and total price are
calculated for all statistics. For serial numbers statistics, the average device price is
calculated and if client reference is checked, the average number of devices per client is
also calculated.

e Click Print to print the listing.

14.22.4 Issue advanced statistics

This dialog is used to calculate the number of monaural and binaural hearing instrument issues
using specified criteria. Note that the binaural issue is the issuing of hearing instruments to a
client for both ears on the same day. Monaural issues are all other issues.

The dialog is called by selecting Statistics -> Issue advanced statistics from the Stock module.

Issue statistics advanced x
Exportto file Calculate Print Close
Calculation criteria
Issue date: |[14/01/2019 | - 14/01/2020 Client age:
Client gender: B Male M Female W Other Issue type: Monaural [« Binaural
Result:
Client name Hospital no. Client secondary code
=Deleted client=
testpat T1200000
testpat T1200000
first name first name last name last name 2888888888 0000001
firstname first name last name last name 858555858588 0000001
FATHER FMAMEZ21 SNAME12 T999999 999999
MR FIRSTMAME183 LASTMAME183 T1183
MR FIRSTMAME183 LASTMAME183 T1183
MRS FIRSTNAMES3 LASTNAMES3 T183
Professor Test111111111111111111111111111111111113 Test1111111111 E333333
< >
TOTAL: 10
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e The Calculation criteria area is used to specify the parameters for the statistical
calculation. The following parameters can be specified:

¢ Date range: hearing instrument issues falling into a specified range of dates will be
included in the statistics. If the field is empty the interval is unlimited.

¢ Age interval: issues to clients with their age falling into a specified interval will be
included in the statistics. No value in the range means unlimited interval.

* Client gender: Male, Female or Not specified. Check the boxes to include in the statistics,
issues to a client of a chosen gender. At least one of boxes must be checked.

¢ Issue type: the statistics calculate Monaural and Binaural issues separately, so the
required issue type must be selected before calculation.

* When all the criteria have been specified, press Calculate to calculate the statistics. The
result is shown in the result table below and includes client name, personal number,
issue date and total number of issues.

e Press Print to print the results.

¢ You can also export the results to a comma-separated (CSV) file. Click Export to file and
select the target file in the file selection dialog.
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14.23 Lent out Articles

¢ Select Statistics -> Lent out items.

¢ An empty dialog will appear.

e Chose a stock type in the Stock type select box and then press Show. The 'Next
upcoming appointment' column will show when the client's next appointment is
scheduled, which may indicate whether the patient needs to be invited to return the item.

Lent out items >
Show Print list Print Close
Filter on
Stock type - User - Price from Price to
Mumber of articles in table 37
Model | Serial Mo | Price | Stock type | User |NHS na. | Mext upcoming appointment ~
BE301 MBG31881 383 LOAM (Lent out to client) USER MAMEZZ2
BE37D R5009173 | 78.95 |LOAN (Lent outto client) | USER MAME13
BE38 NEG41260 5849 | LOAN (Lentoutto client) USER MAME18
BE103 NEG45492 13353 | LOAN (Lent outto client) USER MAME18
BES4 MEG25455 | 61.68 | LOAN (Lentoutto client) USER MAME1S
BE38 MAGE0072 5849 |LOAN (Lent outto client) | USER MAMEZ2
BES4 RGG03157 6168 LOAN (Lentoutto client) USER MAME1S
BE36 101428 65.06 |LOAM (Lent outto client) | USER MAMEG
SUPERO 412 36909 LOAM (Lent out to client) | USER MAME36
SPIRIT 2 POWER 932160 LOAM (Lent out to client) USER MAMESOD
SPIRIT 2 POWER 932142 112.02 | LOAN (Lent out to client) | USER MAMESD
SPIRIT 3 DIRECT 920263 LOAM (Lent out to client) | USER MAMEZ28
SPIRIT 3 SUPER POWER | 16161 LOAM (Lent out to client) | USER MAME3Z2
SPIRIT 2 DIRECT 9016701 7123 |LOAN (Lent outto client) | USER MAME3Z2
SPIRIT 3 DIRECT VC 9016794 7123 |LOAN (Lent outto client) | USER MAME32
SPIRIT 3 SUPER POWER | 43165 LOAM (Lent out to client) | USER MAME32
SPIRIT 3 POWER 414705 132,72 | LOAM (Lent out to client) | USER MAME3S
SPIRIT 3 POWER 9017138 |0 LOAM (Lent out to client) | USER MAME3Z2 W
< >

¢ If no search filters are applied, a warning message will be displayed.

Lent out items

I@I Selecting all lent out items can take a long time. Do you want to proceed?
k. * 4

e The view can be filtered with respect to User, Stock type and price interval.
e [falinein the result is selected, you can print a recall letter to the client by clicking Print
letter.
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¢ The total list can be printed by clicking Print list.
¢ You can print a recall letter by selecting one item in the list and clicking Print.

© Auditdata - 2025, ID: 20.0040/36 319



User Guide

14.24 Financial stock report

e Select Statistics -> Financial Stock Report.

This report is generated and printed based on a selection of Location, Date interval, Stock
Groups and price limits.

Financial stock report ot

Generate Close

Generate report for
Location All lacations -

Date Interval fram 14/01/2019  to 140142020

|F'ri|:e limit Stock group
1
MHS HEARIMNG AID (Serial Mo.)
Senice-ACCessary
COMMERCIAL HEARIMNG AID (Serial Mo}
EARMOULD ACCESSORIES
ELBOWS
LEADS, RECEIVERS & SHOES
MISC. HA ACCESSORIES
SERVICES
TINMITUS DEVICES

OO00000oROEO

The report lists information such as:

Issued articles in period

¢ |ssued recycled articles in period

Articles on stock

Articles lost during a period of time
Articles taken back during a period of time
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14.25 Bar code print

When you have selected an item from stock which is controlled by serial number, a label with
the item data can be printed. Go to Functions -> Print bar code.

File Edit Functions Statistics Settings
& N R o B B R B B =
® Q 2 ® > [o L D Nt o w0 B
ltem | Article | Group  Search serial no.  Registerforstock = Add external items  Newstatus Bulktransfer Batteryissue Fast accessoriesissue  Purchase orders  Add serviceto order  History  Print bar code | New task
Informaticn External items
E Client  <T>T18765 MR JOHN SMITH -] &= Bluser SYSTEM ADMINISTRATOR | Al locations + | All departments - [ 2 Print bar code

The layout of the barcode print depends on the type of barcode to be used. This is defined by
the System Administrator. The settings for type of barcode standard, prefix and suffix are also
defined by the System Administrator.
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14.26 Articles

The Articles dialogue is opened by selecting Functions -> Settings -> Articles from the Stock
module. You can also double-click an article in the list.

Articles - NHS HEARING AID (Serial No.), MHS SUPPLIES x
Order levels Mew Save Delete Close
Article list Article ITE10ML Warranty
NHS SUPPLIES ) Warranty months EERE TR
Discontinued
oE 102t " Article type MODULAR ITE Ear side defaults to M/A
Supplier NHS SUPPLIES Manufacturer ID barcode: 1234567 -
Supplier art. no. GHB 106P eEnTEE s RS -
_ Froduct ID bar code
BE101 Article ID 50143 SE0TH B 54.32-1—
BE101B NHS article no. | 111111111111123 g
BE101G Delete
BE102HF Priority 2
BE103
BE105 Battery cPa
BE18 Colour 11
BE19
BE301 Type 22
BE24 Version 33
gEggBﬁSEEF‘A Internal art. no. Price
BE37 NHS price Purchase price  Discount on purchase Net purchase price
W £70.51 = =
BESTD Article information
Basic profit 1.23%
Calc. Sales price £70.51

In this dialogue articles can be added to the list of the selected group or details of a selected

article can be changed.

e To add a new article, click New and enter the information for the article.
¢ To edit an existing article, select it in the list and modify the record.
e The following information can be entered for an article:

¢ Article: the name of the article.

Article type: the type of the article should be selected from the drop-down list.

Supplier: select the supplier of the article from the drop-down list.

Supplier article number: this can be the catalogue or part number of the Article.
Priority: a priority can be assigned and Auditbase will list the articles by priority and then
alphabetically.

NHS article no, Colour, Battery, Type, Version, and Internal article no: these fields can be
entered as any symbols.

Purchase price incl. vat, Discount on purchase, and Sales price incl. vat can be added.
This will help in stock taking if required. Sales price can be calculated based on article
profit by pressing the Calc. button.

Warranty: check this box and specify the number of months if the article has a warranty.
A maximum of 999 months can be added.

Discontinued: if this box is checked, the Article will not be listed.
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¢ Associated articles: is a list of articles associated with the current article, for instance
spare parts. Press Add” to specify a new associated article, and select it in the opened
dialogue (see Associate articles for details). Press Delete to remove the association with
an article.

+ Manufacturer ID barcode: the barcode for the specific manufacturer can be chosen
here. Several barcodes might exist for the same manufacturer, if the manufacturer
produces articles in different countries.

¢ Product ID barcode: a list of possible barcodes for the current article can be entered in
this table. The format of the barcode is set by the system administrator. The system uses
barcodes to identify articles via scanning with a scanner attached to the computer.

¢ Article information: this is a free text field for entering any required information about the
Article.

¢ Save saves the current article.

* Delete deletes the selected article from the database.

14.26.1 Associated articles

In the Associated article dialogue, you can add a dependent article to an article being edited.
To open the dialogue, click Add in the Associated article section in the Article dialogue.

Associated article - ITE10ML >
Dk Cancel

Group Manufacturer Aricles

G1 . (1)Testmanu :

Cluantity 2 (2)Testmanu BE101

(3)TestManufacturer BE101B

SPECIAL TECH. AIDS (Cuantity 123456759 BE101G

BATTERIES (Quantity-Accessor GMNRESOUND BE102H

PROCEDURES (Service) BE102HF

Senvice-Accessary BE103

COMMERCIAL HEARING AID (£ BE105

EARMOULD ACCESSORIES BE18

ELBOWS BE18

LEADS, RECEIVERS & SHOES ™ BEZ201

4 4 BEZ01B W

¢ |nthe dialogue, select Stock type, Manufacturer, and Article.
* Click OK to add a selected article to the list of associated articles.

14.26.2 Merge and move articles
The Move and Merge functionality can be used to:

* Reorganise stock: When the same article is registered under different manufacturers,
possibly due to a manufacturer being acquired by another, and you need to consolidate
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these entries.

» Correct mistakes: If an article was mistakenly registered under the wrong manufacturer,
it can be moved to the correct one.

* Merge duplicate entries: To combine duplicate articles that have been registered
multiple times under different manufacturers, ensuring that stock records are accurate
and up-to-date.

* Resolve serial number conflicts: To address conflicts where the same serial number is
registered under different articles, ensuring that the stock history is consistent.

PREREQUISITES

The move and merge articles functionality is regulated by the corresponding extended user
right. Only authorized users can perform these actions. If the extended right is not granted, an
error message will appear.

To start merging or moving articles:

1. Open the Stock module and navigate to Functions > Move and merge articles.
2. Onthe Move/merge articles dialog, choose the action you wish to perform.

NOTE: When you switch to the "move article" functionality in the dialog, only the source article
is availalbe; other fields are disabled. For the "merge article" functionality, all fields are
available.

Move Articles

The “Move Articles” feature enables you to transfer an article from one manufacturer to
another. Before initiating the move process, please consider that multiple cannot be moved at
once; each move must be performed individually.

To move an article:

1. Select the source stock group and manufacturer.
2. Select the stock group and manufacturer to which the article will be moved.
3. Click Apply to transfer the article.
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Move/merge articles X
+ Move article Merge article Apply Close
Source Target
Stock group Stock group
NHS HEARING AID (Serial No.) - COMMERCIAL HEARING AID (Serial No ) -
Manufacturer Manufacturer
NHS SUPPLIES - ‘GNRESOUND I -
[y
Article Article
[ test group ~ "] Danalogic 163D
ITE10ML DANALOGIC 283D
ITETIML
BE101
BE101E
BE101G
BE102HF
BE103
BE105
BE12
BE19
BE201 -
Stock items Show history Stock items Show history
Modified date Stock type to ‘L.’R‘ Serial numbe Modified date Stock type to |UR| Serial number
< >
Move/merge articles X
<) Move arlicle Merge article Appl Close
Source Target
Stock group Stock group
NHS HEARING AID (Serial No.) - COMMERCIAL HEARING AID (Serial No.) -
Manufacturer Manufacturer
NHS SUPPLIES A GNRESOUND -
Article Article
[ test group -~ [*Danalogic 163D
ITE10ML DANALOGIC 283D
ITE11ML ITETTMR.
BE101
BE101B
BE101G
BE102HF
BE103
BE105 [
BE18
BE13
BE301
BE34 v
Stock items Show histon Stock items Show history
Wodified date Stock type to [LR|  Serial numbe Wodified date Stocktype to [UR| serial number
< >

NOTE: The system will provide a warning to prevent duplicate serial numbers from being
registered. If a serial number already exists, you will be prompted to confirm the action.

Merge Articles

The Merge Articles feature allows you to combine two articles, typically when the same article is
registered under different manufacturers.

Before initiating the merge process, please consider that:
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¢ Quantity controlled articles cannot be merged.

¢ Devices cannot be merged individually unless they have the same serial number.
e Multiple devices cannot be selected from an article; instead, all items are moved

together. The selection of a specific item is provided to enable the movement history to
be viewed by clicking "Show History."

To merge the articles:

1. Select the source and target articles; both articles must be serial number controlled.

Move/merge articles

x
Move article * Merge article Apply Close
Source Target
Stock group Stock group
COMMERCIAL HEARING AID (Serial No.) - NHS HEARING AID (Serial No.) -
Manufacturer Manufacturer
GNRESOUND - NHS SUPPLIES -
Article Article

[ Danalogic 163D ™) test group ~
DANALCGIC 283D

v

Stock items Show history Stockitems

Show history
Modified date Stock type o LR | Serial number Modified date Stock type to [LR[  serial num ~
04/10/2025 | STOCK - GWH (In stock 543 03/23/2016 | FITTED/EXCHANGED (Issued) L 915483
03/15/2018 |FITTED/EXCHANGED (Issued) R 78888 03i23/2016 | FITTED/EXCHANGED (Issued) R 915434
04i21/2015 | FITTED/EXCHANGED (Issued) |[L 4445 05/14i2015 | FITTED/EXCHANGED (Issued) L 34600309
04/21/2015 | FITTED/EXCHANGED (Issued) (L 444 05/14i2015 | FITTED/EXCHANGED (Issued) L 34800183
04/21/2015 | RECONDITIONED (Issued) R 443 05/14i2015 | FITTED/EXCHANGED (Issued) R 34800130
10/24/2014 | RECONDITIONED (Issued) L1132 05(14/2015 | FITTED/EXCHANGED (Issued) L 915350
IEXCHANG ssued) L 543
10/24/2014 | FITTED/EXCHANGED (Issued) R 1112
06/06/2014 | FITTED/EXCHANGED (Issued) L 1m2n
09/30/2013 | FITTED/EXCHANGED (Issued) R 123123444 T
<

>

2. Click Apply. A confirmation message will be displayed.

Move/merge articles

I@\I Do you want to merge <NHS HEARING AID (Serial No ), NHS SUPPLIES, ITE10MLS with <COMMERCIAL HEARING AID {Serial No.), GNRESOUND, ITETIMR>?
&

Yes No

3. If source and target articles have the same serial numbers, a warning message will be
displayed.

Move/merge articles

I@I The duplicated serial numbers exist for sounce and target articles
sy

Do you still want to merge?

fes No

4. Upon merge, the article will be displayed under Target stock items.
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Move/merge articles

[ Danaloegic 163D

X

Move article =+ Merge article Apply Close
Source Target

Stock group Stock group

COMMERCIAL HEARING AID (Serial No.) - NHS HEARING AID (Serial No.) -

Manufacturer Manufacturer

GNRESOUND - MHS SUPPLIES -
Aricle

DANALOGIC 283D

Stockitems Sh Stockitems Show history
Modified date Stack type to | LR serial number Modified date Stock ype to [Ur] serialnur A

05114/2015 | FITTED/EXCHANGED (Issued) R | 34500190
0511412015 | FITTED/EXCHANGED (Issued) L |34800300
0514/2015 | FITTED/EXCHANGED (Issued) L 34600183
0421/2015 | RECONDITIONED (1ssued) R |443
042112015 | FITTED/EXCHANGED (Issued) L [44s
04/21/2015 | FITTED/EXCHANGED (I53ued) L (4445
10i24/2014 | FITTED/EXCHANGED (Issued) R 112
1012412014 | RECONDITIONED (Issued) L3
06i06/2014 | FITTED/EXCHANGED (Issued) Lz

5. To review history for the merged article, select the article an clicking Show history.

History

x
Close
Article | NHS SUPPLIES, ITE10ML, 5431
Date | Stock type rom| Stock type to I Client Note ["user [1
04/10/2025 STOCK - GWH (In stock) Register for stock - COMMERCIAL HEARING AID (Serial No.), GNRESOUND | Maksy
0410912015 FITTED/EXCHANGED (Issued) FIRST EXTRAMORE LAST | Register external articles Test
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14.27 Edit groups of articles

You can set up groups of articles per manufacturer. This is useful if you for instance want to
group articles with the same colour.

The dialog is opened by selecting Functions -> Settings -> Edit groups of articles from the
Stock module.

Edit groups of articles - MHS HEARIMNG AID (Serial Me.), NHS SUPPLIES X
Mew Save Delete Close
Groups of articles list Group test group Warranty M Interface connection
B Warranty 12  months . )
NHS SUPPLIES Article type - Discontinued
test group Supplier NHES SUPPLIES - Ear side defaults to MNIA
. Aszsociated articles
Supplier group. no. 1
Priority 2 260TM Add
Battery 3 HEIEE
MHS price £4.00
Group information
Testinfa| -
Price
Purchase price Discount on purchase Met purchase price
€600 _ |7.00% = £6.58
Basic profit 1.23%
- Calc. Sales price £5.63

¢ Give the group a name, type and supplier - mandatory in order to save.

¢ Enter other relevant information.

e Click Save.

¢ Once the group is saved it will show up in the main Stock window, when you select main
group and manufacturer.

¢ Right-click the group to edit it directly from the main Stock window.
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14.28 Manage articles in groups

When you have created a group of articles, you need to manage the articles in the group, which
you do by selecting Functions -> Settings -> Manage articles in groups.

NHS SUPPLIES

Manage articles in groups - MHS HEARING AID (Serial Mo.), MHS SUPPLIES

Close

Show discontinued

Articles notin groups

] ——
ITE10ML
ITET1MR

ITE11ML

BE101

BE101B

BE101G

BE10ZHF

BE103

BE105

BE13

BE19

BE201

BE34

BE34BASEEFA

BE36

BE3T

BE3TD

BE3a

BE22B

BE3AFX

BESZ

BES4

RFAR4N v

Article group test group -

Edit groups

Articles in selected group

ITETOMR.

¢ First choose the relevant article group from the drop-down list.
¢ If you want to edit groups of articles, click on Edit Groups.
¢ The list to the left contains all articles that haven not been put into a group.

¢ The list to the right contains the articles that are currently in the selected group.
e Choose an article and use the arrows in the middle to move it either into a group or out of

a group.

e Changes are automatically saved.
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14.29 Creating a new or modifying a service

Select the service and the type and open the Services dialogue by selecting Functions -
> Settings -> Services from Stock.

In this dialogue services pertaining to a selected manufacturer can be defined. Services are
defined by name and prioritised for the list order. Additional attributes can also be specified.

¢ To create a new service, press New and enter the name of the new service.

¢ To edit an existing service, select a service in the list. The service number (ID) is added
automatically.

¢ If required, specify a priority for this service.

¢ Article type can be selected from the drop-down list. The entire list of types is defined in
the dialogue opened by selecting Functions -> Settings -> Article types.

e Enter a sales price for the service and a comment if required.

¢ Click Save to save the new or modified information to the database.

¢ Click Delete to delete a selected service from the database.
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14.30 Suppliers

From this menu item a window is displayed in which suppliers can be defined by name,
address, contact person, supplier number, etc. In Functions -> Settings -> Suppliers:

test

A&M HEARING LTD

AUDIFOM

AUDIMED

AUDIOMEDICAL DEVICES LTD
GHNRESOUMND (DAMAVOX)
LAVIS

OTICON

P C WERTH LTD

PHOMAK

RESOUND VIENMNATOME LTD
SIEMEMNS

STARKEY

1 0XFORD STREET
CARDIFF
CF24 3WY

Contact person

Telephone no.

Fax

Email address

External account 1D

External account

[ Outdated I}

Suppliers X
MNew Delete Close

Supplier Supplier

ArtemTestlD MINERVA

NHS SUPPLIES — -

PLURETOMNE Priority  Supplier no.

Test supplier test 2 0

newhlak Address

e Select New and then enter the name of the supplier in Selected supplier.

¢ A Priority can be assigned and Auditbase will list the suppliers by priority and then
alphabetically. Each supplier must have a unique Supplier no assigned to it.

¢ The supplier's address and contact details can be added to the appropriate fields.

¢ Click Save to save new or altered information to database.

e Select Outdated if you want to outdate a supplier.

¢ Click Delete to delete a defined supplier from database.
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14.31 Manufacturers

In this dialog, you can define manufacturer with name, number and priority.

To open the dialog, select Stock -> Settings -> Manufacturers from the Stock module.

THERAFPAK, OSWESTRY

INFRATECH

Manufacturers - TINMITUS DEVICES X
Mew Save Delete Close

Manufacturer Manufacturer

NHS SUPPLIES INFRATECH

FURETOME Priority

ALIDIMED

3

Use alphabetic characters

in serial numbers when registering a
sequence ofitems. B, 1,0, Q, Sand £
are skipped.

Manufacturer ID
5048 Outdated

s

EHIMA bar codes |

To add a new manufacturer, click New and enter the name. The manufacturer number is
added automatically.

Specify a Priority for the manufacturer.

To edit a manufacturer, click an existing manufacturer and make the required changes.
A manufacturer can be configured to include alphabetic characters in all their serial
numbers. Certain alphabetic characters are never used, (see text warning for list of these)
this is done according to the system used by Phonak. This allows sequences of serial
numbers to be created including alphabetic characters. A text note will appear on the
Register for stock dialog when a manufacturer with this setting is selected. Even when
only numbers are used for first and last serial numbers, the alphabetic characters will be
used in between.

To mark a manufacturer outdated, select the corresponding checkbox

One or several barcodes can be specified for the manufacturer. If a manufacturer
produces articles in different countries, it is necessary to register more than one barcode
ID.
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¢ The name of the barcode depends on the barcode type used. This is defined by the
system administrator.

¢ Auditbase uses barcodes to recoghize an item via scanning with a barcode scanner
attached to the computer.

¢ Click Save to save the new or modified record.

e Click Delete if you want to delete a record.
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14.32 Article types

In the Stock module, go to Stock -> Settings -> Article types. From this menu item a window is

retrieved in which types of articles can be defined.

Article types

Mew

Delete

Close

x

Article types

-
BEDSIDE MASKER

DIAGNOSTIC

DIGITAL BTE

HAFITTING

LIBBY HORN TUBING

LOUDSPEAKER

MODULAR ITE

NORMAL TUBING

OTOSTOP

PRESENTATION BOX

PROGRAMMABLE BTE

REHABILITATION

STAYE DRY TUBING

SYRINGE

THERAPAK

TINNITUS BTE MASKER v

Aricle type
BATTERY
Priority
1

Select New and then enter the name of the Article type in Selected article. A Priority can

be assigned and Auditbase will list the types by priority and then alphabetically.

Click Save to save a new or changed article type in the database.
Click Delete to delete a defined article type from the database.
Click Cancel to close definitions of article types.
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14.33 Order levels

In the Stock module, go to Stock -> Settings -> Order levels. Select this function to type
ordering levels for defined articles. Two levels can be typed, urgent level and an ordering level
which is used at bulk purchasing or for the purchase of more than one article from the same
supplier.

Order levels - NHS HEARING AID (Serial Me.), MHS SUPPLIES *
Save Close

Article Stock type Article ID

~| STOCK-GWH (In stock/a| | 50288

ITE10MR .

ITE10ML HOLDING STOCK Article

ITETIMR Louisa's sorting (In stoc BE102H

ITET1ML STOCK - PAEDS (In stoc

BE101 Sentto manufacturer (In Enable ordering level

BE101B UNTRACEABLE (In Stoc Point of ordefing

BE101G STOCK - DV BOX

BE102HF STOCK - OUTREACH

BE105 From repair sample

BE18 ¥ Auto created -1 -

Select article and stock location for article.

Type number in the fields Point of ordering and Point of warning.
Click Save to save levels in the database.

Click Cancel to close this function.
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14.34 History

By activating this function all changes made in the field Stock type for a specific serial number
are displayed. Select the specific item in Stock and go to Functions -> History.

History X
Close
Article NHS SUPPLIES, BE101B, RKG00255, Baich/Lot 54114
Stockypefrom | Stocktype to [ Client Note User | Receiver
STOCK - GWH (In stock) Register for stock - NHS HEARING AID (Serial No.), NHS SUPPLIES |John Smith

Batch/Lot changed from 54115 John Smith

06/17/2024 STOCK- GWH (In stock) FITTED/EXCHANGED (Issued) | MST FIRSTNAME17575 LASTNAME17575 John 8mith | T117575

Date of change, new stock type and client together with the option to add a note concerning
changes is shown.
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14.35 Fast accessories issue

The “Fast accessories issue” dialog allows users to quickly select several different accessories
(quantity-controlled articles) of any quantity and issue them in one step. To enable fast
selection of the articles we have the traditional Stock Group and Manufacturer route plus three
new fast-to-access ways that accessories are grouped together.

Lists of accessories can be created including associated articles.
14.35.1 Creating lists of accessories

The “Frequently used accessories lists” are the third option for populating articles on the “Fast
accessory issue” dialog. They enable users to select from lists of articles that you can construct
based on what you have issued in the past or on articles that you add to the list manually. You
can make different lists for different groups of users or patients such as one for Hearing Aid
users and one for Cochlear Implant users.

Lists of accessories can be added in the Stock module from Settings -> Frequently used
accessories.

Frequently used accessories n

Accessory lists a v Mew Save Delete Close

Implant accessoaories

Location 2 Location2 -
Department 2 Department2 -
Mumber of accessories 5

Accessories & v

1. (Optional) Create or recreate from recently issued items

675 COCHLEAR IMPLANT
A4 (MM1500)
675

2 (Optional) Add iterns manually

Enter a name for the new list and set a Location and/or Department if required. Select Save.
Once you have saved the list, you can add quantity-controlled items in two different ways and
combine them, from those recently issued and by manual selection. Firstly:
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1. (Optional) Create or recreate from recently issued items.

Search most issued accessories

Stock groups
Cuantity 2 Date from

BATTERIES (Quantity-Acce

TIMMITUS DEVICES

Selection result

Senvice-Accessory Maximum rows in result

to

s

Close

130172020

20

Populate

Article name | Mo. ofissues

Recreate list

Choose a Stock group or groups and a date range for the most issued accessories. By default,
the Date from is set to one year before the to date. You can choose the Maximum rows in

result, this defaults to 20. By selecting Populate, the Selection result is filled.

The list will be populated based on the most issued articles in the period you choose. The
system will scan through all issues in the period and then present the top according to how

many you limit it to, therefore a long period will take longer to populate.
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Search most issued accessories x
Stock groups Close
Cuantity 2 Date from 13012010 to 13012020

BATTERIES (Quantity-Acce
Senvice-Accessory Maximum rows in result 20

TINMITUS DEVICES

Populate

Selection result B Select all
| Article name Mo. ofissues

13 G265

312 401

675 274

675 COCHLEAR IMPLANT | 120

10 17

AATMMA500) 11

AAAMM2400) 5

Recreate list

You can either Select all articles, which is the default setting, or select articles using the check
boxes to the left of the Article name. Once you have selected the appropriate articles press the
Recreate list button in the bottom right to populate or repopulate the accessory list.
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Frequently used accessories

Accessory lists

Implant accessories
Test

Accessories

Location

Department

Mew Save Delete

Implant accessories

2 Location2
2 Department2

MNumber of accessories

Close

13

312

B75

75 COCHLEAR IMPLANT
10

LA (MN1500)

AAA (MN2400)

1. (Optional) Create or recreate from recently issued items

2. (Optional) Add items manually

Articles can also be added manually to the list using the second option.

2. (Optional) Add items manually.

This option opens a window where you can choose accessory articles from the stock module
using the standard grouping hierarchy.

Select accessories

BATTERIES (Cluantity-Accessory)

Senvice-Accessory
TINMITUS DEVICES

Show discontinued

(6)Testmanu

NHS SUPPLIES

X
Add selected items Close
Stock group Supplier Selected articles and article groups
Quantity 2 (5)Testmanu 675 COCHLEAR IMPLAMT

Show discontinued

Select a Stock group, Manufacturer and Article and use the arrow to move the article to
Selected articles and article groups. You can Show discontinued stock groups or articles by
checking the appropriate box. Add selected items will add these articles to the previously
selected list. Close will close the window without moving any articles and take you back to the
Frequently used accessories window.
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Once you have created your list, Close will close the window. Delete will remove the selected
Accessory list. Another list can be created by selecting New and re-starting the process.

The up and down arrows in Accessory list and Accessories will move the lists and the articles
in the list so that they are in your preferred order.

When articles are set as ‘Discontinued’ they will be removed from lists automatically but Article
Groups will not, so they must be removed manually.

14.35.2 Opening ‘Fast accessories issue’

Fast Accessory Issue dialog can be opened in a number of ways, the quickest is to press
Ctrl+F10 on your keyboard. There are also buttons in Stock -> Functions -> Fast accessories
issue or Device list -> Accessory issue or Client Information -> Devices tab -> Accessory
issue. Using these ways the same window will open with the same selection filter showing the
previous Accessories issued to the client, in date order.

The Issue details on the right side of the window are similar to other stock new status functions
and need to be set first. Select the From stock type; this selection will be remembered for the
next time you issue accessories. The To stock type will default to the option selected in the
stock type set up in the System Administration tool but can be changed manually by selecting
from the drop-down list. The Date will default to today’s date but can be adjusted if required.
Select an Invoice type and Reason to issue if required and choose whether the Invoice should
be assigned to client or to customer.

14.35.3 Filtering potential articles

Fast accessories issue X

Client MR JOHN SMITH DK Close
Filter articles Issue details
* Accessories issued to the client, in date order From stock type
Manufacturers of current devices and Accessories linked to current devices STOCK - GWH (In stock) -
Limit to Stock group To stock type
Frequently used accessories from list FITTED/EXCHANGED (Issued) M

Select by Stock group and Manufacturer
Stock group Manufacturer
BATTERIES (Quantity-Accessory) All

Date
13/01/2020

User

AccessoniGroup | Accessory in Group Ear Accessary |UR|at| | [ [Stock | SYSTEMADMINISTRATOR -
MHS SUPPLIES, 675 R
MHS SUPPLIES, 13 L Invoice type
MIA Invoice type 1 -
Qty. Reason toissue
1 & M
» Invoice
4 ShofalEn
<« to customer

Populating: 2 Done

© Auditdata - 2025, ID: 20.0040/36 341



User Guide

There are three other possible filters in the Filter articles area to get you to the accessories you
need as quickly as possible.

* Accessories issued to the client, in date order. This will show a list of all the accessories
that have been issued to the client previously so you can quickly reissue.
e Manufacturers of current devices and Accessories linked to current devices. Selecting
this option will display:
° All accessories from the Manufacturer of the client’s current articles.
° All the accessory articles which are linked, in the article set up, to devices that have
been issued to the client.
¢ You can Limit to Stock group and select from the drop-down box which stock group the
accessory list will be limited to. Sorting results will be in the order:
e Accessories linked to articles
¢ Article groups from suppliers
* Articles from suppliers
¢ Articles that have been grouped will display the group name. If the group is expanded, the
Accessory in Group is shown in the next column.

AccessonyGroup |Fu:t:essnry
=] NHS SUPPLIES, TEST BATTERY GROUP
- 575
312

MHS SUPPLIES, 13

MHS SUPPLIES, 675 COCHLEAR IMPLANT
MHS SUPPLIES, 10

MHS SUPPLIES, A8 (MMN1800)

MHS SUPPLIES, AAA (MM2400)

¢ Frequently used accessories from list. Any lists of articles created in the Frequently
Used Articles dialog will be shown in the drop-down menu and the contents of the one
you select will be displayed in the Accessory/Group window.

» Select by Stock group and Manufacturer. This selection will default to All groups for
Stock groups and All for Manufacturers. If you select one Stock group the Manufacturer
defaults to All in stock group but you can also then filter on any one Manufacturer from

that Stock Group. Sorting will be:

° Manufacturer
° Article group
° Articles

14.35.4 Selecting the accessories to issue

Once you have selected the appropriate filter for the articles, they can be selected by
highlighting the Accessory/Group or Accessory in Group, if an article has been grouped and

342

© Auditdata - 2025, ID: 20.0040/36



User Guide

expanded, and using the right facing arrow or by double clicking, move the article to the right-
hand side of the window. An Ear side can be selected before moving the article by checking the
appropriate box, otherwise it will default to N/A.

The fastest way to select accessories to issue without side is just to double-click on as
many as you need.

The number of articles can be adjusted by using the Qty selection before moving the article or
after using the plus and minus buttons.

The article can be removed using the X button.

Accessory | URl Qty. | | | | Stock
MHS SUPPLIES, 675 COCHLI- |2 + || - || X]| 25
MHS SUPPLIES, 10 - |3 +|| - || X|9
MHS SUPPLIES, AA(MMAS00) L |1 +| - || X |8

14.35.5 Stock level control

The number of articles in stock are shown in the Stock column. If there are no articles in stock,
an information window will open.

Selecting article: NHS SUPPLIES, 312

I@I There are cumerthy 0 tems in "STOCK - GWH ({In stock).
k. 4

You are attempting to mowve 1 items, which will result in a negative amourt in STOCK - GWH (In stock).
Do you want to change number of items to be moved?

Press Yes to change number of tems to move

Press Mo to proceed with moving the entered number of tems

Yes No

Selecting Yes will enable you to change the article or number of articles being issued. The
number selected will automatically change to the number of articles in stock. No will allow you
to issue the article but will result in a negative number in the stock module and will be shown in
red.

MHE SUPPLIES, 312 L |1 + || - || X|0

If Full inventory control is set for an article, an information window will warn you that the stock
article cannot go below zero.
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Selecting article: NHS SUPPLIES, 673 =

There are 0 'MHS SUPPLIES, 675" in "STOCK - GWH (In stock)'
l % The aricle has "Full inventory control’ and cannot go below zero

oK

You will only have the option to OK and return to the Fast accessories issues window and
select another article. You will need to register additional articles into the stock module before
you can issue a Full inventory control article which is at zero stock.

Using the left facing arrow will remove an article from the list to be issued to the client. The
double arrow will remove all articles in the list.

14.35.6 Completing the issue

OK will issue the selected accessories to the client with the chosen options. If an Automatic
Journal Event is set for issuing stock, a single entry will be added to the Journal which just
states Article released to client.

If Show confirmation request on stock article issue is switched on for a user, this will not
display if a number of accessories are issued to a client using Fast accessories issue.

Close will close the window without saving any articles to the client.

14.35.7 Issuing accessories from Noah

Accessories can be issued directly from the Noah stock dialogue. If Open ‘Accessory issue’
automatically is checked, once the new status for a device has been changed and any
automatic journal events have been added to the Journal, the Fast accessories issue window
will open with the filter Manufacturers of current devices and Accessories linked to current
devices.

Serial numbers found in NOAH x

Client MR JOHN SMITH Close

B OpenAccessory issue’ automatically B Open ‘Device list if another current device is found

Serial number Manufacturer Article |Ear side| Stock type Patient Hospital no | Action
0202 R ==Mot found== Register for stock, then Mew status
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15 Journal

Click the button below to access our training materials.

The Journal module is used to create and review client journal text. The main screen consists of
an upper area that shows existing records and a lower area used for entering new records.

To view the Journal a client must first be selected. Some of the Journal entries are
automatically entered and some must be entered manually.

Reading the complete Journal can be time consuming and some of the entries may not be
relevant. This is where the Search string is used. By choosing an appropriate string, only the
entries concerned with the relevant event are viewed. If all entries need to be viewed then All
should be selected. Search strings (keywords) and date is typed for every entry made in the
selected client's record to provide easy access to information and ensure that once information
has been saved it cannot be changed.

To enter text manually into the Journal, type the required text into the Input text box. This text
can then be formatted. When the text is formatted as required, click Save. Once the text has
been saved it cannot be altered or deleted from the database for medico-legal reasons. If a
mistake is made another entry explaining the mistake must be entered. The entered text will
appear in the Journal Text window and is sorted by date either ascending or descending as
required.

When entering text to the journal for a client, search strings should be selected so that the
corresponding text is displayed in the upper part of the window while the new text is in the lower
part.

Signature will indicate which employee is typing the text and can be changed here. The default
is the logged in user.

Journal text formatting options are available from the top window bar or via right mouse
clicking, when typing in text.
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15.1 Journal overview, appearance and layouts

* Press F3 to search for the client or Ctrl+F3 to make a quick search.
e To open the module, go to Navigation -> Journal or press Shift+Ctrl+J.

The module is divided into four tabs: View, List, Treatment summary, and Individual
Management Plan.

There are two tabs for journal text:

¢ The View tab shows a print layout view of the journal text.

e The List tab is a list of journal records ordered with time as well as date that you can
select and edit, sign or delete. Unsigned journals will be deleted permanently. Signed
journals will be marked deleted, but you can see the deleted sighed journals by checking
the deleted box. Unsigned entries appear in red. Records marked as Deleted are shown
as crossed-out on the List tab or are marked with a text comment on the View tab.

Journal layout
In both tabs, you can toggle between the following layouts:

* Normal layout is used for viewing and editing journal text at the same time. With this
layout, a larger section of the screen is available for existing records and a smaller
section for editing.

e Edit layout is also intended for viewing and editing journal text at the same time, but with
this layout a larger section of the screen is available for editing.

¢ View layout is used for viewing journal text only. With this layout, the screen contains no
record editing area.

To toggle the layout, use the buttons in the upper right corner of the screen.

Zoom

The view of the journal on the screen is adjustable via the Zoom option. However, Printing the
journal produces the layout of the screen without the zoom. You can change the default
margins used for Keywords and Text in the View to limit the paper consumption when
printing journals. This can be done by the System Administrator.

Filtering
In the View and List tabs you can filter the records by checking the following boxes:

¢ Unsigned
e Signed
¢ Deleted

Filtering can also be done per keyword, which is explained in the next chapter.

© Auditdata - 2025, ID: 20.0040/36 346



User Guide

The Show all (F11) button on the View tab forces all journal records to be shown. The System
Administrator can define the settings for the whole site to make Auditbase limit the number of
records to be shown automatically on the View tab. This may be useful where clients have a
very large number of entries that may take some time to load. However, the user can select his
or her specific settings in the Administration tool as well. The Show all button overrules these
settings.

Sorting

By choosing the View menu item, you can sort the journal text ascending or descending by date
and time. Time can be viewed in the List tab, edit section.

o)) Auditbase - [Journal]

Eile Yiew Functions

i

sortby " Extended treatment surnmary | Save window setup

Sort by date ascending

v Sort by date descending MITH

| Sort by time ascending — )
) ) View | List | Treatr
v | Sort by time descending

Date

Auditbase automatically enters today's (system) date, but this can be manually altered if
required.

Save window setup

* To save the window setup, choose View -> Save window setup.
The saved settings are:

The current keyword group or keyword

The font on the current cursor

The zoom level
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15.2 Keywords

You can select a keyword from the keyword drop-down list to view a specific type of journal
entry. The keywords are set up by the System administrator. All entries will be linked to a
keyword and you can then view journal entries of a specific type. Keywords are linked to
different keyword groups in system settings. A keyword can be part of more than one keyword

group.

In System Administration settings, the administrator can define user rights linked to specific
keywords, for instance the right to enter journal keyword entries and read keyword entries or
the right to sign and delete specific keyword entries. If a user does not have the right to read
journal entries, the user can only see the keyword header, but not the journal text.

Yiew | List | Treatment summary | Individual management plan

M Unsigned

eyword ................................................................... W Signed T Do O] Show 2 F11) ||E3

SYSTEM ADMINISTRATOR

{SENSITIVE INFORMATION
WO

4PPOINTMENTS
Audiologist

A ADULT REHABILITATION | SYSTEM ADMINISTRATOR
i _ ADULT DIAGNOSTIC
! - PAED HEARING AID | GNRESOUND, CS61
- PAED DIAGNOSTIC
|- PAED COMMUNITY

#IESTH

P Tl 0 LA - RIS mamm s R L ) Il e e A v

10/01/2020

SYSTEM ADMINISTRATOR
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15.3 Use of hot-keys

¢ To speed up the process of entering text into a journal, you can make use of Hotkeys.

¢ Hotkeys can also be used in auto journal event pop-ups.

¢ [f the system administrator has provided you with extended rights for this, the hot-keys
are created in the Journal module for the whole site.

¢ Select Use hot-keys under the Functions menu.

o)) Auditbase - [Journal]

File View Functions
= = = = ooo = = —= —
- - - — - nn “a ™ A-._ . —
o 0 G B m B B A
Add service to invoice | Show audiogram | [ssue 8 review list Uze Properties Uze Onsaving | Properties  MNew task

Hot-Key.. Spell check

¢ Once the feature is selected you can enter Hot-key properties.

Hot key properties >

Print list Mew Save Delete Close

Hot keys Selected hot key

Mumber Name ~
Mumber: o

0z Earmould booking in Mame: Repair appt

03 Postal repair Textto insert:

04 Inappropriate C&B referral " " -

o5 Bafters enau General info given : went over different

0 5 t”_fdfq o . programs today and how to clean the
pstaldiee - pal mould/corda. talked about adaption to

07 Replacement hearing aid ampliﬁcatian

0g Lostaid on Ward funds trans Batteries:

09 Lost aid fit Outcome: Appointment complete / Further

10 D.ref appointment required.

11 AGR

12 Fitting

12 Follow up Y B||1|D ---

< >

e Click on New to enter a new hot-key.

¢ First enter a Number for the hot-key - all numbers below 10 will have a O placed before
them, i.e. 01, 02 etc.

e Enter a Name for the hot-key - not mandatory.

e Enter the Text to insert.

¢ Once you have created a whole list of hot-keys, you can print the list by clicking on Print
list - this will give you easy access to all hot-keys instead of having to look them up in the
system.
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¢ Once back in the journal, the hot-keys are accessed by placing the cursor in the text field

and pressing Ctrl+Shift+[number].

e Example: For the hot-key created in the screen shot above, the short cut would be
Ctrl+Shift+03 (not just Ctrl+Shift+3).

¢ The textis then displayed in the text field.

350
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15.4 Entering journal text

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

¢ Navigation -> Journal or press Shift+Ctrl+].

e Select the View or List tab.

¢ Select an appropriate keyword from the drop-down list for the journal entry.

o Enter the required text in the text box.

° Pasting copied content is also possible. However, the system prevents pasting
images because they cannot be displayed correctly in the Journal.

¢ The text can be formatted to bold, italics, black, blue or red, and it can be aligned to the
right, centre or left via the formatting buttons. Text font can be changed as well.

e The Users default font settings can be saved using the View -> Save window setup -
make sure the font is selected in the Edit window beforehand.

¢ Click Save unsigned to save the entry unsigned. You can also lock the new record from
being signed by checking the Lock box.

OR

* Save signedSign as user drop-down list

Edit Journal
Keyword ~  Date 13012020 Time 12:43 Sign as user: SYSTEMADMINIE v Zoom 100% v

Sample text
Sample text

Sample tex

ck | Saveunsigned | Savesigned || Cancel

w
-
a
i
[l
1]

| |

| |
|
-
i
i
c

* The Date and Time that a journal entry is saved is locked by default unless the user has
the extended right to choose date/time of record.

Your System Administrator decides whether or not you have the right to save a journal
unsigned, so you may experience that the button Save unsigned is disabled if you do not
have the extended user right to save unsigned.

It is important to check the client’s name regularly to make sure you are working with the
correct client.

On PCs in slower networks your System Administrator can configure a checkmark to not
‘Refresh Journal view after saving’ to prevent you having to wait while the Journal
refreshes.
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15.5 Editing a journal entry

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

e To open the module, go to Navigation -> Journal or press Shift+Ctrl+J.

e Select the List tab.

¢ Mark the check box for the record you wish to edit. Note that only unsigned records can
be edited.

¢ Edit the text in the text box at the bottom of the screen.

» Click Save unsigned to save the entry unsigned. You can also lock the new record from
being signed by checking the Lock box. If the journal record was created by another user,
the system will overwrite the value of the Created by column with your name.

OR

e Click Save signed to both save and sign the entry at the same time. You may select user
signature in Sign as user drop-down list (logged in user is selected by default). The
system will put your name to the Signed by column of the list.

0:“) Auditbase - [Journal] — O *
File View Functicns
fl §_?| = ? oo = E;\ = | =
Ak B © TN L
Add service to invoice  Show audiogram  [ssue 8t review list Use Properties Use Onsaving | Properties  New task
Hot-Key... Spell check
IL]| Client <T>T18765 MR JOHN SMITH -l 1= (Euser SYSTEM ADMINISTRATOR All locations = All departments - |2 ?

View ||List | Treatment summary | Individual management plan

Keyword Al - : z;::;ed H Deleted sign | Delete | Print EE i]
| create date Keyword | Created by Signed by Lock ~
[ 13/01/2020 12:37 | ADULT REHABILITATION | SYSTEMADMINISTRATOR | SYSTEM ADMINISTRATOR
[ 10/01/2020 17:05 | ADULT REHABILITATION | SYSTEM ADMIMNISTRATOR | SYSTEM ADMINISTRATOR.
[ 10/01/2020 16:51 | ADULT REHABILITATION | SYSTEM ADMINISTRATOR | SYSTEM ADMINISTRATOR
[ 10/01/2020 11:25 | APPOINTMENTS SYSTEMADMINISTRATOR | SYSTEM ADMINISTRATOR
[1]10/01/2020 10:56 | APPOINTMENTS SYSTEMADMINISTRATOR | SYSTEM ADMINISTRATOR
10/01/2020 10:56  APPOINTMENTS SYSTEMADMINISTRATOR | SYSTEM ADMINISTRATOR
[1]10401/2020 10:52 | APPOINTMENTS SYSTEMADMINISTRATOR | SYSTEM ADMINISTRATOR
[ 10/01/2020 10:50 | APPOINTMENTS SYSTEMADMINISTRATOR | SYSTEM ADMINISTRATOR
[1]10/01/2020 10:47 | APPOINTMENTS SYSTEMADMINISTRATOR | SYSTEM ADMINISTRATOR
[ 10/01/2020 09:20 | APPOINTMENTS iryna skladana iryna skladana
[ 10/01/2020 09:13 | APPOINTMENTS iryna skladana iyna skladana
[ 10i01/2020 08:51 | APPOINTMENTS iryna skladana iryna skladana
[ 09/01/2020 17:42 | APPOINTMENTS SYSTEMADMINISTRATOR | SYSTEM ADMINISTRATOR o
Selectall 1 row selected
Edit Journal
Keyword APPOINTMENTS Date | 10/01/2020 Time | 10:56 Sign as user: SYSTEM ADMINIZ |+ Zoom 100% -
Appointment PHAC new patient mould~ with Res109 on 10/01/2020 13:15 - 13:30 was moved to cancellation history having a status of Qf D
Cancelled

]
~
]
1]
]
-]
It
L}

= Lot Save unsigned || Save signed
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15.6 Use of spell checking

Another feature of the journal is the spell checking tool, activated while typing text to the input
window. This works in a very similar manner to Word. Incorrectly spelt words will either be auto
corrected if the word is already in the dictionary or will be highlighted. It will suggest spelling
options when the highlighted word is right clicked. A window will appear giving spelling options
to choose from. The misspelt word can be ignored or added to the spell check dictionary.

deaf
def.
serf

Add to dicticnary

lgnore

Edit »
Bold

Italic

Underline

Strikeout

+*  Left alignment
Centre alignment

Right alignment

«  Black
Red
Blue
Green

Gray

Find...

¢ Spell checking is disabled /enabled by right clicking and choosing Disable
spelling/Enable spelling or via the Functions menu -> Spell check -> Use

dj)
File WView Functions
R B o oY =
- oo E O ) oo ] v ) @
Add service to invoice  Show audiogram | [ssue & review list Uze Properties Use Properties  Mew task
Hot-Key.. Spell check
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15.6.1 Customising the spell check dictionary

* As well as adding words to the dictionary as you type, the dictionaries that are used by the

spell check can be adjusted by using Properties. A window opens where the default

dictionary can be edited if required. Words that have been added to the dictionary will be
displayed in the default.dic.

Spelling properties

Select folder

Customized dictionaries

{27 Internet Explt
I3 Microsoft SQ
-[:| Microsoft Vis
~[[3 Mme

BI{Z3 Msdn

[0 Metwark
-[:| Office

(17 Outlook
(7 Paint

[ PowerPaint
(I3 Proof

-[:| Protect

(17 QuickStyles
-[:| Signatures
&{C3 Skype for De
-[:| Software Cer
#_] Spesch
3 Spelling

JEL=nco|

A

L

Select dictionary

default NotUtF6 (1).dic
default NotUtF6 (2).dic
default NotUtF6 (3).dic
default NotUtF6 (4).dic
default NotUtF6 (5).dic
default MotUtF6 (6).dic
default NotUtFE (7).dic
default NotUtF6 (8).dic
default MotUtF6 (9).dic

default.dic

Edit dictionary
Add from file ...

* Selecting a dictionary and then Edit dictionary will open a note pad where the words in
the dictionary can be edited or added to.
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15.7 Signing a journal entry

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

e To open the module, Navigation -> Journal or press Shift+Ctrl+J.

e Select the List tab.

¢ All journal records are either unsigned or signed.

e An unsigned record can be modified and is shown in red. A signed record cannot be
modified. However, you can mark it as deleted. A signed record is shown in black.

¢ You can view the signed records, the unsigned records or both kinds by checking the

B Unsigned

boxes Unsigned and Signed ™ Sianed

Signing the record also means saving it. If a mistake is made, another entry explaining the
mistake must be entered.

e Check the boxes for the records you wish to sign. You can sign more than a single record
atatime.

¢ The system automatically signs with the name of the logged in user, but this can be
manually altered if required in the Sign as user drop-down list.

e Click Sign.

¢ The records are now shown as signed in black on the list.

¢ If unsigned journal text is included in a treatment summary, this text can be signed along
with the summary, if this operation is allowed by the system administrator.

Any unsigned journal record can be locked to avoid it being signed until the text is finalized.
To lock a record, check the Lock box in the edit area and save it unsigned.
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15.8 Finding unsigned journal entries

e To find unsigned journal entries, go to Navigation -> User Tasks -> Attention list and

choose the Unsigned journal tab.

Attention list *
Do not show awarning message  D-Alert selection method PAS alert hd Print Show in Journal Close
Referrals | Journal ||Unsigned journal | Unsigned summaries | Deceased alerts | Electronic submission
Unsigned journal records
Date Hospitalno.| MNHS no. Client name User Keyword "~

111142010 | T146023 MR FIRSTMAME46023 LASTMAME46023 | USER NAMEBS ADULT REHABILITATION

26M1/2010 | T11194 MR FIRSTMAME 1194 LASTNAME 1194 USER NAMET1.. | ADULT REHABILITATION

10M2/2010 | T134576 MR FIRSTMAME34576 LASTMAME34576 | USER NAMEBS ADULT REHABILITATION

12/01/2011 | T146604 MST FIRSTMAME46604 LASTNAME46604 USER NAME49.. | PAED DIAGNOSTIC

20/01/2011 | T13646 MR FIRSTNAME3646 LASTNAME3646 USER NAMESS ADULT REHABILITATION

25/01/2011 | T146523 MRS FIRSTNAME46523 LASTMAME46523 | Marten ADULT REHABILITATION

25/01/2011 | T145198 MRS FIRSTNAME45198 LASTMAME45198 | Marten ADULT REHABILITATION

26/01/2011 | T146646 MRS FIRSTNAME46646 LASTNAME46646 USER NAME14 ADULT REHABILITATION

26/01/2011 | T145288 MR. FIRSTNAME45288 LASTMAME45288 | USER NAMES9 ADULT REHABILITATION

26/01/2011 | T15809 MRS FIRSTNAMES809 LASTMAMES809 | USER NAMES3 ADULT REHABILITATION

2710172011 | T146183 MRS FIRSTNAME46183 LASTNAME46183  USER NAMET1 ADULT REHABILITATION

2710112011 | T146077 MRS FIRSTNAME46077 LASTNAME4G077  USER NAMESS ADULT REHABILITATION

01/02/2011 | T12569 MRS FIRSTNAME2569 LASTMNAMEZ2569 | USER NAME29. | ADULT REHABILITATION

30/09/2013 | T1106 5555554444 | MRS FIRSTNAME106 LASTMAME 106 full name tests??? | ADULT REHABILITATION

30/09/2013 | T1106 5555554444 | MRS FIRSTNAME106 LASTMAME 106 full name tests??7? | ADMIN

30/09/2013 | T1106 5555554444 | MRS FIRSTNAME106 LASTMAME 106 full name tests??7? | ADMIN

021012013 | T1106 5555554444 | MRS FIRSTNAME106 LASTMAME106 full name tests??? | ADMIN

17/07/2014 | T999911 1112222211 | Father dz=62 dzal full name tests??? | GENERAL v

|
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15.9 Deleting a journal entry

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

e To open the module, go to Navigation -> Journal or press Shift+Ctrl+J.

e Select the List tab.

¢ Mark the check boxes for the records you wish to delete. You can delete more than a
single record at a time.

¢ Click Delete.

* Deleted text is shown by date of creation, with search string and an indication in RED by
whom and the date and time when the text was deleted.

¢ On the List tab, signed deleted text is shown as crossed out.

¢ Unsigned deleted records can either be shown as crossed out, or disappear from the list.
This depends on the rights defined by the system administrator.

o If deleted records were filtered out, they are not shown in the list.

Note that only unsigned text can be physically deleted from the journal. Deletion of sighed
text only marks the text as deleted. Deleted signed text can be viewed again when you
check the Deleted box.

The system will not allow deleting signed text if the text is included in a treatment
summary. To delete the text, exclude it from the summary first.
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15.10 Printing and previewing the journal

To print or preview the entire journal for the client’s:

* Press F3 to search for the client or Ctrl+F3 to make a quick search.
Go to Navigation -> Journal or press Shift+Ctrl+J.

Select the View tab.
Select File -> Print journal to print a copy of the report on the default printer.
Select File -> Print preview to display the report on the screen.

To print selected records only:

¢ Press F3 to search for the client or Ctrl+F3 to make a quick search.
e Go to Navigation -> Journal or press Shift+Ctrl+J.

o Select the List tab.

¢ Check the boxes for the records you wish to print and click Print.

Crystal Reports is the program presenting the preview and from here, the journal can be printed
or exported in a selectable format and to the relevant path.

Closing down the preview on the screen is done by clicking X in the upper right corner returning
to Auditbase Journal.
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15.11 Issue & review checklist

This function displays a window where you can add more information about a fitting.

* Press F3 to search for the client or Ctrl+F3 to make a quick search.
¢ Go to Navigation -> Journal or press Shift+Ctrl+J.
¢ Select Functions -> Issue & review check list.

e Click New.
¢ Clicking in the various fields will produce a'Y, N or blank.
¢ Click Save.
Issue & review check list -
Mew Save Delete Cancel
Date Mould Aid Controls| Batteries | Fitting | Tubing | Maintenance |Progression| Useof | Useof
of use telephone | telecoil

1310172020 Y I
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15.12 Individual Management Plan (IMP)

In the Journal module, there is a tab on which you can create an IMP for a client including
Needs, Actions and Outcomes; which can be printed out and an automatic journal event
created. A ‘snapshot’ of the IMP can be taken and stored for future reference.

Information documents can be easily printed from the IMP once they have been set up in
Documents and Attachments. You can choose to store these information documents either as
complete documents or by title only.

All columns in all of the tables on the IMP have configurable width set ups. Make adjustments
to the column and then right click and Save user view. See Section 1.7 for further information.

Your System Administrator can set up the required default fields.

IMPs: | iz 280052020, HA issue »| Cientname | COLONEL CHARLIE HARPER Rofresh || Cancel

Prind and Stone Print infarmation documents M Daleti
Selected WP
Sared on 2EME0H0 Fo AL appointmert

WP bype [ EYEETT = Crealed by SYSTEM Ademin - Audogram =
Referal 120672019, DR HAASSESS Treatment type DR HAASSESS Refemal handing
Apreed neads: - Remove

# Need [ Calagories [ Oudatea | Comment ~
1 Hear TV bether Faersanal Public
2 Hearfamily beller Putac

A= T

PRI

Agread and completed actions | v
MHesd Action Comment Compl. dale Apposntmeant sl
O+ |Fatwo hearing aids | | 26052020 |77 200052020 SWITCH ON | BERTA
Pasilion TV batter
Lise aaskssive device

~jooooipE

Mt appointmant

Cuttamss

Heed Dulcomee Soore Diate -
1 |Amsonsd 45 2652020 |

< »

Shared with palient on WP finished and pasent discharged on
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15.12.1 To create an IMP

* Choose a Referral using the ' icon and click Attach.

Selected IMP
Started on 13012020 E At appointment
IMP type Hearing Aid - Adult - Created by
Referral 1810612015, ++ALIDIO REVIEW rue:l____I Tenotronnt b
Attach
Agreed needs: . Detach

| H# | Moo T Armrmant

e The date that the IMP was Started on will default to today's date but can be changed
manually.

¢ The IMP type will use the default type set by the System Administrator. This can be
changed using the drop-down list.

» Created by will show the logged-on user. This can be changed, only if the user has the
extended user right.

An Audiogram for the IMP can be attached by selecting from the icon =~. Once the

audiogram is attached, it can be shown by selecting the preview icon.

¢ The appointment that the IMP was started on will be shown in the At appointment field. If
no appointment is shown in this field, one can be added in the same way as adding a
referral above. If the appointment is not attached to a referral or attached to a different
referral, you will see an information window asking if you wish to link the appointment to
the IMP rather than the selected referral.

» Agreed needs will default to those set by your System Administrator.

Aprded nesds e, |

] Mead Calagonss Outdatid Cammn A
Haar TV betlar —
Hear tamily befler I
Hear phona befer

1
F3
3
4
]
&
T
L

e Further needs can be added by either:
e Clicking in the Need column and selecting from the drop-down menu.

¢ Clicking in the Need column and typing in free text.

e A category for the Need can be selected from the Categories drop-down menu. Multiple
categories can be used by selecting the Multiple categories... option. A window opens
where you can Select IMP category.
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Select IMP category x

select Cancel

Mame

v Personal
v | Public

e Check the appropriate categories and then Select. The categories will be shown
separated by a comma.

Categories

Personal Public

e The Need can be outdated if it is no longer required by selecting the Outdated check box.
Outdated Needs remain in the list, but they are greyed out.

* Afree text Comment can be added to Needs by clicking in the Comment column and
adding text.

e The order of Needs can be altered by highlighting an item and using the up and down
arrows to move it.

* Needs are linked to actions by clicking in the Need column of the Agreed and completed
actions table and selecting the appropriate need number.

Agreed and completed actions: i v

| Need | Action |
] ~ | Fittwo hearing aids
Position TV better
Use assisstive device

DDD'

* |fthe Need in the Agreed needs table is re-prioritised, then the Need in the Actions table
will automatically re-number.

¢ Toremove a Need, highlight the text and click Remove.

e Actions are added in same way as Needs.

e To remove an Action, ensure the Action is highlighted with the box on the left side
checked and then click Remove.

e To complete an Action, ensure that the box on the left side of the Action is checked.
Select Complete and an information message will ask if you wish to complete the action.
Select Yes. Selecting No will cancel the operation.
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Message
I@I Do you want to complete the selected incompleted actions?
k. ® 4

Yes Ha

Once an Action has been completed, it will be highlighted in green text. The date of completion
defaults to the current date, but can be edited by clicking in the Compl. date column and typing
in the required date.

Agread and completed actions - v Altach Dratach Complete Lin-comglete Remove
Heed Acson Commant Compld dale Appoinkment -

Fil kD hpanng aids SWITCH QN BERTA
Pasilian TV beflar

LI58 a55i651he device

(] | mjfs|

¢ If only one appointment occurs for the client that day, and the appointment start time is
earlier than the current time, then the action will be attached to that appointment. If this
is not the correct appointment, it can be removed by checking the relevant box and
selecting the Detach button. The correct appointment can be added by selecting Attach
and choosing the correct appointment. If the appointment is attached to a referral, the
Referral field will be filled in automatically.

¢ If the incorrect Action was completed, select Un-complete to remove the Action from the
Completed actions table.

The next appointment can be booked using the Book or Search and Book facilities in the same
way as for Referrals. See Section 3 for further details.

If a future appointment exists, this will be shown in the Next appointment window.

Nextappointment  16/01/2020, SAV ENT audio Search and book

15.12.2 To add Outcomes to an IMP

e Choose a Need number.

Oubcames Remave
| Heed Culcome Score Duate Ll

2
3

¢ |nput any outcome text by clicking in the Outcome column.
¢ Click in the Score column to add a free text score. The limits for the score are set by the
System Administrator.
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¢ Double-click in the Date column to add the current date. This can be edited if required.

¢ Click in the Need status column and select from the drop-down menu of pre-defined
need statuses.

¢ |f an Outcome should be removed, highlight the Outcome and select Remove.

Outcomes: Remove
Need Outcome Date | Need status A
2 Bin fir 6070 14101/2020 | (EGEGED

W
< >

Once the IMP has been completed, it can be printed. A snapshot of the IMP can be taken at any
time. Both of these actions are performed by selecting Print and Store.

| Printand Store | Printinformation documents
Selected IMP
Started on 130142020 E
IMP type Hearing Aid - Adult -
Referral 180662015, ++ALDIO REVIEW re; |

e Once Print and Store has been selected, a window opens giving you three options.

e Print - Will print the full IMP.

e Snapshot and AJE - Will take a snapshot of the IMP as it is on the current day. A
snapshot is a locked version of the IMP taken on that date, so that the current IMP can be
compared to what the earlier state was. The information from the snapshot can be added
to the Journal as an Automatic Journal Event (AJE) if this is set up by the System
Administrator.

e at appointment - you can attach the snapshot to an appointment by clicking the button
to the right of the field. The button will be disabled if you have not selected Snapshot and
AJE.

¢ IMP has been Shared with patient on (date) - This will indicate on the main IMP page
that the IMP has been shared with the client. The text for this is configurable by the
System Administrator.

Print and Store IMP >k
Ok Cancel
M Print
M Snapshot and AJE
at appointment N
EI Attach
B IMF has been Shared with patient on 2B/05/2020 E
Detach
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¢ Check or un-check the relevant boxes to choose which action to undertake.

e If a snapshot is taken, the IMP can be seen in the IMPs list as a folder item with the
snhapshot attached to it. The folder icon indicates that an IMP has attached snapshots. If
the snapshot is attached to an appointment, it appears under the appointment it is
attached to, but not under the appointment the original IMP is linked to.

 If Print and Store is selected for a snapshot, only the Print option will be active.

[ Client T122729 MRS FIRSTNAME22729 LASTNAME22729 | ~

Wiew | List | Treatment summary | Individual management plan

IMPs: 1210312020, Hearing Aid - Adult

Print and Stgre™ AN A L

¢ Information documents can be printed out for the client by selecting the Print
information documents button.

* A window will open with a list of the available documents. These are set by the System
Administrator.

Print information documents >

W Selectall Erint Cancel

| Title
test letter template 02/09/2013

Cnly M3 Ward documents can be printed, so anly those are shown

¢ All the documents can be selected by checking the Select all box. Individual documents
can be selected by un-checking this box and checking the box of the relevant document.

¢ Print will send the document to your default printer.

e Cancel will close the window without printing.
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Once the IMP is completed, the date of this can be added to the IMP finished and patient
discharged on (date) field. Double clicking in the box will add the current date or the calendar
can be used to add another date.

15.12.3 Adding IMP to offline databases

IMPs are copied to the laptop database. However, referrals are not copied, and not all
appointments are copied.

An IMP appears in the offline database as not attached to a referral, and potentially not
attached to the appointment it was started at.

Similarly, IMP completed actions can be detached from appointments during copying to the
offline database.

However, for IMP snapshots copied to the laptop database, appointment information is copied
as well.
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15.13 Searching the Journal text

The text in a Journal can be searched using the icon in the upper window or by right clicking
in the lower window. A box will open where you can insert the text to be searched.

Find et

Findwhat: ||

Match whole words only Cancel

Match case

Depending on which are you are searching, the box will be labeled Find in upper text or Find in
lower text. There are two choices which are selected by checking the box; Match whole words
only or Match case. Find Next will search the journal and highlight the searched for word.

APPOINTMENTS - SYSTEM ADMINISTRATOR

The appointment was movedClient appointment moved: Date: 10/01/2020; Booking resource(s). Charlie ( start time: 14:00 -
end time: 15:15; Symbnl: PHAC. new natient mauld~ 1

APPOINTMENTS - SYSTE

Appointment PHAC n€ g wnat: | booking Find Next tancellation history having a

status of Qf Cancelled | — -
Match whole words only

APPOINTMENTS - SYSTE Match case

The appointment was n Res109 ( starttime: 13:15-

end time: 1330, Symbu.. T TISW atie i Frioma— f

Cancel

Cancel will close the box.
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16 Treatment summary

Click the button below to access our training materials.

To view treatment summaries for a client, select the client, select the Journal module and click
the Treatment summary tab.

Treatment summary consists of two sections. The upper section is a list of existing client’s
summaries. The lower section is for viewing and entering details about a specific treatment
summary.

The lower section can be in either brief or extended form, i.e. showing standard or extended
data. This can be toggled on/off by the View -> Extended treatment summary menu.

As for journal text, treatment summary can be signed or unsigned. A signed summary cannot be
changed, whereas an unsigned summary can be edited. Signed summaries are shown in black
in the upper table; unsigned summaries are shown in red.

Be aware: Before proceeding, please make sure the correct client is selected to avoid making
an incorrect summary.
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16.1 Treatment summary overview

Press F3 to search for the client or Ctrl+F3 to make a quick search.

Navigation -> Journal or press Shift+Ctrl+].

Select the Treatment summary tab.

A shortcut is available in the menu bar. This can be selected from any module =,

A treatment summary can contain links to the following data for the client:

¢ Observations

e Hearing instruments and earmoulds
e Journal text

e Audiogram

¢ Referrals

e Waiting list entries

¢ Appointments

¢ Clinical history

e Tympanometry information

Oil Auditbase - [Journal] — [} X
File View Functions
LJ| Client <T>T18765 MR JOHN SMITH - 2 % Bl User SYSTEM ADMINISTRATOR All locations ~ All departments Alt « 1
View | List || Treatment summary | Individual management plan
Create date | Mo. Type Created by Signed by Review status
[v]| 2 019 |3 Default summary type SYSTEM ADMINISTRATOR SYSTEMADMINISTRATOR
[/ 21/08/2019 |2 Default summary type SYSTEM ADMINISTRATOR SYSTEM ADMINISTRATOR Draft
[ 21/08/2019 |1 Default summary type SYSTEM ADMINISTRATOR SYSTEMADMINISTRATOR Draft
[ 22/06/2015 |1 Default summary type full name tests??7? full name tests??7? Draft
Mew Print/Send Sending status Sign Delete Save unsigned Save signe
Create date 21/08/2019  No. 3 Review status Draft Audiogram  11/03/2019, no. 1, Aided List =
Client observations Remove | Hearing test outcome
R. SRT.
| obsno. | Dale [Add s Text Comment
0127 2410312015 Test observation qo B0 wm te» mw e ew o o o L SR
o 00 X
" OM. > % % % @ = LISk
= X\I—I—EI—I—E. IE = L. DS%:
= O S S R S &1 ™
Hearing instruments / Earmoulds Re e 40 & DS Moise:
| Modified Description = 'ﬁa'éﬁ‘? &gﬁ?-)é),;p = R.:
&0 = ™ 40
: L:
[]22/06/2015 |R:A&M, SELECTRA, 23223 o SR -
= o
w© M=l d- | me sl n
100 \. S o
1o T- I - B
Journal text Show text (F7) Remove | M—H—Ml
|Create date Keyword Created by | Signed by 120
[]|16/08/2019 | GENERAL SYSTEMADMI SYSTEM ADMI "
Appointment 01/03/2019, ittt oD
Referral 22/06/2015, +DIRECT REFERRAL /Audio ¢
Standard summary

Since a summary contains only links, adding information in the summary only creates a link,
and removing information from the summary only deletes a link, but not the information itself.

369
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A summary can be signed or unsigned. Only unsigned summaries can be modified or deleted.

Unsigned summaries are shown in red in the upper table of the summary window; signed
summaries are shown in black.

A treatment summary cannot be signed when it contains no journal text, or unsigned
journal text, or an unsigned audiogram, or any data in extra details.

The Preview and Print buttons will take you to a selection window, where you chose which
recipient to preview or print the summary for.

The lower part of the window contains details of the summary selected using the check box.
This lower part is intended for the creation and/or editing of summary details.

The detailed part consequently consists of two further parts. The upper part stores
observations, Hearing Instruments and earmoulds, journal text and audiogram.

The extra part is visible when View -> Extended treatment summary menu is flagged from the
menu item View -> Extended treatment summary, and contains the tabs Contact history,
Clinical history and Tympanometry information.

o)} Auditbase - [Journal] — [m] X

Eile View Functions

Sort by  Extended treatment summary = Save window setup

Sort
IL]| Client | Extended treatment summary ETNAMHOS | A = |Bl|user SYSTEM ADMINISTRATOR All locations * All depariments - ¢ @
22. View | List |Treatment summary | Individual management plan
a
= [ create date| No. | Type [ Created by Signed by Reviewstatus | ~
- [~ |15/06/2015 |1 Default summary type full name tests??? full name tests?7?7? Draft
[~ | 28/05/2015 |1 Default summary type full name tests??? full name tests??7? Draft
v I 51 Default summ pe full name )
r 04/2015 |1 Default summary full name tests?277? UNSIGHNED Draft v
New Print'Send Sending status Sign Delete Save
Create date 01/05/2015  No. 1 Review status Draft Audiogram  29/04/2015, no. 8 List
Client obsernvations Add Remove | Hearing test outcome
Obsno. | Date |Adds] Text Comment A R SRT.
125 30/09/2013 |2 | R Presbyacusis LEFT Right o w0 tem aw wee e s ee e Lemz
[~ |128 30/09/2013 |1 |L | Otoscleros QCCUPATIOMNAL Left @ g e
125 16/05/2014 |2 |L | Presbyacusis LEFT Left 1AED 1 e > - R DS%:
¥ = - o - L. DS%:
< > - o o -
Hearing instruments / Earmoulds Add Remove o = @ DS Noise:
Modified Description - = R:
& “
[~ | 01M2/2014 |L: EM 2101 - SOLID~ACRYLIC HARD, R: EN - - L:
[~ |17i/07/2014 |L: EM 0350 - SPECIAL EARMOULD ~ SEE & = 14 EY
[T 1 15/04/2014 |L: EM 2101 - SOLID~ACRYLIC HARD, R: EN = © o o
[~ | 14/04/2014 |L: EM 0350 - SPECIAL EARMOULD ~ SEE 8 e °
o
Journal text Show text (F7) Add Remaove .
Create date Keyword Created by | Signed by | 1
[~ |01/05/2015 | ADULT DIAGR full name test | full name test =
[~ | 01/05/2015 | ADMIN full name test | full name test
Appointment co
Standard summary

NUM e
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Under Contact history you will find referrals, waiting list entries and appointments. The Clinical
history will show medical history and questionnaires. Tympanometry includes tympanograms
with values.
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16.2 Creating a summary

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

Go to Navigation->Journal or press Shift+Ctrl+J.

Select the Treatment summary tab.

Click New.

In the opened window, click either Open blank summary or Create summary of type and
select a type in the drop-down list.

Create treatrment summary H

Open blank summary
# Create summary of type

Default summary type -

OK Cancel

¢ Click OK.
¢ The system shows a blank summary or one filled with some details independent of the

above selection.
OR

* From any module, click the z toolbar button. The system will create a summary pre-filled
with details as configured by the system administrator. The automatically filled details for
a new summary can be modified as required.

In the summary details area:

¢ In both cases the system assigns a number for a new summary and shows any pre-filled
summary details in the lower part of the screen, where the details may be modified if
required to add client observations or procedures, click Add above the table.

¢ To add client hearing instruments and/or earmoulds, click Add above the table.

¢ To add journal entries, click Add above the table.

e To add an audiogram, click List above the table.

¢ |Inthe corresponding windows, select the entry to add.

¢ |n Treatment summary, click Save unsigned.

OR

» Click Save signed to both save and sign.

Please note that lower screen section view may show standard or extended details
depending on the setting in View -> Show extended treatment summary
(checked/unchecked).
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16.3 Editing a summary

* Press F3 to search for the client or Ctrl+F3 to make a quick search.
¢ Go to Navigation -> Journal or press Shift+Ctrl+J.

» Select the Treatment summary tab.

¢ Mark the check box for the summary you wish to edit.

In the summary details area:

¢ Modify the summary date if required.

* To add a client observation or procedure, click Add above the table. To remove an
observation or procedure, click Remove.

¢ To add a client's hearing instruments and/or earmoulds, click Add above the table. To
remove an instrument or earmould, click Remove.

e To add a journal text, click Add above the table. To remove a journal text, click Remove.

¢ To review journal text included in a summary, select the records you want to see in the
Journal text table by checking the box, and press Show text. The system shows a dialog
where the text is seen.

* To add an audiogram, click List above the graph. To remove an audiogram, click Remove.

e To include referrals, check the Show referrals box.

¢ To include waiting list entries, check the Show waiting list entries box.

¢ To include appointments, enter Number of appointments in the past and Number of
future appointments.

¢ Click Save unsigned.

Or

¢ Click Save signed to both save and sign.

Note that only one audiogram can be included in a summary, whereas more than one
observation, hearing instrument, earmould and journal record is allowed.

Extended summary details can include the client’s referrals, waiting list entries and
appointments.

The summary contains references to already existing data for the client. Therefore, when
adding a record to a summary, for instance an observation or procedure or hearing
instrument, only a link to the existing data is established, but no new data is created.
Likewise, removing a record from a summary only removes the link.

Changes made to a summary detail remain only on the screen until the summary is saved.
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16.4 Signing a summary
Sighing means "locking" a summary and protecting it from changes.

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

¢ Go to Navigation -> Journal or press Shift+Ctrl+J.

» Select the Treatment summary tab.

¢ Check the boxes for the unsigned summaries you wish to sign. You can sign multiple
summaries at the same time.

o If defined by the system administrator, any unsigned journal text included in the summary
may be signed along with the summary.

» Click Sign.

¢ The selected summaries will become signed and show in black in the table.
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16.5 Deleting a summary

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

¢ Go to Navigation -> Journal or press Shift+Ctrl+J.

» Select the Treatment summary tab.

¢ Check the boxes for the summaries you wish to delete. You can delete multiple
summaries at the same time.

¢ Click Delete.

¢ The selected summaries will disappear from the table.
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16

.6 Printing or previewing a summary

Press F3 to search for the client or Ctrl+F3 to make a quick search.

Go to Navigation -> Journal or press Shift+Ctrl+J.

Select the Treatment summary tab.

There are two ways of printing a summary:

Select one or more summaries in the upper table and press Print.

If you just want to print one summary, press the Print button below the details area.
Either way, the Print summary dialog opens. In the dialog you can select who the
summary should be printed for and the number of copies.

¢ You can preview the print layout before printing. Please note that the layout for a single

summary only can be previewed.

e To preview, select a summary by checking the mark in upper table and press Preview.

The Print summary dialog opens and you can define the recipients.

Print summary >

Add recipient Erint Preview Send electronically Close

Summary recipients

| MName Copies
P 1
DRAALLEN, 3 VALE AVENUE, WANTAGE, OXON, PC:B376 1
Client 1
CFANDERSON, MERCHISTOMN SURGERY, HIGHWORTH ROAD, STRA 1
[J/ENT 1
[]| DRASH, KINGSWOOD SURGERY, KINGSWOOD AVENUE, PARK NOR] 0
[/ Journal 2
Print to other recipient Copies 1

Please note that a summary print layout can depend on the summary type. This is defined
by the system administrator. The system administrator can also define that an unsigned
treatment summary is marked with additional text on the print layout.
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16.7 Sending status of summary review

There is a possibility of sending the status of the treatment summary electronically instead of
printing it:

Make sure that the necessary client is selected.

Open the Journal module and go to the Treatment summary tab.

In the list of treatment summaries, double-click the summary to open it.

Under the audiogram, select the appropriate summary review status.

Under the treatment summary list, click the Print button.

In the Print summary dialogue box, select the necessary recipients and click Send

electronically.

o0 rwONE

The system will collect submitted summaries and will reflect the acknowledgement status in
the treatment summary list.

To review the submission status of the treatment summary, please follow these steps:

1. Inthe treatment summary list, double-click the necessary summary to open it.

2. Under the treatment summary list, click the Sending status button.

3. The Treatment summary submission status dialogue box opens. Use the Edit and
Delete buttons to edit or delete the treatment summary status correspondingly.
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17 Invoice

The invoice module is divided into two tabs; Postings and Invoice. Postings are orders which
are not yet invoiced. When you open the invoice module the postings view is shown by default.

The top part of the screen is a filter. You can use a user defined filter or use filter criteria such
as date interval, customer, for instance an insurance company, or invoice type.

o)} Auditbase - [Invoice] — [m] ped
File View Functions
@ Client  T1106 MRS FIRSTNAME106 LASTNAME106 = ,.o\ > |H|user SYSTEM ADMINISTRATOR All locations ~ All departments - Q @
= Postings | Invoice
2
=y
3
= Search
Cust. group - Invoice type -
Customer - User -
Date from to Show postings Notinvoiced -
Save Refresh
Selectall Mo rows selected Cop Edit
All
Date ‘ Serial No Group | Manufacturer Aricle |Side | Hospital no. | MNHS no.| Invoice type | Customer -
|| 10/03/2020 PROCEDURES (Senice) ADULT 1 T1106 Invoice type 1 Oleksand
10/03/2020 PROCEDURES (Service) ADULT 1 T11068 Invoice type 1 Oleksand
|| 18/02/2020 908765432101234 |NHS HEARING AID (Serial Mo.) |MHS SUPPLIES |ITE10ML L T1106 Invoice type 1 | BRISTOL PCT SYSTEM:
_2‘])’10)’2015 PROCEDURES ADULT PTAT T1106 Invoice type 1 full name
211042016 PROCEDURES ADULT 1 T11068 Invoice type 1 full name
7219’109’2018 PROCEDURES ADULT 2 T1106 Invoice type 1 full name
_2‘])’10)’2015 PROCEDURES ADULT 1 T1106 Invoice type 1 full name
18/10/2016 PROCEDURES ADULT PTA1 T11068 Invoice type 1 full name
7189’109’2018 925104 MHS HEARING AID MHS SUPPLIES |ITE10ML - T1106 Invoice type 1 | SWINDON PCT | full name
_‘IEJ"IUJ’EU‘IE PROCEDURES ADULT 2 T1106 Invoice type 1 full name
18/10/2016 PROCEDURES ADULT 1 T11068 Invoice type 1 full name
|| 18M0/2016 PROCEDURES ADULT 10 T1106 Invoice type 1 | SWINDON PCT | full name
_‘IEJ"IUJ’EU‘IE PROCEDURES ADULT 1 T1106 Invoice type 1 full name
0B6/07/2016 PROCEDURES PAEDIATRIC COMMUNITY T11068 Invoice type 1 | SWINDOMN PCT | full name
|| 05/03/2016 BATTERIES MHS SUPPLIES |13 - T1106 Invoice type 1 | UNKNOWN PCT | full nasz
05/03/2016 BATTERIES NHS SUPPLIES |13 - 7108 Invoice type 1 | UNKNOWN PCT |full name——————
< 3
Total price: 1,042.82
Fostings count: 43

NUM
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17.1 Symbols

(= Invoice, in the list

E] Credit note, in the list

~ At least one invoice has been credited
['E All of the invoices have been credited
- Invoice, in the Invoice window

F

Credit note, in the Credit note window

379
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17.2 Set up filters

You can apply a filter to the list of postings or invoices.

Two filters are pre-defined for both Postings and Invoices, Client and All. These filters are shown
and accessed via buttons above the table containing the list of postings and invoices. By
default, when entering the invoice module, all postings and invoices for the selected client are
listed. If you change the client, the list is updated. If you check the All button, all postings or
invoices are listed.

You can also create more complex filtering criteria such as pre-defined date range or a specific
customer, by setting up a user-defined filter.

If you want to use an existing filter, the filter can be applied by selecting the Filter from the drop-
down list.

If you want to create a new filter, first create the filter parameters in the section Search. You
can filter the list by customer, customer group, date range, payment method, invoice type or the
user who created the posting or invoice. Note that you can leave one of the date fields empty. If
you leave the From field empty, the date interval indicates less than or equal.

Setup filters x

Save Delete Close

Mew

Filters Filter info

# | Posting filter Name

Invoice and credit filter

Filter 1
Filter 2

For invoices, two more criteria are available. If you wish to see invoices as well as credit notes
select both in the View drop-down list. Otherwise, select either invoice or credit note. You can
also specify invoice number.
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Next, save the defined filter by pressing Save. In the opened Setup filters dialog, select a filter
type, Posting or Invoice and enter a name for the new filter. If you want to overwrite an existing

filter, select its name in the list and press Save.
From now on the new filter can be applied by selecting in the Filter drop-down list.

Alternatively, you can start by creating a name for the new filter in the Filter setup dialog. Then,
specify parameters and save the filter.

381

© Auditdata - 2025, ID: 20.0040/36



User Guide

17.3 Creating an invoice

An invoice is created from postings. A posting is a row describing a number of articles of the
same type which have been issued to a client.

)
o))

Invoice

File View Func %
IO client  <T>T18765M Invoice s -|[2x] 2
Postings | Invoice Information Sendto
Customer group Cu #| Client
Filter Filter 2 R
Search Date of invoice 13/01/2020 MName FIRSTNAME106 LASTNAME106
Cust group User SYSTEM ADMINISTRATOR |+ Address
9 200K XXX
Customer Payment account  Audiology dept - KOO0
Date from | 1 Invoice type Invoice type 1 XHXXXRK

M| Selectall 1row selected
Selectall 1 row sel

= M | [Transaction date| Article | Manufacturer |Signature|Gustomer| Hospital no.] aty[ Unit price| Discount] Total ex. vat| Tot:
e = 16/04/2014 ITE10MR | NHS SUPPLIES |tests T1106 1| 9000 0.00% 99.00 [ Total price | Refer

?,/| 16/0412014 | 212123 5| 99.00
| |16i0412014] 23222 I 0.00
| < 2>
|| Total price ex. VAT 99.00 |
| Comments Total price inc. VAT 99.99 |
I -~
<1 -

99.00

¢ Select Modules -> Invoice or press Shift+Ctrl+l.

¢ From the stock module, you can access the invoice module directly by clicking the invoice
button.

¢ Select the Postings tab.

¢ Press F3 to search for the client or Ctrl+F3 to make a quick search.

» Postings for the selected Client are displayed or select postings for All.

e Choose the posting(s) and click on the Invoice button. You can only select one type of
posting.

¢ Specify the payment accounts and submit the invoice by clicking Invoice.

¢ The invoice module creates and saves the invoice.

¢ The postings are transferred to one single line with the same invoice number and are no
longer listed in the postings tab.

¢ The Invoice module returns and displays the remaining postings.

¢ If the invoice addressee is a customer or group, the system requires customer code.

¢ Depending on the setting made by the System Administrator, if the customer has no code
specified, the system either show a warning or prohibits the invoice saving.
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17.4 Payment accounts

» Select Functions -> Payment accounts to view accounts listed.

Default

Payment account x
Mew S Delete Close
Accounts:
: Information

Audiology dept.

General treatment Mame: ||
Mumber:
Description: -

¢ Press New to initiate the creation of a new account.
¢ Enter Name, Number and Description of a new payment account.
¢ Set the default payment account by checking the default box.

¢ Press Save to save the account.
e To edit an account, select the account in the list and modify the details. Then press Save.

¢ Press Delete to delete an account selected in list.

Note that the system does not allow for deleting an account referenced by an invoice.
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17.5 Customer groups

Creating a Customer or Customer group has now been moved to the Administration portion of
Auditbase and is now an extended right for users.

Information on how this is done can be found in the Administration User Guide.
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17.6 Creating a credit note

A credit note is created from the invoice view in the invoice module.

¢ Go to Navigation -> Invoice or press Shift+Ctrl+I.

* Select the Invoice tab.

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

¢ Invoices for the selected client are displayed. You can also select invoices for All.

¢ Double-click on the invoice. If the invoice contains several postings, select the invoice(s)
you wish to credit and click on Credit note.

OR:

¢ Select the invoice and click Credit note from the invoice tab.
¢ Click Yes on the appeared warning.
¢ Click Print to print the credit note.

Only users who have been granted rights to create notes can create the credit notes.
You cannot cancel a credit note when you have pressed the credit note button.

Postings | Invoice

Filter -
Search
Cust. group - Invoice type - Date from to
Customer - User - View Both ~ Mo,
Save Refresh
Credit note Open Cancel invoice
All T L

Date Number|Invoice type| Receivertype| Rec Invoice X User CIL|Hospital no.| NHS no.

£ 5 15 OTHER Client . 3 Y I y lame te 7L |T18765 8
h{ nt st t ctions,
(2700312015 16|OTHER | Client SMITH /B for postings imduded i this credt note. | jametests???|L |T18765 | 28388888
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17.7 Editing postings

Sometimes you need to modify a posting before invoicing, e.g. change customer or price.

Select the Postings tab.

Highlight the posting and click Edit button.

In the opened Edit posting dialog, the following data can be modified:

* Invoice type may be selected in the drop-down list.

¢ Price.
¢ Invoice payer.

Go to Navigation -> Invoice or press Shift+Ctri+l.

Press F3 to search for the client or Ctrl+F3 to make a quick search.
Postings for the selected client are displayed or select postings for All.

¢ The “to customer” option must be selected along with Customer in the drop-down list if

the payer is a customer.

¢ An Invoice without client reference can be made by selecting the corresponding check

box.

¢ The “to client” option must be selected if the payer is a client.

e Click Save or Cancel to close without saving.

Edit posting: ADULT, 1 prd
Receipts Label Print Save Cancel
Client MR JOHN SMITH
Date 131012020
Referral
Price Invoice type
£0.00 Invoice type 2 -

Invaice

to customer

# to client

Annual card number
Annual card date due

Preferred payment method  [{ef=l =0Ty =i -

Receipt 1D

Card request status

Transaction submission
status

Transaction ID

© Auditdata - 2025, ID: 20.0040/36

386



User Guide

« |f Visit charge features are enabled in the Administration tool there will be a section in
the bottom of the dialog referring to visit charges. Here you can read or enter Annual card
number, Annual card date due, Preferred Payment method, Receipt ID, Card request
status, Transaction submission status and Transaction ID which are options that refer

to managing visit charges, primarily used in Sweden.

In this case you will also see a Receipts key in the top part of the dialog. Receipts allows the
user to select and print one or more of the following documents: Anonymous humber, Roadmap
or route directions from present location to selected waiting room, and Payment receipt.

387
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17.8 Deleting postings

¢ Go to Navigation -> Invoice or press Shift+Ctrl+l.

Select the Postings tab.

Press F3 to search for the client or Ctrl+F3 to make a quick search.
Postings for the selected client are displayed, or select postings for All.
Select one or more postings and click on the Delete button.

User rights to perform this action are set up by the System Administrator.
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17.9 Regenerating postings

Postings can only be regenerated if they have been created from services, not from stock
articles. This is set by the System Administrator.

¢ Go to Navigation -> Invoice or press Shift+Ctrl+l.

e Select the Postings tab.

¢ Press F3 to search for the client or Ctrl+F3 to make a quick search.

» Postings for the selected client are displayed, or select postings for All.

¢ Select one or more postings by clicking on the far-left hand box and click on the
Regenerate button. An information box will appear asking for permission to continue.

Inveoice

I@I Do you want to regenerate the selected 3 postings?
k. * 4

Yes No

¢ The postings will then be copied but one year will be added to the date of the postings.

Postings | Invoice

Filter Filter 1 -
Search
Cust. group - Invoice type -
Customer - User -
Date from to Show postings Mot invoiced -
Payment method - Save Refresh
Selectall 1 row selected Invoice Delete Copy Regenerate Edit
All

Date Serial No Group Manufacturer Article | Side|Hospital no.| NHS no. | Invoice type Cug ~

z 10/01/2022 PROCEDURES (Service) ADULT 8 8| Invoice type 1
. 1000172022 PROCEDURES (Semvice) ADULT 3 T18765 38888888 | Invoice type 2
. 10/01/2022 PROCEDURES (Semice) ADULT 3 T18765 38888888 | Invoice type 2
. 10/01/2021 PROCEDURES (Semvice) ADULT TYMP T18765 38888888 | Invoice type 1
. 1000172021 PROCEDURES (Semvice) ADULT 2 T18765 38888888 | Invoice type 2
. 10/01/2021 PROCEDURES (Semice) ADULT 2 T18765 38888888 | Invoice type 2
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17.10 Export invoices to CSV file

A list of invoices can be exported to a CSV file by selecting Functions -> Export to CSV file from
the Invoice tab.

Create CSV file X

Save Cancel

CSY file

Choose delimiter Semicaolan -
Save as..

M Include Column headers in C3V file

Open file after creation

¢ In the opened dialog, select a delimiter to use from the drop-down list. Semicolon is the
default setting.

e Choose a file name by pressing the ‘..." button near the Save as field or enter a file name
manually.

e Check Include column headers in CSV file if the data should be created with headers.

¢ Check Open file after creation if you want to view or edit the file after creation.

* Save performs the export.
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17.11 Cancelling an invoice

Go to Navigation -> Invoice or press Shift+Ctri+l.

Select the Invoice tab.

Press F3 to search for the client or Ctrl+F3 to make a quick search.

Invoices for the selected client are displayed, or select invoices for All.

Select the invoice and click on the Cancel invoice button.

The system asks the user to confirm the invoice cancellation.

Once an invoice has been cancelled, an Automatic Journal Event can be created if this
has been set up by your System Administrator.

oil

File

View Functions

ILJ| Client <T>T18765 MR JOHN SMITH - 8 | Z|El|user SYSTEM ADMINISTRATOR All locations +* All depariments - Q ?

Postings || Invoice

Filter -
Search
Cust. group - Invoice type - Date from to

Customer - User ~  View Both ~ Mo
Save Refresh
Creditnote || Open || Cancel invoice
Al

Date |Number\lnvoicerype‘Receivertype| Req Inveice User |Cf|_|HospitaIn0. NHS no.
@ 13/01:2020 73| OTHER Client SMITH =~ e it T S 7Ef\'|ADT{HT‘“STR.ATOR L |T18765 568588868
(2| 2710312015 15 OTHER | Client SMITH |@| YOH SurE you wart fo cancelie sERced VOIS bme tests 777 L |T1s765 | s@ssssss

16 OTHER Client

Yes No

Total price ex. VAT 0.00
Total price inc. VAT 0.00
Invoice count 3

e To view cancelled invoices, select View -> Show cancelled invoices.

Note: Only users who have been granted rights to cancel invoices can perform the cancel

action.
It is only possible to cancel one invoice at a time.
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18 Repair

The repair module keeps track of on-going and closed repair tasks in a hearing clinic. The main
screen in the repair module shows a list of on-going and closed repair tasks.

When the module is opened, the number of displayed tasks is limited by the system
administrator. Click on the More button to show all tasks. The actual task is described in a
repair task.

The repair task contains a description of the task to be conducted and elements and parts
(articles) used to fulfil the task. The repair task will automatically calculate the repair price and
update stock, based on elements and parts used. Each repair task is linked to a client or a
stock item. The repair task is identified by a unique number, and holds information about how it
is handled in the clinic work process.

The repair task is divided into a description of the work to be done (the Order tab) and a list of
actual parts and services used to do the job (the Workflow tab).

9)) Auditbase - [Repair list] - O *
File Functions
]| Client <T>T18765 MR JOHN SMITH -] A =| Bl |user SYSTEM ADMINISTRATOR All locations ~ All departments - Q 9
MNew repair task by serial number New repair task for current client
Serial Mo. || New Selected client JOHN SMITH MNew
Quick select repair task
Order Mo Serial Mo Find
Repair task list
Filter =All active tasks> - Filter Mare Show all (F11 Open Erint
Order No.|Serial Mo.| Created |Completed Client name Postcode Order type | Status Assignedto |Additional not
12 414697 | 08/10/2015 MR33 BANG13 BENG1233 ABC 1234 | Sample order type | Assigned | USER NAME44.
15 2221 28M10/2015 MRS FIRSTMAME106 LASTNAME 106 PC:4347 | Testorder2 Assigned |USER NAME32
16 21 28/M10/2015 MRS FIRSTMNAME106 LASTNAME 106 PC:4347 | Test order Invoicing | USER NAME32
17 22/05/2018 MISS FIRSTMNAMEZ23089 LASTNAMEZ23089 PC:3192 | Sample order type | Registered
18 07/06/2018 Dr.Test 5 Test 5 M Sample order type | Registered
19 07/06/2018 MISS FIRSTMAMEZ3089 LASTNAMEZ23089 PC:3192 | Testorder2 Registered
20 07/06/2018 MISS FIRSTMNAMEZ3089 LASTNAMEZ23089 PC:3192 | Sample order type | Registered
21 07/06/2018 Dr.Test 5 Test 5 M Sample order type | Registered
22 07/06/2018 Dr. Test5 Test 5 11 Sample order type | Registered
23 07/06/2018 Dr. Test5 Test 5 11 Sample order type | Registered
24 07/06/2018 Dr. Test5 Test 5 11 Sample order type | Registered
25 11/06/2018 MRS3 BANG14 BENG1233 ABC 1234 | Sample order type | Registered
26 02/07/2018 MISS FIRSTMAMEZ23089 LASTNAMEZ23089 PC:3192 | Testorder2 Registered
27 04/07/2018 MRS FIRSTMAME106 LASTMAME106 PC:4347 |Test order 2 Registered
28 04/07/2018 MRS FIRSTMAME106 LASTNAME 106 PC:4347 | Sample ordertype Registered
29 221172018 Professor 20-111FIRSTMNAME32991 15-LASTMAMES2991 | PC:2861 | Test order 2 Registered
30 221112019 Professor 20-111FIRSTNAME32991 15-LASTNAME32991 | PC:2861 | Sample order type | Registered
< >
Total tasks: 17

.
The Repair Task list can be printed out.

e Click Print or select File -> Print list.
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18.1 Repair task list filter

You can apply a filter to the list of repair orders.

» To modify criteria of an existing filter, select the filter from the Filter drop-down list and

click Filter.

Repair task list

Filter =All active tasks=

oG ETRNE <Al active tasks=
43 Mew Filter
Mew Filter1

-1. P S LS

- Filtar

IRS3 BANG
WIRS FIRSTH

¢ If you need a new filter, select Functions -> Search, or with <All active tasks> selected in
the Filter drop-down list, click Filter.

M Show deleted tasks

Create date

From To

Completed date
From To

Make this filter available for:

Current user only # All users
Save as new
# Save as current Save

Filter - Mew Filter >
Mew Delete Search Close
Search parameters
Order Mo, Serial Mo.
Filter parameters
Order type Sample order type - bl
Technician - */ Customer v
User - Client
Workshop Internal workshop - Delivered by Client -
2IE Registered T After repair -
Sub-status -
) Save filter
Warranty expired? Yes -
Filter name:
B Show only the current client's tasks Mew Filter

* Enter criteria for a new filter. You can combine the filter criteria in many different ways,
using repair task status and label, date, workshop used, warranty, etc.
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¢ Enter a filter name and decide whether this filter should be available for all users or only
for the current user.
* Click Save.

The filter is now saved and available from the drop-down list in the Repair task list on the main
screen in the repair module.

You can then edit the user-defined repair list filter.

¢ Select afilter to be edited in the Filter drop-down list, and click on the Filter button or
select Functions -> Search.

¢ Modify the criteria you wish to use for this specific filter.

e Modify the filter name if required.

¢ Select the Save as current option.

e Click Save.
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18.2 Repair order

The repair module is designed to handle different types of orders. The repair orders are defined
by the system administrator. Each order has three subcategories. Two repair order types could
be Repair and Service issue.

Repair

The order type Repair is used for physical repairs of hearing instruments and other serial
number controlled items. This repair takes place in the hearing clinic or the item is sent for
repair to an external workshop.

Service issue

The order type Service issue is used for service tasks and repairs of items without a serial
number. A Service issue could be a repair or installation of hearing accessories in the home of

the hearing impaired.
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18.3 Creating a new repair task

A new repair task is created from the main screen in the repair module. Either the repair task is

created for the selected client or the repair task will be created based on a hearing instrument
serial number.

e Go to Navigation -> Repair list or press Shift+Ctrl+R.
¢ Press F3 to search for the client or Ctrl+F3 to make a quick search.
e Click on New or select Functions -> New repair task -> Create for current client.

OR:

» Create new repair task by serial number. Enter the serial number of the hearing
instrument and click on New or select Functions -> New repair task -> Create by article
s/n. To create a new repair task by serial number; the article must be on stock.

¢ Select order type from the drop-down list and select details in Breakages description.
Group is linked to Type in Order information (pre-defined by the administrator), whereas
Details and Second details are articles in stock.

Once you have selected Type, you cannot undo or change the record.

The Order types are defined by your System Administrator. Additionally, some types require
selection of a device to be repaired. Each order type has three sub-categories: Group, Details
and Second details.

Update repair task X
L B Save Close
Order | Workflow
Information
Client Test5Test5 Hospital no. $432516 Device list log
Audiogram 041/06/2018, 5, Aided, AuditBase audiogram v Show Deleted
Order information Invoice to Internal
Type Sample order type - * Customer  SWINDON PCT h User SYSTEM ADMINISTRATOR |+
Client Mo client reference
Order No 18 Workshop Internal workshop -
Customer
Create date 07/06/2018 Delivered by Client - Message
Status Invaicing - After repair Postto client -
Breakages description
Details
Show discontinued
Group Details Second details )
BATTERIES (Quantity-Accessory) (5)Testmanu 312
(6)Testmanu 10
NHS SUPPLIES AA(MNA1500)
AAA(MN2400) v
Units 4 Repair type - Note | A
Headline | Details Second details |Units‘Repairtype|Note
BATTERIES (Quantity-Accessory) | MHS SUPPLIES | 675 COCHLEAR IMPLANT | 1
BATTERIES (Quantity-Accessory) NHS SUPPLIES | 312 1
BATTERIES (Quantity-Accessory) | NHS SUPPLIES | AA(MN1500) 1
Additional notes
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¢ The repair task identifier number is automatically generated by the repair module. You
can type the number manually, e.g. a number that reflects the year and the month.

¢ Select who to send the Invoice to. The clients default customer is defined in the client
module. The customer can be a person or an organisation pre-defined by the
administrator.

e Enter Customer and Internal data or select from the drop-down lists.

e Enter the appropriate data or select from the drop-down list Delivered by.

e Enter the appropriate data or select from the drop-down list After repair. Note that the
content of the After repair list is defined by the system administrator.

¢ If you wish, select the Workshop to perform the repair and write a message to that
particular workshop, e.g. internal workshop, cleaning. The workshops are predefined by
your System Administrator, who can also configure the order they appear in the drop-
down menu and a default workshop.

¢ Click the Device list button. Select the device that needs to be repaired. The Device list
shows all devices restricted to a specific client divided into serial number controlled
articles, amount controlled articles and ear moulds.

e [fa hearing instrument is not listed in the device list, click the Add external article button,
select the device and Save. You typically need to add a hearing instrument to the device
list if a client has been provided with the instrument from another hospital.

¢ When accessing the device list outside the repair module, the list will also contain a list of
the clients pending and closed work orders.

» By default, only not discontinued articles will be shown. To also show discontinued
articles tick the Show discontinued checkbox.

e Save the repair order.

¢ [f the warranty has expired, the warranty date will turn red.

¢ You can now print the repair task by clicking the Print button.

¢ Close the repair order.

NOTE: Creating a repair task creates a clinical action. If you attach it to an appropriate
appointment. it will be seen in the Clinical actions tab of the Referral module.
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18.4 Finding a repair task

You can find a repair task either by entering the serial no. of a hearing instrument or by entering
the task no. of the repair order.

18.4.1 Find by article

¢ Go to Navigation -> Repair list or press Shift+Ctrl+R.
e Enter Serial No. in the Quick select repair task field.
¢ Click on Find or select Functions - > Find repair task -> Find by article s/n.

18.4.2 Find by Repair task number

e Go to Navigation -> Repair list or press Shift+Ctrl+R.
¢ Enter Repair task no. in the Quick select repair task field.
¢ Click on Find or select Functions -> Find repair task -> Find by repair task number.
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18.5 Repair task status
The status of the repair task is either Registered, Assigned, Invoicing, or Completed.

Registered - When an order is created and saved, it will automatically be set to the status
Registered. You can change the status manually to Assigned or the repair task can stay as
Registered until Completed.

Assigned- If the repair cannot be performed now, you can set the status manually to Assigned.
Use a repair task status label to specify why the task is not completed, for instance waiting for

spare parts or external repair. The Assigned status is used together with a status label to detail
the repair process.

Assigned and all further statuses require a technician to be specified for order.

Invoicing - Set task status to Invoicing when the repair of a device is completed, but the task
cannot be closed yet because third parties have not yet issued invoices.

Completed - When the repair task is completed, set the status to Completed manually. An
invoice will be issued and stock will be updated. If the repair price is set to O, the system will
ask if you wish to issue an invoice

Note: The system administrator can configure the system to automatically set the
Completed status for a task right after creation. This may be useful for tasks requiring no
action.

Repair task status label

The Repair task sub-status provides additional details for the repair task status. Each repair
task status can have different user-defined additional sub-statuses.

An assigned task could for instance have the sub-status waiting for spare parts. The repair
task sub-statuses are predefined by the system administrator.
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18.6 Handling a repair task

¢ Go to Navigation -> Repair list or press Shift+Ctrl+R.

¢ Find the repair task.

* You can use the Quick select repair task. Enter either the Repair task no. or the Serial
no. of the hearing instrument and click the Find button.

¢ Orfind a repair task by Article or by Repair task number - See earlier chapter Finding a

repair task.
Update repair task X
Label Print Save Close
Order | Workflow
Information
PN NHS SUPPLIES, ITE10MR] Serial No. 1121 Warranty date
Client  FIRSTNAME106 LASTNAME106 Hospital no. T1106 Order No. 16
Technician USER NAME32 hd
Order Information
Work date | 28/10/2015 Status Invoicing ~  Sub-status -
Infarmation
‘Work Order
Details
Supplier article no Article name Show discontinued Apply filter X
Component Detail

BEAT (BOOKLET)

BE1001 (PFRES BOX)

OL441 (EM BOX)

AM18805 (SPEC ADAPTORS)

Units 1 Repair type -
Unit price Mote

Articles shortcut

Type Component| Detail | Units | Repair type | Unit price|TolaI | Mote

Total price 0.00

¢ Choose the Workflow tab. Your system administrator can setup what tab will be default
for each work order type.

e The Technician on the Workflow tab can be filled out with the logged in user as default -
contact your System Administrator.

¢ Enter work date, status and sub-status. The work date is set by default to the current
date, but you can change the date if you wish. Status is set by default to Registered.

¢ Select the article(s) you have used to perform the repair task by clicking on Type,
Component and Detail.

e To reduce the number of articles and faster find the one you are looking for you can also
enter part of the Supplier article no. or Article name in these two fields and press the
Apply filter button.

OR:
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¢ Click on the Articles shortcut button to select from a list of the 10 most often used
components. The 10 shortcuts are pre-defined by the administrator.

¢ Open up the article’s information by right clicking on the article under Details.

» Specify Repair type (pre-defined by system administrator) and number of units.

¢ Adding a Repair type can be made mandatory by your System Administrator.

¢ Click on Add.

¢ Once the article has been added, you can also open up the article’s information by right
clicking on the article in the bottom table.

e Complete the repair task by changing the Status to Completed and click Save.
A dialog box stating the price is shown. You now have the possibility to change the price
of the invoice. If the total price of the invoice is zero, you will be prompted to accept or
reject the invoice.

¢ Once the repair task has been saved, stock is immediately updated.

¢ You can now Print the repair task.

¢ Close the repair task.

¢ When a repair task is completed an invoice will be generated based on the articles used
to perform the repair.

¢ The repair module generates postings to the invoice module.

Workflow article

Workflow articles are items used during a repair process. The article is either a part of a hearing
instrument or a device to be repaired/changed, such as a microphone or a job to be done, such
as cleaning up and final assembling of the device. Based on the workflow article used in the
repair process, stock will be updated and a repair price will be calculated automatically.

By default, only not discontinued articles will be shown. To also show discontinued articles, tick
the Show discontinued checkbox.

Repair type

The repair type details how the Workflow article will be used. This could be a used spare part
(article) to be exchanged or cleaned. The repair types are predefined by the administrator, for
instance exchange, cleaning or used part.

Each repair type can be marked under stock control, i.e. under full stock control or amount
controlled, see Repair task status. If a repair type with stock control is selected for a Workflow
article, the stock is updated (reduced) with the parts used for the repair.

The repair type factor is pre-defined by the administrator e.g. a cleaning could be defined as
30% of the full price.
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19 Questionnaires

Click the button below to access our training materials.

A number of questionnaires are available from Auditbase. They are all accessible from
anywhere in Auditbase System via Navigation -> Questionnaires. When working with
questionnaires, a client should be selected.

When the required information has been entered, you can save the questionnaire with the
client's record and view it later.
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19.1 HI satisfaction questionnaire

The HI satisfaction questionnaire window is called via Navigation -> HI satisfaction
questionnaire. The window handles and processes HI satisfaction questionnaires
automatically generated by the system.

The window consists of two parts: one for searching for a questionnaire, and one for editing the
retrieved and selected questionnaire.

19.1.1 Search

The following search criteria are available:

Label. You can search for a specific questionnaire by entering its label number.

Client. You can search for all questionnaires for a specific client by entering the Client number.

For selected client. You can mark this check box to copy the number of the current global
client into the Client number.

You can also perform a search without specifying any criteria, but the system will issue a
warning that the search result can be large.

* Press Find to search using the specified criteria. Questionnaires meeting the criteria will

be filled into the Found drop-down list.
¢ Once questionnaires have been retrieved, you can select any of the questionnaires in the

Found drop-down list.

¢ The system shows details of the selected questionnaire in the HI satisfaction
questionnaire area, and changes a global client to one the selected questionnaire
belongs to.

19.1.2 Edit
The following data can be reviewed and/or changed:

* Client name, personal number, questionnaire label number and creation date are shown
in read-only mode.

¢ Questionnaire sent check box and Date: Reflects whether the questionnaire is sentto a
client. You cannot check this box manually; you can un-check it if you want to resend the
questionnaire.

¢ Questionnaire received check box and Date: This is used to register a client’s reply to a
questionnaire.

¢ Questionnaire cancelled check box and Date: Used to register if a questionnaire has

been cancelled.

¢ Press Save to save the changes made to the questionnaire.

¢ Send initiates the window for storing unsent questionnaires in a file. See Send
questionnaire for details.
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Send questionnaire

Click Send from HI satisfaction questionnaire to open this window. This window
produces a list of unsent and un-cancelled questionnaires to a file according to
parameters specified in the window.

In Send questionnaire registered not later ... days ago specify the minimum age of
guestionnaire to be included into a file. Age is specified in days. The default value for this
parameter is defined by the system administrator. When creating the list, the system
calculates the questionnaire age from the creation date.

In Limited or unlimited number of questionnaires per file specify whether the file
should include an unlimited number of questionnaires, or limit the amount to a specified
number.

In File name enter the name of the file to be created.

Click Send to start the scanning of the database for questionnaires meeting the entered
age criteria and creation of the file.

For each questionnaire included in the file, the system sets a send date. Note that only
one questionnaire per client is included, and if a questionnaire for a client is included in
the file, the system cancels all other questionnaires for that client.
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19.2 Medical History Questionnaire

The Medical History questionnaire window is called via Navigation -> Medical History
questionnaire.

¢ For details, refer to the Section below (19. Medical History).
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19.3 Completing a Glasgow Hearing Aid Benefit Profile

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

» Click Navigation -> Questionnaires, and then click Glasgow Hearing Aid Benefit Profile.

e Fill in First part date. To enter the current date, double-click.

e Fill in First part user. To enter the current user, double-click.

¢ Special buttons are available for attaching the questionnaire parts to or detaching them
from appointments. The buttons have a picture which reflects the state of the

questionnaire part: either attached (=) or not attached (‘:4-:1 ). In addition, the buttons
have a tooltip that displays detailed information about the questionnaire linking.

» Click Before Fitting.

» [f you want the client to consider additional situations, click Yes.

e Select answers to the questions.

* When the client considers his own situations, type these in and click Finish to ask about
these situations.

¢ Click OK when the questionnaire window is complete.

e Click Show stats.

* To view the results, click OK and view Raw scores and Percentiles as required.
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Glasgow Hearing Aid Questionnaire - GHABP

Questionnaires

Mew Save & show stats Show stats Delete Close
First part date ok, Firstpartuser
Second part date &k, Secondpartuser
Situation | Exists |Q1|Q2|Q3|Q4|Q5|Q6

Listening to the television with other family or friends | |
when the volume is adjusted to suit other people

Having a conversation with one ather person when v
there is no background noise

Carrying on a conversation in a busy street or shop rd

Having a conversation with several people in a group | |+

Does this situation happen in your life?

Before fitting Before and after fitting After fitting

* The Glasgow Hearing Aid Questionnaire can also be used offline.

¢ The questionnaire can be started in the main mode and completed in the laptop mode.
For more information, see Glasgow and COSI questionnaires in laptop mode.
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19.4 Dizziness Handicap Inventory

The Dizziness Handicap Inventory (DHI) can be completed and saved for a client. To access the
DHI, select a client and then select Navigation -> Questionnaires -> Dizziness Handicap
Inventory.

A New DHI can be created.

History will show all previous DHI for the selected client.

The date the DHI was completed is shown in the Date field.

Special buttons are available for attaching the questionnaire parts to or detaching them
from appointments. The buttons have a picture which reflects the state of the

g +
questionnaire part: either attached (C - ) or not attached (CD ). In addition, the buttons

have a tooltip that displays detailed information about the questionnaire linking.

¢ Phase can be selected from the drop-down list.

completed automatically.

¢ The DHI can be saved or printed by selecting the appropriate button.
¢ Delete will remove the selected DHI from the database.
¢ Once changes have been made, Close will shut the page.

As each Answer (Yes, No, Sometimes) is selected, the Total score for questions is

Client

Dizziness Handicap Inventory

FIRSTNAME106 LASTNAME106

I
=
)
=

History

NN |

CQuestion

Answer

P1
E2
Fa
P4
F5
F6
F7
P8
E9
E10
P11
F12
P13
Fl4
E15
F16
P17
E18
F19
E20
E21
E22
E23
F24
P25

Total
Total
Total
Total
Total

Does looking up worsen your balance problem?

Because of your balance do you feel frustrated?

Because of your balance problem do you restrict travel for business or recreation?

Does walking down the aisle of a supermarket increase your balance problem?

Because of your balance problem do you have difficulty getting into or out of your bed?

Does your balance problem significantly restrict your participation in social activities?

Because of your balance problem do you have difficulty reading?

Does performing activities like sports, dancing, household chores such as sweeping or putting dishes away make your balance problem worse?
Because of your balance problem are you afraid to leave home without having someone accompany you?
Because of your balance problem do you feel embarrassed in front of others?

Do quick movements of your head increase your balance problem?

Because of your balance problem, do you avoid heights?

Does turning over in bed worsen your balance problem?

Because of your balance problem is it difficult for you to do strenuous work around the house or garden?
Because of your balance problem are you afraid people might think you are drunk?

Because of your balance problem, is it difficult for you to go for a walk by yourself?

Does walking down the pavement increase your balance problem?

Because of your balance problem is it difficult to concentrate?

Because of your balance problem is it difficult for you to walk around the house in the dark?

Because of your balance problem are you afraid to stay home alone?

Because of your balance problem do you feel handicapped?

Has your balance problem placed stress on your relationships with your family or friends?

Because of your balance problem are you depressed?

Does your balance problem interfere with your job or household responsibilities?

Does bending over increase your balance problem?

score for questions

score for Physical (P) questions 128
score for Emotional (E) questions 136
score for Functional (F) questions 136

score for all questions oo
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19.5 Custom questionnaires

Auditbase users can create their own customized questionnaires using this feature found in
Auditbase rather than the System Administration tool. No additional user rights are required to
save the questionnaire for a client, but there is a required extended user right to be able to
create or edit questionnaires. The questionnaire that is created can become a clinical action
and can be seen on the Client Pathway Overview. Questionnaires that have been designed or
saved for a client can be found in Navigation —> Questionnaires -> Custom Questionnaires.
They can be moved to Favourites in the usual way. Once information has been entered into a
guestionnaire for a client, you can print the questionnaire by clicking the Print button.

19.5.1 Questionnaire design

Select Navigation -> Questionnaires -> Custom questionnaires -> Questionnaires design.

Questionnaires Test Questionnaire - MNew Copy Delete Export Import Preview

Selected questionnaire

MName Test Questionnaire

1D {internal} 12 Awailable for attaching to Implant forms Outdated

Attributes

W] | (] - Copy

1D {internal} Mame Type Value(s) -

Date on Pathway

130 Mew attribute2 Text

109 Mumber2 MNumber -10..10

10 slider2 Slider -10..10

111 text2 Text

12 drop-down list2 Drop-down list Mew value3;MNew value2;MNew value1

13 radio buttons2 Radia buttons Mew value1;New valued;New value2

114 Checkbox2 Checkbox

115 Multiselection list2 Multi-selection list MNew value1;Mew valuef;New value2;New val
116 Fixed text2 Fixed comment text v
<7 Tt >
Selected attribute

Type Date - B Use this date in Client pathway view

Name  Date2 e | | |

=
Prompt  prompt2 ---

==

Short result name number

Previously designed questionnaires are shown in the drop-down menu labelled Questionnaires.
Selecting a previously designed will allow it to be edited.
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To create a new questionnaire, select New and give the questionnaire a Name. Once the
questionnaire has been saved, an ID (internal) number will be automatically created which will
be needed when designing a Crystal Report.

If the questionnaire is to be attached to forms in the Implant module, the Available for
attaching to implant forms box should be checked.

A questionnaire can be hidden from view by checking the Outdated box.

A copy of a current questionnaire can be made by selecting a questionnaire and then select
Copy. You will be asked if you want to make a copy of the selected questionnaire. Select Yes
and the name of the questionnaire will have - Copy added to the end of it. This can then be
edited.

Questionnaires can be saved or deleted by selecting the appropriate button. In each case you
will be asked for confirmation. Deletion is only permitted if no questionnaires have been
completed for clients, in that case outdating should be used.

The design of a particular questionnaire can be exported by selecting a questionnaire from the
drop-down menu and then Export. The Save file window will open and you can select where to
save the resultant XML file.

The design of a questionnaire can be imported from a file using the Import button. Once this
has been selected, a Save file window opens where you can navigate to where the file has
been stored. Select the File name and click Open. The new questionnaire will then be saved if
the name of the questionnaire does not match any you have already saved.

A questionnaire can be previewed at any stage by selecting the Preview button. This will show
the questionnaire as a user will see it.

The components of the questionnaire are known as Attributes and can be added, removed,
copied and re-ordered. To create a new attribute, select. ¥ ' and a New attribute will appear in
the Attributes window. To remove an attribute, select’' = ' and you will be asked if you want to

save the questionnaire. Select Yes and you will then be asked to confirm that you want to
delete the selected attribute. The order that attributes appear can be changed using the up and

down arrows ' “ ¥ | Highlight an attribute then use these arrows to change the position of
the attribute in the questionnaire.

The Name of the attribute is displayed as well as the Type of attribute and any Value(s)
associated with that Type.

There are a number of different predefined attributes that can be added to a questionnaire.
Selecting different attributes from the Type drop down menu will show information relevant to
that attribute. The system will request you to save the design between making each attribute.

Text can be formatted using the format icons at the end of each line. Additional parameters can
be shown be selecting the double arrow icon. This will display a box labelled Height (px) where
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the height of the attribute box can be changed. This is the number of pixels in height for the
attribute box. The system attempts to auto-size each control to fit the content, but you can fine
tune it with this feature.

2 NN
| ]

=

==

us]
—

==

Each questionnaire must have one Date attribute which is mandatory for displaying on the
Client Pathway View. One such field will be created automatically with each questionnaire

Date - This attribute will display a date and can be made mandatory by checking the box Value
is mandatory. If you want to see the date in the Client Pathway View, check the box labelled
Use this date in Client pathway view. A Name can be given to the date and text to Prompt the
user can be added.

Selected aftribute
Type Date A W Use this date in Client pathway view

u[a S

==

Prompt ---

==

Number - This attribute will display number values and can be made mandatory by checking
the box Value is mandatory. The Name for the new attribute will default to New attribute, but
this can be changed. As with the Date attribute, text can be added to Prompt the user and the
text can be formatted. A Numerical value range can be added to restrict the numbers that can
be entered. Entering the From value and the To value means that users will only be able to
enter values between these two numbers. If the result needs to be shown in the Implant
module test summary, the Include result in Implant test summary box needs to be checked.
Once a number of questionnaires have been saved for a client, you can compare the results
over a time period by selecting the box Enable ‘Compare results’ over time. This will enable a
further box where you can add a Short result name which will appear in the compare results.

Selected attribute
Type Mumber - Value is mandatory ==

=

» IHNE
a NN

MName Number of ears i

==

=

Prompt i
==
Mumerical value range

From

M Enable "Compare results’ over time
To

Short result name| Ears|
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Slider - This attribute will display a sliding scale and can be made mandatory by checking the
box Value is mandatory. The Name for the new attribute will default to New attribute, but this
can be changed. As with the Date attribute, text can be added to Prompt the user and the text
can be formatted. A Numerical value range must be added to display the numbers that can be
entered. Entering the From value and the To value means that users will only be able to move
the slide between these two numbers. If the result heeds to be shown in the Implant module
test summary, the Include result in Implant test summary box needs to be checked. Once a
number of questionnaires have been saved for a client, you can compare the results over a
time period by selecting the box Enable ‘Compare results’ over time. This will enable a further
box where you can add a Short result name which will appear in the compare results.

Selected aftribute
Type Slider - Value is mandatory

Mame New attribute f

==

=

2 -
A -

=

Prompt

==

Mumerical value range
From -10 B Include result in Implant test summary

10 B Enable 'Compare results’ over time
To

Short result name slider

Text - This attribute will display a box where free text can be added and can be made mandatory
by checking the box Value is mandatory. The Name for the new attribute will default to New
attribute, but this can be changed. As with the Date attribute, text can be added to Prompt the
user and the text can be formatted. If the result needs to be shown in the Implant module test
summary, the Include result in Implant test summary box needs to be checked. This will
enable a further box where you can add a Short result name which will appear in the compare
results.

Selected attribute
Type Mumber - Value is mandatory ==

Name  Number of ears f

==

=

2 NN
2 NN

Prompt !

==

=

Mumerical value range

From [ include resultin Implant test summary:

B Enable ‘Compare results’ over time
To

Shortresultname| Ears |

Drop-down list - This attribute will display a drop-down list of items that can be added and can
be made mandatory by checking the box Value is mandatory. The Name for the new attribute
will default to New attribute, but this can be changed. As with the Date attribute, text can be
added to Prompt the user and the text can be formatted. Option values are added using + sign
and removed using -. Selecting + will create a New value which will be highlighted. This value
can be edited and more added to build up the list. The position of each value can be adjusted
using the up and down arrows. If the result needs to be shown in the Implant module test
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summary, the Include result in Implant test summary box needs to be checked. This will
enable a further box where you can add a Short result name which will appear in the compare
results.

Selected attribute
Type Drop-down list = M Value is mandatory ==

Mame  New attribute HERENE | | |
=

promat || flul Al ..
=

Option values

FYIEIRES S B Include resultin Implant test summary

ID (internal) value

514 Red Short result name

515 White

516 Blue

Radio buttons - This attribute will display a series of radio buttons. This attribute cannot be
made mandatory as it will default to the value at the top of the list. If a negative response is
required then a list item called “Not responded” or “Not answered” can be added as the first
item in the list which will then be the default. The Name for the new attribute will default to New
attribute, but this can be changed. As with the Date attribute, text can be added to Prompt the
user and the text can be formatted. Option values are added using + sign and removed using -.
Selecting + will create a New value which will be highlighted. This value can be edited and more
added to build up the list. The position of each value can be adjusted using the up and down
arrows. If the result needs to be shown in the Implant module test summary, the Include result
in Implant test summary box needs to be checked. This will enable a further box where you can
add a Short result name which will appear in the compare results.

Selected attribute
Type Radio buttons - ==

Mame  New attribute Here | | |
B

Prompt i u A ---
==

Option values

Al [+ - W Include resultin Implant test summary

ID (internal) | Value
Left Shortresult name
Right
Both

Checkbox - This attribute will display a check box. Checkboxes cannot be made mandatory as
the desired option could be unchecked. The Name for the new attribute will default to New
attribute, but this can be changed. As with the Date attribute, text can be added to Prompt the
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user and the text can be formatted. If the result needs to be shown in the Implant module test
summary, the Include result in Implant test summary box needs to be checked. This will
enable a further box where you can add a Short result name which will appear in the compare
results.

Selected attribute
Type Checkbox -

1=

Mame New attribute I
==

2 NN
2 NN

=

Prompt )

==

[ include result in Implant test summary:

Short result name

Multi-selection list - This attribute will display a box from which a series of options can be
selected and can be made mandatory by checking the box Value is mandatory. The Name for
the new attribute will default to New attribute, but this can be changed. As with the Date
attribute, text can be added to Prompt the user and the text can be formatted. Option values
are added using + sign and removed using - sign. Selecting + will create a New value which will
be highlighted. This value can be edited and more added to build up the list. The position of
each value can be adjusted using the up and down arrows. If the result needs to be shown in
the Implant module test summary, the Include result in Implant test summary box needs to be
checked. This will enable a further box where you can add a Short result name which will
appear in the compare results.

Selected attribute
Type Multi-selection list hd Value is mandatory >

Name  New attribute i jjul|a ---
=

(ul s EEEEEE
=

Option values

allw] [+ - [ Include result in Implant test summary:

ID (internal) | Value

521 Mew value Short result name
522 Mew valued

523 MNew value2

524 MNew value3

525 Mew valued

526 MNew values

Fixed comment text - This attribute will display a box where fixed text is displayed and cannot
be edited by the user. The Name for the new attribute will default to New attribute, but this can
be changed and formatted as before.
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Selacted attribute
Type Fixed comment text -

Name | Multi-select]

»

(B (NRRRRENE | | |

* ==

Separator line - Inserts a line into the questionnaire to separate sections. No formatting or

editing can be performed.

Once the questionnaire has been created, it can be previewed so that you can see the

attributes with their values.

Test quest

Client

MNew

[}
o
T

Delete Close

Questionnaires

Date 13/01/2020 Age attest Oy Om

SYSTEM ADMINISTRATOR

co| Referral stage Mot linked to appointment

Mew attribute

Mew attribute1

Mew attribute2

i Mew value
) Newvalug2
) Newvalue3
) Newvalued

MNew attribute 4
2 4

MNew attribute 5

Available items:

1
4

2

3 4

AddAll Remuove All

This is fixed text

New attribute 3
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A re-start of Auditbase is required to display the newly created questionnaires in the Navigation

window.

B-[:i] Custom guestionnaires

[T Questionnaires design

~[I} Questionnaires exportto csv

-] AQP Satisfaction questionnaire (CHIME)
~[ti] Cl-spergeskema til bern

~[:i] PPVT-4 test (Peabody)

~[:1] Sproglydtest

~[t1] Viborg test

19.5.2 Questionnaires export to csv

Once information has been entered into a questionnaire for a number of clients, the data can
be extracted by selecting Navigation -> Custom Questionnaires -> Questionnaires export to
csv. A window will open where the required Type or name of the questionnaire can be selected.
A Date range can be selected by typing in a date in the format dd/mm/yy or by right clicking
and choosing a date from the calendar. A delimiter can be chosen by selecting one of the
options from the Choose delimiter drop down menu. Semicolon or comma are commonly used
for this field. The location to save the file can be selected by typing in the path in the Save as ...

box or by using == at the end of the field. This will open a Windows explorer window and the

save location can be browsed for.

Cuestionnaires export to csv *

Save Cancel

Custom questionnaire

Type Test quest -
Diate range

From 19M12/2014) | To

CSVfile

Choose delimiter Comma -
Save as..

Cpen file after creation

If you want to view the file that is created, check Open file after creation and Microsoft Excel will

open and will display the data from the questionnaire.

A B C D E F G H I J K L
Hosp Mo. NHS No. Firstname Last name Customer code Customer name Date Number Slider Text box A drop down Shoeside
3 EVELYN HARPER 13/10/2014 24 51 Red Both shoes
TO00002 KAROLINA PAC THG2 WEST COUNTY  13/10/2014 25 61 White Left shoe
TO00007 TEDDY TED 13/10/2014 67 99 White Both shoes
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19.6 Glasgow and COSI questionnaires in laptop mode

An audiologist can complete part of a Glasgow (GHABP, GHDHP, HDHP MHAS) or COSI
guestionnaire online and the rest offline during a home visit. Then, the part filled out offline can
be synchronised with the main database. It is also possible to create a new questionnaire in
offline mode.

Synchronising questionnaires

* When changes are made to a questionnaire offline, the central database records will be
overwritten.

¢ A user can create the initial part of a questionnaire directly in the central database while
maintaining another instance in an offline database.

e [f a patientis in the offline database and the user opens an existing questionnaire
instance from the offline database, a warning appears in the central database: “This
patient is on an offline database. If the questionnaire record in the offline db is changed
then any changes you make in this central database will be overwritten.”

Deleting a questionnaire
When a user attempts to delete a questionnaire, the system checks its origin.
¢ If the questionnaire was created during the current offline session, deletion is allowed.

» If the questionnaire was imported from the central database to an offline session,
deletion is prohibited. A warning message explains why the questionnaire cannot be
deleted.
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20 Medical History

Medical History is now available as a separate module that may contain the current medical
data of the client and/or the client’s history of medical issues, including;:

¢ Otoscopy, Audiometry

e Eardisease, Surgery

e Balance, Hearing

e Ext.History, Aetiology

¢ Tinnitus, Other history

¢ Lifestyle and Communication
e Qutcome and Other data

The Medical History window is called from the Navigation pane. If it has been added to
Favourites, it can be accessed from the Favourites section.

The Copy option allows reusing Medical History questionnaires. An existing instance of the
Medical History can be saved with a new date.

The copied questionnaire becomes available when the Medical History window is called again.
Users can then apply and save the required changes.

[
; File Edit View Functions
A& M g B 8B B B A A

Detailed Quick Exportto MS Qutlook  Print schedule | Print letter  |mport data | Export data | Exportto Noah Logoff | Exit Auditbase

Search Export Print Import/Expert Client data Exit

o Waiting list
= )
5] AB Audiogram
LA NOAH madule seledfion

E Client <X>T130763 MISS FIRSTNAME30763 LASTNAME30| - || & | = | |User SYSTEM ADMINISTRATOR All locations ~ Al departments A Q ?
| Navigation Monday 09/03/2020 | Mo fiter] ~ . |||f]| General || Daily |||/ ® 15min
| B Favourites = .
i+ Client information Medical history X
E % :efskrra\ Print- history Print - Ext. history Copy || New Save Delete Close
[ ooking
e Date 070212020 |G| PatientName FIRSTNAME30763 LASTNAME30763

Otoscopy, Audiometry | Ear disease, Surgery | Balance, Hearing  Ext.History, Aetiology = Tinnitus, Other history | Lifestyle and Communication | Outcome and < »

i Individual client

5 Clientinformation

i Paediatric

=] Journal

] Documents and attachments
55 Referral

=2 Clients entries

| L2 Device list

| +-EZ Observations and procedures
-{% Earmoulds

Hearing Therapi

Medical history Q

Direct referral HAadult)
Tinnitus

. 7 Surgery

| wi] HiI Satisfaction Questionnaire
: B[] Measurements

Individual client
Client pathway view
Clinic management

Stock management

IED k> 534 o

i
o

User tasks

The Medical History questionnaire can also be printed by employing the corresponding controls.

k]
k-l
°

OTOSCOPY
Tick if no significant problem m

AUDIOMETRY
Tick if no significant problem

Is there any marked

asymmetry?

Significant air-bone gap?

Fluctuation of hearing?

Other aud.comment

Left

Right

«  Specify any
description

«  Specify any
description

« Description
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21 Other Features
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21.1 Client’s entries

Click the button below to access our training materials.

Client’s entries presents an overview of a client’s appointments and waiting list entries.

Client's appointments and waiting lists X
Client MR JOHN SMITH Close
Appointments list- 42 item(s) History of changes Aftached actions Delete from history Show in appt book
Date | Time |Loc.| Dept.| Appt. |Status| Resource Reason |SMS1 | sr\-182| Declined offer Symbo ~
12/01/2020 | 11:15 I *  |Res4f from1
0 Z * | Charlie 2
1 * | Charlie 1
09/01/2020 | 16:30 f A | Stassy GWH 1 st
09/01/2020 | 13:45 E]| * Stassy PHAC new patieni
09/01/2020 1215| 3 3 1 * |ResB4 1
09/01/2020 (1215 32 3 3 * Res109 |++GP direct referral PHAC new patieni
09/01/2020 | 12:45 [E] A | Trawy PHALC new patienl »
< 3
Waiting list entries - 7 item(s) Add E W
Wait time| Date| Waiting list] Information -
-186 1806 TGW - PHA
8 06/03 TGW - AUD
-14 06/03 TGW - CALY
-1 16/08 TGW - Audis
9 16/08 TGW - CALY
13 09/0° TGW - DO

AN TOGRE el g

Go to Navigation-> Client’s entries or press Shift+Ctrl+Q or from the Booking screen
Functions -> Client’s entries.

Click Show in appt. book to go directly to the appointment in the appointment book. Note
that the appointment or waiting list entry can be displayed on the Booking and Waiting
List screen, even if these screens are not currently behind the Client’s entries.

If a clinic view has been applied to the Booking screen and the appointment you want to
look at is not available due to this filter, you will receive a message that you will need to
change the clinic filter before you can view the appointment.
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Message

The appointment you are trying to view in Booking is not available because:

- The Clinic fitter you have applied does not include this resource.

Would you like to go to that date in the Booking screen to change your view settings?

Yes Mo

¢ Select Yes and you will be taken to the appropriate date. Once the clinic filter has been
changed, the required appointment will be highlighted.

¢ No will return you to Client’s entries

¢ To view any clinical actions, documents or IMPs attached to the appointment, click the
Attached actions button. A list of attached clinical and other actions will open in a
separate dialogue box where you can detach them from the appointment if needed.

¢ You can Add and Edit waiting list entries directly from here and jump to the Waiting list
module by pressing Show in waiting list.

¢ To delete cancelled actions—they appear in grey—from the history, select them in the list
and click the Delete from history button.

* Navigate fast between the two lists by using TAB or the keyboard shortcuts Alt+p for
Appointments and Alt+t for Waiting list entries. Use the keyboard arrows to navigate
inside the list.
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21.2 Day view

Day view represents an overview of a booking day. The default setting of the Day view is today's
date, but you can change the date manually if you wish to see a list of appointments for another

day.

Go to Navigation -> Day view or press Shift+Ctrl+F3.

The system updates the view automatically with the timeout set by the System Administrator.

You can filter the day view by:

View: All appointments, client bookings, reservations or workflow (see below for more
information).

Date

Symbol: If you only wish to view appointments with a specific symbol including outdated
symbols.

Status: If you only wish to view appointments with a specific appointment status e.g.
DNA, Finished. The statuses can be selected by clicking on the ... icon at the end of the
field and then checking the box next to the required status. Multiple statuses can be
selected by checking multiple boxes. Select will then filter the view showing the selected
appointment statuses. The selection can be cleared by clicking on Reset. If multiple
selections are chosen, their code will display in the Status field. The full description of the
status can be seen resting the mouse cursor on the Status field and a tool tip will display
the code and description for the appointment statuses.

Resource: If you only wish to view appointments associated with a specific resource.

You can navigate between the filters by using the TAB button and select specific filters by
using the keyboard arrows or the mouse wheel.

You can choose to view appointments for all locations and departments, individual
locations/departments or several specific locations/departments.

Right-clicking on an appointment initiates the Booking information window where you
can modify e.g. the appointment Information or enter Outcome status.

Double-clicking on an appointment initiates the Edit booking window, so you can edit the
booking directly from Day view.

Clicking on the Save window setup button saves the currently selected view plus column
order, columns width and the table sort order. The next time you run the Day view
window, the saved table configuration will automatically be used.

The system refreshes the Day view with the data currently present in the database. The
interval is defined by the System Administrator.

21.2.1 Appointments / Reservation view

Select the View drop-down list.
Select either All appointments, Client bookings, Workflow or Reservations.
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14:00-15:15 T18765

48888888 MR JOHM SMITH

OID Auditbase - [Day view] — ] X
File View Edit
| Client  <T>T18765 MR JOHN SMITH -2 =|B|user SYSTEM ADMINISTRATOR | All locations ~ All departments - |[gx|?
Save window setup Restore default layout =
View Date Symbol Status Resource
All appointments - 10/01/2020 E Al - All -
Time  |Hospitaino.| NHSno. | Resource|Status|  Reason Information | symbol Referenced by| Locati
08:00-08:15 T1110 MRS FIRSTMAME 110 LASTNAME110 All

Resd4i |D 11

Charlie  |* ++GP direct referral

3 PHAC new patient mould Al

¢ The appointments of the selected type are shown in the table.

¢ Select an appointment by highlighting it.

« |f you right-click anywhere in the appointment, the Booking information opens up, where
you can edit appointment status and outcome status.

Client observation or procedure

Booking information X
Client: MR JOHN SMITH Time: 09/01/2020  16:30- 17:30 Attached actions Close
Appointment  Bf GWH1 ST Location All {no location) Letter:
Timetable 22 Department All (no department) Verbal
Made by: IRYNA SKLADANA on ¢9!01f2020 Attnd. with
Resource(s): STASSY Status
[no status] -
* Appt arranged
0, Cancelled
B, Being seen hd
Referenced by Stages condition:
Stage 1| Stage 2| Stage 3| Stage 4|
Reason [] [] [] []
Status change Jelete
Outcome status g Delete
*, Appt arranged 09/01/2020 16:57 [17m]
In, Arrived 0970172020 17:13 5YSTEM ADMINISTRATCR
Current outcome
Appointment not linked to referral
Linked Waiting list
Details
Hospital no.: T18765; NHS no.: 88888888
MR JOHM SMITH ; i
History of changes
99 Information ry g
OO0 -
Q00000 -

Add/ Edit/ Delete

Im
=t
[w]
@
o
@

Obs no.| SNOMED code|ICD10 code| Date| Add. | S| Text| Comment
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¢ |f you double click on the appointment, the Edit booking window opens up, So you can
edit the appointment directly from Day view.

Edit booking >
Offer declined Save Close
Client appointment | Reservation | Group appointment F_‘II;H_“'I:
o recurrence
Hospital no T18765 Daily
Mame MR JOHN SMITH Veekl
Phone Home: 99999 9999949 Monthly
Annually
Information ||
Reason « Referenced by -
Location All (no location) Department All {(no department)
Single resource
Symbol Resource All locations Date Time End
16 a | Trawy - 10/01/2020 09:00  10:30
22 Stassy Duration
II" from ; _
I tad Res100 * hours a0 = min.
[ ENT new patient mould~ Resdf .
Appointment stages
3 PHAC new patient mould~ Res68 - -
B8 SAV ENT audio Res70 | Name Descr
@I%\%ENT new patient mould: Ees?g Stage 1 Sample stage 1
Bs
"CLEAR ResT3 Stage 2 Sample stage 2
it GWH 1 st ResB2 Stage 3 Sample stage 3
bif GWH 2nd fit~~ Res75
[ ]| Stage 4 Sample stage 4
A2 GWH Audio assess~ Res71 g P g
73 BWH Audio review-~ Res72 = %
03 GWH Direct referral~ v |Res105 i
21.2.2 Workflow view

¢ Select the View drop-down list.
¢ Select Workflow.

This view is used for tracking client appointments flow via observation and changing of
appointment stage conditions.

The table shows client appointments and their stages.

¢ A grey square means that the appointment does not include a specific stage.

¢ Red square means that the appointment includes a stage but no condition has been set
yet.

¢ Right-click on the stage cell to set a condition for the stage.
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OZEI Auditbase - [Day view]

— O X
File View Edit
[O| Client <T>T18765 MR JOHN SMITH -2 Z B |user SYSTEM ADMINISTRATOR | All locations - All departments - x| ?
Save window setup Restore default layout Frint =
View Date Symbol Status Resource
Workflow - 10/01/2020 ﬁ All - - All -

Information|Time|
15:471 1

Symbol

Stage 2 ‘ Stage 3 | Stage 4 |Referenced by| Location |Departm|Elooking cocH Waiting room

® Pending

93 PHAC new patient mould

In Process
Completed

Clear stage condition
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21.3 Device list

Use this module to review devices, accessories, earmoulds and repair tasks for a client.

Press F3 to search for the client or Ctrl+F3 to make a quick search.

Go to Navigation -> Device list or press Shift+Ctrl+D.

Only Serial number controlled articles are shown on the Devices tab. Quantity controlled
articles can be shown on the Accessories tab, if configured so by your System
Administrator.

For Devices and Accessories the current situation or the historical situation can be
shown by clicking Present or History.

Devices are listed with stock type, the date when the device entered this stock type, the
name of the device, quantity, status of left/right along with the signature of the user
logged in to the system when the new status was given to the device. Left/right status is
presented by symbols defined by the system administrator.

Accessories are listed with Created date (the date the article was first added to the
client's device list), Latest issue date (showing the last time one of these articles were
added to the device list), Stock type and Stock Group, the Article name, status of left/right
and quantity along with the signature of the user logged in to the system when the new
status was given to the accessory. When this information is viewed in Client Information,
Devices tab, only the Created date is shown NOT the Latest issue date. This is for
performance reasons.

Devices and accessories can be attached to or detached from an appointment by clicking
Attach or Detach, respectively.

The Device tab also shows the serial number of the device and a version number.

ltem information is shown where it has been added for a particular article.

You can change the status of an item marked in the listing by clicking New status or
Alt+N.

NOTE: Changes in device status create clinical actions. If you have attached them to
appropriate appointments, they can be seen on the Clinical actions tab of the Referral
module.

For devices, you can view the selected device in the Stock module by pressing Show in
stock, or Alt+S, or show information for a device by pressing Information or Alt+l. You
can view the History of a particular Serial number controlled article by pressing the
History button or pressing Alt+T.

Earmoulds list shows the date of impression, date of sending to manufacturer, ready
date, types of left and right mould and comments.

Repair list shows which devices are being repaired. The information shown is the
information from the Order tab in the Repair module. Depending on how the Order type
has been set up by the System Administrator, breakage details can be shown over
several lines.

Double-click on a post to open the post.

Click Print to get the listing on paper.
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¢ You can print a receipt from the Device list by selecting one or more articles and pressing
Print receipt.

Device list X

MNew status Information Show in stock History Print receipt Client | MRS FIRSTNAME106 LASTNAME 106 Print Close

Devices | Accessories | Repairlist | Earmoulds | Requested

%) Present History Accessory issue Attach Detach Selectall Copy SN
1 entry selected

Modified date Stock type to Article LR User Serial number | Batch/Lot|lkem information | Version | Reason to issue -~
O 11/26/2015 | SENT FOR REPAIR (Repair) NHS SUPPLIES, ITE10MR SYSTEMADMINISTRATOR | PO a0 3
O 06i26/2015 |RECONDITIOMED (Issued) Testman 2, Testarticlel L |Test 7
| € |05/14/2015 | FITTED/EXCHANGED (Issued) NHS SUPFPLIES, ITE10MR R | Test 1121 1 [ = 5/14/2¢
O 05/08/2015 | FITTED/EXCHANGED (Issued) NHS SUPPLIES, ITE10MR L | Test 123123 1 3 Ba = 5127120
[ € |05/08/2015 | FITTED/EXCHANGED (Issued) NHS SUPPLIES, ITETMML | L | Test 12121 1 1 Ag * 5127020
O 05/08/2015 | FITTED/EXCHANGED (lssued) NHS SUPPLIES, ITE10MR L | Test 1123 3 3 Ba * 8127120
O 05i01/2015 | FITTED/EXCHANGED (Issued) Test man, Test arlicle 1 R |Test 2222 7 Ba = 8127120
O 04/28/2015 | FITTED/EXCHANGED (Issued) Test man, Test article 1 R | Test 123213 7 [m = 4r28/2¢

e The Copy SN button allows you to copy the serial number from a selected row. If no row is
selected, it will copy the serial number from the most recently issued device.

¢ An appointment associated with when an article was modified can be attached to the
Device list by selecting Attach. This will display all the client’s appointments. The
appropriate appointment can be selected by highlighting it and selecting Attach. Close
will shut the window without selecting. If the clinical action for issuing an article is set up
by your System Administrator, an appointment on the same day as a modified article
event will automatically link the event with that appointment, if the appointment start
time is earlier than the current time. The appointment can be unlinked from the event by
selecting the article in the list and choosing Detach.

Attach appointment to stock transaction *

Aftach Close

Resource Status ~

PHAC new p Charlie

@ | PHAC new p Charlie

12/26/2015 [m] SAV ENT ney Res4d *

1212312015 Z 2 Resd6 A

12/08/2015 m | SAV ENT ney Travy *

11/03/2015 Z 2 Charlie * W
- b

Device list s
New status Information | Show in stock History Print receipt Client MRS FIRSTNAME106 LASTNAME106 Print Close
Devices | Accessories | Repair list | Earmoulds | Requested
% Present History Accessory issue Detach Select all Copy SN
1 entry selected
Wodified date Stock type to Article LR User Serial number | BatchiLot|Item information | Version | Reason to issue A

] 11/26/2015 | SENT FOR REPAIR (Repair) NHS SUPPLIES, ITE10MR SYSTEMADMINISTRATOR | PO890909 3 [E I
O 06/26/2015 |RECONDITIONED (Issued) Testman 2, Testarticle! L | Test 2221 7
[ % |05/14/2015 | FITTED/EXCHANGED (Issued) NHS SUPPLIES, ITE10MR R | Test 1121 1 [m] *, 511420
O 05/08/2015 | FITTED/EXCHANGED (Issued) NHS SUPPLIES, ITE10MR L | Test 123123 1 3 Ba = 5127120
[ € |05/08/2015 | FITTED/EXCHANGED (Issued) NHS SUPPLIES, ITETMML | L | Test 12121 1 1 Ag * 5127020
O 05/08/2015 | FITTED/EXCHANGED (Issued) NHS SUPPLIES, ITE10MR L | Test 1123 3 3 Ag * 5127020
O 05/01/2015 | FITTED/EXCHANGED (lssued) Test man, Test article 1 R | Test 2222 7 Ba * 8127120
O 04/28/2015 | FITTED/EXCHANGED (Issued) Test man, Test article 1 R | Test 123213 7 [m = 4r28/2¢
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¢ On the Requested tab, the system displays all requisitions for the patient along with their
order numbers (IDs). If the order number is empty, it indicates that the requisition has not
been included in an order yet. Only undelivered items are shown on this tab. Delivered
items appear on the Devices tab.

Device list X
Histon, Print receipt Client MRS FIRSTNAME106 LASTNAME106 Print Close
Devices Repairlist
Req. date ‘Accemed|0.uant\ty| Deliver by | Deliveredto |Urder|D| Calour ‘ Ordered by | Supplier | Supplier art. no Stock type ‘ Ordertype Audiogram Emp\oyee|Amc\e\D‘Umtpnce Total price | Next appointment date
081512024 1 06/11/2024 |Location 33 SILVER |John Smith | STARKEY | GHB022 NHS ORDER | 12/11/2018, no. 1 50252 | $32.07 $3207 06/18/2024 12:00:00
06/15/2024 ] 1 06/20/2024 | All (no location) John Smith GHEG00 tpel 12/11/2018, no. 1 50273 |$0.15 $0.15 06/18/2024 12:00:00
081512024 O 1 06/20/2024 | All (no location) JVHITE | John Smith GHB 106P STOCK - GWH (In stock) 1211142018, no. 1 50143 | $7051 $7051 06/18/2024 12:00:00

NOTE: The ‘Device List’ window can be resized if necessary. The modified size is retained after
restarting Auditbase.
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21.4 Client observations and procedures

Click the button below to access our training materials.

Use this function to add a predefined observation or procedure to a client.

* Press F3 to search for the client or Ctrl+F3 to make a quick search.
¢ Go to Navigation -> Observations and procedures.

Observations and procedures *

Add to client Delete Close

Observation list In location and department: = All B Observations M Procedures

0bs no.|ICD10 code | SNOMED code | Add. Text

Presbyacusis

126 126 Otoscleros
127 127 Testobservation
128 128 Test procedure
Client observations Attach appointment
Obs ne.|ICD10 code|SNOMED code| Date  |Add.[ S| Side | Text Comment A
127 127 09/01/2020 Test observation
02 Presbyacusis
127 127 09/01/2020 Test observation
_125 125 01/05/2015 1 r |Right|Presbyacusis OCCUPATIONAL Right |123abc#5%123abcl123abc# 5% 123abcl123abcl#5%123abcl123abck
_125 125 2110412015 1 L Left |Presbyacusis OCCUPATIONAL Left 2
(_ 120 129 NNINARA R | hilat | Taet nraradira rada nn A hilat :\hré\mrrl')QI"I(B\#G:MM?.*((\':\hrémm'I')QI"I(;hiiﬂ:MJ\J?.*((\':hrémrrl')QI"I(;-‘H)N 2

¢ Select the Current or All location to filter the observations.

» Select Observations and/or Procedures to filter the observations.

e To add an observation or procedure to a client record, highlight the observation or
procedure in the upper table and click Add to client or double-click. Repeat this process
until all required observations/procedures are displayed in the lower table. Click Save.

Be aware: Be careful when adding observations and procedures; ensure the Client is
correct. Entering an incorrect observation or procedure can cause incorrect treatment.

e To remove an observation or procedure from a client record, highlight it in the lower table
and click Delete.

¢ Inthe lower table, you can type in a number in the Add. column (Additional code) and a
preconfigured text created by your system administrator is added to the Text field.

e EnterL, RorBinthe S column for left, right and bilateral or use the Side box to select it.

¢ To edit the Comment column, double-click in the lower table and the Edit client’s
observations and procedures window appears.
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Edit client's observations and procedures X
Mew Save Delete Cancel

Date 09/01/2020

Qbservation or procedure 125, Presbyacusis -

ICD10 code 125

Add. code

Side -

Comments Some comments

e Enter your comments and click Save.
* You can also add a comment to the observation directly in the list by clicking in the
Comment’s field and entering your comment.

Observations and procedures X

Add to client Save Delete Close

Observation list In location and department: Curren = All M Observations M Procedures

0bs no.|ICD10 code | SNOMED code| Add.

126 126 Otoscleros

127 127 Test observation
128 128 Test procedure
Client observations Aftach appointment

0Obs no.|ICD10 code| SNOMED code|  Date | Add.|S[Side Text Comment | Appt.| Appt.date| Apptname

Some comments

¢ Once saved, you can also attach the observation or procedure to an appointment by

selecting the observation or procedure in the lower table and click Attach appointment.

Attach chservation or procedure to appointment X

Attach Close

Date Symbol | Description Resource Status A
81212018 MALMESBUE Alan
28M2/2018 &t MALMESBUFR Charlie *
2822018 B MALMESBUF Res70 *
10122018 2 SAY ENT auc Charlie *
10M12/2018 E| PHAC new p Alan *
05/07/2018 1 1 Trawy * "
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¢ Choose an appointment from the list of appointments and click Attach.
¢ If you wish to detach the observation or procedure from an appointment, you simply
select the observation or procedure in the lower table and click Detach appointment.

If you choose to detach the observation or procedure from the appointment, it will still
remain on the client’s record.

¢ Once an observation or procedure is attached to an appointment, it will show up on the
Booking information dialogue box, from where an observation or procedure can also be
attached, edited or deleted.

Booking information *
Client: MRS FIRSTNAME106 LASTMAME106 Time: 28/12/2018  08:00-08:20 Attached actions Close
Appointment 5% MALMESBURY ENTAUDIO Location All (no location) Letter:
Timetable 2 2 Department All (no department) Verbal: X
Made by: YULNA MAKUKHA on 28M12/2018 Attnd. with
Resource(s): ALAN Status
% 08:00 Charlie [no status] 'Y
5 08:00 Res70 * Appt arranged

Q, Cancelled

A, Arrived

B, Being seen v
Referenced by Stages condition:
Reason

Status change Delete
¥, Appt arranged 28/12/2018 14:38

Outcome status

Current outcome
Appointment not linked to referral

Linked Waiting list

Details

Hospital no.: T1106; NHS no.: 5555554444 -
MRS FIRSTMAME106 LASTNAME106

930000000

HOOOCOO0T

HOCOCO -

Information History of changes

Client observation or procedure Add [ Edit/ Delete Edit Delete

0Obs no.| SNOMED code |ICD10 code Date Add.| S Comment

5is | Some comments

¢ Back in the Observations and procedures window, everything from the observation or
procedure will be written to the journal when you save, including full text and comments
as well as appointment information if the observation or procedure was attached to an
appointment.

¢ You will also find the observation or procedure in the Referral module with the option of
editing the observation or procedure from the Referral module.

e Further, all changes are reflected in the Paediatric module on the Clinical information tab.
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21.

o Hearing Therapist

The Hearing Therapist module contains a number of check boxes and free text fields used to
store specific Hearing Therapy data for the selected client.

Press F3 to search for the client or Ctrl+F3 to make a quick search.

Go to Navigation -> Hearing Therapist.

Previous reports can be viewed by selecting the required date from the Therapist
Reports drop-down list.

When a previous report is selected, the button Progress report becomes active and brief
comments on specific areas of Therapy can be added such as date and note to training,
visits, etc., to get an overview of the client’s progress.

Comments can be added and saved with the signature of the Auditbase System user
logged in at the time.

New clears the details so a new report can be added.

Click Save.

Print the report if required.

Progress report Mew Save Delete Print Close

| Therapistreports 1, 04/07/2016

Client MRS FIRSTNAME 106 LASTMAME 106
o Progress report X
Save Cancel
Signature full name tests??7? -
Date MNote
Hearing instrument adj. 04/07/2016
Functional training 040712016 | 2
Training 04/07/2016 | 344
Hearing damage treatment
Intensive course
Education
Home visit
FI
Comments
': Comments - .
-
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Hearing Therapist

Progress report Mew Save Delete Brint Close
Therapist reports 1, 040712016 -
Client MRS FIRSTMAME106 LASTMNAME106
Date 04/07/2016 User full name tests?77 -
Pocket BTE ITE Canal Previous hearing aid? Yes Mo
Difficulty walking Sight damage Manufacturer
Iil Work/phone no.
Technical aids:
Acoustic signal door phone
Optic signal door phone atTv
Twiradio telecoil room telecoil chair HP-zet
Other wake up call other
Technical aids at work # Yesg Mo
Mould handling # Good Medium Bad
Previous contact with therapist Yes ) Mo Advised
Audiologists -
notes
-
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21.6 Direct Referral HI (adult)

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

¢ Go to Navigation -> Direct referral HA (adult).

e GP and ENT are selected from lists using the button at the end of the fields.

e Choose reason for ENT referral from the drop-down lists if required.

¢ You can right-click on the drop-down boxes to edit the list of reasons for ENT referral.
¢ Choose Priority of referral from the drop-down list.

¢ Click Save.

When this referral page is completed the Direct Referral box in the Details tab of the Client
Information module is automatically checked.

This referral form is a shorter version of the Direct Referral - Medical/audiological history -
DR-Med questionnaire covering the TTSA guidelines for Direct Referral.

Direct Referral HA (Adult)

x

Delete Save Cancel

GP
EMNT

Date referral received

DR S RATMANDAN, NORTHLAMDS SURGERY, I
MRS AMMAN, 222 STR, HOME CITY

advicelcounselling?

Referral correct? M Yes Mo
Date of DR clinic visit
Clear of wax? Yes M Mo
ENT referral advised? Yes [WNo;
“x e -
Priarity of referral? -
Impression(s) for hearing
aid provision? Yes No
Referral for — -
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21.7 Tinnitus

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

¢ Go to Navigation -> Tinnitus.

¢ Fill in the required details using the tabs to view each screen.

e The Audiogram list will show a list of the client's audiograms. Double-click the date of the
audiogram to view it; no adjustments can be made to the audiogram.

» Click New to create a new form for tinnitus analysis and type in the relevant information.

* Save the report when finished.

The Tinnitus Analysis drop-down field lists any previous tinnitus reports for the selected client.

You can also delete a tinnitus report and print the reports using the buttons at the top of the
page.

Tinnitus *
Audiogram list New Save Delete Print Close

Client: MRS FIRSTNAME 106 LASTNAME 106

Date of onset Tinnitus analysis -

Doctor

Aetiology Analysis date | 13/01/2020

Remark User SYSTEM ADMINISTRA |

Site/Character |Inventory | Patient Description of MTT | Exposure to Moise | Health Problems | Effect of Lifestyle | Tests | Analysis < »

Date Phase Grade
Pre Tinnitus Handicap Inventory Score % ..
Tinnitus Handicap Inventory Score ki |__|
Post Tinnitus Handicap Inventory Score % Attach
. : Detach
Categories Emoaotional %
Functional %
ki

Catastrophic

¢ Under Inventory, you can either manually enter the percentage score from a pre, post or
current Tinnitus Handicap Inventory questionnaire or you can attach a score from a
guestionnaire by clicking the Browse button next to the percentage field and choosing
from a list of questionnaires.
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21.8 Run an external application

¢ Go to Navigation->Run an external application.

The external application configured by your Administrator will be launched with the parameters
configured.
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21.9 Attention list

Click the button below to access our training materials.

When opening the Attention list the system will check the database for issues requiring special
attention. The Attention list consists of several lists, including:

¢ Referrals

¢ Journal

¢ Unsigned journal

e Unsigned summaries
¢ Deceased alerts

¢ Electronic submission
¢ Interface notifications

Each time you open the Attention list, the system automatically generates the list. Progress is
shown at the bottom of the window. You can start to work on the top rows while others are
populating. To cancel this, just select another tab. The text below the tab names describes the
reason why clients are shown.

Floating attention list

The Attention list can remain open while you deal with records in Auditbase. This allows you to
work faster by avoiding the need to close and reopen the list repeatedly.

Full and collapsed views

The Attention list can be collapsed and expanded using this button

Attention list - Unsigned journal X
Do not show a warning message D-Alert selection method Alert - Print Show in Journal Close
Referrals | Journal | Unsigned journal | Unsigned summaries Deceased alerts | Electronic submission  Unsubmitted postings  Interface notifications

Unsigned journal records
Date Hospital no NHS no. Client name User Keyword A

111172010 | T146023 MR FIRSTNAME46023 LASTNAME46023 | USER NAMESS | ADULT REHABILITATION

11/26/2010 | T11194 MR FIRSTNAME1194 LASTMAME1194 USER MAME11 |ADULT REHABILITATION

12110/2010  T124576 MR FIRSTNAME24576 LASTNAME34576 | USER NAMESS | ADULT REHABILITATION

1M12/2011 | T146604 MET FIRSTNAME4G604 LASTNAME46604 | USER NAME49 PAED DIAGNOSTIC

1/20/2011 | T13646 MR FIRSTNAME3646 LASTNAME3G46 USER MAMEBS |ADULT REHABILITATION

1/25/2011  T146523 MRS FIRSTNAME46523 LASTMAME46523 | USER NAMES1 | ADULT REHABILITATION

1/25/2011  T145198 MRS FIRSTNAME45198 LASTMAME45198 | USER NAMES1 | ADULT REHABILITATION

1/26/2011 | T146646 MRS FIRSTNAME46646 LASTNAME46646 | USER NAME14 | ADULT REHABILITATION

1126/2011  T145288 MR. FIRSTMAME45288 LASTMAME45288 | USER NAMESS | ADULT REHABILITATION

1/26/2011 | T15209 MRS FIRSTNAMES209 LASTNAMES209 USER MAMES3 | ADULT REHABILITATION

112712011 T146183 MRS FIRSTNAME46182 LASTMAME46182 | USER NAME71 | ADULT REHABILITATION

112712011 T146077 MRS FIRSTNAME4G077 LASTMAME46077 | USER NAMESS | ADULT REHABILITATION

2142011 T12569 MRS FIRSTNAME2569 LASTNAME2569 USER MAME29 |ADULT REHABILITATION

9/30/2013  T1108 MRS FIRSTNAME106 LASTNAME106 Test ADULT REHABILITATION

9/30/2013 | T1108 MRS FIRSTNAME106 LASTNAME106 Test ADMIN

9/30/2013  T1108 MRS FIRSTNAME106 LASTNAME106 Test ADMIN

10/2/2013  T1108 MRS FIRSTNAME106 LASTNAME106 Test ADMIN

71712014 T999911 1112-222211 | Father 362 a=a1 Test GENERAL

Q112014 T1106 MRS FIRSTNAMF10A | ASTNAMFADA Test ANMIN v

Populating: 659 / 86
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Attention list - Unsigned journal X

¥ Do not show a warning message D-Alert selection method Alert - Print Show in Journal Close

Populating: 639 / 127

Manual refresh

The list does not refresh automatically after each problem is resolved to avoid performance

issues. You can manually refresh the list when needed. The refresh button ? is available on
various tabs.

Module navigation

The Journal tab allows you to jump directly to the relevant module, while other tabs require you
to manually select the module to work on the record. You can work on records from different
tabs, such as the journal or referral tab, without closing the Attention list.

°)
File | View  Fundions
SO B RBE D G awew 4 4]
Detailed | Quick  Signed | Unsigned  Print iew Import data | Export data | % ExporttoNoah  Logoff | Exit Auditbase
Search Save print Import/Export Client data Exit
IL] Client MR FIRSTNAME45023 LASTNAME45023 -l & Z B user  Maksy (At tocations | an MiE-1E
Navigation
N View | List | Treatment summary | Individual management plan Attention lst - Unsigned joumnal X
+/\ Attention list Keyword All S @ Unsigned e # || Donotshowawaming message  D-Alertselection method Alert - Frint || ShowinJournal || Close sign
i Q, Clients entries Signed
i/, Clientinformation -
= Create date Keyword Created by | Signed by | Referrals | Joumal | Unsigned joumal | Unsigned summaries | Deceased alerts  Electronic submission = Unsubmitted postings | Interface notifications 4 »
|&) Dayview )0 [ADULT REHABILITATION | USER NANESS |UNSIGNED | ]
2] Documents and attachme Unsigned journal records -
-2 Booking —
155, Referral Date | Hospital no. | NHS no. Client name User Keyword A
[ stock USER NAMESS | ADULT REHABILITATION
££] Joumnal 11262010 | T11194 MR FIRSTNAME1194 LASTNAME1194 | USER NAVE1! |ADULT REHABILITATION
1211012010 | T134576 WR FIRSTNAME34576 LASTNAME34576 | USER NAVESS | ADULT REHABILITATION
1122011 | T146604 WST FIRSTNAME 46604 LASTNAMEA6604 |USER NAME49 | PAED DIAGNOSTIC
1202011 | T13646 WIR FIRSTNAME3G46 LASTNAME3646 | USER NAVIEBD | ADULT REHABILITATION
_— 12512011 | T146523 MRS FIRSTNAME48523 LASTNAME48523 | USER NAVES1 | ADULT REHABILITATION
Individual client 1252011 | T145198 MRS FIRSTNAME45198 LASTNAMEA45193 | USER NAME9T | ADULT REHABILITATION
5 Clientinformation 12612011 | T146646 MRS FIRSTNAME48646 LASTNAME48646 | USER NAVE14 | ADULT REHABILITATION
] Paediatric 12612011 | T145288 WR. FIRSTNAME45288 LASTNAVIE45288 |USER NAVIESD | ADULT REHABILITATION
-] Journal 12612011 | T15809 MRS FIRSTNAMES809 LASTNAMES809 | USER NAVES3 | ADULT REHABILITATION
4| DERIITE 70 2 B TR 1/27/2011 | T146183 MRS FIRSTNAME46183 LASTNAMEA4G183 | USER NAVET1 | ADULT REHABILITATION
f S:;E’:;:‘ewles 1272011 | T148077 MRS FIRSTNAUEA8077 LASTNAME48077 | USER NAVESS | ADULT REHABILITATION
5 Device fst 2112011 T12580 WIRS FIRSTNAUE2560 LASTNAME2560 | USER NAVIE20 | ADULT REHABILITATION
e e T 9302013 | TH06 MRS FIRSTNAME106 LASTNAME106 Test ADULT REHABILITATION
-5 Earmoulds 9302013 | T1108 WIRS FIRSTNAUE106 LASTNAME106 Test ADMIN
) Hearing Therapist 9302013 | TH06 MRS FIRSTNAME106 LASTNAME106 Test ADMIN
[1] Medical history 10122013 TT06 MRS FIRSTNAME106 LASTNAME108 Test ADMIN
&, Direct referral HA (adutty TH72014 | T999911 | 1112-22: Father dme2 smol Test GENERAL v
g i B Selectall 1 rowselected a
-4 Surgery < 5
[1] Hi satistaction Questionnaire | - Edit Journal Populating: 659 / 659 Done ]
53 easurements Keyword - ADULT REMABILITATIC ~  Date /1112010 Time 1222 Sign as user. Maksy
% :esls i joumal record; journal record; joumal record; journal record;
i

Global client change

When you select a record from the Attention list, the global client changes. However, you need
to select the module you want to work on manually.

Usage tips

¢ You can start working on the top rows while the rest of the list is still populating.

¢ Keep the list open, minimize it to deal with a record, and then maximize it again to
continue with the next record.

* Refresh the list manually after dealing with several records to keep performance optimal.

Locations filter

If a user has a Location or Multiple locations selected, the results will be further filtered by the
client’s Location and they will not see all records.
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When location is selected globally, a corresponding message will appear informing that "The
List is filtered by Client's Location".

Attention list - Unsigned journal H
& Do not show a warning message D-Alert ion method Alert - Print n Journal Close
Referrals | Journal | Unsigned journal | Unsigned summaries | Deceased alerts | Electronic submission | Unsubmitted postings | Interface notificatior 4 » =
Unsigned journal records - The list is filtered by clients’ location .
Date  |Hospital no. | NHS no.| Client name User Keyward ~
T1M1/2010 | T146023 MR FIRSTNAME46023 LASTNAME46023 | USER NAMESS | ADULT REHABILITATION
1M/26/2010 | T11194 MR FIRSTNAME1194 LASTNAME 1194 USER NAME11 | ADULT REHABILITATION
12M0/2010 | T134576 MR FIRSTNAME34576 LASTNAME34576 | USER NAMESS ADULT REHABILITATION
11212011 | T146604 MST FIRSTMAME46604 LASTMNAME46604 | USER NAME49 |PAED DIAGMOSTIC
1/20/2011 | T13646 MR FIRSTMNAME3646 LASTNAME3G646 USER NAMESS | ADULT REHABILITATION
10252011 | T146523 MRS FIRSTMNAME46523 LASTNAME46523 | USER NAMES1 | ADULT REHABILITATION
1/25/2011 | T145198 MRS FIRSTMNAME45198 LASTNAME45198 | USER NAMES1 | ADULT REHABILITATION
102602011 | T146646 MRS FIRSTNAME46646 LASTNAME46646 | USER NAME14 | ADULT REHABILITATION
1/26/2011 | T145288 MR. FIRSTNAME45288 LASTMNAME45288 | USER NAMES9 | ADULT REHABILITATION
1/26/2011 | T15809 MRS FIRSTMNAMES809 LASTMNAMESE09 USER NAMES3 | ADULT REHABILITATION
12712011 | T146183 MRS FIRSTNAME46183 LASTNAME46183 | USER NAMET1 | ADULT REHABILITATION
10272011 | T146077 MRS FIRSTMNAME4G077 LASTNAME46077 | USER NAMESS | ADULT REHABILITATION
21201 T12569 MRS FIRSTNAME2569 LASTNAME2569 USER NAMEZ23 | ADULT REHABILITATION
9/30/2013 | T1M06 MRS FIRSTMNAME 106 LASTMNAME106 Test ADULT REHABILITATION
9/30/2013 | TM0G MRS FIRSTMAME 106 LASTMAME106 Test ADMIN
9/30/2013 | T1106 MRS FIRSTNAME 106 LASTMNAME106 Test ADMIN
10/2/2013 | T106 MRS FIRSTMNAME106 LASTNAME106 Test ADMIN
9172014 T1106 MRS FIRSTMNAME 106 LASTMNAME106 Test ADMIN he -

Populating: 469 / 469 Done A\ The list is filtered by clients' location

If they want to see all clients, they should change to All Locations. There will be a message to
users on the first time they do this which they can then check to prevent it showing again.

Attention list - Unsigned journal x
E Do not show a warning message  D-Alert selection method Alert - Print win Journal Close

Referrals | Journal ||Unsigned journal | Unsigned summaries | Deceased alerts | Electronic submission | Unsubmitted postings | Interface notifications | <1 » =

Unsigned journal records

Date Hospital no |NHS no | Client name User Keyword ~

111152010 | T146023 MR FIRSTMNAME46023 LASTMNAME46023 | USER MAMESS | ADULT REHABILITATION

11/26/2010 | T11194 MR FIRSTMNAME 1194 LASTNAME 1194 USER MAME11 |ADULT REHABILITATION

12M0/2010 | T134576 MR FIRSTNAME34576 LASTNAME34576 | USER NAMESS |ADULT REHABILITATION

AM2/2011 | T146604 M3T FIRSTNAME4G604 LASTMNAME4G6604 | USER MAME49 | PAED DIAGNOSTIC

172002011 | T13646 MR FIRSTMNAME3646 LASTNAME3646 USER MAMESY | ADULT REHABILITATION

1i25/2011 | T146523 MRS FIRSTMNAME46523 LASTMNAME46523 | USER MAMES1 | ADULT REHABILITATION

1/25/2011 | T145198 MRS FIRSTNAME45198 LASTNAME45198 | USER NAMES1 | ADULT REHABILITATION

26/2011 | T146646 MRS FIRSTNAME4G646 LASTNAME46646 | USER NAME14 | ADULT REHABILITATION

1/26/2011 | T145288 MR. FIRSTMNAME45288 LASTMNAME45288 | USER MAMESS | ADULT REHABILITATION

1i26/2011 | T15809 MRS FIRSTMAMESS09 LASTNAMESS09 USER MAMES3 | ADULT REHABILITATION

2712011 | T146183 MRS FIRSTNAME46183 LASTNAME46183 | USER NAMET1 | ADUEA REHABILITATION

272011 | T146077 MRS FIRSTNAME4G077 LASTNAME46077 | USER NAMESS |ADULT REHABILITATION

21201 T12569 MRS FIRSTNAME25G9 LASTNAMEZ2569 | USER MAMEZ29 | ADULT REHABILITATION

9/30/2013 | T1106 MRS FIRSTMAME106 LASTNAME106 Test ADULT REHABILITATION

9/30/2013 | T1106 MRS FIRSTMAME106 LASTNAME 106 Test ADMIN

9/30/2013 | T1086 MRS FIRSTNAME106 LASTNAME106 Test ADMIN

10/2/2013  T106 MRS FIRSTNAME 106 LASTNAME106 Test ADMIN

772014 | T999911 1112-22: | Father dze? =51 Test GENERAL hd =

Populating: 659 / 659 Done

If configured in Auditbase Administration (General settings > Options), the warning on changing
the global client will be applied.
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Change of client bt

IK'—;)_\.I Do you wish te change client?

I

Referrals

Lists all clients with a referral which has not been followed up by an appointment or put on a
waiting list from the referral page. This list makes sure that no referred clients are left without
attention. It is possible to see the Referral Treatment Type on the list of Referrals:

& Do notshow a warning message  D-Alert selection method Alert - Print Show in Journa Close

| 1
Referrals | Journal | Unsigned journal | Unsigned summaries | Deceased alerts | Electronic submission | Unsubmitted postings | Interface notifications | 4 »

Active referrals (not Closed or Mullified) that have not been booked or put on the Waiting list

=

Date |Number| Hospital no.|NHS no.| Client name Treatment type ~
3712000 (30700 |T12639 MISS FIRSTNAME2639 LASTNAME2639 SWINDON EARLY SUPPOF
3/8/2000 | 282 T19296 MR FIRSTNAMES296 LASTNAMES29G | ++DIRECT REFERRAL /Audio assessment | DR MILEUSNIC 2, THE KI
4M7I2000 | 30701 | T13788 MISS FIRSTMAME3758 LASTNAME3TS58
5M19/2000 |30702 | T14181 MST FIRSTMAME4181 LASTNAME4181
5M9/2000 | 30704 |T14118 FIRSTMAME4118 LASTNAME4118
5M9/2000 | 30705 |T14118 FIRSTMAME4119 LASTMNAME4119
5/19/2000 | 30706 |T14109 MISS FIRSTMAME4109 LASTNAME4109 HASSAN
52312000 | 30707 | T14132 FIRSTMAME4132 LASTNAME4132 SWINDOM EARLY SUPPOF
5/23/2000 |30708 |T14131 FIRSTMAME4131 LASTNAME4131 SWINDON EARLY SUPPOF
6/2/2000 |30709 |T12094 MST FIRSTMAMEZ2094 LASTNAMEZ094 HASSAN

Journal

Lists all client appointments which have not been followed up by journal entries during the last
month. This list makes sure that there is a journal entry for each appointment.
Unsigned journal

Lists all clients with journal texts which have been saved unsigned. This list makes sure that no
journal text is left unsigned.

To select a client, click on the row in the list. The client now becomes the global selected client.
When you have taken care of the issue, the client is automatically removed from the list.

The columns in the list can be sorted by clicking on the column header.

Unsigned summaries

Lists all clients with unsigned treatment summaries. This list makes sure that no summary is
left unsigned.
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e To select a client, click on the row in the list. The client now becomes the global selected
client.

When you have taken care of the summary, the client is automatically removed from the
list.

The columns in the list can be sorted by clicking on the column header.

Deceased alert

Lists uncompleted activities for clients with Deceased alert. Separate tabs show each kind of
open record that a deceased client could have. The text below the tabs describes why a client is
shown on that particular tab.

e To select a client, click on the row in the list. The client now becomes the global selected
client.

When you have taken care of the issue, the client is automatically removed from the list.

The columns in the list can be sorted by clicking on the column header.

Deceased alerts can be searched for in two separate places to make the results populate
quicker. The user must select either PAS alert or Alert in the D-Alert Selection method drop
down list depending how deceased alerts are normally entered.

Auditbase will retain the D-Alert Selection method chosen by the user for any future lists to be
populated. Any subsequent change to the selection method will be retained for the user.

o

B Do notshow a warning message  D-Alert selection method Alert - Print Show in Journa Close

=
Referrals | Journal | Unsigned journal | Unsigned summaries | Deceased alerts | Electronic submission | Unsubmitted postings | Interface nofifications | 4 »

D-Referrals | D-Waiting lists | D-Appointments | D-Unsigned journals | D-Unsigned summaries

| Clients with Deceased alert and Referrals that are not closed

Iy
L

Hospital no. | NHS no. | Client name | Date | Information

Warning X

Populating may take long time. There are 2385 rows to show

OK Cancel

A warning is shown when there are a lot of deceased records. If the user does not wish to see
the message each time the Deceased attention tab is selected the box Don’t show this
message again can be checked to disable the message.

Within the Deceased attention tab there are further tabs to identify clients with a Deceased
alert whose Referrals are not closed, are still on a Waiting list, have Appointments booked in
the future, have unsigned journal entries and have unsigned treatment summaries.
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In the bottom left corner of the Attention list is an indication the current state of the search and
once populated will indicate how many records are specific to the tab selected.

Electronic submission

This is intended for reviewing all Electronic Submission events and for dealing with Treatment
Summary submissions. These could be for optional interfaces of clinical documents with
Hospital Electronic Patient Record Systems or of appointment details for patient arrival or
Hospital appointment systems.

Depending on the option set in Administration under Event Settings-> General settings some
of the controls may not be available. If the option is checked to not show Treatment Summary
submission controls then only the Data type filter will be available and should be set to All or to
one of the configured event types. In the case of event driven automatic Electronic Submission
events will only be shown in the list between the action being performed on the client and the
regular scanning work of the server components. Users have the ability to Show data to show a
Treatment Summary, Audiogram or Document (document Properties dialog) whose submission
was rejected. The Delete button can be used with supporter assistance in the case of serious
failure but the event will not then be resent.

Treatment Summary electronic submissions will remain in the list after they are actively
submitted by a user. The following filtering options are available for displaying Treatment
Summary electronic submissions:

e Data type

¢ Detail type - shows the sub-type of the event

¢ Ready for submission

e Submitted

¢ Rejected

e Signed not submitted

e Status date. A range of dates can be added. Double clicking in the field will add today’s
date. The Status date is only relevant for Treatment Summaries where the record of

Submitted is kept.

When an option changes, you have to press the Refresh button to update the list of electronic
submissions.
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Attention list - Electronic subrnission

] Do not show a waming message  D-Aler selection method Alert ~ | Editrecipient Edit

Close

X

List of electronically submitted documents

Referrals | Journal | Unsigned journal | Unsigned summaries | Deceased alerts | Electronic submission | Unsubmitted postings

-
Interface notifications | 4 »

Populating: 60 / 24

Unsubmitted postings

Filter

Data type: All ~ M Ready for submission W Rejected Status date:
Detailtype: 4 B Submitted Signed not submitted

Date created| Data type | Detail type | Hospital no | NHS no. | Client name Recipient Status Status datefime ~
3/6/2025 Journal GEMNERAL | T134921 MR FIRSTHAME34921 LASTNAME34921 Ready for submission | 03/06/2025 16:45:0
31112025 Audiogram T134921 MR FIRSTMAME34921 LASTNAME34921 Ready for submission | 03/11/2025 11:27:4
31142025 Audiogram | Aided T134921 MR FIRSTHMAME34921 LASTNAME34921 Ready for submission | 03/11/2025 11:33:41
3112025 Audiogram T134921 MR FIRSTMAME34921 LASTNAME34921 Ready for submission | 03/11/2025 11:46:4
31112025 Audiogram T134921 MR FIRSTMAME34921 LASTNAME34921 Ready for submission | 03/11/2025 11:47:4
311/2025 Audiogram T134821 MR FIRSTHMAME34921 LASTNAME34921 Ready for submission | 03/11/2025 14:12:2
3112025 Audiogram T134921 MR FIRSTHMAME34921 LASTNAME34921 Ready for submission | 03/11/2025 15:39:0
3M1/2025 Audiogram T444444 4739-3 | Tymp Tymp Ready for submission | 03/11/2025 16.08.5
31712025 | Journal ADMIN F458967 LadyAmeli A Ready for submission | 03/17/2025 15:05:3
3712025 Journal ADMIN F458967 LadyAmeli A Ready for submission | 03/17/2025 15:09:2
31712025 Journal ADMIN F458967 LadyAmeli A Ready for submission | 03/17/2025 15:10:5
31712025 | Journal ADMIN F458967 LadyAmeli A Ready for submission | 03/17/2025 15:17:3
3712025 Journal ADMIN F458967 LadyAmeli A Ready for submission | 03/17/2025 15:18:2 v
< >

This list is shown if Visit charge features are enabled in System administration. It shows the
postings which should have been submitted to the Swedish online reimbursement system

eFrikort, but have not been.

The list can be filtered by creation date to e.g. only show those created this week. After editing
the date range, press the Refresh button to update the list.

Attention list - Unsubmitted postings

R Do not show a warning message D-Alert selection method Alert A

*

Close

List of postings which had or potentially had to be submitted to the eFreeCard program, but have not been
Filter

Date created:  04/04/2025

- D4M1/2025 |22

re
Referrals | Journal | Unsigned journal | Unsigned summaries = Deceased alerts | Electronic submission |Unsubmitted postings | Interface notifications | 4 »

Date created| Hospital n0.|NHS n0.|Clientname|SeM’ce|Cost|Gemng status | Registering transaction

Interface notifications

When an HL7 message is received from the hospital system informing of the need to merge two
patients in Auditbase, an email (not containing Patient Identifiable Information) will be sent
informing about it, and an entry will be added to the 'Interface Merge Notifications' Tab in the

Attention list.

Identifying information is displayed for both major and minor patients:
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e Users with the corresponding Extended Right can open the Client merge screen from here

with the Major and Minor clients preselected.

e The Major client is selected as the Global client after the successful merge, and the

notification about the merge record is then removed from the list.

Attention list - Interface notifications

Merge message date | Minor Hospital no. | Minor NHS no. Minor Client Name Minor DOB | Gender | Posicode Major Hospital no. | Major NHS no. Major Client Name Major
3 1311124234 TFIRST EXTRAMORE TLAST |13/111912 ABC 1234 15 5 TFIRST EXTR RE2 TLAST31 | 18/04,
01/09/2023 11:41:19 | 1311124234 TFIRST EXTRAMORE TLAST |13/11/1912 ABC 1234 1502620955 TFIRST EXTRAMORE2 TLAST31 | 18/04.

Merge clients *

Major client for merge

Hospital no | 1502620955 Select

NHS no.

First name TFIRST EXTRAMOREZ2
Lastname  TLAST31

Gender Male -
Birthdate 18/04/2016

== Merge ==
Minor client to be merged with major client

Hospital no. | 1311124234 Select

NHS no.
Firstname  TFIRST EXTRAMORE

Lastname  TLAST
Gender -

Birthdate 13111912

Detected merge problems

There are no conflicts detected. Clients can be merged.

Information X

Clients merged successfully

—C—
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Referrals | Journal = Unsigned journal | Unsigned summaries Deceased alerts | Electronic submission = Unsubmitted postings | Interface notifications
Filter
Merge message date: 10/01/2020 - 10/0412025 |2
Merge
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21.10 Location and Department handling
Location and Department are found in the upper right part of the toolbar.
Filter information

You can use locations to filter information in Auditbase. The Location and Department can be
seen and selected in the upper right part of the toolbar.

The selected location will filter:

¢ Resources, symbols and appointment stages in Appointment book

¢ Day view in Appointment book

o Letters in Appointment book

¢ Document types

¢ Waiting lists

¢ Stock types in Stock

e Earmould delivery address on the printout

e Stock types and requisitions list on Requisitions

¢ Ordered requisitions on Purchase orders (filter by ‘Deliver to’ location)

Location

A location can be a physical location, such as a satellite clinic or a department. It could also be
a separate functional area within the clinic, such as an ENT clinic, Paediatric services.
Department

Departments are virtual groupings such as Adult, Paediatric or Implant which could have
activity at more than one location.

Creation of Location and Department

Locations are created in the System Administration tool.

Default Location and Department

A user or a workstation can be assigned to a specific location i.e. this location will be selected
by default when logging in.

Resources

Resources can be associated with more than one location so that they can be seen and booked
from any of their associated locations.

Locations that the user is allowed to access are shown in black on the drop-down lists;
Locations that the user has restricted access to are greyed out. If a user selects a greyed-out
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location, it won't select, but will return the user to the last selected one. If a user has the
extended user right of overruling the client access restriction, they can move a patient from a
Location they are not allowed to normally access, but that action is logged in the Security log.
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21.11 Visit charge management

In Sweden, everyone is entitled to receive financial aid once you have surpassed a specific
amount used on hospital, dentist and doctor bills for the year. This makes you eligible for an
annual card on which the rest of the health care visits will be charged. As a patient, your visits
are free of charge for the remainder of the year.

In Auditbase, you can register details such as the annual card number, payment method and
whether or not the client is eligible for free of charge visits. In order for these functions to be
enabled, your System Administrator needs to do the following settings in the System
administration tool:

¢ Under Invoice definitions -> Preferences, check the box Enable visit charge features on
invoice events and postings.

¢ Under Event definitions -> Event settings, make sure the event number 1921, Add
services on appointment status change, is enabled (checked) and set up correctly
(choose the service associated with visit charges and check the box Prompt for user
input).

¢ Under Appointment definitions -> Appointment statuses, make sure the appropriate
status (usually Arrived) is associated with invoice event 1921 (choose the status in the
list and check Associate with invoice event 1921).

With these settings in place, you will see the following invoice event after having changed a
client’s status to the status defined in System administration associated with visit charges
(usually Arrived):

Services to be invoiced ®

Date 13/01/2020 ﬁ Referral

Annual card number 43454546 Date due 13/01/2020 Payment method  |nvaice

M Selectall Print full page receipt Printvisit receipts

|Sewice|lnvoice| Invoice type |Units|F'rice| %o |T0ta|price Customer
1 Client | Invoice type 1)1 0 1000

Total price: 0

¢ Here you can enter the client’s Annual card number, Date due, Payment method and
whether or not the visit is Free of charge.
¢ You have two options for printing:
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e Full page receipt (size A4)

¢ Receipt as label (only possible if you have a label printer set up to your computer)

e The selection you choose for printing will be saved per workstation.

e The Free of charge option will not take effect, if the Date due has been surpassed and
therefore the client is not eligible for the visit to be free of charge. Change the date in
order for the Free of charge option to take effect again (the Total price will be zero when
the visit is free of charge).

 [f the visit is not free of charge, choose the Payment method being either Cash or Credit
card.

« [f Visit charge features are enabled in System administration it is possible to let the
system automatically set the patient to free of charge status depending on age (e.g. if
younger than 19 or older than 85).

¢ All this information will be saved on the Client information screen, under the tab Visit
charge. The data on the Client information screen is always the most recent.

Contacts | Details | Lists/Photo | Devices | Implant | Visit charge | Paediatric | PPFP 4 »

Annual card number ||

Annual card date due

Preferred payment method -

Free of charge
Protected identity Prohibit self check-in

¢ You can also change the default information for the client here.
¢ Free of charge, shows if the patient receives services free of charge.
* Protected identity, shows if the patient has protected identity.
¢ Prohibit Self-check-in, shows if self-check-in is allowed for the patient. Can be pre-
filled based on symbol or locked if the patient has protected identity.
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22 Documents and attachments

Click the button below to access our training materials.

You can write and store ad hoc documents, general letters and reports or set up templates for
these documents. The documents can be saved in the database under the client's registration
number instead of in separate files.

There is an optional extended licence for this module called File attachments, which enables
you to create file types as well as upload and download documents of any format.

The user access to the document types is defined by the settings for the individual user in the
system administration. The rights are Read, Create and Update/Delete.

A separate document database can be specified by the System Administrator.
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22.1 How to handle Documents and attachments

* Press F3 to search for the client or Ctrl+F3 to make a quick search.

¢ Go to Navigation -> Documents and attachments or use the shortcut Shift+Ctrl+U.

¢ Your System Administrator configures what rights you have within this module. You either
have rights to Read, Create and/or Update/Delete per document type. For that reason,
some of the features might not be available to you.

¢ While you have a document open, you are still able to browse through other Auditbase
screens.

¢ When editing only one document can be open at a time.

Note: with the extended license File attachments, you are able to upload documents of
any format type such as .jpg, .pdf and .bmp files, and you will be able to filter documents
on File type.

o) Auditbase - [Documents and letters] — O x

File Functions

| Client  <T>T18765 MR JOHN SMITH - & Z | Bl|user SYSTEM ADMINISTRATOR All locations ¥ All departments - ?

Document type: %‘Leﬁertemplales - Al A Save filter =

File type: All - Upload Download

K
i
(8|
=1l
4

Created |Sent|Mo.| MWodified Mame / Comments File type Appointment| Recipients| Site name ~
1 ord d

02 ] Expedite enguiry reply

E=] 23M212014 1 | 16M2/2019 testtemplate MS Word document
EE 231212014 2 test template2 MS Word document

HE G 19/02/2015 1 |21/04/2015|19/02/2015 all variables MS Word document
E=] 05/03/2015 1 | 05/03/2015 Monitoring report MS Word document
= 01/04/2015 1 Sample.pdf Adobe PDF

HE G 2710412015 1 test template 27/04/2015 MS Word document

HER 30/04/2015 1 test 30/04/2015 MS Word document
EE 22/06/2015 1 testr MS Word document
B E 28I09/2015 1 01AudVars MS Word document
E=] 29/09/2015 1 Postcode and Location address MS Word document
EE 29/09/2015 2 1 Address MS Word document
B E 20/09/2015 3 2address MS Word document
E=] 221012015 1 | 22M10/2015 audiograms and address MS Word document ™

Recipients of the highlighted document

Type Mame

Client

All rels. and other contacts marked as CC

All professional contacts

Document types

All documents are divided into Patient related documents or Templates. The specific document
types are set up in System Administration. A document can also be saved with a patient record.
Patient related document types can be a letter type or a document and attachment type.
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Templates can also be either a letter template or a document and attachment template. All of
this is set up by your system administrator.

If the Location and Department Filtering option is licensed then Document Types can be
filtered by Location and/or Department with Location groups and the multiple locations
options.

A Document Template can have a Location and/or Department which is used for filtering only
in the Letters dialog.

Document types are identified by an icon:

%Leﬁertemplates -
o=IP-NR

[22] STANDARD

o< client letters

N

Letter templates
[22] IMP information
C':-Z'Dnctype 3

L)

@ Doctype 4
g’zlmpnrted

All clients” documents
All template documents

g7

& Patient related documents

Letter templates

@ Document templates, not letters

Filters

¢ The documents listed are the currently available templates or patient related documents
and saved letters.

¢ You can filter on Document type (patient related or template) and on Letters or Docs
and attachments.

¢ You can also filter on File type if you have the extended license for File attachments.

¢ You can save a default filter, so you only view the documents relevant to you when
opening the module. Choose relevant Document type, whether to view Docs and
attachments, Letters or All, File type, if applicable, and press Save filter. This will be your
default view when opening Documents and attachments in the future.

¢ Filters are included to view All client's documents or All template documents,
regardless of their Document Type.
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Icons and columns in the document list table

Indicates if the document is a letter.
Indicates if the document has content.
Indicates if the document can be edited.

2 60 [ [

Indicates if the document is read-only.

Date created The date on which the document was first saved

Will be filled automatically for letters with the date sent where the
sent date is recorded. For documents that are generated in the
Documents module and not as a letter, this can be added to the
document by opening Properties and entering a date.

Date sent

Date modified The date on which the document was last changed.

If the document was saved from a letter about an appointment,
that appointment is the one that appears here.

If the document was saved from the Documents module, then any
appointment that happened that same day is the one that
appears here.

If only one appointment occurs for the client that day, and the
appointment start time is earlier than the current time, then the
action will be attached to that appointment.

If the doc was saved from the Documents module but no
appointment happened that day, then no appointment will appear
here. You can link the document to an appointment by opening its
properties and selecting the browse button and Attach.

Appointment

Enter name and/or comments directly in the table by clicking in

N
ame/Comments the field, which will open up an editable text area

Recipients

You can see who have received the highlighted document in the lower table. Highlight a letter or
document in the selected patient’s letters and the table ‘Recipients of highlighted document’ at
the bottom of the screen will display all those recipients the letter/document was sent to. The
relevant icon will be marked, denoting whether the letter/document was posted or emailed.

Edit the properties of a document.

22.1.1 Create and edit document templates

¢ To create a new document template, first select a template document type as your filter
and click on New. New document templates will be created as DOC or DOCX depending
on the settings in the Administration tool.

¢ To edit a template, choose the document in the list and click on Edit template. Enter a
Name and/or add Comments for your template.
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¢ Set up the document as you need with variables and layout.

e You can insert variables in the Word template in 3 ways:

¢ Place the cursor at the required position in the document and double-click on the variable

¢ Place the cursor inside the document and click on Insert variable

¢ Click and drag the variable into the required position in the document - it is important
that you hold the mouse still above the variable before you click and drag the variable
into the required position

« If the Clinical action for documents has been activated by your System Administrator and
there is only one appointment on that day, the attachment will be made automatically. If
there is no appointment or more than one then a box will appear asking you to Attach the
document to an appointment. Select the required appointment and click Attach. If it is
not relevant to attach an appointment, click Close to close the window without attaching.
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ME JOHM SMITH >

1300142020, 2 E

g

Mame f Comments

Expedite enquiry reply -

[y ]

av

(57}

as new document of type
@ .
o= client letters -

Send .. Save andclose Cancel

g

Variables

[ Appointment data I
[* Client data

[ Currentissued accessories

[ Currentissued devices

[F1 DHI questionnaire results

[*1 General information

[ Implant data

[F] Latest audiogram data

[ Latest tympanometry data

[*] Letter specific information

[ Multi-resurs avtal

[F] Relevant referral data

[ Selected AB Words test 1 data

[ Selected AB Words test 2 data

[ Selected AB Words test 3 data

[ Selected AB Words test 4 data

[ Selected AB Words test 5 data

[ Selected AB Words test 6 data

[ Selected Audiogram&Tymp 1 data

[ Selected Audiogram&Tymp2 data W

Insert variable Insertvalue

oy
el

This box can be minimized or maximised by two levels if the button is selected.

¢ When finished with your document, click on Save and close and the file will appear in the
list of documents.

» To close without saving, click on Cancel.

¢ You will be prevented from saving the document if the size exceeds that allowed by your
system administrator.

¢ You can also edit the name of your document directly in the list of documents in the
Name/Comments field.
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¢ Decide or change the default template document type for the document to save to when
applied to a patient. Highlight the document template in the template list. Click
Properties. Select the Default type for client document from the drop-down list. Click
Save. When you now apply this document template to a patient, the document type it
saves to will default to the one you have selected.

¢ Via Properties, you can optionally choose the Location and Department that can use this
template. Also, you can specify the modules where the document template will be
available for usage by selecting the corresponding boxes in the Available in box.

¢ On emailing multiple recipients, you can choose to send a single email or separate
emails for this document template.

Document, attachment and Letter properties X
Save Cancel
Read only The document is a letter M Contentis available File type Word document
Documenttype TEMPLATE Letter templates
Description Letter Template
Date 08/09/2022 | Defaulttype for client document | o= LETTER - Available in Module -
Location All locations - ¥ | Booking
Department All departments - I | waiting list
[ | Referral receipt
¥ | Onward referral v
Recipients Add Remaove
Type Name
Client

All rels. and other contacts marked as CC

Highlighted recipient
Name Postcode

Address

On emailing to multiple recipients Send single email hd

o After a new client document or template is created, the Document list will refresh to show
the new document according to the sort order.

Note: Occasionally you may have a Word dialogue box open in the background. If the floating
dialogue box does not close after you think Word has closed, check your Windows task bar to
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see if a Word dialogue has been left open. If it has, close this, the dialogue will then close
correctly.

22.1.2 Turn templates into patient related documents

* To edit a template for a client and attach the document to the client, choose the template
in the list and click on Open for client or double click on a template. This will open the
template for the active client only.

¢ New client documents will be created as DOC or DOCX depending on the settings in the
Administration tool. File type description on the File type column will be taken from the
Attachment file types setup in System Administration.

« |f the Clinical action for documents has been activated by your System Administrator and
there is only one appointment on that day, the attachment will be made automatically. If
there is no appointment or more than one, then a box will appear asking you to Attach the
document to an appointment. Select the required appointment and click Attach. If it is
not relevant to attach an appointment, click Close to close the window without attaching.
This set up will be required if appointment variables are to be used in documents.

Attach appointment to document >
Attach Close
Date | Symbnl| Description Resource Status L]
16/01/2020 EH SAV ENT auq Charlie *
13012020 [m] EMT new pa) Stassy *
13012020 | I |from1 Resd6 *
13/01/2020 )
100012020 3 PHAC new p Charlie *
1040172020 1 1 Charlie * v

e [fthe variable is linked to a selected clinical action e.g. BKB test, Audiogram or
Tympanogram, then the document will request the Auditbase user to select the correct
action for the variable being inserted. A selection dialog for this will appear on screen (if
opened for a patient) with the list of related actions:
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Select audiogram 1 d
Select Close
. | Audiogram Date |N|J.| Signed| Type |Cumrnents| Previewl Su A
E Audiogram changed in AB 1040142020 1 Preview
E AuditBaze audiogram 1032019 1 =igned Aided Preview
= AuditBaze audiogram 210205 2 Preview
= AuditBase audiogram 2102015 1 Prewview
= AuditBaze audiogram 20092015 1 Preview
E Audiogram changed in AB 25/0%2015 &  signed Preview
El Hew Audiogram 250082015 7 Prewview
E OTCO=uite Audiemetry - Audiogram 25032015 & Preview
E New Audiogram 25/092015 5 Preview
El New Audiogram 250082015 4 Prewview
= Hew Audiogram 250%2015 3 Previgw
= AC440 measurement 250802015 2 Preview
El Audiogram 250082015 1 Prewview
= Hew Audiogram 24/0W201% 2 Preview
= AuditBase audiogram 240802015 1 Preview
= Audiogram not linked to NOAH 22062015 1 Prewview
= AuditBase audiogram 18/08/2015 9 Preview
= Audiogram not linked to NOAH 18062015 8 Prewview
= Audiogram not linked to NOAH 18062015 7 Prewview
E Audiegram changed in AB 180642015 & Preview
E Audiogram changed in AB 18/06/2015 5 Preview
E Audiogram changed in AB 18/06/2015 4 Preview v
= A e e e e i s -
< >

The above box will appear for Audiogram and Tympanogram information.

Select tests for attachments

Test | [Dateoftest| | Details | Result|Test Condition

= BKB test|[]
[/ 01/04/2015 | | L: HAT, R: 0%
[/ 09/01/2020 | L:HA1, R: HA1 56% |Audition +lipre

The above box will appear for BKB tests.
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e The Type has now changed to a Patient related type, which you can edit to other Patient
related document types, and you will see the client name at the top of the floating
dialogue.

¢ The variables within the floating dialog are hidden unless expanded. To expand click the
down arrow and a list of available variables will appear. Keeping them hidden by default
will make this dialog open quicker, the system will remember the previous state.

e Enter a Name and/or add Comments for your document.

¢ Make changes to the layout of the document as you need.

¢ You can insert values in the Word document in 3 ways:

¢ Place the cursor at the required position in the document and double-click on the variable

¢ Place the cursor inside the document and click on Insert value

¢ Click and drag the variable into the required position in the document - it is important
that you hold the mouse still above the variable before you click and drag the variable
into the required position.

¢ If the template contains the audiogram graph variable or tympanometry graph, a window
will open to allow the user to select which audiogram is to be used. The number for the
audiogram variable (there can be up to four) will appear at the top of the Audiogram List
dialog.

¢ Click Send and the document will print according to the options set by the System
Administrator or email to recipient's dependent on your preferences as set in system
administration or on the recipient.

e The document will either be sent to the default Windows printer or a message will appear
where you can choose printers, number of copies etc. This depends on the setting for the
workstation in Auditbase Administration.

Print by
Prirter
Mame: IOneMote - Properties...
Status: Ready

Type: Microsoft Software Printer Driver
Where:  Microsoft.Office.OneMote_16001.12527.20128.0_x64__ Bwelyb3d8bby

Comment: [ Print to file
Prirt range Copies

Al Mumber of copies: m
" Pages from:|1 to:

-
- 11 212l 3|3

QK | Cancel

¢ To change the preferences for this document as a one off, click the browse box next to
Send. In the pop up that has now opened, change settings between email or print as
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needed. Select or de-select available recipients and change whether document should be
sent as an attachment or in the body of the email.

 [f creating a patient document from Letter, the document will go into the body of the
email whereas if creating from the Document module, the information goes into an
attachment.

¢ Use the printer icon at the top of the floating box to print just one copy of the document.

¢ When finished with your document, click on Save and close and the file will appear in the
list of documents.

¢ To close without saving, click on Cancel.

¢ If you close Word without saving, you will be asked whether you want to save the

document or not.
Microsoft Word

Want to save your changes to AB[7]?

- —

If you dick "Don’t Save’, a recent copy of this file will be temporarily available.
Learn maore

Save Don't Save Cancel

s

e Select Save or Don’t Save as appropriate. Either of these options will close the
document. If you want to go back to the document, select Cancel

e To print a single copy of a document without opening the document, highlight the
document in the table and click the Print once icon on the ribbon (Functions tab).

e To print and/or email a document according to recipient option or to display dialog for
print and/or email, highlight the document in the table and click the Send icon on the
ribbon (Functions tab).

22.1.3 Turn document templates into letter templates and vice versa

You can convert an existing document template into a template that can be used for letters with
a CC list and variables pertaining to a future appointment.

¢ First an existing or a new document template type needs to be defined in System
Administration as Letter templates. In the Documents and attachments module, select
the template type that the document template is in.

¢ Choose it and click Edit template.

e Check the box in the MS Word assistant floating dialog to Save as a new document.

¢ If a new Template type is being used for letter templates then choose that from the
Template drop down list.

e Save and close the document.

e The new letter template will now be available in the Letter module from Booking ->
Functions -> Letters where CCs can be added.

You can also build a Word letter template in Booking -> Functions -> Letters and save that
letter template to Documents.
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Note that a CC list cannot be used on Templates in the Documents module; in Documents, you
can neither add CCs to Templates nor see Recipient types in Templates saved from the Letters
module.

If you need to have CCs in the Documents module you can do the following;:

e A CC list can be built for a Client letter in Booking -> Letters, either from the pre-set
recipients in a letter template or by adding named recipients to the letter. If this letter is
saved to the Documents module the recipients are seen there and can be printed from
the floating Word dialog using the Print to all CCs button at the bottom. The letter can be
further edited in Documents and then If Read only is set it must be removed in order to
add further recipients.

¢ Alternatively, a Document can be made either from a Document template or from scratch
and specific recipients added to that individual document for printing by opening the
Properties window for that doc.

Note that unlike the Letter module there is no facility to print address labels for recipients in the
Documents module.

22.1.4 Edit patient related documents

Edit

* Chose a patient related document in the document list.

¢ Click on Open for client or double click on a document to edit it.

e Edit Name and/or add Comments for your document.

¢ Set up the document as you need with variables and layout.

¢ You can insert variables in the Word document in 3 ways:

¢ Place the cursor at the required position in the document and double-click on the variable

¢ Place the cursor inside the document and click on Insert variable

¢ Click and drag the variable into the required position in the document - it is important
that you hold the mouse still above the variable before you click and drag the variable
into the required position

* Instead of inserting variables you can insert the current values of the selected client.
Either chose a variable in the list of variables and click on Insert value or click on
Replace all variables with values to edit the whole document at once.

¢ When finished with your document, click on Save and close and the file will appear in the
list of documents.

¢ To close without saving, click on Cancel.

22.1.5 Issues working with Word

Cannot open a document
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If the system cannot open a template or substitute variables with values because of
unexpected technical reasons, it opens MS Word (so that you can see any problems there) and
shows a message about the inability to read content, with the options Retry, Ignore, Abort.

Message

Cannot process an open Document

Abort Bletry lgnone

Ignoring the error may allow Auditbase to produce a correct document using a slower but more
robust way of population.

Cannot save a document

If the system cannot save a document because of unexpected technical reasons, it displays a
message with an option to retry (e.g., if more time is needed for Word to save). You can either
retry or cancel saving.

Message >

Cant save to afile
CiUsers'\User'AppDatatLocal Temp'AB docx

Betry Cancel

If you cancel the action, then it is possible to copy the edited content or save and upload the
document manually.

Losing saved changes

Changes will be lost when you open a document in Auditbase, make changes, save those
changes to a location outside of Auditbase and close Word by any method without saving those
changes also to Auditbase. This happens because the document location has changed. If a
document opened from Auditbase is saved from MS Word to a different location, then the
button Save and close in the Word Assistant floating window must be used to save the
document to the Auditbase database if changes are to be retained.

Mame / Comments

Westibular Report Template

Save as new document of type

aZIP-NR

Send .. | Save and close | Cancel ¥
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Just closing MS Word will not save the latest changes to Auditbase if Save as has been used to
change the save location of the document.

Document locking

Sometimes, while working with Word documents, you may encounter an unwanted lock on a file
when a document is edited outside of Auditbase. In this case, the system will display a warning:

'Please close all Word windows or applications that may be using Word before proceeding'. To
resolve the issue, close all Word windows or applications.

22.1.6 Edit the properties of a document

e When you have a document selected in the list, select Functions -> Letter Properties.

Document, attachment and Letter properties

X
S ave Cancel
Read only The document is a letter B Contentis available File type Word document
Description audiograms and address26 -
w
Type P-MNR Date 26M0/2015
4+ | When a letter is generated from Booking, it is automatically linked to the appointment it
2| refers to. Adocument is automatically linked to an appointment which occured on the
same day the document was first saved. Date sent
Recipients Add Remove
Type Mame Address Postcode |£
Client FATHER. FNAMEZ21 SMNAME12 TESTADDRESS 1231111111111 1111111111112, 112, 4,5 | EM POST
Maother Mrame testAddress1 112
Father FMAME 3 2
Father 1

1 1

<

Highlighted recipient

Name Postcode

Address

e Here you can see different information about the document such as file type, if the
document has content, creation date etc.

¢ You can also set if the document should be Read only, which means other users cannot
make changes to the document. A user can only remove this flag, if he or she has the
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extended user right “Documents: Remove ‘read only’ flag”, configurable by your System
Administrator.

¢ You can choose if The document is a letter. In the document list, a letter icon with a tool
tip to the left will reveal that the document is a letter.

¢ You can enter a Description of the document, if it is not Read only.

¢ Aspecial button is available for attaching the document to or detaching it from an
appointment. The button has a symbol which reflects the state of the document: either

oD C+D
( (=)

attached ) or not attached . In addition, the button has a tooltip that displays
detailed information about the document linking.

NOTE: The document is automatically attached to an appointment, if the document was
saved from a letter about the appointment. If the document was saved from the
Documents module, then any appointment that happened that same day that has the
appointment start time earlier than the current time is the one that the document
automatically attaches to. If the document was saved from the Documents module but no
appointment happened that day, then no appointment will appear here.

+ Date is the date the document or letter was first saved.

¢ If the document or letter is a patient related document or letter, you will see a Date sent
field. This is the date the document or letter was printed and thereby sent. You can
manually add a date, if the document has not been sent.

Recipients
Note: You can only add recipients to patient related documents and attachments.

To edit an existing letter, you need the extended user right given by your system
administrator to add or remove letter recipients after creation.

¢ To add recipients, click on Add.

Add recipient >

Add Cancel

Select recipient

W Client

B Referral referring agent

W All relatives and other contacts marked as CC

W All professional contacts

B Specific professional contact type Registered Practice hd
B Specific referring agent

(W] :Specific relative or other contact: Mather -

¢ You can add the selected Client.
¢ You can choose to add All relatives and other contacts marked as CC in the Client
information module under the tab Contacts.
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¢ You can add All professional contacts.

e You can add just a Specific professional contact type.

¢ You can add a Specific referring agent.

¢ And you can add a Specific relative or other contacts, even if they have not been
marked as CC in the Client information module.

e Back in Properties, you can remove a recipient or recipient group by choosing the
recipients in the list and click on Remove.

e Highlight a letter or document in the selected patient’s letters and the table at the bottom
of the screen will display all those recipients the letter/document was sent to. The
relevant icon will be marked, denoting whether the letter/document was posted or
emailed.
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22.2 Importing and exporting documents

Word documents created outside Auditbase can be pasted into Auditbase as templates or ad
hoc documents.

Open a new document in Auditbase under the document type required.

Go back to the start menu on your desktop and open your normal word-processing
document.

Choose Edit and Select all.

Choose Edit and Copy.

Click on the minimised Auditbase document at the bottom of the screen.

Choose Edit and Paste.

Select File and Exit and click Yes to save.

Type the letter name in the Name/Comment field.

Close your other word-processing document.

Extended license: File attachments

If you have the extended licence called File attachments, you can upload documents in any kind
of format, like .jpg, .pdf etc., by simply using the Upload button.

Open Documents and attachments from Navigation -> Documents and attachments or
use the shortcut Shift+Ctrl+U.

Select Upload.

Choose files you wish to import in the file directory. Multiple files can be selected.

The Files chosen for upload are shown in the window.

The Document type where the chosen files will be stored to, can be selected from the
drop-down list.

There are two further options to Attach to appointment and to Delete file(s) after
upload. These are check boxes which can be selected.

Once the choices have been made, OK will then close the window.

The document is now imported into Auditbase and attached to the current patient.
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Select files and options for uploading x

Files chosen for uploading Choose files...

Cilsers\ANDSHUNDesktop\DocumentTemplate.bd
ChilUsers\ANDSHU\Desktop\Formats02AudSample.nhax
Cilsers\WNDEHU\Desktopimpedance Standard format 100 pdf

Document type ,Q.El P-MNR -
M Attach to appointment 28M2/2018, 08:00-08:30, *, MALMESBURY ENT a1

Delete file(s) after upload
Ok Cancel

With the File attachments extended licence, you can also download documents from Auditbase

to your computer.

e Open Documents and attachments from Navigation -> Documents and attachments or

use the shortcut Shift+Ctrl+U.
¢ Highlight a file in the list.
¢ Select Download.
¢ Choose where to save the file.
¢ Enter a file name.
e The document is now exported from Auditbase.
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22.3 Password protected documents

You can limit access to a word-processing document:

¢ Type the document.

» Select Tools -> Options -> Security.

e Set a password to avoid unauthorised access to the document or edition of the
document.
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23 Tests

Creating a new test
A new test can be created in one of two ways:

¢ From Navigation, select Tests and then select the required test.

¢ From the Auditory Implant module - Expand the referral then expand a stage. The
predefined tests will be displayed. Select the required test. The order of the tests is based
on the priority order in the System Administration tool -> Client Scheduling -> Client
pathway overview settings -> Auto-linking settings and ordering.

Each test has a similar header comprising of:

 Compare results - Select to enable a comparison of test results. Tests with scores which
are available for comparison over time can be selected according to the date they were
performed and the score type in use on each test can be selected for plotting. Only one
test from any one day can be used since the comparison is always over time.

¢ A number of variables can be selected and a graph displayed. This option is for the
following tests only:

¢ BKB test

« BKB Sentences (Adaptive or Standard)

¢ AB words test

e CUNY test

¢ New - Select to create a new test.

e Save - To save the current test.

¢ Delete - Will remove the selected test from the database.

¢ Close - Will close the test without saving it.

» Tests - A drop-down menu which shows existing instances of the test for the client.

¢ Created by - Will display the name of the logged-on user that created each instance of

the test.
» Date of test - Defaults to the highlighted date, but can be adjusted to reflect the actual
date of the test.

» Age at test - This is calculated and fixed when saving so that the age will be displayed
whenever the test is shown. The age is shown in years unless the patient is less than 5
years old, when years and months are shown.

¢ A special button is available for attaching the test to or detaching it from an appointment.

( (o, =)

The button has a picture which reflects the state of the test: either attached ) or not

+
attached ( == ). In addition, the button has a tooltip that displays detailed information
about the test linking.

NOTE: If only one appointment occurs for the client that day, and the appointment start
time is earlier than the current time, then the test will be attached to that appointment.
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* Referral stage - This displays the stage in the referral that the appointment is in
currently, if a stage can be identified.

» Test ver. - Shows the version of the test being used, the default for this is set in the
System Administration and can be changed when a new version or edition is released.
This means that when auditing test results you can be sure that you are comparing like-
with-like. The version can be changed when any test is performed so that non-default
versions can still be used.

* Not administered - a reason can be selected to record why a particular test was not
performed. The drop-down list can be defined by the System Administrator.

For individual tests where percentile is in use, the percentile rank field will take values of -1 and
99+ as well as numeric values. These values are held in the database but values of O and 100
are also stored in order to enable plotting graphically.
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23.1 CELF school age test set up

The CELF school age test can have different layouts; Concise, Extended, Extended with
limited number of values or Test Scaled Scores. The required layout is selected in the System
Administration tool -> Testing -> Test settings -> General test settings.

470
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23.2 Other speech test

After a hearing assessment, you can do other speech tests to verify primarily special hearing
aid types. In the Navigation area, under Tests, select Other speech test.

Other speech test *
Client MRS FIRSTHAME 106 LASTMAME 106 Print Sign Mew Save Delete Close
Tests 211002015, 7 ~ Created by full name tests??7? -
Date oftest 2110/2015 Age attest 26y oo Referral stage Appointmentis not linked to referral

B Mot administerad Mon English speaking1 ~| Operative Pre-operative «

Add Edit Eemove

Test |List| Audiovisual | Direction | Reliablel Result | Level | Moise HI status R | HI status L Comment Te:
Testtype’1 | Audiovisual TestLeftD Yes -99.9 150de |10 dB Unaided112 HA1 test comment Total
< >

Click on Add to register a new test; a pop up will open. Choose from the drop-down lists and
enter the results directly into the different fields. Some column content is configured by your
System Administrator.

Once a test has been registered, you can edit or remove the test by highlighting it in the table
and clicking either Edit (which opens a pop-up window for editing) or Remove (deletes the test
from the list). You can also edit the test directly in the table by clicking in each field.

You can Sign the test so that it is locked for editing, it cannot be changed apart from linking it to

an appointment.

The signed user appears on the window title bar.
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Other speech test - Signed by: SYSTEM ADMIMISTRATOR 13/01/2020 16:31:35, [Read only] it
Client MRS FIRSTMAME106 LASTMAME106 Print Sign Mew Save Delete Close
Tests 211012015, 7 » Created by full name tests?77 -
Date of test 21102015 Age attest 26y =o| Referral stage Appointment is not linked to referral
Mot administered Operative Pre-operative «
Add Edit Eemoave
Test |List| Audiovisual | Direction | Reliablel Result | Level | Moise Hl status R | Histatus L Comment Tes:
Testtype” 1 |Audiovisual TestLeftD| Yes -99.9 150dB -10dB Unaided112 | HA1 test comment Total
< >

The Notes field is for general notes about the client in connection with the tests and the field

Comments under each test refers to the specific test.
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24 Auditory Implant module

With an extended licence for Auditbase, you can have access to the Auditory Implant module,
which handles the workflow for Implant patients.
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24.1 Referral settings

A Treatment Type for Implant needs to be set up by your System Administrator. Please contact
your System Administrator for more information.

The Referral Module now shows a client’s age in years. If the client is under the age of 5, the

age is shown in years and months.

Referral overview || Client's referral | Referral answer | Clinical actions

Referrals: 95061, 30/09/2008, PAEDIATRIC hearing aid journey (PHAC = Client name MISS FIRSTNAME1605 LASTNAME1605 Refresh Ca

Book Search and book Add to list Add observation Print referral Print receipt Print answer Mew Save Delete
Selected referral
PathwaylD || Edit Waiting list entries Aftach Detac Ec 5 vaiting lis
RTT start date 30/09/2008 Age at start 18y Waittime 104 Wait time Date Waiting list Informati
Referral date 30/00/2008 Other date 30/09/2008 -506 30/09/2008 | TGW - DOMI new 1 2y review - during Uni summer break
Treatment type PAEDIATRIC hearing aid journey (PHAC) -
Reason AUDIOLOGY referral -
Customer SWINDOMN PCT v < =
Referred by REGISTERED PRACTICE, MARLBOROUGH SURGE | ..\ Appointments Aftach D Ed 5 B g

Referring agent ref.

Medical priority -
Referral handling -
Information Put on waiting list Booked directly Edit
2y review - during Uni summer break -
b
Interview Client contact date
brnmv -
b
Registered by ALISON STAGG hd
Current status
Outcome 30a, Treatment commenced Clock | Stopped
since 05/03/2020 11:48:17 Addnew | History

Comment  Auto assigned by: 05/03/2020, 30a, PHAC new patient mould~

Mew outcome status 303, Treatment commenced -

Date | Time | Symbol | Statug

Resource

06/03/2020 |13:00| I * |Stassy
05/03/2020 |08:00| D¢ * |Res78

AUDIOLOGY re
AUDIOLOGY re

< >

Observations and procedures Ed
Obs no. | SNOMED code |  Date  |Add|s| Text
< >

Referral stages

Name Targetdateandwarnings|Current ~ Active length:

Assessmen 10/11/2008 O
Treatment |30/M12/2008 O
Follow up

RTT end date:
RTT end date set by outcome status

596w, 2d
05/03/2020

30a, Treatment commenced
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24.2 Opening the main Auditory Implant module page

To open the main Auditory Implant module, Navigation — Client pathway overview. The views
are described in more detail in the Client pathway overview.

<) Auditbase - [Referal] - o X
File View Functions
E Client  T1106 MRS FIRSTNAME106 LASTNAME106 - R|Z Bl|user SYSTEM ADMINISTRATOR All locations ~ | All departments - a 9
Navigation R Clients referral | Referral answer | Clinical actions
- Favourites -
I 5\ Referral Referrals: 109547, 15/08/2019, ++FITTING - from previous referral Clientname MRS FIRSTNAME 106 LASTNAME 106 Refresh Cancel
i--£f] Documents and attachments
| P Waiting list Book Search and book Add to list Add observation Print referral Print receipt Print answer New Save Delete
5] 4B Audiogram Selected referral
i fi\. Attention list 4 PathwaylD Edit Waiting list entries Attach Detach Edit Show in waiting list
Client pathway view RTT start date 15/08/2019 Age atstart 30y Waittime Wait time Date Waiting list Informati
Full pathway - o Referral date 15/08/2019 Other date 15/08/2019
Treatment type ++FITTING - from previous referral -
~
TN Reason ++GP direct referral -

07/12/2018 ++FITTING - from previa Customer Auto-created customer with code IEMPTY! - I* z
2110812016 ,++AUDIO REVIEW reas: Referred by * DR CN BARRY, CORNERSTONE PRACTICE, STAT Appointments Attach | [ Detach Edit w in Booking
2211212015 ++AUDIO REVIEW reas: Dals [ Time Symbol[stau e
301112015 ++AUDIO REVIEW reass .

061112015 ++AUDIO REVIEW reass Medical oy e

H 08/06/2015 ++AUDIO REVIEW reas: Referral handling -
12i05/2015 ++AUDIO REVIEW reass S Edit
01/05/2015 ++AUDIO REVIEW reas: =~ < 3

28i04/2015 ++AUDIO REVIEW reas:s -

= ZUDAZ15 A-AUHO REVIEW reass Observations and procedures De{Click to sort column
i aimoar +svimie ¥ || Intenview SELEIIELEE Obsno. | SNOMED code |  Date | Add]s| Text
< > N
-
individual chen
2, Individual client
Registered by Oleksandr Pushchalo - < >
&5 Client pathway view Current stalus
E) Cii " Outcome  20a, Decision to treati@#§%*&*/?"  Clock  Counting Referral stages
inic managemen Active length 21w 4d
since 1510812019 16:36 Add new | | History Name [ Target date and warmings{Curent _ ~ g
Stock management R Treatment | 14/11/2019, Has been bre[4] RTT end date:
Followup  14/05/2020 O RTT end date set by outcome siatus
iq User tasks New outcome status 20a, Decision to treat!@#5%"&*/2\" - Completed O v
ppp PPPlist
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24.3 Opening other Auditory Implant Module pages

To open other pages in the Auditory Implant Module, select from the Navigation-> Implant —
choose which page from the following options:

¢ Pre-op assessment Form
Switch on / Review sessions
Programming sessions
Rehabilitation sessions
Implant surgery
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24.4 Pre-op assessment forms

This screen serves several purposes:

¢ Achecklist that can be used to ensure that all the necessary steps have been completed
before moving the patient to the next stage in their pathway.

¢ Acollector for the results that should be produced on the report for that stage.

¢ Aplace to record information specific to that stage in the pathway that is not recorded
elsewhere in Auditbase.

Pre-op assessment *
Client MRS FIRSTNAME 106 LASTMAME 106 Print - New Save Delete Close
Assessment 011042013 - Date 0110/2013 | [5] User full name tests?27? -

Funding authority  WILTSHIRE PCT - Referral  0310/2013, x DO NOT USE-VRA
Planned date of . ;
srET 03M0/2013 E Earside Right + Treatmentstage Follow up -

Essential | Optional = Decision | Final = Baseline testresults | Counszelling

Related data Clinician Concerns
Initial appt 01/10£2013, PHAC new patient mould~ JULIE TYAS ~ | Addconcern
PTA 27/09/2013, no. 1, Pre-operative -~ full name tests?7? ~* | Addconcemn
Aided Aud. 27109/2013, no. 2, Post-operative 2-6m | full name tests??7? ~ | Add concern
Tymp 30/09/2013, no. 3 - full name tests?77? ~ | Addconcemn
OAE ~ | Addconcern
Speech tests 30/09/2013, PHAC new patient mould-~ JULIE TYAS ... | Add concern
Hearing Aid trial 30/09/2013, 2 USER MAME32 ~ | Addconcern
Rehab assess 27109/2013, 2 USER MAME15 .| | Add concern
Medical history
CT Scan MRI Scan
B L B R M Head MRALLENPAUL ORALSURG| | /L W R M Head ANAESTHETIC CONSULTANT, | | M Scanshave been reviewed
031102013 [5] Add concern 04/10/2013  [5] Add concern
Concerns ShowAll | Remaove

Adi0n|00ncern descripti0n|8ide| Date|CIinician|User Comment
CT Mormal cochlea Right 0110 MR ALLE| full n: 234234
MR Absent cochlea Righy 01110 AMANDA full nz 123

The following options are available:

¢ New - Select to create a new test.

Save - To save the current test.

Delete - Will remove the selected test from the database.
Close - Will close the test without saving it.

Assessment - Displays a list of any previous assessment forms.

© Auditdata - 2025, ID: 20.0040/36 477



User Guide

» Date - Defaults to the highlighted date but can be adjusted to reflect the date of the
assessment either by entering the date manually or by clicking on the calendar icon to
choose a date from a calendar float-window. Double-click in the field to enter today’s
date.

e User - Will be the name of the logged in user.

e Funding authority - Will be the client’s customer but can be altered if required.

» Referral - The relevant referral for the client can be attached to the form using the
button.

If the referral does not exist or an existing one cannot be used, you can create a ‘quick’

referral by clicking the New button from the == button to the right of the Referral field.
See details in Quick referral creation.

¢ Planned date of surgery - The date for surgery can be entered manually or by clicking on
the calendar icon to choose a date from a calendar float-window. Double-click in the field
to enter today’s date.

o Ear side - Right, Left or Binaural can be selected. This is a mandatory field.

* Treatment stage - If a Referral has been selected above, the relevant treatment stage is
displayed here.

* DR-Med - itis now possible to create a new DR-Med questionnaire from the Pre-Op
Assessment form in the Implant Module.
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Pre-op assessment X
Client MRS FIRSTMNAME106 LASTNAME106 Print |~ MNew Save Delete Close
Assessment - Date  13/01/2020 E User SYSTEM ADMINISTRATOR -

Funding authority  SWINDOMN PCT - Referral
z:ﬁ;g;d EEE E Ear side ~ Treatment stage
Essential | Optional  Decision | Final  Baseline testresults | Counselling
Related data Clinician Concerns
Initial appt - | Add concern
PTA v | Add concern
Aided Aud. * | Add concern
Tymp - | Add concern
OAE v | Add concern
Speech tests Add concern
Hearing Aid trial * | Add concern
Rehab assess Add concern
Medical history
CT Scan NIRI Scan Stiach
L R Head L R By Scans have been reviewed
[=1 Add concern h Review/Edit Add concern
Concemns Eeasned ShowAll | Remove
Adion|Concern descripti0n| Side|Date|CIinician|User| Comment

There are a number of tabs which can be selected. These tabs show different information under

the following headings:

+ Essential

* Related data - Various tests and appointments that are stored in Auditbase can be
added including Initial appointment, PTA, Tymp, OAE etc. can be added to the form by

selecting the browse button. |-

¢ Clinician - The user that saw the client can be added from this drop-down menu.
Clinician can be used if Resource is not linked to a specific staff member and you want to
manually assign the staff member involved.

+ Concerns -

o Adding Concerns - These can be added to the form by selecting the Add concern
button. Once selected, the Concern name can be chosen from the drop-down
menu. The Type of action, ear Side and Date can be added and a Clinician should
be pre-selected from the appointment or test that the concern is logged against.
There is a text box for comments.
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° Viewing Concerns - The concerns from each tab are then displayed at the bottom
of each tab page. You can see the action the concern came from. Numerous
concerns can be displayed.

o Show all - All concerns can be shown regardless of which tab they were inserted
under.

CT Scan - It can be indicated if a left, right or head CT has been performed, on which
date and by whom. A concern can be added in the same way as above.

MRI Scan - It can be indicated if a left, right or head MRI has been performed, on which
date and by whom. A concern can be added in the same way as above.

Optional - Various Related data, Clinicians and Concerns can be added in the same
way as the essential tab.

Decision - Various Related data and data specific to the team decision and client’s
choices can be saved here. The implant decision or Discharge reason, Clinicians and
Concerns can be added in the same way as the Essential tab. In this tab, there is now a
section where multiple client preferences can be selected relating to their accessories.
Where these have been selected they will transfer through to the Client Information tab.

Client

MRS FIRSTNAME106 LASTNAME106 Print - Close

Assessment

Funding authority  SWINDON PC
Planned date of

surgery

Select stock preferences X

Select Cancel

Type |R| L| MName
Essential | Optional | Decision | 5. Cable O
= CIImE1oMR
Cl Clinic =8 ][] Danalogic 163D
TrTEET ; MO DANALOGIC 1630 White
Mok informat [ id 10368
sk imormation OO DANALOGIC 163D Red
Meningitis vaccination Magnet ITE10ML
Multi disciplinary team gl 1L
- Implant [ CIITETIMR
D;Tgf; e Processor |[][JITETML
RETIGTE Ear hook |[]J[JBE101
Battery type [][]BE101B
Client preferences Other LICIBE101G
= Colour |

Type|R|L| Name|

Concerns

Action| Concern description | Side|

¢ Multi-disciplinary team - Decisions made by the multi-disciplinary team can be recorded

including the date of decision and any Discharge reason.
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¢ Implant type - Right and Left are identical options. There are a number of options from
the drop-down menus. These are set up by the system administrator. These client
preferences are transferred to the Client Information module on the Implant tab. This is
done by selecting the Copy to Client Information button.

¢ Final - Various related data, clinicians and concerns can be added in the same way as
the Essential tab.

* Baseline test results - Tests performed during the stage can be selected. The results of
these tests will be the ones which are included on the report for that stage. Other
instances of these tests may have been performed in that stage which you may not want
to include in the summary. The tests will be grouped under the same test type and some
summary results will be seen. A New test can be created, the list of available tests and
any custom questionnaires will be listed and can be selected. The selected test or
questionnaire will open in a new window. Tests can be viewed by selecting a test and
choosing Open. The appropriate test will be displayed. Additional tests can be added
using Attach or removed using Detach. The order of the tests is based on the priority
order in the System Administration tool -> Client Scheduling -> Client pathway overview
settings -> Auto-linking settings and ordering.

e Counselling - Appointments are shown in chronological order with a series of counselling
topics which can be checked to show they have been covered. There are 4 user definable
topics that are set by the system administrator.

¢ Questionnaires - These can be added by selecting the button and attaching any
previously completed questionnaires.

e Concerns can be added in the same way as above.
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24.5 Switch on / Review sessions
This screen serves several purposes:

¢ Achecklist that can be used to ensure that all the necessary steps have been completed
before moving the patient to the next stage in their pathway.

* A collector for the results that should be produced on the report for that stage.

¢ Aplace to record information specific to that stage in the pathway that is not recorded
elsewhere in Auditbase

Switch on / Review sessions =

Client MRS FIRSTNAME106 LASTNAME106 Print |~ New Save Delete Close
Reviews 01/10/2013 - Review date  01M10/2013 User full name tests??? -
Treatment stage Completed - Referral  03M0/2013, x DO NOT USE-VRA
Purpose Switch-on/Reimplant ~| Upgrade due date 01/10/2013 | [ Earside Right -
kain data | Attached tests and other | Issued devices and accessories

Programming sessions Aftach | Detach MNew Open Rehab sessions Attach | Detach Mew Cpen

Date Purpose of session Date

01/10/2013 | Mapping requested 011052013

Middle ear status (Right) Middle ear status (Left)

Condition  Grommet - 54 Condition  Perforation + 49

Result Flat - Result Megative -

Programming summary Rehab summary

L} A |7 -

- -
Audiometry = e
Condition left ear Condition right ear

PTA Unaided112 w HA1 - 27/09/2013, no. 2, Post-operative 2-5m

AR Unaided112 * Unaided112 - 27109/2013, no. 1, Pre-operative
Preservation of hearing ‘None - ENTreview 1771002013 E AMAMDA CARROLL, MERCHISTO | ..
Expectations Q 15M10/2013 g LISER MAMES1.. » OtherQ 141002013 ﬁ LSER MAMEST.. A
Infarmation Pack  25/10/2013 g USER MAKMET9. - 30/09/2013, PHAC new patient mould~
Report Sent 191002013 ﬁ USER MNAKE42. -

There are the following options:

* New - Select to create a new session.

e Save - To save the current session.

* Delete - Will remove the selected session from the database.
* Close - Will close the session without saving it.
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* Reviews - Displays a list of any previous sessions.

¢ Review Date - Defaults to the highlighted date but can be adjusted to reflect the date of
the session either by entering the date manually or by clicking on the calendar icon to
choose a date from a calendar float-window. Double-click in the field to enter today’s
date.

¢ User - Will be the name of the logged in user.

* Treatment stage - If a Referral has been selected above, the relevant treatment stage is
displayed here.

* Referral - The relevant referral for the client can be attached to the form using the
button. This is a mandatory field; a referral must be selected.

If the referral does not exist or an existing one cannot be used, you can create a ‘quick’

referral by clicking the New button from the == button to the right of the Referral field.
See details in Quick referral creation.

¢ Purpose - The purpose of the session can be selected from the user defined drop down
list.

e The selection here will define which date appears on the Implant tab on the Client
Information screen. If Switch-on/Re-implant is selected, then the date on this form will
transfer to Latest Switch on date in Client Information.

* Upgrade due date - Can be selected from the calendar

¢ This date is calculated depending on the value of the field in the Administration tool
under Implant module definitions - General settings - General settings. It will add this
period to today’s date when opening a new form

¢ This date will be shown on the Client Information screen - Implant tab - Upgrade Due
date

e Ear side - Right, Left or Binaural can be selected. This is a mandatory field.

There are a number of tabs which can be selected. These tabs show different information under
the following headings:

e Main data - Multiple Programming and Rehabilitation sessions can be recorded and
saved. Any of these can be linked to a Switch-on/Review screen. They will be linked
automatically if they are opened using the New button on the Switch-on/Review screen or
can be attached after saving.

e Attach - Can be used to attach a Programming or Rehabilitation session. Once selected,
choose the required session and Select.

e Detach - Can be used to remove a selected Programming or Rehabilitation session.

* New - This will create a new Programming or Rehabilitation session.

e Open - This will open a selected Programming or Rehabilitation session for viewing.

¢ Condition - The condition of the middle ear can be selected from the drop-down menu
and further information can be added to the free text box.

¢ Result - Tympanometry results can be selected from the drop down menu.

* Programming summary - Additional information can be added to this free text box.

¢ Rehab summary - Additional information can be added to this free text box.
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Audiometry - Results from audiometry can be displayed.
° Condition left or right ear - The type of audiometry can be displayed by selecting
from the drop-down menu.

o

An audiogram can be selected by using the browse button .. This can either by
attached to the session or just viewed by selecting Show.

Preservation of hearing - This can be selected from the drop-down menu.

ENT review - The date of an ENT review and the name of the referring agent can be
added.

Expectations Q - The date and a user can be added to show when this questionnaire
was completed.

Other Q - The date and a user can be added to show when another questionnaire was
completed.

Information Pack - The date and a user can be added to show when an information pack
was given to the client.

Report sent - The date and a user can be added to show when a report was sent for this
client.

Attached tests and other - Once a review has been selected, any tests that have been
attached to that session can be observed.

Tests performed during the stage can be selected. The results of these tests will be the ones
which are included on the report for that stage. Other instances of these tests may have been
performed in that stage which you may not want to include in the summary. The tests will be
grouped under the same test type and some summary results will be seen. Tests and
guestionnaires can be added in the following manner:

New test - A list of tests and questionnaires will be shown. Select from the list and
complete the test then Save and Close.

Open - If a test is already attached, the test can be viewed by selecting the test and
choosing Open. The test will then be displayed.

Attach - By selecting Attach, all currently saved tests and questionnaires will be
displayed. Check the required test and Select. These will then be added to the session.
Any test or questionnaire can be removed by selecting it and then using the Detach
button. Tests can be viewed by selecting a test and choosing Open. The appropriate test
will be displayed. Additional tests can be added using Attach or removed using Detach.
The order of the tests is based on the priority order in the System Administration tool ->
Client Scheduling -> Client pathway overview settings -> Auto-linking settings and
ordering.

Issued devices and accessories - Once a review has been selected, any stock articles
that have been attached to that session can be observed. Articles can be added in the
following manner:

Issue device - A search dialogue will be shown.

° Add a serial number or article name to the search fields. Please note that
these fields are case sensitive.
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° Articles can be filtered using the Default filter view button. By selecting this,
options are shown for various Articles and Stock Types.

° Select Search.

° Select from the list ensuring the left-hand column in the table is checked and
then Issue.

° A New status for serial number: XX or New status for quantity controlled
article: XX window will appear.

° Select a Location if relevant.

° Select the new To stock type.

° Depending on the selection, a number of other fields will need to be
completed in the same way as for issuing an article from the Stock module
directly. Once the options have been selected, select OK.

° The selected article will now be included in the table.

NOTE: Changes in device statuses create clinical actions. If you have attached them to
appropriate appointments, they can be seen on the Clinical actions tab of the Referral
module.

e Attach - By selecting Attach, all currently issued articles will be displayed. Check the
required article and Select. These will then be added to the session.

¢ Articles can be removed from the list by using the Detach button.

¢ Warranty registration - A Right and Left check box are available to show that the
warranty registration for an implant has been sent back to the manufacturer.
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24.6 Programming sessions

This screen serves several purposes:

¢ Achecklist that can be used to ensure that all the necessary steps have been completed
before moving the patient to the next stage in their pathway.

¢ Acollector for the results that should be produced on the report for that stage.

¢ Aplace to record information specific to that stage in the pathway that is not recorded
elsewhere in Auditbase

Prograrmming sessions *
Client MRS FIRSTNAME106 LASTNAME106 Print New Save Sign Delete Close
Sessions 01/10/2013 - Session date  01/10/2013 E oo User full name tests??? -
Purpose of session  Mapping requested - Referral stage  Assessment
hain data | Additional data
Processor (Right) Processor (Left)
Processor type - Magnet strength, M - Processor type - Magnet strength, M -
Actions performed (Right) Actions performed (Left)
Electrode mapping Accessories fitted B Electrode mapping B Accessories fitted
FM/Radio aid Repairs B FW/Radio aid B Repairs
Device instruction Implant site checked B Device instruction B Implant site checked
Other Other 2
Mapping details (Right) Mapping details (Left)
Neural responses Al - Impedance testing MotWithin normal range »  Meuralresponses  Some - Impedance testing |Within normal range -
Comfort levels All - Balancing Comfort levels Some ~ W Balancing
Threshold levels Al - Interpolation Threshold levels Some ~ W Interpolation
Electrodes activated Electrodes deactivated M Electrodes activated M Electrodes deactivated
Electrodes deactivated Electrodes deactivated
MNumber Electrode reason ~ MNumber Electrode reason ~
1 ART shows no nerve response 2 Disturbing overall sound impression
2 Extra Cochlear
3 Excessive noise
v v
Electrodes inuse 3 Electrodes in use (previous) Electrodes inuse 4 Electrodes in use (previous)
Comments Comments
5 G
Information
7 -
b

Multiple instances of Programming screens can be recorded and saved. Any of these can be
linked to a Switch-on/Review screen. They will be linked automatically if they are opened using
the New button on the Switch-on/Review screen or can be attached after saving using the
Attach button.

New - Select to create a new session.

Save - To save the current session.

Delete - Will remove the selected session from the database.
Close - Will close the session without saving it.

Sessions - Displays a list of any previous sessions.
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» Session Date - Defaults to the highlighted date, but can be adjusted to reflect the date
of the session either by entering the date manually or by clicking on the calendar icon to
choose a date from a calendar float-window. Double-click in the field to enter today’s
date.

e User - Will be the name of the logged in user.

» Purpose of session - The purpose of the session can be selected from the user defined
drop down list.

¢ Aspecial button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either

iy +

attached ( == ) or not attached (ED ). In addition, the button has a tooltip that displays
detailed information about the session linking.

* Referral stage - This displays the stage in the referral that the appointment is in

currently, if a stage can be identified.

There are two tabs which can be selected. These tabs show different information under the
following headings:

* Main data - A number of check boxes, free text boxes and drop-down lists can be
selected. The drop-down lists can be defined by the System Administrator. In this section
the Processor type has now had Hearing Aid added, as this particular drop down is hard-
coded it is only possible to have changes made by the developers.

* Areason for electrode deactivation can be added by clicking in the Reason field under
Electrode reason and selecting from the drop-down list. The reason lists can be defined
by the System Administrator.

* Electrodes in use - The current electrodes in use can be entered into this box. The
Electrodes in use (previous) box will display the previously saved figure. The number of
electrodes entered can be up to twenty one.

¢ Additional data - More information can be added to the number of free text boxes and
drop-down lists.

e Program - Is a free text box.

» Strategies and Add-ons are drop down lists configured by the System Administrator.
Where more than one Add on is in use for a Strategy, that Add on pair can be defined as
a new one by the System Administrator.
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24.7 Rehabilitation sessions

This screen serves several purposes:

¢ Acollector for the results that should be produced on the report for that stage.
¢ Aplace to record information specific to that stage in the pathway that is not recorded

elsewhere in Auditbase.

Session content or aim

B Assessment(screening orformal) Session details
B Counselling 1
B Advising

B Rehab

B Coaching/demonstrating Goals identified
B Goal Setting 2

M Speech Tracking

B Closed set (multiple choice)

M Open set Management plan
3

B Musictraining

B Telephone training

B Expectations counselling

W Tinnitus counselling

B QofL Questionnaire 4

W Accessories fitted

M User checkbox 1

Other (eg. attention, school liaison, play)

B User checkbox 2 Device use ] hours per day estimate (0 to 24)

Speech
5

Receptive language
]

Expressive language
7

Listening
8

Rehabilitation sessions *
Client MRS FIRSTMAME 106 LASTNAME 106 Print Mew Save Sign Delete Close
Sessions 011012013 - Session date  01/10/2013 E =)

User full name tests??? - Referral stage Assessment

Multiple instances of Rehabilitation sessions can be recorded and saved. Any of these can be
linked to a Switch-on/Review screen. They will be linked automatically if they are opened using
the New button on the Switch-on/Review screen or can be attached after saving using the

Attach button.

* New - Select to create a new session.

e Save - To save the current session.

* Delete - Will remove the selected session from the database.
* Close - Will close the session without saving it.

¢ Sessions - Displays a list of any previous sessions.

» Session Date - Defaults to the highlighted date, but can be adjusted to reflect the date
of the session either by entering the date manually or by clicking on the calendar icon to

choose a date from a calendar float-window. Double-click in the field to enter today’s
date.

e User - Will be the name of the logged in user.

¢ Aspecial button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either
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+
attached ) or not attached (GD ). In addition, the button has a tooltip that displays

detailed information about the session linking.

» Referral stage - This displays the stage in the referral that the appointmentis in
currently, if a stage can be identified.

¢ Device use can be used to record hours in use (O- 24 hours).

( oD

Information can be added to the various check boxes and free test boxes. User check box 1
and 2 labels at the bottom left of the screen can be defined by the System

Administrator. Checkboxes are grouped into roughly child or adult at the top, adult at the
bottom and closed/open set question in the centre.

When saving the Rehabilitation session it is possible to Sign and Lock the data. This is done by
pressing Save and the following pop-up will appear:

Client MRS FIRSTNAME106 LASTNAME 106 Print New Save Sign Delete | Close
Sessions 01/10/2013 - Session date  0110/2013 ﬁ oD
iUser full name tests??? - Referral stage Assessment
i Session content or aim
[| Assessment(screening or formal) Session details Speech
| M Counselling 1 5
|| Adisin
| 2 Sign a session X

B Rehab
| i y OK Cancel

B Coaching/demonstrating Goals idé
| M Goal Setting 2 Client

W Speech Tracking MRS FIRSTNAME106 LASTNAME 106

Date

B Closed set (multiple choice) 0110/2013
; B Open set Managen| &) sign with d-
. : 13012020 | full name tests 277 -
| M Musictraining

| M Telephone training

| M Expectations counselling

|| M Tinnitus counselling Other (eg. attention, school liaison, play) Listening
4 8
| M QoflL Questionnaire
W Accessories fitted
M User checkbox 1
B User checkbox 2 Device use g hours per day estimate (0 to 24)

Selecting the sign with date box will allow the user to lock the data which has been entered
therefore preventing anyone from editing the information. It is possible to Save the document
without signing it and then review and Sign later.

If Save is selected and sign with date is not completed then the Sign button will become
available for selection in the top right corner. Selecting it will provide a pop-up where the
information is filled and the user selects OK to save and sign.
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Sign a session

DK Cancel

Client

MRS FIRSTHNAME106 LASTHNAME106
Date

011042013

Sign with date

1307172020 full name tests 777

When looking at the previous sessions there is information in the heading to state by whom it
was signed and locked.

Rehabilitation sessions

X
Client MRS FIRSTNAME106 LASTNAME106 Print New Save Sign Delete Close

Sessions 01/10/2013 - Locked and signed by full name te -

Session date 011012013 [37] e=
User

full name tests???

-

Referral stage  Assessment
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24.8 Implant surgery

This screen serves several purposes:

¢ Acollector for the results that should be produced on the report for that stage.
¢ Aplace to record information specific to that stage in the pathway that is not recorded

elsewhere in Auditbase.

Implant surgery >
Client MRS FIRSTMAME 106 LASTNAME106 Print Mew Save Delete Close
Surgeries 0211012013 -| Date 020102013 [5] == M Active User SYSTEM ADMINISTRATOR -
Referral 03/10/2013, x DO NOT USE-VRA .. Treatmentstage Treatment - Add compl.

Irmplant data and summary | Approachfentry | Anchoring and closure | Postoperative | Explant | Intra-Op audiology | Complications

Summary
Ear side Left ~ Procedure name  Initial implant - Age at surgery 24y
Implant type
Right Electro acoustic implant - Left Electro acoustic implant -  Surgeon MISS SE CHALSTREY, CONSULT |
Summary from other tabs, fill here or on other tabs Additional details of procedure Add/Remove
) ) ) Electrodes usable 3
Ossification Partial - e Code MName
Insertion Partial A Electrodes outside 4
Implant requires u 34
explant
Implant data
Issue device Aftach Detach

Implant details
Modified date | Stock type to| Article | LIR| User| Serial number | Notes| aty

Multiple instances of Implant surgery screens can be recorded and saved.

¢ New - Select to create a new session.

e Save - To save the current session.

¢ Delete - Will remove the selected session from the database.

¢ Close - Will close the session without saving it.

e Surgeries - Displays a list of any previous sessions.

+ Date - Defaults to the current date, but can be adjusted to reflect the date of the session

either by entering the date manually or by clicking on the calendar icon to choose a date
from a calendar float-window. Double-click in the field to enter today’s date.

e User - Will be the name of the logged in user.
¢ A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either

g +
attached ( == ) or not attached (GD ). In addition, the button has a tooltip that displays
detailed information about the session linking.
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» Referral - The relevant referral for the client can be attached to the form using the
button. This is a mandatory field.

If the referral does not exist or an existing one cannot be used, you can create a ‘quick’

referral by clicking the New button from the = button to the right of the Referral field.
See details in Quick referral creation.

* Treatment stage - The relevant treatment stage is displayed here.
¢ Active - A check box can be selected to show that the client is active.
¢ Add compl. - A surgical complication can be added on any of the tabs below by selecting

this button.

Add implant surgery complication >

Add Cancel

Side

User

Surgery compl. -

Comment

Right - Date 13/01/2020 [5]

SYSTEM ADMINISTRATOR. -

» Select a complication from the drop-down list Surgery Compl. Select a Side, Date, User
and add a Comment if required. Select Add to include this in the list of complications or
Cancel to leave the screen without saving.

There are a number of tabs which can be selected. These tabs show different information under
the following headings:

¢ Implant data and summary - Information from a number of drop-down lists can be
selected. The drop-down lists can be defined by the System Administrator.

o

Ear side - Right, Left, Unknown or Binaural can be selected. This is a mandatory
field.

Procedure name - The name of the procedure can be selected from the drop-down
menu.

Age at surgery - Will display the client’s age at the date of surgery not their current
age.

Implant type - This can be selected for Right and Left.

Surgeon - Can be selected from the Referring Agents table using the button.
Summary from other tabs, fill here or on other tabs - Selections can be made
from the drop-down boxes if there are no entries in other tabs.

Additional details of procedures - Can be added using the Add/Remove button. By
selecting this, a list of procedures is displayed. Procedures can be selected from
this list.
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° Implant details - Any stock articles that have been attached to that session can be
observed. Articles can be added in the following manner:

° |ssue device - A search dialogue will be shown.
° Add a serial number or article name to the search fields.

Please note that these fields are case sensitive.

o Articles can be filtered using the Default filter view button. By selecting this,
options are shown for various Articles and Stock Types.

o Select Search.

° Select from the list ensuring the left-hand column in the table is checked and
then Issue.

° A New status for serial number: XX or New status for quantity controlled
article: XX window will appear.

o Select a Location if relevant.

° Select the new To stock type.

° Depending on the selection, a number of other fields will need to be
completed in the same way as for issuing an article from the Stock module
directly. Once the options have been selected, select OK.

° The selected article will now be included in the table.

NOTE: Changes in device status create clinical actions. If you have attached them to
appropriate appointments, they can be seen on the Clinical actions tab of the Referral
module.

o Attach - By selecting Attach, all currently issued articles will be displayed. Check
the required article and Select. These will then be added to the session.
o Detach - Articles can be removed from the list by using the Detach button.

e Approach/entry - A number of drop-down and free field text boxes are shown and
information can be added to them.

e Anchoring and closure - A number of drop-down boxes are shown and information can be
added to them.

¢ Postoperative - A number of drop-down and free field text boxes are shown and
information can be added to them.

e Explant - A number of drop-down and free field text boxes are shown and information can
be added to them. Check the Explant performed box to make the options active.

¢ Intra-Op audiology - Information from a number of free text boxes and drop-down lists
can be selected.

e Complications - Surgical complications can be added by selecting either Add or Add
compl. Both have the same function.

° Select a complication from the drop-down list Surgery Compl.
o Select a Side, Date, User and add a Comment if required.
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o Select Add to include this in the list of complications or Cancel to leave the screen
without saving.
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24.9 Implant surgery complications

Any surgical complications that are added to the Implant surgery form can be listed here. All
surgeries are shown here grouped by surgery; if there are no complications recorded, a value of
<No complications> will be shown. You can also add any complications which may appear
after the surgery from this screen and thus the date of them will not be a surgery date.

Implant surgery complications X
Client MRS FIRSTMNAME106 LASTNAME106 Add Deleie Print Close
Surgery date |Procedure name| Side of surgery Surgical complication | Side | Date User Comment

NIA Flap problem without removal | Right 031072013 USER MAMESOD sdfsdf

02/10/2013 | Initial implant Left Flap problem without removal | Binaural | 01/10/2013 | USER NAMESD 234

03/03/2013 | Explant Left Flap problem with removal Left 04/03/2015 | full name tests?77? | 123

04/03/2014 | Initial implant Right =Mo complications=

05/03/2014 | Explant Left =MNo complications=

27104/2013 Explant Right =MNo complications=

¢ Add - Will display a further window.

Add implant surgery complication x

Add Cancel

Surgery compl. Flap problem with remaoval -
Side Right - Date 13/01/2020 | [5]
User SYSTEM ADMIMISTRATOR -
Comment

|Some comment |

e Select a complication from the drop-down list Surgery Compl. Select a Side, Date, User
and add a Comment if required. Select Add to include this in the list of complications or
Cancel to leave the screen without saving.

* Delete - Will remove a highlighted complication from the list.

¢ Print - Will send a copy of the list to the default printer.

¢ Close - Will close the Implant surgery complications window.
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24.10 Additions to other Auditbase screens

24.10.1 Client Information screen
An additional tab has been added to the Client Information screen. This is the Implant tab.

Contacts | Details | Lists/Photo | Devices || Implant | Visit charge @ Paediatric | PPP 4 »

Invoice senvices Print device info report
r RIGHT rLEFT
Implant type Implant type
Electro acoustic implant Electro acoustic implant
First surgery date 0303/2013 First surgery date 03/0242043
Latest surgery date 021002013 Latest surgery date 021002013
First switch-on date 04/M10/2013 First switch-on date
Latest switch-on date 011012013 Latest switch-on date
Upgrade due date 01/10/2013 Upgrade due date
Client preferences \mmunisation
Select
Type |R| L| Name | Status
Cable ] ITETOMR v
Magnet 1] ITE10ML
Date =
Ear hook |[©][]BE101
Battery type [][]BE101B Surgical consent
Other =[] BE101G -
Date E

Consortium (Customer Group)

Funding Status

Implant keyworker

The top section shows information from various Implant screens including;:

¢ Implant type - From the Implant surgery screen.

» First surgery date - From the Implant surgery screen.

e Latest surgery date - From the Implant surgery screen.

» First switch-on date - From the Implant surgery screen.

* Latest switch-on date - From the Implant surgery screen.

* Upgrade due date - From the Switch on / Review sessions screen.

¢ Client preferences - From the Decision tab on the Pre-op assessment form.
Thesepreferences can be overwritten as choices change.

¢ Immunisation and Status - Choose an immunisation and/or a status e.g. Immunized,
Patient advised, Parent advised or GP advised. Double-click in the date field for today’s
date or chose a date by clicking on the calendar icon.

© Auditdata - 2025, ID: 20.0040/36 496



User Guide

e Surgical consent - Indicate whether or not consent has been given to e.g. use pictures of
the patient for educational purposes or scientific research. Double-click in the date field
for today’s date or chose a date by clicking on the calendar icon.

e Consortium (Customer Group) - A consortium or group of customers can be added by
selecting from the drop-down list. This list is populated by the following method and
assumes that Customers have been set up:

¢ From the Client Information screen select Functions in the menu bar.

e Select Settings.

¢ Select Customer Groups.

¢ Select New and enter a name for the Customer group.

¢ Other details can be added as required.

e Save the new group. Once this has been done, group members can be added.

¢ Select the required Customer group and choose the Edit group members button.

¢ Alist of available customers will be displayed. These can be chosen by highlighting them
and using the Add button. Customers can be removed from a group using the Remove
button.

¢ Once the customers have been selected, Close the window.

¢ Close will then save the customer group.

¢ A group can be removed by using the Delete button.

¢ Funding status - This is a drop-down list that can be defined by the System
Administrator.

¢ Implant keyworker - This field displays a list of users, one of which can be selected.
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25 Surgery Module

An optional module for entering Surgery details is available. It is possible to record pre-
operative and perioperative assessment and post-operative follow-up data for three main ear
surgery types.

e Otosurgery
e Stapes surgery
e Implant surgery - using existing screens from the Auditory Implant module.

For complete research data, the majority of field options are hard-coded and are not user
definable. The two user definable fields in each type of surgery can be defined in the System
Administration tool. Client drop out and the reason for it, can be recorded.

Surgery stages can be linked to appointments either automatically or manually. Referrals can
be attached to surgeries, this can either be made mandatory or non-mandatory in the System
Administration tool.

Planned clinical actions will be visible in the Client Pathway Overview. These clinical actions
include Pre/Per-operative, Postoperative 2-5 month follow-up and Postoperative >12 month
follow-up for Otosurgery and Stapes surgery.

User reports have been added to include:

¢ Audiometric outcome and surgery data reports
 Visual histograms and CSV export for full research

To open the Surgery module, Navigation — Surgery or Ctrl+Shift+Y. If the client does not
already have an ongoing surgery, a window is displayed for you to select the type of surgery
required.

Mew Surgery *

QK Cancel

Choose a surgery type

iOtoSurgery
Stapes3Surgery
Implant

Double-click on the required surgery or highlight it and click OK. Cancel will close the window
without selecting a surgery.

Be aware: Before proceeding, please make sure the correct client is selected to avoid
incorrect operation planned.
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25.1 OtoSurgery

There are tabs for Pre/Per-operative, Postoperative 2-5 month follow-up, Postoperative >12
month follow-up and Drop Out along the top of the page showing different information.

General data will display the Operation information on each tab, it can only be edited on the
first tab, the same information is displayed but greyed out on the others.

Other indications and diagnosis are also shown above each tab.

To save an OtoSurgery, the minimum data required to be entered is Op. side. Date is also
required but is set to today’s date by default. If Referral has been made mandatory, this will
need to be saved as well.

surgery X

Client MRS FIRSTMAME 106 LASTNAME 106 Surgery type OtoSurgery Select MNew Delete Close

Pre-iper-Operative Assess | Post-Operative follow up 2-5m | Post-Operative follow up =12m | Drop-out

General data

Referral

Hearing impairment

Meeda HI
Pre-lper-operative data
Status of ear at surgery

Tympanosclerosis
Eustachian tube function
Origin of cholesteatoma
Approach

Myringoplasty
Ossiculoplasty

Type of graft

Frosthesis material
Prosthesis type

Batch

Added to gel foam
Anaesthetic

Chorda tympany

Drain

Facial nerve

Lateral semicircular canal
Field3

Field4

Date ofsurg. | 0711712018 [5]

Age 29y

Vertigo
Discharge

Dry ear

Silastic
Ampicillin

General anaesthesia

Eartube

Maormal

8/21/2016, ++AUDIO REVIEW reasse ..,

Lot

Op.Side Left
Surgeon

Tinnitus
Wish to swim

~ Op.Mumber

~ Per-operative diagnosis

-

Cholesteatoma

Created by
Appt

Additional diagnoses

= =]

Submit

Care
Checkbox 2

Delete Save

SYSTEM ADMINISTRATOR

-

Stage Completed

-

Add/Remave

Code

Mame

Audiometry

Comments

Concurrent procedures

.. /B Goto

-

Add/Remave

Code

Mame

» Select - Displays a list of any previous sessions. Choose a surgery and click OK to display
the information relating to that date.
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Client Surgeries X

QK Cancel

Choose a surgery
10.04.2015 OtoSurgery (Left)

¢ New - Select to create a new surgery. The New Surgery dialogue will open.

* Delete - Will remove the selected surgery and all related sessions from the database.

¢ Close - Will close the session without saving it.

» Date of surg. - Defaults to the current date, but can be adjusted to reflect the date of the
operation either by entering the date manually or by clicking on the calendar icon to
choose a date from a calendar float-window. Double-click in the field to enter today’s date
again.

¢ Age - Will show the client’s age at the time of the surgery. If the client is less than 5 years
old, the age will be displayed in years and months.

¢ Op. side - Left or right can be selected for the Operated side. This is a mandatory field.

¢ Op. Number - 1-12 or unknown can be selected manually.

» Created by - Will be the name of the logged in user.

» Referral - The relevant referral for the client can be attached to the form using the
button. This may be a mandatory field depending on your settings.

If the referral does not exist or an existing one cannot be used, you can create a ‘quick’

referral by clicking the New button from the == button to the right of the Referral field.
See details in Quick referral creation.

e Surgeon - Can be selected from the Referring Agents table using the button. The list will
default to the Surgeon referring agent type. Click New to create yourself as a Surgeon if
not already in the system. If another referring agent type is required by default, your
System Administrator can set this up. If you as a user are linked in Administration to a
Referring Agent, the Surgeon field will be pre-filled with your data.

e Other indications, such as Hearing impairment, Tinnitus and Need to Swim are
displayed as check boxes on each surgery screen. There are two site configurable
checkboxes available. Apply your own values to these from within System Administration.

* A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either
attached (°° ( b )

) or not attached . In addition, the button has a tooltip that displays
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detailed information about the session linking. The appointment will be linked
automatically if the data entry takes place on the same day.
e Stage - The relevant treatment stage is displayed here.

25.1.1 Pre-/per Operative Assess

¢ Pre-/per-operative data - There are a number of hard coded drop-down lists which can
be selected. These are not user definable, in order to produce consistent research data.

+ User field #1 and User field #2 - These fields’ labels and content can be defined by your
System Administrator.

¢ Delete - This button will only remove the details on the current session. It does not
remove the entire surgery. To do that, use the Delete button at the top as described in
the OtoSurgery topic.

e Save - To save the information on the selected tab for the current session.

e Other indications - These can be added by using the Add/Remove button. A user
definable list of other indications is displayed. Check all that are appropriate and click
Select. Cancel will close the dialogue box without adding any indications.

¢ Audiometry - Audiograms can be added to the session by selecting the button. This will
give you a choice to Attach an audiogram, Detach an already attached audiogram or to
Show an already attached audiogram. Clicking Attach will display the list of currently
saved audiograms for the client. This list will include the ability to Preview a selected
audiogram. The audiogram can be selected by double clicking or by highlighting and
clicking Select. Once the audiogram has been attached, the details for it are displayed.
The attached audiogram can be viewed by selecting the preview button.

Audiometry 04M10/2013, no. 1, Pre-operative /Bl Goto

¢ Click Go to to open the audiogram in the full Audiogram module.

e Comments - A free text box is available for comments.

¢ Concurrent procedures - These can be added by using the Add/Remove button. A user
definable list of other procedures is displayed. Check all that are appropriate and click
Select. Cancel will close the window without adding any indications.

25.1.2 Post-Operative follow up 2-5 m

» General data is displayed as described in the OtoSurgery topic.

¢ Created by - This will be the user that has created the information on this tab. Users can
be selected from the drop-down list.

e A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either

iy +
attached (C . ) or not attached (==). In addition, the button has a tooltip that displays

detailed information about the session linking.

e Stage - The relevant treatment stage is displayed here.

» Post-operative data 2-5 months - Information from a number of drop-down lists can be
selected here.
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¢ Date of event - This will be the date of the 2-5 month review and is independent of the
main date of surgery.

¢ Delete - This delete button will only remove the details on the current session. It does not
remove the entire surgery. To do that, use the Delete button as described in the
OtoSurgery topic.

e Save - To save the information on the selected tab for the current session.

¢ Audiometry - Audiograms can be added to the session by selecting the button. This will
give you a choice to Attach an audiogram, Detach an already attached audiogram or to
Show an already attached audiogram. Clicking Attach will display the list of currently
saved audiograms for the client. This list will include the ability to Preview a selected
audiogram. The audiogram can be selected by double-clicking or by highlighting and
clicking Select. Once the audiogram has been attached, the details for it are displayed.
The attached audiogram can be viewed by selecting the Preview button.

* Press Go to to open the audiogram in the full Audiogram module.

e« Comments - A free text box is available for comments.

¢ Drop out - This button will take you directly to the Drop out tab so that information can
be added.

Surgery X

Client MR JOHN SMITH Surgery type  OtoSurgery Select Mew Delete Close

Pre-fper-Operative Assess | Post-Operative follow up 2-5m | Post-Operative follow up =12m | Drop-out

General data

Date of surg. | RLUEIERE Age 5y Op.Side Left + OpNumber 1 + Per-operative diagnosis
Referral 10/04/2015, ++AUDIO REVIEW reass Surgeon MRS AMMAN, 222 STR, HOME CITY H72.9  « Perforatio membrana tympani -
M Hearing impairment Vertigo M Tinnitus Cholesteatoma M Care
M MeedaHl M Discharge Wish to swim M Checkbox 2
Post-operative data 2-5 months
11/04/2015 i
Postoperative infection No | Pate of event E submit R
) Created by SYSTEM ADMINISTRATOR -

Chorda function Mormalino change A

Appt oo Stage Assessment -
Facial nerve function Normal - ) :

Audiometry 11/04/2015, no. 1, Post-operative 2-5m ..|B Goto
Anacusis MNew anacusis -

) Comments
Vertigo Preoperative level -
Tinnitus Preoperative level -
Otomicroscopy Intact, normal aeration -
Drop out

25.1.3 Post-Operative follow up >12m

¢ General data is displayed as described in the OtoSurgery topic.

¢ Created by - This will be the user that has created the information on this tab. Users can
be selected from the drop-down list.

¢ Aspecial button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either
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attached (=) or not attached ( &b ). In addition, the button has a tooltip that displays
detailed information about the session linking.

Stage - The relevant treatment stage is displayed here.

Post-operative data 12 months - Information from a number of drop-down lists can be
selected here.

Date of event - This will be the date of the twelve month review and is independent of
the main date of surgery.

Delete - This button will only remove the details on the current session. It does not
remove the entire surgery. To do that, use the Delete button as described in the
OtoSurgery topic.

Save - To save the information on the selected tab for the current session.
Audiometry - Audiograms can be added to the session by selecting the button. This will
give you a choice to Attach an audiogram, Detach an already attached audiogram or to
Show an already attached audiogram. Selecting Attach will display the list of currently
saved audiograms for the client. This list will include the ability to Preview a selected
audiogram. The audiogram can be selected by double clicking or by highlighting and
Select. Once the audiogram has been attached, the details for it are displayed. The
attached audiogram can be viewed by selecting the preview button

To open the audiogram in the full Audiogram module, click Go to.

Comments - A free text box is available for comments.

Drop out - This button will take you directly to the Drop out tab so that information can
be added.

Surgery *
Client MR JOHN SMITH Surgery type  OtoSurgery Select Mew Delete Close
Pre-fper-Operative Assess | Post-Operative follow up 2-5m || Post-Operative follow up =12m | Drop-out
General data
Date of surg. | pULER=NY] Age 5y Op.Side Left + OpMNumber A1 ~ Per-operative diagnosis
Referral 10/04/2015, ++AUDIO REVIEW reass Surgeon MRS ANMAN, 222 STR, HOME CITY H72.9 = Perforatio membrana tympani -
M Hearing impairment Vertigo M Tinnitus Cholesteatoma M Care
M MeedaHl M Discharge Wish to swim M Checkbox 2
Post-operative data 12 months
Chorda function - Date of event 13/01/2020 E D &
Created by -
Facial nerve function -
Appt S5 Stage -
Anacusis -
Audiometry .. B Goto
Vertigo -
Comments
Tinnitus -
Otomicroscopy -
|5 client satisfied -
Drop out
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25.2 Stapes Surgery

There are a number of tabs along the top of the page showing different information.

General data will display the same information on each tab. Once a surgery session has been

saved, this information is displayed but greyed out on all but the first tab. To save a Stapes

Surgery, the minimum data required is Op. side. If Referral has been made mandatory, this will

need to be saved as well.

Surgery

Client MRS FIRSTMAME106 LASTMAME106 Surgery type StapesSurgery Select New Delete

Close

Pre-iper-Operative Assess | Post-Operative follow up 2-5m | Post-Operative follow up =12m | Drop-out

General data

Date of surg. |

Age 24y Op.Side Right ~ OpNumber 1 ~ Per-operative diagnosis

Referral 071212018, ++FITTING - from previot .| Surgeon MISS SE CHALSTREY, CONSULTANT EM . H80.9 = Otosclerosis -
B Hearing impairment W ‘ertigo W Tinnitus W Aid
B Hl on operated ear Family members with Otosclerosis B Checkbox 2
Pre-iper-operative data
Anaesthetic General anaesthesia - Submit Delete
ACCess Trans canal ~ Created by full name tests???
Procedure DDAOD |~ Stapedotomy ~ Appt =) Stage Treatment
Type of laser Diode Additional diagnoses
Drill Skeeter test diagnoses
Prosthesis Mitinol-Smart -
Batch Lot
Piston diameter 04 -
Piston length . Audiometry 04/10/2013, no. 1, Pre-operative .. B Goto
Comments
test comments
Facial nerve Marmal -
B Stapedial artery
Add/R
Niche dressing Gelfoam . Concurrent procedures emove
Code MName
Ear canal dressing Gelfoam + HT-meche MERTT exc probat meatus ac ext
Field1 1 -
Field2 3 -
[}

Select - Displays a list of any previous sessions. Choose a surgery and click OK to display
the information relating to that date.

New - Select to create a new surgery.

Delete - Will remove the selected surgery and all related sessions from the database.
Close - Will close the session without saving it.

Date of surg. - Defaults to the current date, but can be adjusted to reflect the date of the
session either by entering the date manually or by clicking on the calendar icon to choose
a date from a calendar float-window. Double-click in the field to enter today’s date.

Age - Will show the client’s age at the time of the surgery. If the client is less than 5 years
old, the age will be displayed in years and months.

Op. side - Left or right can be selected. This is a mandatory field.

Op. Number - 1-12 or unknown can be selected.
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Created by - Will be the name of the logged in user.
Referral - The relevant referral for the client can be attached to the form using the
button. This is may be a mandatory field depending on your settings.

If the referral does not exist or an existing one cannot be used, you can create a ‘quick’

referral by clicking the New button from the = button to the right of the Referral field.
See details in Quick referral creation.

Surgeon - Can be selected from the Referring Agents table using the button. The list will
default to the Surgeon referring agent type. If another referring agent type is required by
default, your System Administrator can set this up. If you as a user are linked in
Administration to a Surgeon Referring Agent, the Surgeon field will be pre-filled with your
name.

A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either

g +
attached (C 3) or not attached (/7). In addition, the button has a tooltip that displays

detailed information about the session linking.
Stage - The relevant treatment stage is displayed here.

25.2.1 Pre-/per Operative Assess

Pre-/per-operative data - There are a number of hard-coded drop-down lists which can
be selected. These are not user definable to assist in research.

User field #1 and User field #2 - These fields can be defined by your System
Administrator.

Delete - This button will only remove the details on the current session. It does not
remove the entire surgery. To do that, use the Delete button as described in the Stapes
Surgery topic.

Save - To save the information on the selected tab for the current session.

Other indications - These can be added by using the Add/Remove button. A user
definable list of other indications is displayed. Check all that are appropriate and click
Select. Cancel will close the window without adding any indications.

Audiometry - Audiograms can be added to the session by selecting the button. This will
give you a choice to Attach an audiogram, Detach an already attached audiogram or to
Show an already attached audiogram. Clicking Attach will display the list of currently
saved audiograms for the client. This list will include the ability to Preview a selected
audiogram. The audiogram can be selected by double-clicking or by highlighting and
clicking Select. Once the audiogram has been attached, the details for it are displayed.
The attached audiogram can be viewed by selecting the preview button.

Audiometry 04M10/2013, no. 1, Pre-operative .. Bl Goto
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¢ Click Go to to open the audiogram in the full Audiogram module.

e Comments - A free text box is available for comments.

e Concurrent procedures - These can be added by using the Add/Remove button. A user
definable list of other procedures is displayed. Check all that are appropriate and click
Select. Cancel will close the window without adding any indications.

25.2.2 Post-Operative follow up 2-5 m

¢ General data is displayed as described in the Stapes Surgery topic.

* Created by - This will be the user that has created the information on this tab. Users can
be selected from the drop-down list.

e A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either

attached (=) or not attached (‘:+:’ ). In addition, the button has a tooltip that displays
detailed information about the session linking.

e Stage - The relevant treatment stage is displayed here.

» Post-operative data 2-5 months - Information from a number of drop-down lists can be
selected here.

« Date of event - This will be the date of the 2-5 month review and is independent of the
main date of surgery.

* Delete - This button will only remove the details on the current session. It does not
remove the entire surgery. To do that, use the Delete button as described in the Stapes
Surgery topic.

* Save - To save the information on the selected tab for the current session.

* Audiometry - Audiograms can be added to the session by selecting the button. This will
give you a choice to Attach an audiogram, Detach an already attached audiogram or to
Show an already attached audiogram. Clicking Attach will display the list of currently
saved audiograms for the client. This list will include the ability to Preview a selected
audiogram. The audiogram can be selected by double-clicking or by highlighting and
clicking Select. Once the audiogram has been attached, the details for it are displayed.
The attached audiogram can be viewed by selecting the preview button.

¢ Click Go to to open the audiogram in the full Audiogram module.

e Comments - A free text box is available for comments.

¢ Drop out - This button will take you directly to the Drop out tab so that information can
be added.
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Surgery x
Client MRS FIRSTMAME106 LASTHAME 106 Surgery type StapesSurgery Select New Delete Close
Pre-/per-Operative Assess | Post-Operative follow up 2-5m | Post-Operative follow up =12m | Drop-out
General data
Date of surg. | [Vl Age 24y Op.Side Right v OpMNumber 1 ~ Per-operative diagnosis
Referral 071212018, ++FITTING - from previou Surgeon MISS SE CHALSTREY, CONSULTANT EP H80.9 - Otosclerosis -
M Hearing impairment M Vertigo M Tinnitus W Aid
M Hl on operated ear Family members with Otosclerosis M Checkbox 2
Post-operative data 2-5 months
09/10/2013 i
R r e AE it Yes . Date of event ﬁ Submit Delete
) Created by full name tests 2?77 -
Charda function Maormal/no change -
Appt =5 Stage -
Facial nerve function Preoperative function -
Audiometry 03M10/2013, no. 1, Post-operative 2-5m .. |B Goto
Anacusis Monefno change hd
) Comments
Vertigo Preoperative level - testcomments
Tinnitus MNone -
Otomicroscopy Intact, normal aeration -
Drop out

25.2.3 Post-Operative follow up >12m

General data is displayed as described in the Stapes Surgery topic.

Created by - This will be the user that has created the information on this tab. Users can
be selected from the drop-down list.

A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either

attached (=%)) or not attached (°+° ). In addition, the button has a tooltip that displays
detailed information about the session linking.

Stage - The relevant treatment stage is displayed here.

Post-operative data 12 months - Information from a number of drop-down lists can be
selected here.

Date of event - This will be the date of the twelve month review and is independent of
the main date of surgery.

Delete - This button will only remove the details on the current session. It does not
remove the entire surgery. To do that, use the Delete button as described in the Stapes
Surgery topic.

Save - To save the information on the selected tab for the current session.

Audiometry - Audiograms can be added to the session by selecting the button. This will
give you a choice to Attach an audiogram, Detach an already attached audiogram or to
Show an already attached audiogram. Clicking Attach will display the list of currently
saved audiograms for the client. This list will include the ability to Preview a selected
audiogram. The audiogram can be selected by double-clicking or by highlighting and
clicking Select. Once the audiogram has been attached, the details for it are displayed.
The attached audiogram can be viewed by selecting the preview button.
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Surgery X
Client MRS FIRSTNAME106 LASTNAME 106 Surgery type StapesSurgery Select New Delete Close
Pre-fper-Operative Assess | Post-Operative follow up 2-5m | Post-Operative follow up =12m | Drop-out
General data
Date of surg. | [eRlvFNy| Age 24y Op.Side Right ~ OpMNumber 1 ~ Per-operative diagnosis
Referral 07/12/12018, ++FITTING - from previot | Surgeon MISS SE CHALSTREY, CONSULTANTEPM | H80.9 = Otosclerosis -
M Hearing impairment W Vertigo M Tinnitus M Aid
M Hl on operated ear Family members with Otosclerosis M Checkbox 2
Post-operative data 12 months
] Date of event 091072013 Submit Delete Save
Chorda function Normalino change - ﬁ = =
. . Created by full name tests?77 -
Facial nerve function Maormal -
Appt = Stage -
Audiometry 021062013, no. 3, Post-operative =12m .. /B Goto
Vertigo Mone -
Comments
Tinnitus Mone ¥ testcomments -~
Otomicroscopy Intact, normal aeration -
|5 client satisfied Satisfied - w7
Drop out

» Click Go to to open the audiogram in the full Audiogram module.
¢ Comments - A free text box is available for comments.

¢ Drop out - This button will take you directly to the Drop out tab so that information can
be added.
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25.3 Surgery Drop out

A client Drop out can be opened from the tab of the Surgery window or with the button of that
name on the two follow up screens.

General data is displayed as described in the OtoSurgery and StapesSurgery topics,
correspondingly.

Created by - This will be the user that has created the information on this tab. Users can
be selected from the drop-down list.

A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either

g +
attached (C . ) or not attached (=7). In addition, the button has a tooltip that displays

detailed information about the session linking.

Stage - The relevant treatment stage is displayed here.

Drop-out data - A Reason for the drop-out can be chosen. If the selected Reason is
State of drum, then the field Otomicroscopy is activated and items can be selected.
Date of interruption - This can be added in the same way as other dates. Once a date
has been added, the Follow-up duration is displayed in months and days.

Delete - This button will only remove the details on the current session. It does not
remove the entire surgery. To do that, use the Delete button as described in the
OtoSurgery and StapesSurgery topics, correspondingly.

Save - To save the information on the selected tab for the current session.
Comments - A free text box is available for comments.

Surgery X
Client MRS FIRSTMAME106 LASTNAME106 Surgery type  StapesSurgery Select Mew Delete Close
Pre-fper-Operative Assess | Post-Operative follow up 2-5m | Post-Operative follow up =12m | Drop-out
General data
Date of surg. | MEIR{VPgE Age 24y Op.Side Right ~ OpMNumber 1 ~ Per-operative diagnosis
Referral 07M2/12018, ++FITTING - from previot Surgeon MISS SE CHALSTREY, CONSULTANT EM H80.9 ~ Otosclerosis -
M Hearing impairment W Vertigo M Tinnitus W Aid
M Hl on operated ear Family members with Otosclerosis M Checkbox 2
Drop-out data
i i 09/10/2013 i s
Reason State of drum . Date of interruption E Submit Delete S
) Created by full name tests?7?7? -
Otomicroscopy Lateralization A
Appt oD Stage Completed hd
Follow-up duration om
Comments
test comments
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25.4 Additions to AB Audiogram

If the Surgery module has been added as an option, an additional tab is activated in
Measurements — AB Audiogram. This tab is called Surgery and shows additional data for a

selected audiogram.

o)) Auditbase - [AB Audiogram - 10/01/2020, no. 1, PTA, Initial assessment [READ OMNLY]] - O x
Eile View Functions
| Client  T1106 MRS FIRSTNAME106 LASTNAME 106 ||| Z| Bl|user SYSTEM ADMINISTRATOR | All locations ~ Al departments ~ x| ?
Measure
125 250 500 1000 2000 4000 8000 HORMAL - 1285 250 500 1000 2000 4000 8000
-10 -10 Q s -10 -10
ymbol @
0 0 O > 0 0
@ AC MASKED s

10 10 10 10

£ BC UNMASKED Ty

20 20 L BC MASKED | 20 20

0@ 30 |L ucLum 4 3 30

’ UcL M ] KWK X % X % X
0 —O0—&—86—0& L& 5 & 1 . MCL UM Mo 40 40
50 so [k woLu L A A A AN AN A A A A e S )
% SF &

60 S 60 60 60

~f---C-G---C- G- C-G-—C-C ® SFH -

] 7o ® RIPSY &= T0 a, 70
80 80 O mEVIL " 50 80
& R CONTRA *

90 90 90 90
100 100 100 100
110 110 110 110
120 120 120 120
130 130 130 130
140 140 140 140
hight T Surgery 17.07.2018 OtoSurgery (Rignt) |l open Lot Reference

Surgery stage b
Compare to - D

EEErE) B operated ear side . B BECE pajics
AC (4-pta) 40 ABG "overclosure AC (4-pta) 35
BC (3-pta) 65 AC (4-pta) improvement BC (3-pta) 57
ABG (4-pta) 25 ABG (4-pta) improvement = ABG (4-pta) 20
Inter-Aural DiffAC 5 Belfast 15/30 dB rule of thumb using "AND" using 'OR’ Inter-Aural DIFAC -5

® |nformation | @ Referral | @ Speech | Speechin hoize | Tump | Compare | Graphical Speech | Others | Westibular | @ Surgery

Linking audiograms to surgeries can be performed in either direction. Audiograms can be linked to

surgeries or surgeries can be linked to audiograms. To link an audiogram to a surgery, see above

sections.

An audiogram can only be attached to one stage in any surgery but to more than one surgery. An
audiogram cannot be attached to a stage date earlier than one that is attached to a later stage date for

the same surgery.

e Tolink a surgery to an audiogram, select the button at the end of the Surgery field. Select
Attach and a list of the client’s available surgeries will be displayed.
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Client Surgeries X

QK Cancel

Choose a surgery

30.09.2013 OtoSurgery (Left) -
09.10.2013 StapesSurgery (Right)

15.04 2014 OtoSurgery (Left)

20.03.2015 OtoSurgery (Right)

26.03.2015 OtoSurgery (Left)

03.11.2015 OtoSurgery (Left)

17.07.2018 OtoSurgery (Left) hd

Aftach to stage

Post-operative 2-5m -

¢ Double-click or highlight the appropriate surgery and click OK. Cancel will close the
window without selecting a surgery.

Surgen 17.07.2018 OtoSurgery (Right) ... | Open

Surgery stage Post-operative =12m A

e The surgery is now linked to the audiogram and the information will be displayed
including Surgery stage.

e The surgery can be viewed by clicking the Open button.

¢ 4 point mean values for AC, BC and Air-Bone Gap (ABG) are displayed. These means are
set for US research publication purposes.

Right Operated

BC (4-pta) E5

AC (4-pta) 40

BC (3-pta) 65

ABG (4-pta) -25
Inter-Aural DiffAC 5

e If 3 kHz is not plotted, the user will get a warning by the relevant box flashing in an
appropriate colour, i.e. red for right and blue for left. The mean will then be calculated
using 4 kHz instead. If this is the case, a tooltip will be displayed.

* Aflagis stored in the database for the audiogram if this warning is required. This flag is
for reporting purposes only and cannot be seen by the user.

e By checking Compare to operated ear side, a previous audiogram can be selected. This
will populate further fields regarding the operated side.
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W Compare to 5122015, 3 hd |:|

operated ear side
ABG "overclosure”

AC (4-pta) improvement 8
ABG (4-pta) improvement

B S
Belfast 15/30 dB rule ofthumb using 'AND" [(/)|  using 'OR

¢ Anicon will be displayed to show whether the compared audiograms meet the Belfast
15/30 dB rule of thumb. The Belfast rule is calculated according to two interpretations
of the rule. One with 'AND' where the interaural difference must be less than 15dB and
the hearing loss in the ear is under 30dB and the other with 'OR' where either of these
conditions can be met.

¢ The colour of the audiogram that is being compared can be changed by selecting the
coloured square to the right of the compare field. A colour palette opens and the new
colour can be selected.

¢ If more than two audiograms need to be compared then the Compare tab on AB
Audiogram should be used. The current selections will be shared between the two tabs.
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25.5 Other Additions
25.5.1 Reports

Crystal and CSV reports have been added to Navigation — User reports — Surgery — Crystal
Reports tab or CSV reporting tab. These are run in the same way as other Crystal and CSV
reports.

25.5.2 Client pathway overview

The following actions have been added to client pathway overview settings in the System
Administration tool. All except Surgery Drop out can be added as planned actions.

e OtoSurgery Pre-Op

e OtoSurgery PostOp 2-5m

e OtoSurgery PostOp > 12m

e StapesSurgery Pre-op

e StapesSurgery PostOp 2-5m
e StapesSurgery PostOp > 12m
e Surgery Drop out.

Icons have been added to the Client Pathway Overview for these surgery actions. The relevant
surgery screen can be viewed by selecting it from the overview. They will be under the
appropriate referral if this has been set by your System Administrator.
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26 Laptop Synchronization

If laptop synchronization has been purchased, Auditdata IT Support staff will set up a laptop to
allow parts of Auditbase to be used without a network connection. If this has been set up, you
must connect your laptop to a network point and create the database you will be using without
your network connection. This is the 'off line-database' and is usually called ABASEOFF.
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26.1 Creating the offline database

e Login to the online database as a normal user.

» System settings -> Prepare offline database.

* Make sure that you have selected the correct name of the database you want to create in
the Offline database drop-down list, usually ABASEOFF.

e Click Next.

¢ Click OK to overwrite the existing database. Note that the laptop database must be
synchronised in advance with the main system to recreate the same database. If this has
not been done an error message will be displayed.

* When the database structure has been created you can choose clients to add to the
database in one of the following ways:

» Add Client allows you to use the Search Client function and add individual clients by
highlighting them and clicking on Select.

* Add Clients from waiting list allows you to add all the clients from a waiting list to the
offline database by choosing the waiting list from the drop-down list.

¢ Add clients from a resource allows you to select the clients who already have
appointments booked in the diary. Choose the name of the resource from the drop-down
list and fill in the date range required. The date range needs to specify the date before
and the date after those required, for instance for 3rd April 2005 choose 02/04/2005 to
04/04/2005.

¢ When all the required clients are selected, click Next.

¢ When the wizard is complete, click Finish. The database is now ready to use offline.

It is important that the network connection is not unplugged during this procedure.

Prepare for off-line work >
Add client Add clients from waiting list Add clients from a resource

Code | Mame
T1104 MR FIRSTMAME 104 LASTNAME104
T1105 MRS FIRSTMNAME 105 LASTNAME105
T1108 MRS FIRSTMNAME 106 LASTNAME 106
T1107 MRS FIRSTMAME107 LASTNAME107

L to sort colu
Currently 4 clients are selected Remove
B Mext Cancel Help
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26.2 Appointment symbols in the offline database

To minimize the time it takes to prepare an offline database not all appointments are visible on
the laptop.

¢ [f the selection of clients for creating the offline database was made based on Resources
then all the appointments and reservations in the period selected will have their symbols

copied to the booking screen on the offline laptop.

¢ If the selection of clients for creating the offline database was based on client names or
via a Waiting List then only the appointments for the forthcoming 30 days will have a
symbol on the booking screen. No other reservations or group appointments will be
copied.

* All the appointments belonging to a client, that have taken place in the past or are
booked for the future, will be copied to the laptop, but apart from the ones above the
symbols will not be visible on the booking screen.
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26.3 Logging in to the offline database

¢ Double-click on the Auditbase icon on your desktop.
¢ Change the database name in the drop-down list to the name of your offline database,
usually ABASEOFF.
e Loggingin
1. Logging in with a Microsoft Windows account
¢ The login name will be preselected. No need to enter a password.
2. Logging in with an Auditbase account
¢ Type your normal username and password.
e You can now use the areas of the database which are accessible offline in the normal
way.

e Creation of documents and templates is allowed. Editing of either offline is not supported.
To work around this, make a copy of an existing document when offline and edit that.
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26.4 Synchronization

When a user has connected to the offline database, for instance during a house visit, changes
in the laptop (local database) must be synchronized with the central database when back at the
clinic.

e Connect the laptop to a network point.

¢ Log onto the normal Auditbase database, usually the database name is ABASE.

» System settings -> Laptop synchronization.

* Follow the onscreen wizard instructions ensuring that the right name appears in the
database name field, usually ABASEOFF.

It is important that the network connection is not unplugged during this procedure.

e The synchronization wizard activates a search for the name of the offline database. If not
found, the user is asked to select from a list.

e Asearch on the client ID(s) from the offline database is performed in the central
database. If a client with the same ID exists in the central database, the client data is
transferred without prompting the user.

¢ If no identical client ID is found in the central database, the user is asked whether the
client should be inserted as new or merged with an existing client in the central database.

¢ [f the replication log table holds a record of a new client registration, the merge client
dialog will appear.

¢ To process client data from offline database, one of three solutions must be selected:

° import as new
° merge with existing client data
° skKip client -all data related to this client is skipped and cannot be retrieved
e By using a subset of client data from the offline database, the user can locate the right
client in the central database by searching on for instance:
° clientID
° name(s)
° birth date
° address

e Entering one or some of the criteria and pressing Search opens the Client search dialog
with results matching those criteria.

¢ Not entering any criteria but pressing Search still opens the search dialog for a user to
search for a client in the usual way.

» After processing all new and changed client information, other changes are copied to the
offline database by the system. The user is informed that the offline database is no longer
available but needs to be reinitialized prior to further use.

¢ In the offline laptop database, clinical actions will not be linked automatically to
appointments and cannot be linked manually. Appointments from the offline database
are not synchronised back to the main database so linking cannot be updated. To link
actions on the offline laptop to appointments use the Attach feature after the database
has been synchronised and the actions are in the main database. Noah actions however
can be linked automatically to the appointment when the database is synched back to
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the main database. If the patient has more than one appointment on the same day then
the action will be linked to the latest appointment.
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26.5 Merging new clients created when you were offline

If new clients were created in the offline database you can merge them into existing records or
create them as new records in the main database during laptop synchronisation.

A window box named A new client is found in the offline database appears during the laptop
synchronisation wizard.

The left-hand side of the window fields are filled with the new client data and the user should
select which criteria to search on by pressing the arrow(s) > copying the field value(s) to the
right-hand side and pressing Search.

Clients matching the criteria are listed to Select from filling in the information in the right-hand
side fields.

Having the data of the clients to be merged respectively on the left and right-hand side,
pressing Merge will log all data on the ‘two’ clients into a log table in the database.

Client data as first name, surname and address of client in the offline database are ignored as
this data is retrieved via a PAS link connection and updated from there.

If the user decides not to merge the two clients, pressing Load as new will save the client from
the offline database as a new, separate client.

If the user decides to leave the client from the offline database out of the central database,
pressing Skip will perform this action.

Continue the synchronisation wizard in the usual way.

A new client is found in the offline database. You can import him/her as new, merge with existing client or skip... d

Mew Client Search Existing Client
Hospital no 11108 Generate new
MNH3no. 7777777777 Generate new =
Names  FIRSTNAME =
Surname | ASTNAME =
Birthday

Address - = -

Merge AS anew Skip

o) Auditbase

ext Cancel Help
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26.6 Offline mode restrictions

When using Auditbase in the offline mode, there are certain constraints to be aware of:

¢ Client summary module is not available in the offline mode.
¢ [tis not possible to transfer clients who have a Noah action on the date you are creating
the offline database.
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27 PPP and Import/Export

Auditbase contains an import/export facility to enable the transfer of patient data between
databases.

With the PPP module, you can export a selected number of clients from a Public Partner, put
the client data on a CD and send it to a Private dispensing company who will consult the client
and fit them with a hearing instrument. Having done so, the Private Partner will refer the client
back to the Public Partner with the revised client data.

All PPP transfers have to be approved by the client.
The module is also referred to as PPP list.
General workflow of the PPP module goes in 5 stages:

e Export of client data from Public Partner (data retrieved from Auditbase System e.g. at
hearing clinic).

e Import of client data at Private Partner (data imported to local Auditbase System e.g. at
hearing instrument dispenser A).

¢ Intermediate work with client data at Private Partner's (e.g. client visiting hearing
instrument dispenser A and being granted a hearing instrument).

o Export of revised client data from Private Partner (revised data retrieved from local
Auditbase System e.g. at hearing instrument dispenser A).

¢ Import of revised client data to Public Partner (revised data is merged into respective
client records in central Auditbase System e.g. at hearing clinic).

The most likely flow is looking up a Waiting list and selecting one or more clients to be referred
to the private partner.
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27.1 Definitions

The following definitions are used throughout this document.

e External site - this is the site to which you are sending the database. It could be a PPP
partner, education or another hospital.

e External partner - essentially the same as an external site also known as a private
partner.

¢ Configuration file - this is a special type of file which is used to set up the import/export
facility.

¢ Journal mapping - this is where you decide what a journal string is called. Rarely do two
databases have the same names for journal strings so you need to associate what you
call your string with what the external site calls theirs.

e PPP - Public Private Partnership.
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27.2 Setting up

The following will assist you to set up and use this facility. The setting up needs to be performed
in the Auditbase Administration tool, which is opened from Auditbase by going to System
settings -> Open system administration. Once opened, select Import/Export.

27.2.1 Import Configuration

Setting up the import configuration will define which fields are imported into the database.
There are two default configurations. Default has all options selected. Default demographics
only has client demographic information only. A new configuration can be made by selecting
New. The Name of the new configuration should be entered in the field provided. There are
then 3 tabs which also need to be selected.

¢ Client - The client demographics can be selected for import.

* Update demographics for existing clients - If this option is selected, then the client’s
demographic details will be automatically over written when data is imported. When you,
at the public partner, import a PPP file from a private partner, data will never be updated,
but when differences shown in a log file after the import is completed.

¢ Selection of client data to import - Here information from the Clientinformation module
can be selected for import. To select all demographics select All.

¢ Journal - Journal data will be imported if this option is selected. Note that only mapped
journal strings are imported.

¢ Other - There are a number of check boxes that can be used to select which information
is created or updated when the data is imported. Check the required options or All for
everyone.

Once the options have been selected, Save will store the configuration. To remove a
configuration, select Delete.

Note: When importing a PPP file at a private partner, you will not be able to select a specific
import configuration; all data for the client will automatically be created/updated when
imported.

27.2.2 Export Configuration

Setting up the export configuration will define which fields are exported from the database.
There are two default configurations. Default has all options selected. Default demographics
only has client demographic information only. A new configuration can be made by selecting
New. The Name of the new configuration should be entered in the field provided. There are
then 3 tabs which also need to be selected.

¢ Client - The client demographics can be selected for export.

¢ Journal - Here, choices are made as to how much of the journal is to be exported.

¢ Enable export of journal data - If this option is selected, the journal search strings can
be chosen to export data.
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Export data for all search strings - When this option is selected, all search strings from
both Audiologist and Hearing therapist journal are exported. Also search strings to be
created in future will be included in an export.

The alternative is to configure exactly which search strings those are to be exported.
There are a number of check boxes that can be used to define this. Check the required
options or All for everyone.

Other - There are a number of check boxes that can be used to select which information
is exported. Check the required options or All for everyone.

Once the options have been selected, Save will store the configuration. To remove a
configuration, select Delete.

Note: When exporting a PPP file from a private partner, you will not be able to select a
specific export configuration; all data for the client will automatically be exported.

27.2.3 External site set up

Once a configuration file has been sent to an external site, the file can be used to set up
that external partner.

The site name will be produced by the imported configuration file and cannot be adjusted
manually.

The Default configuration can be set for both importing and exporting. The required
configuration is selected from the drop-down menu.

The search strings in the journal must be mapped so that the search strings from the
external database match those for the main database.

Selecting Journal mappings will open a window called Map search strings for journal.
Search strings for the audiologist or hearing therapist can be selected using the Select
type of journal search string to map drop down menu.

The journal entries for the Source site are shown in the left window, the Target search
strings are shown on the right. Select a search string from the source site by clicking on
it.

Select a Target search string and Map. The Current mappings are displayed at the
bottom of the window.

To remove a map, select from this window and Delete map. Note that unmapped search
strings will not be imported.

27.2.4 Exchange set up

This is where the exchange configuration files are imported and exported. A parthership
cannot be set up until these files have been exchanged.

To export a configuration file, it has to be decided if the file will be password protected or
locked for a single site. A site locked configuration file can only be made for already
known sites.

Choose either Password protect file or Lock for site and then select the site from the
drop-down list. If no site is in the drop-down list, a file will have to be imported first.
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¢ To export this file, select Export and decided where the file should be saved. This file can
then be saved to disk or emailed to the appropriate partner.

e To import a file from a partner, select Import and open the file from wherever it has been
saved to. You will be asked to confirm the password that the partner will have sent you
and the configuration will be imported. At this point you will be asked if you wish to map
journal search strings in the same way as for the external site set up above.

¢ The Exchange identification code is used to identify a client when exchanging between
Auditbase databases. This can either be the NHS or Case note number. It is possible to
allow export without identification number, but this is mandatory for the PPP project.
Partners in the NHS project must use the NHS number as exchange identification code
when exchanging client information.

27.2.5 PPP specific set up

This feature is only available if you have a license to the PPP module. There are 3 Site
definable settings check boxes.

e Warn before creation of sessions if PPP exchange is not approved by client - A
warning will appear when adding a client to PPP list if the client has not given approval to
join the PPP.

* Block for export of clients without approved PPP exchange -

» Display warning when client with open session is selected - A warning is given each
time a client is selected that has an open PPP session.

Once the options have been selected, Save will store the information.

It is possible to add status labels for two of the system statuses, In process and Returned.
Status labels can be added by selecting the New button. The label name is then added in the
Status label field. Save will store the information and Delete will remove a Status label from
the database.

27.2.6 Session filter set up
This feature is only available if you have a license to the PPP module.

¢ The session filter can be set up so that the PPP list can be viewed any way that the user
wants. A new filter can be created by clicking the New button. Visible columns can be
selected by checking or un-checking the boxes. Conditions can also be added by
selecting from the Status, Public partner or Private partner drop down menus and
clicking the Add buttons.

¢ The order that columns appear in the PPP list can be changed by selecting a column and
then moving it up or down using the arrows. Once the filter has been set up, Save will
store the information.

¢ The order of filters in the drop-down list in PPP list can be changed by selecting a filter,
and then moving it up or down using the arrows. The filter on top will be the default filter
used when the PPP list is opened.
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27.3 Additions to modules
27.3.1 Client Information

The Client Information module now has an additional tab called PPP (only available with license
to PPP module). This tab contains information on the client’s PPP session status. If the client
gives permission for them to be added to the PPP list, the Approval field should be checked.

The Sessions drop down list shows all the instances that this client has of PPP sessions.

27.3.2 Waiting List

Once a client has been selected, Export and Move to PPP become active. The client is selected
by checking the box on the left-hand side of the waiting list. All clients on the waiting list can be
selected by checking the Select all field. The number of clients selected is displayed below this
field. These selected clients can now either be moved to the PPP export list or exported directly.

¢ Move to PPP - When this option is selected, a PPP session properties window is
displayed. The client’'s name and NHS number are displayed as well as their approval
status. If the PPP approval given box is un-checked, it must be determined if this client
has given approval to be sent to a PPP dispenser. This field must be checked in order for
the patient to be exported. The Session status will default to new as this client is being
moved from a waiting list. The Session setup will determine which external site the client
is being sent to. Choose the Private partner from the drop-down list. The Referral status
can be selected from another drop-down list. This will indicate the referral route. If the
client is being transferred by paper only then the box should be checked. Once the
choices have been made, Save will transfer the details from the waiting list to the PPP
list.

e Export - When this option is selected, an Export data window is displayed. Clients can be
added to the export by using the Search button. Remove will take the selected client off
the list for export. The export file can either than be password protected or locked for the
particular external site. The Export configuration has to be selected from the drop-down
list. This operation can be cancelled using the Cancel button. Once Export has been
selected, you must Enter password for encryption and then re-enter to confirm. Once Ok
has been chosen, the Saveexport file window opens and the path where to save the file
can be chosen. Auditbase automatically names the file, but this can be re-named
providing the file extension remains agi. Once Save is selected, a progress bar appears.
Once the export is complete, the Export status log can be viewed or printed. The text can
be copied and pasted into another application such as Word. The export log can be saved
as a text file by selecting Save as. Close will complete the export. The client’s details will
remain on the waiting list.
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27.4 PPP list

The PPP list is open from Navigation -> PPP list.
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27.5 Exporting from the PPP list
The PPP list is opened from Modules -> PPP list.

e The session information can be displayed using the drop-down list titled Filter. These
filters are set up by the System Administrator. Clients for export must be selected by
checking the box to the left-hand side of the client’s details.

¢ Next to this box is a flag, this will be green if the client is ready for export. Red flag shows
that there are details missing for the export. All the clients can be selected by using the
Select all check box. The number of rows selected will be displayed. Once at least one
client has been selected, the Properties and Export buttons become active.

¢ Properties will display the PPP session properties window where changes can be made
to ensure the client is ready for export. The client’'s name and NHS number are displayed
as well as their approval status. If the PPP approval given box is un-checked, it must be
determined if this client has given approval to be sent to a PPP dispenser. This field must
be checked in order for the patient to be exported.

PPP session properties X
Save Cancel
Client information
_ Date and time| Status/action Site Us
ATEEE DD TR 131032019 | Exported Swindon (United Kingdom) | Yuliia M:
JETE R L ] e 1310312019 | Exported (full) | Swindon (United Kingdom) | Yuliia M:
W PPP approval given 13/03/2018 | New Swindon (United Kingdom) | Yuliia Mz
Session status
Exported, 13/03/2019 History
Force full export of data
Session setup
Public partner Swindon (United Kingdom)
Private partner PN -
Referral status ENT -
Paper transfer onl
p y - -

¢ The selected client’s import/export History can be shown. The Session status can be
changed to show that the client has been exported. The Session setup will determine
which external site the client is being sent to. Choose the Private partner from the drop-
down list. The Referral status can be selected from another drop-down list. This will
indicate the referral route. If the client is being transferred by paper only then the box
should be checked.

¢ Once all clients are ready, the Export button should be selected, which will display the
Export clients for PPP window. This will show the Destination site, number of Clients
and the export File name. The Export configuration can be chosen, either the default one
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or a particular configuration depending on the external site to which this data is being
exported. The file name can be changed by selecting the Change file name button. The
export can be cancelled or a file skipped by selecting the appropriate buttons.

Export clients for PPP

Export

Cancel

X

Destination site | Clients |

File

[v |Falun

4

Clsers\ANDSHU\Desktop\Swindon (United Kingdom)_to_Falun_2020-12-22 aei

Export configuration

Skipfile

@ Use default export configuration for destination site

Use specific configuration

Change file name

¢ Once the Export button is selected, a progress bar appears and then a window telling you
how many clients were successfully exported.
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27.6 Importing to the PPP list

Once a file has been sent to you, it must be imported to be read. Once the PPP list is opened,

select the Import button and a Client import for PPP window is displayed. Use the browse
button to find the correct file and then Import. The import file must now be found using the

browse button.

Client import for PPP

Cancel

*

Folder CiUsers\andshu\OneDrive - AuditdataAD\Desktopt

File |l

Collect all new and matched clients in a List

List for new patients
Referral list #1

List for merged patients
Test Referral list

Once the file has been found and opened, the details are displayed, including Exporting site,

User, Date/time and Number of clients in the file.

Client import for PPP

Import

X

Cancel

Folder CilUsers\andshuiDownloadst

File Patient_DaveAnonymised_Test aei

File information

Exporting site  Trafford General Hospital Adult
User SYSTEM ADMINISTRATOR
Date/Time 26/09/2022 17:32:38

Mumber of clients in file 1

Collect all new and matched clients in a List

List for new patients
Referral list #1

List for merged patients
Test Referral list

=Default=

CsV file
Generate CSV file with client demographics
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A Match clients for import window now opens. Automatically matched clients are shown in the
bottom half of this window. If there is a problem with the matching of any client due to an
absence of an NHS number or other match criteria, they are displayed in the top half of this
window. Using the Find match and Accept buttons, you can decide whether to accept these
clients or not. Once all the clients have been accepted, select Import.

Watch clients forimport x

Import | | Cancel

[Proiem|site| source Hospital no. | Source NHS no.[Source Name [ Source DOB[Source gender| Target Hospital no. | Target NHS no. [ Target Name| Target DOB | Target gender | Source first name [ Source last name | Target first name [ Target 1ast name [match problem(s)|

Automatically matched clients: 1

Import match status [ site [Source Hospital no. Source NHS no. Source Name Source DOB | Source gender| Target Hospital no_ | Target NHS no Target Name

Watched on Auditbase internal ID from a previous import, cannot change target Traf 12577 DAVE ANONYMISED 01/01/1950 _|Male DAVE ANONYMISED

Once this has been done, a progress bar will be displayed. As soon as the import is complete,
an Import status log is shown. This log shows the following:

¢ Filename - that was imported.

e Username - of the user logged in during import.

e Org. site - the originating site of the import.

¢ Clients total - the total number of clients that were in the import file.

¢ Clients imported - the number of clients that were imported from the import file.
¢ Clients errors - the number of clients that had errors during the import.

¢ Time - the time and date of the import.

¢ |d, Name - displays the NHS number and name of the clients that were imported.
e Status - shows which client had an error during import.
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Import status log X

Save as Print Copy text Close

IMPORT STATUS LOG

File name: C:\Users\andshu\Downloads\Patient_DaveAnonymised_Test.aei
Username: SYSADM

Org. site:  Trafford General Hospital Adult

Clients total: 1

Clients imported: 0

Clients error: 1

Time: 29/M11/2023 14:33:23
D MName Status
DAVE ANONYMISED ERROR

- PATIENT: Update/NHS no.: Invalid length. [Failed to update with the specified
exchange D]

This log can then be stored in a number of ways:

e Save as - the log can be saved as a text file to either disk, locally or to a network.
e Print - the log can be printed using the Windows default printer.
* Copy text - the log file is copied to the Microsoft Office clipboard and can be pasted into

a Word document.

Once the log file has been saved or if you do not wish to save the log, Close will close this
window. You will then return to the PPP list.
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27.7 Exporting an Import/Export data file

Clients can be added to be exported by hitting Search. When a client is selected, they are
added to be exported by pressing Add client. Remove will take the selected clients off the
export list. Multiple clients can be selected using the Shift key.

The export file can either be password protected or locked for the particular external site. The
Export configuration has to be selected from the drop-down list but can be cancelled by
pressing Cancel.

Once Export has been selected, the Password for encryption must be entered twice for
confirmation. Press OK, and a window opens to Save export file and the path where to save
the file is defined.

Auditbase automatically names the file which can be renamed providing the file extension
remains *.agi.

Pressing Save is followed by a progress bar and when this has finished, the Export status log
can be viewed or printed. The text can be copied and pasted into another application, for
instance Word. The export log can be saved as a text file by selecting Save as.

Close will complete the export.

When exporting from a waiting list, the client's data will remain in the selected list and must be
deleted when the export is initiated by moving the client. This should then also be reflected in
the client information/Alert. See Client information.
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27.8 Importing an Import/Export data file

Client import for PPP

Import Cancel

ot

Folder Cilsers\aMNDSHUNDeskiopl

File ||

File infarmation
Exporting site
User
Date/Time

Mumber of clients in file

Import configuration

SV file
Generate C3V file with client demographics
Cutput file
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28 Noah Import/Export

Noah import

It is possible to import client data from Noah, namely all Noah actions, including fast data
views, actions in sessions, and client demographics according to the mapping in Auditbase
Administration. Noah Audiograms can also be created as Auditbase audiograms. Noah Journal
module's text content will be imported into the Auditbase Journal under the Keyword set in
Admin; however, the attached files will not be imported.

NOTE: the same patient can be imported multiple times.

To import a file to Noah, go to the File menu > click Import from Noah. Two types of files are
used for import: Nhax and Enhax (which is password-protected). When using an Enhax file type,
it is necessary to enter a password.

Enter password for decryption >

Ok Cancel

Confirm passwaord

*****t***l

Pre-import dialog

On the Import clients from Noah dialog (which is shown before the actual import is performed),
you can verify the number of patients in a file and patient details (Noah client no, social security
number, first and last name, date of birth, gender).

NOTE: you cannot import over 10 patients without an extended licence.
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Import clients from Noah X

Import Cancel

File

Folder

File information

Exporting site  Noah export file
Date/Time 1/9/2024 23:15:39
MNumber of clients infile 1

Clients preview

CUserslyanbya\OneDrive - AuditdataAD\Desktop\AUDITBASE 6.6.0\Woah import fi
Happy_Case.enhax

Moah Client No | 55 Number | First name | Last name | Date of birth | Genderl
0000024 342198 Happy Case 11151975 |F

User recorded under John Parker

Default journal keyword ADMIN

Social security no. will be imported to client's "NHS no.’
Allow import of clients with Invalid I1d
Apply notification rules based on audiograms

Callect all new and matched clients in a List

List for new patients

List1 -
Listfor merged patients
List2 -

Import configuration

Moah import configuration -

The pre-import dialog also displays:

User that all import actions will be logged under. It is recommended to have a specific
user for Noah imports. All imported records will be logged under this user regardless of
who created them.

Journal Keyword used for saving all records that are imported from the Noah Journal
Module.

Social security no. will be imported to ... - shows which Auditbase identifier (Hospital no.
or NHS code) Noah's Social Security number will be mapped to. The matching of
identifiers is set in Auditbase Administration (via Data handling and technical > Export /
Import to Noah settings)

Whether patients with invalid IDs can be imported. If invalid IDs are allowed, patients
with such IDs will be listed under 'Clients with match problems' on the 'Match clients for
import' dialog.

Apply notification rules based on audiograms - an option to apply Auditbase notification
rules for audiogram content. The checkbox controls whether you will be shown
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notifications immediately after import.

o Lists for new and merged patients that in Auditbase Administration can be configured
as either Client Lists or Trial Lists. You will need a Noah import licence to be able to
collect all new and matched clients in a List.

¢ Import configuration: if there are several configurations set up in Administration, use the
dropdown to select the required configuration from the list.

NOTE: pre-selected checkboxes on the Pre-import dialog show that the option is enabled in
Administration; empty boxes signify that the option is available but was not activated in Admin.
Greyed out Client lists/Trials section means that the extended licence was not granted.

Use the Import button to open the Import dialog. The import process is not initiated at this
stage.

Import dialog

On the 'Match clients for import' dialog, you can review clients with matched problems and
automatically matched clients. The dialog is resizeable, and the system remembers the last
used size and returns to that size.

The table provides patient details (DOB and Gender for both the source and the target patients
as well as Auditbase identifiers, i.e., NHS no./Hospital no.), so that matching can be analysed
better.

¢ An import file can be processed more than once; not all patients need to be imported on
each processing.

¢ If a patient has been imported before, then you cannot change the match to the patient in
Auditbase; that patient will be shown as matching on Noah's internal ID.

¢ Demographics matching is done on First name, Last name, DOB, and Gender. For the
matching of two patients, all four attributes must not be empty and must match. If only
some criteria are met on a particular pair, that pairing is not suggested to the user and
the record is reported as a New client.

Clients with match problems (top list)

Here you can see records for import where an issue is found that needs to be resolved. When
you select a row in the top list, the following controls become active: Find match, Accept, Skip,
Create as new.

If you tick the left-hand column, any problems will be alerted on a message. You can also review
the text in the Problem column.
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Import Cancel

Clients with match problems: 1 -

Problem Noah Client Mo. | Source Hospital no. | Source NHS no. Source Name Source DOB | Source gender| Target Hospital no. | 1
v | Watched on NHS no., please check demographics match | 0000025 3421-98 Mincode Anotherpatient | 06/05(1974 | Male 3

Message

I@ Waming!
-

Match was found on 'Hospital no.' but not on gender andfor date of birth

Do you wantto use this match and include the clientin the import?

The issues described in the Problem column may be as follows:

« If a Noah patient has an ID that does not pass Auditbase validation rules but the
import of patients with invalid IDs is allowed, the system will inform that "Invalid <Id
name> must be corrected in Auditbase before any changes can be made."

¢ |f a match is found on the Identifier number in Noah with the Auditbase identifier
(whichever type has been configured as matching) but Name, DOB, Gender do not
match, the following text is displayed: "Matched on <id name>, please check
demographics match," and the system suggests the target patient. Selecting another
patient is allowed.

¢ [f the Identifier is not matched but a single match on Name, DOB, Gender is found,
the following text is displayed: "Matched one result only on Name/gender/DOB, <id
name> does not match," and the system suggests the target patient. Selecting another
patient is allowed.

 [f the Identifier is not matched and multiple matches are found on Name, DOB,
Gender, the following text is displayed: "Match to more than one result only on
Name/gender/DOB," and the system does not suggest a target patient, the target name
says '<multiple match>' and the user must select a patient for match.

Automatically matched clients (bottom list)

Here you can review records that were matched automatically. To be able to use available
controls, you need to select a row by clicking on it so that is becomes highlighted. Then the
buttons become active: Find match, Accept, Skip.
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Automatically matched clients: 1

Find match Accept Skip

Import match status Moah Client No_| Source Hospital no. | Source NHS no.|  Source Name | Source DOB | Source gender| Target Hospital no. | Target NHS no. Ti

J» |Waiched on Noah internal ID from a previous import, cannot change farget | 0000028 9999-9 Match MainCode | 06/11/1974 | Male 9999-9 I ai]

The Import match status column contains a description of the match status.
Possible matching scenarios:

¢ A match is found between the user entered identifier number in Noah and the linked
identifier code type in Auditbase; First Name, Last Name, DOB and Gender match.
The Import match status says '‘Match on <ld name>/name/DOB/gender'. The system
suggests the target patient and automatically selects the checkbox in the left-hand
column to include the patient in the import.

e The record from Noah has been imported previously; the match to that Auditbase
patient is locked. The dialog shows the target patient and the text says Matched on Noah
internal ID from a previous import, cannot change target. The record can be reimported
to update the information from Noah.

e [f the record was imported previously, so it matched on the internal identifier, but
Name, Gender or DOB differ, the Import match status is described as: Matched on Noah
internal ID from a previous import, name/gender/dob doesn't match. In this case, the
system does allow the import to proceed if the user changes the Import checkbox from
clear to selected, so users have to review the match.

¢ No match is found on identifiers or demographics. In this case the system does not
suggest a target, and the Import match status contains New client but an existing patient
can be selected for matching.

Click Import to start importing patients. NOTE: The checkbox in the left-hand column must be
selected for any record to be imported.

Since another user can potentially add or modify Auditbase patients on another workstation
while the Import dialog is still open, the uniqueness of patient identifiers is checked during
import. If any identifiers are found to be duplicated, this information is included in the text log
produced after the import, and a warning is displayed to review the log.

Post import dialog and logging
On the Import Status Log, you can review:

1. File user statistics on file content;
2. List of patients and their status.

If necessary, the log can be saved to a secure location.
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Save as Print Copy text Close

|File name:  C:\Userslyanbya\OneDrive - AuditdataAD\Desktop\AUDITBASE
6.6.0'Noah import files (1)\Patient match\5\5.11Match_MainCode2 enhax
|Username:  JOHN

|Org. site:

IClients total: 1

|{Clients imported: 1

|Clients error: 0

[Time: 1/11/2024 02:23:13

|

D Name Status

! Match MainCode 0K

| |
1 v
Noah export

To export a file to Noah, go to the File menu > click Export to Noah. On the 'Export data' dialog,
click Add client to add the current global client to the export file. Use Search to add multiple
clients.

Use the export preview to verify export information and, if necessary, remove those clients that
do not need to be exported.

Add client Export Cancel

4 clients selected for export

Hospital no. Client Search
T110002 MRS FIRSTNAME10002 LASTHNAME 10002 Remove
T110003 MR FIRSTHAME10003 LASTNAME10003
T110004 MR FIRSTHNAME10004 LASTNAME10004
T110005 MR FIRSTHNAME10005 LASTNAME10005

File encryption
Password

The password must be at least eight characters long
Anonymize clients

You can protect the file with a password. If you enter the password in the corresponding field,
an Enhax export file will be created. If the password is not set and the field is left blank, the
system will create an Nhax file.
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For security reasons, you can anonymize clients by selecting the corresponding chekbox.

9} Save Noah System export file x

Savein: | | NOAH EXPORT FILES - & ®EckE

-

* MName Status Date modified

Ma items match your search.
Quick access ¥

|
Desktop

Libraries

2

This PC

Netwark

< >

|Fi|ename: |Swindon {United Kingdom)_2024-01-10.nhax j| [ save |

Save as type: |Export MNoah System file (*.nhax) j Cancel

After the file is exported from Auditbase, an Export Status Log is shown with export information
specifying the folder where the export file is stored, the name of the user that initiated the

export, the number of exported clients, etc.

Export status log X

Save as Print Copy text Close

File name: C:\Userslyanbya'\OneDrive - AuditdataAD\Documents\NOAH
EXPORT FILES\Swindon (United Kingdom)_2024-01-10.nhax

Username: JOHN

Dest. site: Unknown

Clients total: 4

Clients exported:4

Clients error: 0

Time: 1/10/2024 01:10:25

D Name Status

1110002 MRS FIRSTNAME10002 LASTNAME100020K

1110003 MR FIRSTNAME 10003 LASTNAME10003 OK

1110004 MR FIRSTNAME 10004 LASTNAME 10004 OK
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29 Reports

Click the button below to access our training materials.

You can create your own reports or queries in Crystal Reports, Microsoft Query and Microsoft
Excel, and access them directly from Auditbase. Reports can be stored in sub-directories in the
correct country directory under the directory specified in Auditbase Administration -> User and
workstation options -> Workstation settings -> Printing and reports - > Path to reports. The
system shows reports in a folder-like structure corresponding to the disk sub-directories
reports. This may be used for logical reports grouping. Folders will appear under each tab on
the User Reports dialog whether they include reports of that type or not.

A CSV reporting tool tab provides reporting in a different format. Report parameters are
indicated and corresponding values must be selected in order to run the report.

When you open a Crystal Reports report, the database, user and password currently used in
Auditbase will be used for an automatic login with the ODBC data source name Auditbase -
ODBC. When using Microsoft Excel and Query, you will be prompted for login, with database and
username set in the ODBC set-up in the administration tool.

To edit a report made with Crystal Reports, you will need a full installation of Crystal Reports
Professional edition. A license for this product is not provided by Auditdata. With Auditbase only
a viewer for existing Crystal Reports 11 is provided. When Standard User reports provided with
Auditbase are saved, they are editable in Crystal Reports Version 9 Professional. However, this
version will not work on an Auditbase client PC without first installing the Crystal Reports
Service Pack 7, which can be found on the Auditbase installation disk or on the Crystal Reports
website.

To use the Microsoft Excel and Query examples you will need an installation of Microsoft Office
(or the products mentioned), in order to open the files. To open a Microsoft Query file (*.dqy) in
Microsoft Query, you will need to manually associate the file type with Microsoft Query.

Notes:
Microsoft Query editor is not installed by default by the Microsoft Office installation wizard.

When you create your own new report, you should always use the ODBC data source name (also
called DSN) Auditbase - ODBC to make sure the settings are correct. You should then make
sure your report is located in the folder specified by the system administrator.
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When you create reports in Microsoft Excel, you should be aware that Excel by default saves the
password and data with the spreadsheet. To avoid this, you should modify the properties for the
data area in the Excel sheet. With Crystal Reports, you have a similar setting under File -> Save
data with report where you should avoid saving data with the report.

If using Windows Single Sign-on to access Auditbase and you receive a log in prompt for any
report, please enter an asterisk symbol * in the user field and leave the password field empty.

Be aware

It is strongly recommended NOT to edit data in the Auditbase database from an external tool.
Errors caused by such an action are not supported by Auditdata. If you want to edit data in an
Auditbase database from an external tool, you should only do it on a database copy - never the
live database - and make sure you are actually connected to this copy before performing any
actions.
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29.1 Report examples
The following reports (specified by the UK user group) have been supplied as examples on how
to access the Auditbase database from external tools supporting ODBC.

Crystal Reports

Age of All Clients Alive

Shows the basic client data with a simple calculation of the age based on today's date and date
of birth. Only clients alive are listed.

Created with Microsoft Query.

All Client Type of Aid - Quantity Controlled

Shows the quantity controlled hearing instrument models and counts currently issued. The
report is based on stock types set up as Released.

Created with Crystal Reports.

All Client Type of Aid - Serial Number Controlled

Shows the serial number controlled hearing instrument models and counts currently used by
clients alive, in the specified date of birth range. Aids issued to clients with no registered date of
birth will not be included. The report is based on stock types set up as Released.

Created with Crystal Reports.

Appointment symbol list

Shows the Appointment symbol names and symbol id referenced from Calendar table

Appointment Type and Article

Shows the hearing instrument models and count associated with the appointment type the
client had in a certain date range.

Created with Microsoft Query and Microsoft Excel.

Duplicate lasthame, firsthame, DOB and sex

Shows groups of clients having the same last name, first name, DOB, and sex and displays their
addresses and primary codes so that merging can be considered.

Earmould Types Left

Shows the count of the different types of earmoulds for left ears made in a certain date range.
Created with Microsoft Query.
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Earmould Types Right

Shows the count of the different types of earmoulds for right ears made in a certain date range.
Created with Microsoft Query.

Earmould Types

Shows that you can have two Microsoft Queries in the same Excel sheet.

Created with Microsoft Excel.

Firstname with space character at beginning

Lists clients having a space character at the start of the name which therefore may not be
found using Firstname as a search criteria.

Lastname with space character at beginning

Lists clients having a space character at the start of the name which therefore may not be
found using Lastname as a search criteria.

Hearing Aid Clients Male-Female-Other

Shows the distribution of gender among clients alive. Can also be used to check for typing
errors in the gender data field.

Created with Crystal Reports.

Hearing Aid Clients Gender Other List

Lists clients alive with a gender different from M (male) or F (female). Should be used to check
for typing errors in the gender data field.

Created with Crystal Reports.

Hearing Aid Type

Shows basic client data with used hearing instrument(s) born in a certain date range.

Created with Microsoft Query.

Incorrect Age

Lists all clients with a default age of less than O (negative) or greater than 110, default can be
changed. Use this report to check if you have clients with wrong D.O.B. registration.
Created with Crystal Reports.

Number of 15 Minute
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One-page report displaying the most frequently used appointments in a pie chart. This version
is ordered by the number of used 15 minutes timeslots in a certain date range. This report also
demonstrates how to use parameters in Crystal Reports.

Created with Crystal Reports.

Number of 15 Minute - Resource

Same as above, except that you can limit the appointments to those booked with a certain
resource. The resource parameter can be configured to some default values. This is site
dependent and has to be done for each site. The resource parameter must match the case
used in the database (upper case).

Created with Crystal Reports.

Number of Procedures

One-page report displaying the most frequently used appointments in a pie chart. This version
is ordered by the number of procedures booked in a specific date range. This report also
demonstrates how to use parameters in Crystal Reports.

Created with Crystal Reports.

Number of Procedures - Resource

Same as above, except that you can limit the appointments to those booked with a specific
resource. The resource parameter can be configured to some default values - this is site
dependent and has to be done for each site. The resource parameter must match the case
used in the database (upper case).

Created with Crystal Reports.

Number of referenced appointments

Appointments created with Referred by field completed.

Number of Left Earmoulds

Displays the number of earmoulds for left ears created in a specific date range.
Created with Microsoft Query.

Number of Right Earmoulds

Displays the number of earmoulds for right ears created in a specific date range.

Created with Microsoft Query.

Client List With Temporary Numbers
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Lists all clients that have been created with a temporary hospital ID. If you use a prefix different
from 'T' for your temporary hospital IDs, you will need to modify the criteria in the report.
Created with Crystal Reports, Microsoft Query and Microsoft Excel.

Referrals grouped by Treatment Type & Client's GP PCT Code

Shows summary count of client referrals between specified Start and End dates, grouped by
Client’'s GP PCT Code and by Treatment type.

Referrals grouped by Treatment Type & Client's GP PCT Code - detailed

Shows summary count and individual details of client referrals between specified Start and End
dates, grouped by Client’s GP PCT Code and by Treatment type.

Post Code Extract

Lists hospital ID with post code for all clients where the Comm. Hearing Aid or the NHS Hearing
Aid check box has been checked in the Client information window, but you can modify this to
meet your wishes. This report is intended for further processing by another tool - i.e. Excel.
Created with Microsoft Query.

Furthermore, a report to view/print the schedule of a certain resource has been added as a
system report, and it can be accessed from the menu Functions->Print schedule in the
Booking screen. This report should not be modified by the user.

Activity by PCT code

Shows a table of appointments by PCT code within a date range. The PCT code is taken from
the Referring Agents (GP) table within Auditbase.

Appointment code numbers

Shows the appointment symbol names and their symbol id referenced from the Calendar table.

Appointments by PCT code with date range

This shows two tables of selected appointments using the code numbers obtained from the
Appointment code numbers report. The first table shows how many appointments have been
made for each PCT code. The second shows the amount of time in weeks that the
appointments have been waiting since their referral. To use this report accurately, the referral
page must be used.

Waiting list by customer with last referral using AC date

This report shows two tables of selected waiting lists using the code numbers obtained from the
Waiting list code numbers report referenced to the customer table rather than the Referring
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Agents table. The first table on the report shows how many clients are on the selected waiting
lists for each customer. The second table shows how long each client has waited on the
selected waiting lists for each customer. The wait time is calculated from the last audiogram
made for the client.

Waiting list code numbers

Shows the waiting list names and their symbol ID referenced from the waiting list table.

Waiting list printout with addresses
Shows a printout of a selected waiting list and includes the following details:

¢ Wait time - taken from the waiting list module.
¢ Hospital number

¢ Name and address

¢ Date of Birth

¢ Postcode

¢ Home phone

¢ Information taken from the waiting list module

Custom Report and Statistics

These reports can be accessed from the Custom reports and statistics reporting tab and will
report data in Comma Separated Values (CSV) format. For these reports, the user is able to
select the parameter values from a list of options (pre-defined in Administration).

Reports for this tab can be found in the folders:

e AQP reports
e Surgery
¢ CIDS reports

These include:

¢ AQP - Monthly full patient minimum dataset - Per piece of activity

¢ AQP - Monthly full patient minimum dataset - Per referral

¢ Hearing aid journey outcomes

e Patients access service in extended hours

¢ Re-fitted with hearing aid after re-assess

* Referrals with a ‘rejected’ referral outcome applied in a chosen period
* Referral with an outcome of a request to transfer provider

* Aids replaced due to mechanical failure

¢ Lost, damaged hearing aids

¢ And more.
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29.2 Running a standard user report

A series of standard reports are available in Crystal Reports, Excel or Microsoft Query report
formats.

¢ Navigation -> User Reports.

» Use the tabs to select a Crystal Report, Microsoft Excel, Microsoft Query or Custom
report.

¢ Open the relevant folder.

¢ Select the relevant report.

e Select Open or double-click the report to run it.

User reports X

Edit Open Close

Crystal Reports | Microsoft Excel | Microsoft Query | Custom reports and statistics

(Z3 Appts ~
-Appointment symbol listrpt

-Appointments grouped by status, resource.rpt
-Appointments statistics per status.rpt

Booked appointment time - Resource - with Locations.rpt
Booked appointment time - with Locations rpt

Mumber of Procedures - Resource - with Locations.rpt

- MNumber of Procedures - with Locations.rpt

MNumber of referenced appointments.rpt

Schedule - with Locations.rpt

-Time spent by resources on appointments.rpt

Waiting Time Monthly Summary Report.rpt

(C3 AQP reports

[C Articles

(1 CIDS reports

(23 Client deletion - Bulk permanent deletion

[C] Data checks

(3 Hearing screening

3 1MP

(23 Implant

(Z7 Lists used in interface setup

(£ Paediatric

[C] Referrals

(3 Schema Templates

(£7 Studies v

An EXAMPLE of a standard user report indicating clinical activity in a department:

¢ Open the Number of procedures report.

e Select a Start date for your report.

¢ Click on End date and select the date you want the report to end.
¢ Click OK and then view the report and/or print it.
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26|27(28|29(30]|31

B Enter Values *
Please enter a start date. StartDate
Please enter Date in format “yyyy-mm-dd™.
?Bu siness Objects ]
Please enter an end date. EndDate
Please enter Date in format "yyyy-mm-dd™.
Su|Mo| Tu|We|Th| Fr|Sa
E 112[3]4
5|6]7]8]9]10][11
12[13]|14|15]|16[17|18
19]20(21(22[23 (24|25

AMOUNT (%) PROCEDURES

756 (69,8%) LUNCHI
8  (1.9%) LABWORK
A AGTESEMENT a6 (6,1%) HAFU

55

(5.1%)

HEARING TEST

7

(2.0%)

ADMINISTRATION

a2

(2.0%6)

ADULT OAD

2

(10%)

BAHA ASSESSMENT

20

(1,5%)

NOT IN WORK1

(L0%%)

BAHA FIT

(1,0%6)

BAHA FOLLOW UP

(1.0%)

MEETING

(0,1%)

Paediatne Assessment

LAR WORH: LUINCHY

Crystal Reports

¢ You may need to press the refresh button on the report to update the report.

e Print as required.

The user reports will only work on a computer where the system administrator has enabled the

correct driver.

For advanced reports, Crystal Reports training courses can be provided. Please contact the

Auditdata Help-desk for further information.
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29.3 Running a report from the Custom reports and Statistics
tab

Select and Open the required report by double clicking it.

User reports *

QOpen Close

Crystal Reports | Microsoft Excel | Microsoft Query || Custom reports and statistics

3 AQP reports A
- Additional follow-up availability xml

Aftercare availability.xml

Aids replaced due to mechanical failure after 3yr review.xml

AQIP - Monthly full patient minimum dataset - Per piece of activity xml
AQIP - Monthly full patient minimum dataset - Per referral xml
Assessment to fitting time xml

C0OS| questionnaire results xml

Fitting to follow up time. xml

Glasgow questionnaire results xmil

Hearing aid journey outcomes . xml

Infarmation shared.xml

|Ol-HA questionnaire results xml

Lost, damaged hearing aids xml

Patient wearing HA at review.xml

Patients accessing semvice in extended hours.xml

Patients reached 3 years review pointxml

Personalised care planning (IMP audit based on AuditBase IMP).xml
Personalised care planning (IMP audit based on Documents).xml
Personalised care planning (IMP audit based on Journal).xml
Quicker follow-up availability xml

Re-fitted with hearing aid after re-asses xml hd

To set up the report fill each of the mandatory parameters and whichever of the non-mandatory
parameters you want to filter your data on.

Mandatory items

The red exclamation mark alongside a parameter denotes a mandatory field. When a
mandatory field is completed, the exclamation mark will disappear from alongside it.

If you attempt to run a report without completing one or all of these parameters, a warning will
appear on screen.

Message x

All mandatary fields marked with "1 must be completed in order to run report.

[ —

If you should save a report without completing one or all of these parameters, a warning will
appear on screen.
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Message *

I@I Some mandatary fields marked with " are not completed. Would you like to save the fiter without completing these?
k.

Output file name and location

Each report requires a designated name and location for the output file, which is where the
data will be saved once the report is run. On selecting the Value field for the output file the user
must browse to select the destination folder for the report output.

It will however still be possible to save the report without completing the mandatory fields.
Filling parameter values

Parameters selections are made in recognisable controls depending on the type of data, such
as dates, single selections, multi-selections, number fields, etc.

For drop-down single selections, click on the drop-down arrow for a parameter.
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Report Filters
Current filter
. Default [Default] A Save Save as ... Delete

4| Ifatleast one of report dates is not entered, the previous whole calendar month will be used.

When clicking 'Save parameters for future use’ or 'Save parameters for future use and Run report’ |+ Run report

If report start or end date is not entered, then start or end of the previous whole calendar month will be used.

Start date

6

End date

6

Holiday and working day settings, if saved, will be used also for other AQP reports.
Holiday date 1

6

Holiday date 2

=

Holiday date 3

6

Holiday date 4

6

Holiday date 5

6

Saturdays are working days
No -

Included additional GP details

No v

Parameters below are only saved for this report:

Exclude patients with alerts and parameters in list

Include only patients with alerts and parameters in list

Select the value you wish to populate that parameter.

Multi selection fields

To report on multiple values from multi-selection fields, each value is clicked on and moved to
the Selected items box using the arrows adjacent to the box. When a value is transferred to the
Selected items box that value will be reported on and anything left in the Available items box

will not be reported on.
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Report Filters
Current filter
¢ | <Mew filter= - Save Saveas ...

1 | Ifreport dates are blank, no filtering by date will be done
Run report

Enter parameter: -

[5] surgery &

Enter parameter:

Age at

Surgeon

Available items: Selected items:
AMAMDACARROLL

WMISS SE CHALSTREY

MR BASS0O

MR D GUPTA

MR JP DONNELLY »

MRS ANNAN

AddAll Remove All

Operation side

Available items: Selected items
Left
Right

AddAll Remove All

Operation number
Available items: Selected items:
<Empty value= a

EIF R CIN

Above each Selected items box is a check box titled Ignored. This remains checked until a
value is moved into the box. If values are not moved across to a Selected items box and that
box remains empty, no filtering will be done on that selection and all parameter values will be
included in the report.

Selected items:

Remaove All

Lists

If there is a list of possible values which could be used in multiple reports (such as Assessment
appointment symbols) these can be defined in Lists set up in Auditbase Administration ->
Other definitions -> Lists for report parameters.

Show List Items
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When a parameter is a list of items, you can view the items by clicking on the Show list items

button. The button will only appear when you have selected a value containing a list.

Although the list items will be shown, you cannot make changes to the list from here. This must
be done from within Auditbase Administration since the same list may be being used in other
reports and to make changes will affect all the reports it is used in.

Moved + Interprete

Close

X

| Text

[] D Deceased

1 Interprete

M Moved

[J| T Transport

[] 0 .0perated

[J HHome visit

[J/F Medical

[J ¥.Check info

[J] Research

[] Paed. client

[J| Commercial

7| July 04 - digital aid info leaflet
[] MHAS digital aid

[] NHS

[J Domiciliary patient

[]| Private

[] Paper journal

[] 02,02

[/ 09,09

[] 03,08

[J .Comm. need - Large print
[] =, Comm. need - Braille

[J] #Comm. need - Easy read

Report Filters

To save report value selections you have made, click Save. You will be asked to give the
selections a Filter name.

Save report filker

Close

Rename the current filter

# Save as a new filter

Save to the current filter =Default=

Mame

B Save as the default filter
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Once you have done this, the report selections are saved as a named Filter and can be
accessed from the Current filter drop down list.

Multiple Report Filters

You can create differing versions of the same report and save them as Filters. To do this, open
the report you wish to adjust the parameters on. Change the values and click Save as. Give the
filter a name.

Save report filter x

Save Close

Save to the current filter =Default=
Rename the current filter

#| Save as a new filter
Name |testd |

[W] Save as the default filter

This will now be available in the Current filter drop down box along with your original report set-
up. Saving each report change as a filter will mean they are all there to be re-used in the future.
There is no need to keep re-building reports with varying values.

You can also direct Auditbase as to which report should be the default.

Save report filter >

Save Cloze

Save to the current filter =Default=

« Rename the current filter;

Save as a new filter
MName test2

W Save as the default filter

The report will always open the default report as standard.

If you have made changes to report parameters but have not saved them, you will be asked if
you wish to save them if you re-open the User reports list or exit Auditbase.

Run and refresh

The Run report button will highlight yellow as soon as a parameter is changed. This will alert
the user to the need for refreshing the existing report output. Clicking on the Run report button
will generate a new output for CSV reports.
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Report Filters
Current filter
o testz [Defauli] A Save Save as ... Delete

4 Ifatleast one of report dates is not entered, the previous whole calendar month will be used. -
When clicking "Save parameters for future use® or "Save parameters for future use and Run report’ [+

The white space to the right of the parameter lists will display the running dialogue and its
progress. If the report data is short, the dialogue will only flash onto the white area before
disappearing. A Stop button will display along with the report dialogue in order that the process
can be brought to a halt if it is taking too long to complete.

A LOG file is included in the output file in case there were errors which can be reported to
Support. If the report ran without errors, then it does not need to be retained and can be
deleted.

Once the report has completed running, the output file will open automatically in Excel.
Opening the report in Excel

The output file will open automatically in Excel.

H ©- = Extraction of StapesSurgery data and audiogram cutcome - Excel ? EH - O %
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADD-INS Team Sona Aghayan ~
X - sert - -
[ Calbri A =E=E 8- SEwepTe General - S st E‘“""E“ = éY ik
- G rJ' | F o C‘\I & Delete - v Sort & Find &
" B I U- #. & s === &E35= EMegefiCenter - - % 0 %10 onditional Formatas Cel . ort in
4 4 ? ° " 7% Formatting - Table- Styles- 0 Formats & = oo gojeq -
Clipboard 1 Font o Alignment 7] Mumber ] Styles Cells Editing ~
D1 - S Preop Date v
A B C D E F G H | J K L M N a |-
1 |nSurgery ID Surgery date Surgery Nr|Preop Da‘te_Pustop Date Followup Date Dropout Date Earside nAge atsuAge groug Concurrer ConcProcz ConcProc: ConcProct ConcPro
2 8 10/9/2013 1 10/9/2013  10/9/2013 10/9/2013 10/9/2013 R 13 19-Oct DBADO, exc probat meatus ac ext
3 9 2/7/2014 1 2/7/2014 2/7/2014 2/7/2014 2/7/2014 R 13 19-Oct DBAOO, ex DBBOO, ex DBD20, op plast meatus ac ex
4 12 3/7/2014 2 3/7/2014 3/7/2014 3/7/2014 L 46 40- 49

Data will populate the corresponding headed columns. Empty cells will indicate there is ho
corresponding information available in the patient’s record.

The CSV report once opened in Excel can be re-saved as an Excel document using the File ->
Save As option. If required it can also be renamed and/or dated to prevent overwriting by a
future report run.

Opening other reports from the Custom reports and statistics tab
To open a new report, go back to Modules -> User reports.

When you open a new report from Modules -> User reports, and another report is already
open, the back-ground screen will change. Despite this, the report screen will re-open once your
desired report has been selected.

Custom Reports and Statistics with Crystal report output
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Only in the Surgery folder will you find reports that display as Crystal reports. The Crystal report
output is displayed in the white space to the right of the report parameters.

When parameters are changed on a report, clicking the Run report button will cause the report
to be refreshed. Differences in output with modified selections can therefore be easily seen.

Crystal report output can be exported to a PDF document.
Scroll Bar

The scroll bar to the right of the report cannot recognise the size of the report and therefore will
always display as though the report is large (the scroll bar will be small). This scroll bar does not
support mouse scroll wheels.
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30 Communication
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30.1 Task list

Click the button below to access our training materials.

Atask list is a list of tasks that are not completed yet, for instance new appointments. Access
the Task list module from Navigation -> Task list or press Shift+Ctrl+T.

o}) Auditbase - [Task list]

File  Functions
[ Client 7132153 MRFIRSTNAME32153 LASTNAME32153 |~| 2 55 User  SYSTEMADMINISTRATOR | Alllocations Al departments -2
Filter | Al v| [ Complsted Selectall No rows selscled | New Edit
| [ [pate createa] Tasktype | Taskiapel [ Description | Hospital no Client name Assigned [ User Completed by| Date completed
0! 040812021 | Appointment T132153 VR FIRSTNAME32153 LASTNAME32153 | USER NAWE32 SYSTEM ADMINISTRATOR
0! 04/08/2021 | Appointment T132153 VR FIRSTNAME32153 LASTNAME32153 | USER NAMETT SYSTEM ADMINISTRATOR
0ot 040812021 | Repair T132153 MR FIRSTNAME32153 LASTNAME32153 | USER NAME41 SYSTEMADMINISTRATOR
0ot 040812021 | Appointment T132153 VR FIRSTNAME32153 LASTNAME32153 | USER NAMEST SYSTEMADMINISTRATOR
ot 0410812021 | Repair T132153 MR FIRSTNAME32153 LASTNAME32153 | USER NAME42 SYSTEMADMINISTRATOR

¢ The Task list shows the tasks created by any user linked to the current location or to the
global location. Change location to filter all entries for the desired location or choose All to
see all tasks.
¢ When location filtering is used, tasks will appear in the locations to which both the
assignee and the assigner belong.
» Tasks assigned to me will show all your tasks to do regardless of location.
e To create a new task, click New.
Mew task x
Add client Clear client Search client Save Cancel
Client
Hospitalno.  T18767 Mame FIRSTMNAMEBTGET LASTNAMEBTET
Task =
Date 13/01/2020 ALT;;?;
Task type - | Username n
Task label []| USER MNAME11
LISER NAMEGT
Priority Mormal - USER NAME44
Description - ]| USER NAME14
[ USER NAMES
[]| USER NAMES2
[]| USER NAME3S v
- Resource group
User full name tests??7? - -

e Select a client.
* Click Add client to select the current client or press Alt+a for a shortcut to add the current
client. If you wish to add a different client, click Search client. Click Clear client to create

a task without associating it with a client.

© Auditdata - 2025, ID: 20.0040/36

561


https://www.auditdata.com/courses/auditbase/task-list-new-user-training-raw-kaxpim_2/#/

User Guide

Select Task type, for instance Appointment or Audiogram. The task types are predefined
by your System Administrator. Task types can be outdated by your system administrator
and if so they will show in Auditbase with an asterisk * but will not be selectable.

Select Task label. The task labels are only enabled in Auditbase if defined by your system
administrator first and linked to a task type.

Add/move sections from below on entering Assignee, date priority etc.

The default date is set to today’s date. You can change the date manually.

Select the person to whom you wish to assign this task. You can select one or more
resources or a resource group. Users are listed by those from the currently selected
location first.

You can set the task to high, normal or low priority.

The System Administrator can link a predefined description to the task label or you can
type a description here.

When you have completed a task, select the check box column to the left and click
Complete.

To delete a task, select the check box column to the left and click Delete. Deleting tasks
is a permanent action. Once deleted, tasks cannot be retrieved. The System
Administrator can control which users are permitted to delete tasks which are not created
by themselves. If a user does not have the extended user right Task list: Delete any task
they will only be able to delete tasks created by themselves.

A warning is displayed to users when deleting tasks and includes the number of tasks
being deleted, this will mitigate the risk of users accidentally deleting tasks or deleting
more tasks than intended.

An Auto Journal Event can be enabled for Task deletion of uncompleted tasks associated
with Clients. This can be used to ensure that a record of an uncompleted Client Task is
always kept since it can include the Task description.

From the task list view you can see the priority of a task, which can be high, normal or low:

! High priority

< Low priority

To filter the task list view, select a filter from the drop-down box. You can also filter on
Completed tasks by checking the corresponding box.

Tasks related only to the current global client can be filtered by selecting Tasks for
selected client from the filter drop down.

The content of the filter and state of the Completed checkmark is remembered for each
user so they do not have to reapply their preferred filter.

To edit a task, double click on the task or select the check box column to the left and click
Edit.

When a user selects a Task on the list which is related to a different client, the System
Administrator can enable a warning to the user that the client is changing.
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¢ As a default, only the creator of the task and the person assigned to the task have a right
to edit the task. However, the system administrator can give extended rights to other
users so they can edit tasks as well.

e Click Save.

¢ When assigning a task, the user to whom the task was assigned will be alerted. If the task
is assigned to a whole group, all resources within the group will receive an alert. The user
must be associated with a group to receive group alerts. The alert for the task will be
cleared for all resources once the first user opens the task for review. Your system
administrator can set up whether the user should be notified only at login or also on the
screen while working.

¢ Bulk multi selection of Tasks is done using Shift and Control buttons in combination with
the mouse click in the normal Windows method. This will highlight the chosen rows in
black which can be selected for a Delete or Complete operation by checking the Select
highlighted button which reads Select all when no rows are highlighted.

o)) Auditbase - [Task list]

File Functions

| Client 7132153 MR FIRSTNAME32153 LASTNAME32153 | -| 8 5 ]| User  SYSTEM ADMINISTRATOR | Alllocations ~ | All departments -|[fx] 2

Filter | Al ~ W Completed ‘ Select highlighted rows | New

[ [ | [oatecreated| Tasktype | Taskiavel | Description [ Hospital no Client name Assigned [ User
0! Appointment T132153 | MR FIRSTNANE USER NAME32 SYSTEM ADMINISTRATOR
0! Audiogram T132153 | MR FIRSTNA 5 |USER NAMET1. SYSTEM ADMINISTRATOR
= Audiogram T132153 | MR FIRSTNAN 153 |USER NAMEGT SYSTEM ADMINISTRATOR
0! Earmouild T132153 | MR FIRSTNA 53 |USER NAME32 SYSTEM ADMINISTRATOR
01! |04m@iz021 |Appaintment T132153 | MR FIRSTNAME32153 LASTNANE32153 |USER NAMETT SYSTEM ADMINISTRATOR
Ot Jos Repair Ti USER NAME41 TEMAD TOR
O/t Jos Appaintment Ti: USER NAMEGT TEMAD TOR
O '] [04/08/2021 |Repair T132153 | MR FIRSTNAME32153 LASTNAME32153 | USER NAME42. SYSTEMADMINISTRATOR
0| [v/|0408/2021 |Appaintment T132153 MR FIRSTNAME32153 LASTNAME32153 |USER NAMETT.. SYSTEMADMINISTRATOR
0| [v/|0408/2021 |Appaintment T132153 MR FIRSTNAME32153 LASTNANE32153 |USER NAMEGT SYSTEM ADMINISTRATOR
O ' [/ |04108/2021 |Audiogram T132153 MR FIRSTNAME32153 LASTNANE32153 |USER NAME32 SYSTEM ADMINISTRATOR
O [v/|0408:2021 |Appaintment T132153 | MR FIRSTNAME32153 LASTNANE32153 |USER NAME32 SYSTEM ADMINISTRATOR
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30.2 Auditbase Viewer

The Viewer enables a user to view a client’s articles and audiograms. The user is not allowed to
enter any client data.

The Viewer is typically used as an interface application between a central Client Journal system
and Auditbase.

¢ Start the Viewer from the desktop icon.
¢ Log in with username and password.

You can also start the Viewer from the command line or from external application launch
facilities in third party applications in the following way:

e To start the program only by logging in:

¢ Viewer.exe - DBNAME:xxx-USERID:xxx-PASSWORD:xxx

¢ To start the program only by logging in and by pre-selecting a client:

o Viewer.exe - DBNAME:xxx-USERID:xxx-PASSWORD:xxx- CODE_P:xxx-CODE_S:xxxx
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30.3 General notes and daily notes

Both General notes and Daily notes are resource specific. General notes will be seen every day
until they are deleted. Daily notes will only appear for that particular day.

¢ Notes may be entered by clicking either General or Daily on the booking screen while

having selected a resource.

¢ To save the note, close the window and click Yes when prompted to save.

e The resource name in the resource list will now appear in red. To see the note, select the
resource and click Daily note/General note.

e The resource will also be alerted of the note with an alert, either at login or on screen
while working. Settings for this function are done by your system administrator.

565
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31 Technical Information
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31.1 Installation and Set-Up

For minimum and recommended client and server specifications, please refer to the Auditbase
Server and Client Specification.

For full step by step guidelines on how to install Auditbase System, please refer to the
Auditbase Complete Install Guide.
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31.2 Symbols Used on the System and in Documentation

Symbols are used on the system and in the documentation in places where this is required by
regulations or where it is simply more convenient due to space restrictions.

You can find an overview of the symbols used on packaging. Also, see below.

A General warnings

u Manufacturer address

ce
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32 Manufacturer and System Data

The SaMD Auditbase System is manufactured and sold in the EU by:

Head office:

Auditdata A/S

Wildersgade 10B 1408 Kgbenhavn K Denmark
Phone: +45 70203124

www.auditdata.com

2003 Auditbase

Documentation version:

Auditbase Help System version 20.0040/36

Symbols used on the system, its packaging, and in documentation:

See the section "Symbols Used on the System and in Documentation" for an overview of
symbols used.
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